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پيشگفتار

هنر می تواند به کیفیت زندگی بیفزاید اگر انسانی بتواند زندگی خود را به صورت هنرمندانه ای خلق کند که در نهایت به 
اثری که از خود خلق کرده آفرین بگوید و از زندگی نهایت لذت را ببرد در واقع آن فرد یک هنرمند است. اگر شما در هنری 

که خلق می کنید کمی خلاقیت نیز به خرج بدهید در این صورت هنر شما خاص و منحصربه فرد به نظر می رسد.
در کارهایی که انجام می دهید از خود خلاقیت به خرج بدهید. خیلی ها فکر می کنند فقط کارهای گرافیکی، نقاشی 
کردن یا امثال این ها هنر نامیده می شود اما حقیقت آن است که در این دنیا هر حرفه ای به نام هنر شناخته می شود و اگر 
بتوانید در آن حرفه به صورت حرفه ای کار کنید و سپس در آن از خود خلاقیت به خرج  دهید شما تبدیل به یکی از بهترین ها 
در آن حرفه خواهید شد. حتی خلاقیت هم یک هنر است و باید آن را یاد بگیرید. آدم ها از همان بچگی خلاق به دنیا نمی آیند 
بلکه کم کم بزرگ می شوند و با این بزرگ شدن مهارت خلاقیت را هم کسب می کنند. فراموش نکنید که خلاقیت ذاتی نیست 

بلکه اکتسابی است و مانند هر هنر دیگری قابل آموزش است.
در این کتاب در بخش های مختلف نرم افزار، نگاه جامع و کامل تری نسبت به ارتباط طراح و نیاز بازار وجود دارد و 
اهمیت موضوع، به تجربه ها و نکات کاملًا کاربردی و موردنیاز طراحان و کاربران عزیز اشاره شده است؛ دغدغه و آرزوی مؤلفان، 
سودمندی کتاب و افزایش سطح اطلاعات نرم افزاری شما، حداقل برابر با هزینه و زمان صرف شده برای مطالعه این کتاب است 

و امیدواریم که خداوند متعال یاری دهد و رضایت خوانندگان محترم فراهم شود.
جا دارد از تمام کسانی که در این مورد ما را یاری کردند تشکر کنیم.

مؤلفان
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  نرم افزار InDesign را نصب و راه اندازی كند.

  يک سند را باز كند.

  سندی را ايجاد كند.

  پنل ها را در حين انجام كار مخفی كند.

  يک فضای كاری سفارشی ايجاد كند.

  خطوط راهنما را به كار گرفته و آن ها را پس از ايجاد سند تغيير دهد.

  چگونگی تغيير تنظيمات سند را پس از ايجاد بررسی كند.

  ابزارهای Gap را به كار گيرد.

  حاشيه و ستون بندی صفحات را تنظيم كند.

  از الگوها استفاده كند.

 كليات

InDesign را درست مثل هر برنامه ديگری كه استفاده می كنيد، اجرا كنيد. روش های مختلفی برای اجرای 
InDesign وجود دارد. ساده ترين و سريع ترين روش موردنظر خود را انتخاب كنيد. می توانيد آن را از نوار 
وظيفه Windows باز كنيد يا از ميانبر موجود در دسک تاپ استفاده كنيد و الی آخر. لازم نيست همه راه ها 
 Adobe را بدانيد، همان روشی را كه راحت هستيد انجام دهيد. مثلًا می توانيد روی آيکن برنامه كاربردی

InDesign CC در منوی Start، صفحه نمايش Start يا نوار وظيفه كليک كنيد.
يا در صورت استفاده از Windows 10، می توانيد InDesign را در Cortana تايپ كنيد و پس از ظاهر شدن 

برنامه كاربردی InDesign در نتايج جستجو، روی آن دابل كليک كنيد يا Enter را فشار دهيد.
هنگامی كه InDesign را اجرا می كنيد، با يک فضای كاری Start مواجه می شويد )شکل 1ـ1(. اين فضای 
كاری Start برای كمک به شما در جهت استفاده صحيح از InDesign و يادگيری آن طراحی شده است.

InDesign در Start شکل 1ـ1ـ فضای کاری

زمان آموزش

عملینظری

713
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می توانيد برای مشاهده مطالب آموزشی و چگونگی ايجاد اسناد مختلف، روی برگه Learn كليک كنيد. تا 
مطالب آموزشی را مشاهده كنيد تا به شما بياموزند چگونه انواع اسناد مختلف InDesign را بسازيد.

هنگام ايجاد سند جديد، برگه Work فضای كاری Start دو راه برای شروع كار در اختيار شما می گذارد. 
 File>New>Document است كه ميانبری برای فرمان Create New روش اصلی كليک كردن روی دكمه
است. اين امر موجب باز شدن كادر محاوره ای New Document می شود كه پيش تنظيمات متعددی را ارائه 
می دهد كه می توانيد از آن ها به عنوان نقطه شروع استفاده كنيد. در صفحه 20 تا 23 نگاه دقيق تري به كادر 

محاوره اي New Document شده است.

1ـ1ـ روش های استفاده از الگوها

 Start در پايين فضای كاری Adobe Stock اگر علاقه منديد از يک الگو شروع كنيد، در فيلد جستجوی
يا از طريق فرمان ... File>Search Adobe Stock، هر آنچه را كه به دنبالش هستيد، تايپ كنيد و روی 

Go كليک كنيد. در نتيجه اين كار به صفحه وب Adobe Stock از الگوهای سند InDesign می رويد.
در استفاده روزانه، اولين كاری كه اغلب و پس از شروع InDesign می خواهيم انجام دهيم، ادامه كار روی 
پروژه های فعلی تان است. هنگامی كه فضای كاری Start ظاهر شد، روی Recent كليک كنيد. اين كار موجب 
 InDesign می شود كه اخيراً باز كرده ايد )چنانچه اولين بار است كه از InDesign نمايش فهرستی از اسناد
بازنشانی  را   InDesign پيش فرض(  )تنظيمات  ترجيحات  يا چنانچه  استفاده می كنيد  كامپيوتر خود  روی 
 File>Open ميانبری برای فرمان Recent خالی خواهد بود(. فهرست Recent كرده ايد، احتمالاً فهرست

Recent است.
اگر اسناد InDesign خود را در فضای ذخيره سازی آنلاين Creative Cloud Files نگه می داريد، می توانيد 
با كليک كردن روی CC File آن ها را ببينيد. Creative Cloud Files فضای ذخيره سازی ابری مربوط به 

Adobe ID است كه در آن ثبت نام كرده ايد.

 InDesign 2ـ1ـ چگونگی كار با فضای كاری 

هنگامی كه يک سند InDesign را باز می كنيد، خود را در فضای كاری سند InDesign می بينيد )شکل 
2ـ1( كه برای ارائه گزينه هايی طراحی شده است كه بيشترين ارتباط را با آن چيزی دارند كه در حال كار 
روی آن هستيد. به علاوه، می توانيد فضای كاری InDesign را با كنترل هايی سفارشی كنيد كه می خواهيد 

دم دستتان باشد و فضای نمايش را با پنهان كردن گزينه هايی كه مدنظرتان نيستند، خلوت كنيد.
حال اجازه دهيد نگاهی به برخی از نواحی فضای كاری InDesign بيندازيم كه اغلب از آن ها استفاده خواهيد كرد.

3ـ1ـ پنل كنترل 

ارائه می دهند كه در ميان منوها،  را  InDesign صدها ويژگی و گزينه  برنامه های كاربردی حرفه ای نظير 
پنل ها و كادرهای محاوره ای گسترده شده اند. چالش عمده پيمايش بين اين مکان ها در حين كار كردن و 

به ويژه در حين يادگيری است.
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شکل 2ـ1ـ فضای کاری InDesign حاوی پنجره های سند و پنل های برنامه کاربردی است.

پنل كنترل )شکل 3ـ1( با سازگاری خودكار با آنچه كه انجام می دهيد، گام بزرگی به سوی حل اين مسئله 
برمی دارد. هنگامی كه ابزاری را انتخاب می كنيد، پنل كنترل گزينه هايی را برای آن ابزار خاص نشان می دهد. 
هنگامی كه چيزی را انتخاب می كنيد، پنل كنترل برای تمركز بر گزينه هايی كه برای شیء منتخب در سند مفيد 
هستند، تغيير می كند. مثلًا، اگر يک شیء گرافيکی را انتخاب كنيد، پنل كنترل گزينه های گرافيکی را نشان 
می دهد. اگر متنی را انتخاب كنيد، پنل كنترل، كنترل های تايپ را ارائه می دهد. اگر چند شیء را انتخاب كنيد، 

پنل كنترل گزينه هايی را برای هم تراز كردن آن ها اضافه می كند. 

شکل 3ـ1ـ پنل کنترل پر استفاده ترین گزینه ها را برای شیء فعال جاری نشان می دهد.
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گزينه های موجود در پنل كنترل فقط در آنجا وجود ندارند. مثلًا، در حالی كه پنل كنترل گزينه های مربوط 
باشيد  باز كرده  را هم   Character برای يک فريم متنی منتخب نشان می دهد، چنانچه پنل  را  تايپ  به 
)شکل 4ـ1(، گزينه های مشابه متعددی را هم در آنجا خواهيد ديد. نکته اينجاست كه فقط به اين دليل 
 Character كه به مدت 30 ثانيه با متن كار كرده ايد، نيازی نيست كه به خودتان زحمت دهيد و پنل

را باز كنيد، در صورتی كه گزينه های تايپ مدنظر شما هم اكنون در پنل كنترل در حال نمايش هستند.

شکل 4ـ1ـ گزینه های موجود در پنل کنترل از پنل های تخصصی تر گرفته می شوند، بنابراین می توانید با پنل های باز کمتری 
کار بیشتری انجام دهید.

ابزارهای متعددی وجود دارند كه همه آن ها هم زمان قابل رؤيت نيستند. برخی از ابزارها گروه بندی شده اند و 
در هر زمان، فقط يکی از آن ها قابل مشاهده است. هنگامی كه مثلث كوچکی را در گوشه سمت راست پايين 
يک ابزار می بينيد، آن مثلث نشان می دهد كه گروهی با ابزارهای پنهان وجود دارد )شکل 5ـ1(. برای مشاهده 

كل گروه ابزار، ابزار را فشار داده و نگه داريد تا بقيه ابزارها در يک منوی بازشو پديدار شوند.

Selection ابزار A
Direct Selection ابزار B

Page ابزار C
Gap ابزار D

)Content Placer گروه بندی شده با ابزار( Content Collector ابزار E
)Type on a Path گروه بندی شده با ابزار( Type ابزار F

Line ابزار G
 )Convert Direction Point و Delete Anchor Pointو،Add Anchor Point گروه بندی شده با ابزارهای( Pen ابزار H

)Erase و Smooth گروه بندی شده با ابزارهای( Pencil ابزار I
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)polygon Frame و Ellipse Frame گروه بندی شده با ابزارهای Rectangle Frame ابزار J
)Polygon و Ellipse گروه بندی شده با ابزارهای( Rectangle ابزار K

Scissors ابزار L
)Shear و Scaleو،Rotate گروه بندی شده با ابزارهای( Free Transform ابزار M

Gradient Swatch ابزار N
Gradient Feather ابزار O

Note ابزار P
)Measure و Eyedropper گروه بندی شده با ابزارهای( Color Theme ابزار Q

Hand ابزار R
Zoom ابزار S

Stroke و Default Fill ابزار T
Stroke و Swap Fill ابزار U

V آيکن های Fill و Stroke برای اعمال رنگ ها
W آيکن Container و Text برای اعمال رنگ ها

Apply Color/Gradient/None آيکن X
View Options آيکن Y

Tools شکل 5ـ1ـ پنل
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 4ـ1ـ نحوه تنظيمات نوار ابزار 

پس از يک نصب درست InDesign، پنل Tools هميشه ستون منفردی در سراسر سمت چپ فضای كاری 
باشد. در صورت چنين  بزرگ  نمايش كوچک تر، خيلی  برای صفحات  است  Tools ممکن  پنل  البته،  است. 
اتفاقی، می توانيد روی فلش های دوتايی در بالای پنل Tools كليک كنيد تا آن را به يکی از حالت های ديگرش 
ببريد )شکل6                  ـ1( كه ممکن است پنل Tools با صفحه نمايش شما متناسب تر باشد و آسان تر بتوانيد برخی از 

دكمه های مفيد را در پنل Tools ببينيد.

شکل 6   ـ 1ـ برای امتحان چیدمان های مختلف پنل Tools، روی فلش های دوتایی در بالای پنل کلیک کنید.

 5 ـ1ـ چگونگی كار با فضاهای كاری مختلف و ایجاد فضای كاری سفارشی

تاكنون درباره فضای كاری InDesign به عنوان نمايش كلی ابزارها و گزينه ها روی صفحه نمايش شما صحبت 
كرديم و بيان كرديم چگونه آن ها قابل سفارشی شدن هستند، زيرا می توانيد پنل هايی را كه روی صفحه 
نمايش می بينيد، بسط دهيد، جمع كنيد و بازآرايی كنيد. ولی پنل های بسياری وجود دارند كه ممکن است 
اهميت چندانی برای شما نداشته باشند. به اين علت است كه شما می توانيد پيکربندی های مختلف پنل را 

ذخيره كنيد و آن فضاهای كاری را نام گذاری كنيد.
می توانيد فضاهای كاری نزديک سمت راست نوار برنامه كاربردی را در بالای فضای كاری InDesign درست 
در سمت چپ فيلد جستجو تغيير دهيد. روی سوئيچ كننده1 فضای كاری )شکل 7ـ1( كليک كنيد تا منويی 
از فضاهای كاری پيش تنظيم نصب شده با InDesign را ببينيد. اگر فضاهای كاری خاص خود را ايجاد كنيد، 

در بالای آن منو ظاهر خواهند شد.

Switchir ـ1
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شکل 7ـ1ـ سوئیچ کننده فضای کاری به شما اجازه تغییر دادن فضای کاری فعال را می دهد.

فهرست فضاهای كاری نيز در زيرمنوی Window>Workspaces ظاهر می شود.
حال به نکاتی درباره استفاده از فضاهای كاری می پردازيم:

  اگر آرايشی از پنل ها را ايجاد كرده ايد و می خواهيد آن را ذخيره كنيد، New Workspace را از منوی 

سوئيچ كننده فضای كاری انتخاب كنيد.
  اگر از يکی از فضاهای كاری نام گذاری شده خود استفاده می كنيد و می خواهيد آن را به روزرسانی كنيد، 

دوباره New Workspace را انتخاب كرده و همان نام فضای كاری مدنظرتان برای به روزرسانی را به آن 
بدهيد؛ InDesign در مورد جايگزينی با فضای كاری موجود از شما سؤال می كند.

  اگر بعضی از پنل ها را در يکی از فضاهای كاری معين خود بازآرايی می كنيد، ]نام فضای كاری[ Reset را 

از منوی سوئيچ كننده فضای كاری انتخاب كنيد، فضای كاری به حالت پيش فرض باز می گردد.
به دليل اينکه پنل ها در InDesign كاربرد مشخصی دارند، بعضی از پنل ها فقط برای وظايف يا گردش های 
با   eBook يا يک  تعاملی   PDF ايجاد يک  برای   InDesign از  كاری خاص مفيد هستند. مثلًا، می توانيد 
 Buttons and Forms پويانمايی هايی استفاده كنيد كه نياز به استفاده از پنل های خاصی دارند، از قبيل پنل
يا پنل Animation.وAdobe تعدادی فضای كاری پيش تنظيم InDesign را برای گردش های كاری متداول 

ايجاد كرده است؛ می توانيد از بين آن ها از سوئيچ كننده فضای كاری كه قبلًا ديديد، انتخاب كنيد.
فضاهای كاری پيش فرض InDesign عبارت اند از:

  Start: هنگامی كه هيچ سندی در InDesign باز نيست، فضای كاری Start تنها فضای كاری موجود است و 

به طور خودكار ظاهر می شود. هنگامی كه يک يا چند سند باز هستند، فضای كاری Start در دسترس نخواهد بود.

  Essentials: اين فضای كاری پيش فرض است. می توانيد از آن برای طيف گسترده ای از پروژه های پايه استفاده كنيد.

  Advanced: اين فضای كاری شامل پنل ها در فضای كاری Essentials است، در حالی كه پنل های اضافه ای 

دارد كه در حفظ تصاوير گرافيکی و استانداردهای حروف نگاری از طريق فهرست های شيوه InDesign به 
.)Character Styles و Paragraphو،Object Styles شما كمک می كنند )پنل های

  Book: چيدمان پنلی در اين فضای كاری برای ايجاد و مديريت اسناد طولانی بهينه شده است. در اين فضای 

كاری، پنل هايی برای ويژگی های اسناد طولانی مثل مراجع و مآخذ، متن شرطی، نمايه و نشانه ها اضافه شده است.
  Digital Publishing: اين فضای كاری بر پنل های مورد نياز برای ايجاد اسناد ديجيتال تعاملی تمركز 

.Hyperlinks و Buttonsو،Mediaو،Timingو،Animation دارد، از قبيل پنل های
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  Interactive for PDF: اين فضای كاری بر پنل هايی تأكيد دارد كه از ايجاد فايل های PDF تعاملی 

.Media و Buttons and Formsو،Page Transitions پشتيبانی می كنند، از قبيل پنل های
  Printing and Proofing: پنل ها در اين فضای كاری بر يک گردش كار پيشرفته برای چاپ تجاری 

.Preflight و Trap Presetsو،Separations Preview تمركز دارند، از قبيل پنل های
 InDesign اين فضای كاری بر پنل های حاوی ويژگی های متنی و حروف نگاری قوی در :Typography  

Character،وCharacter Styles،وParagraph،وParagraph Styles،و پنل های  قبيل  از  دارد،  تأكيد 
می توانيد  زمان  هر  در  شما  هستند.  پيشنهاد  درحد  فقط  پيش تنظيم  كاری  فضاهای   .Story و   Glyphs
كاری  فضای  از  است  ممکن  می كنيد،  كار  كاتالوگ  يک  روی  اگر  مثلًا،  كنيد.  استفاده  كاری  فضای  هر  از 
كاری  فضای  به  متن،  دقيق  تنظيم  برای  كنيد،  استفاده  صفحات  كلی  چيدمان  انجام  برای   Advanced
 Printing and Proofing سوئيچ كنيد، برای آماده كردن كاتالوگ برای چاپ، به فضای كاری Typography
برويد.  Interactive به فضای  كاتالوگ  از  دانلود  قابل   PDF نگارش  آماده كردن يک  برای  برويد و سپس 
هنگامی كه در InDesign تجربه پيدا كرديد، ممکن است آرايش پنلی خودتان را ترجيح دهيد كه متفاوت 
از همه آرايش های پيش تنظيم باشد. اينجاست كه بايد فضای كاری سفارشی خاص خودتان را ذخيره كنيد.

6ـ1ـ ایجاد فضاهای كاری سفارشی

برای ايجاد يک فضای كاری سفارشی )شکل 8 ـ1(:
1 همه پنل هايی را كه نمی خواهيد ببنديد.

2 پنل هايی را كه می خواهيد در فضای كاری شما ذخيره شوند، باز كرده و آرايش دهيد.
3 در سوئيچ كننده فضای كاری از منوی Window>Workspace گزينه New Workspace را انتخاب كنيد.

4 فضای كاری خود را نام گذاری كنيد، مطمئن شويد كه Panel Locations انتخاب شده است و سپس 
روی OK كليک كنيد.

شکل 8 ـ1ـ پس از ایجاد یک فضای کاری سفارشی، در بالای سوئیچ کننده فضای کاری ظاهر می شود.

7ـ1ـ بررسی حالت های صفحه نمایش

يکی از مهم ترين موارد درباره پنجره سند InDesign اين است كه تمام انواع دستيارهای بصری را به شما 
نشان می دهد تا به شما كمک شود بدانيد دنبال چه چيزی هستيد و سند خود را به صورتی كارآمد صفحه آرايی 
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هستند. صفحات  كنترل هايی  و  دارای شاخص ها  اشيا  كنيد. 
دارای حاشيه1، خطوط راهنما2 و مشبک3 هايی هستند كه در 
صفحه بندی و برآورده ساختن نيازها به شما كمک می كنند. 
از اين دستيارهای بصری قرار نيست در سند  ولی هيچ يک 
كه طرح  ببينيد  تنهايی  به  می خواهيد  وقتی  و  باشند  نهايی 
شما به چه صورت است، می توانند مانع باشند و حواس شما را 
پرت كنند. به همين دليل InDesign چندين حالت صفحه 
را فراهم می كند )شکل 9ـ1( تا بتوانيد انواع مختلف عناصر را 

در فضای كاری پنهان كنيد يا نمايش دهيد.
  Normal: حالت صفحه نمايش Normal معمولاً حالت كاری روزانه شماست، زيرا شما می توانيد تمام اشيا و 

خطوط راهنما را ببينيد، حتی آن هايی كه در ناحيه غيرچاپی Pasteboard و خارج از لبه های صفحه هستند.
  Preview: حالت Preview روشی عالی برای مشاهده چگونگی طراحی سند به هنگام چاپ يا صدور است، بدون 

اينکه درهم و برهمی ناحيه Pasteboard، خطوط راهنمای مختلف و علامت های روی صفحه نمايش ديده شوند.

شکل 10ـ1ـ استفاده از سوئیچ کننده فضای کاری در نوار برنامه کاربردی برای تغییر دادن فضاهای کاری

Margin ـ1
Guides ـ2
Grids ـ3

InDesign شکل 9ـ1ـ حالت های صفحه نمایش در
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آن ها  ولی  نمی كنيد،  استفاده   Slug و   Bleed حالت های  از  الان  همين  احتمالاً  شما   :Slug و   Bleed   

برای بعضی از پروژه های چاپی مفيد هستند كه در آن پروژه ها، سند دارای مقادير Bleed و Slug در كادر 
محاوره ای File>Document Setup است. Bleed ناحيه ای اطراف صفحه برای عناصری است كه پس از 
چاپ بريده خواهند شد و Slug فضايی اضافی برای چاپ اطلاعات سند است )كه آن هم بريده خواهد شد(. 

حالت های Bleed و Slug نشان می دهند كه اين نواحی خارج از لبه صفحه هستند.
  Presentation: اگر بخواهيد يک سند InDesign را به صورت يک اسلايدشو روی صفحه نمايش نشان 

از  را كه خارج  پنهان می كند، هر چيزی  به جز طراحی  را  اين حالت هر چيزی  اين راهش هست.  دهيد، 
لبه های صفحه است، می برد و صفحه را در يک پس زمينه سياه نشان می دهد. می توانيد صفحات را با استفاده 

از كليدهای جهتی يا كليدهای Page Up و Page Down حركت دهيد. 

برای تغيير حالت صفحه نمايش می  توانيد به يکی از اين روش ها عمل كنيد:
  در پنل Tools، روی دكمه Screen Mode كليک كنيد )شکل 11ـ1( و حالتی را انتخاب كنيد. توجه 

داشته باشيد كه اگر پنل Tools در حالت دو ستونی است، دو دكمه Screen Mode وجود دارد: دكمه چپ، 
بازنشانی تک كليکی به Normal است و دكمه راست به شما اجازه می دهد بين همه حالت ها سوئيچ كنيد به 

استثنای حالت Normal. اين تغيير حالت، با فشردن و نگه داشتن دكمه امکان پذير می شود.

View از منوی Screen Mode شکل 11ـ1ـ انتخاب

  View>Screen Mode را انتخاب كرده و حالتی را از زيرمنو برگزينيد.
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8ـ1ـ روش های مختلف بزرگ نمایی روی صفحات

روش های متعددی برای تغيير بزرگ نمايی پنجره يک سند InDesign وجود دارد، استفاده از ابزارها تا فرامين 
و ميانبرها، بنابراين می توانيد روش هايی را انتخاب كنيد كه بيشترين تناسب را با شيوه كاری شما دارند.

:Zoom برای تغییر دادن بزرگ نمایی سند با ابزار
( را انتخاب كنيد. ( Zoom 1 ابزار

2 روی شيئی كه می خواهيد بزرگ نمايی كنيد، كليک كنيد.
با هر بار كليک، سطح بزرگ نمايی افزايش می يابد. ممکن است برای بزرگ نمايی بخشی از صفحه، نياز به 

چند كليک باشد.
برای بزرگ نمايی ناحيه ای خاص )شکل 12ـ1(:

Zoom شکل 12ـ1ـ بزرگ نمایی بخشی از صفحه با کشیدن مستطیل دربرگیرنده ناحیه با ابزار

1 ابزار Zoom را انتخاب كنيد.
2 مستطيل چشمک زن را حول ناحيه ای از صفحه كه می خواهيد بزرگ نمايی كنيد، بکشيد.

ناحيه محصوركننده شما حالا كل پنجره سند را پر می كند.
 Fit Page In Window و Actual Size )100%( ،دو مورد از مفيدترين سطوح بزرگ نمايی پيش تنظيم
است. هر دو سطح بزرگ نمايی دارای فرامين منوی راحتی هستند، با اين حال می توانيد از كليدهای ميانبر 

آن ها نيز استفاده كنيد.
 View>Fit Page In سند،  پنجره  در  فعال  صفحه  كردن  وسط چين  و  بزرگ نمايی  برگرداندن  برای    

Window را انتخاب كنيد يا Ctrl+0 را بفشاريد.
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  برای تنظيم سطح بزرگ نمايی با 100 درصد، View>Actual Size را انتخاب كنيد يا Ctrl+1 را بفشاريد.

هنگام طراحی گزارش ها، كتاب ها و مجلات مدنظر برای چاپ، مشاهده صفحات روبه رو )با طراحی صفحه 
سمت راست و چپ در كنار هم( با جايگذاری عناصر طراحی و ايجاد ريتم، تراز و  هارمونی در طراحی شما 

Spread گفته می شوند.  كمک خواهد كرد. صفحاتی كه روبه روی هم قرار می گيرند، اصطلاحاً 

میانبر: برای دستيابی موقت به ابزار Zoom به هنگام انتخاب ابزاری ديگر، Ctrl+Spacebar را فشار 
دهيد. برای كوچک نمايی كليد Alt را هم به اين مجموعه اضافه كنيد.

برای وسط چين كردن Spread فعال در پنجره سند )شکل 13ـView>Fit Spread In Window ،)1 را 
انتخاب كنيد يا Ctrl+Alt+0 را فشار دهيد.

شکل 13ـ1ـ هنگام کار با Spreadهای چند صفحه ای، می توانید کل Spread را در پنجره سند مشاهده کنید.

برای بزرگ نمايی  را فشار دهيد.   Ctrl+5 تا سطح 50 درصدی،  برای كوچک نمايی سريع  میانبر: 
را فشار دهيد.  Ctrl+2 200 درصدی، 

منوی View حاوی انتخاب كاملی از فرامين بزرگ نمايی و ميانبرهای صفحه كليد آن هاست )شکل 14ـ1(. 
فرامين Zoom In و Zoom Out با تغييرات از پيش تنظيم شده بزرگ نمايی را انجام می دهند.
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شکل 14ـ1ـ سطوح بزرگ نمایی پیش تنظیم و فرامین Zoom In و Zoom Out را در منوی View مشاهده خواهید کرد.

مکانی ديگر برای تغيير بزرگ نمايی سند، منوی Zoom Level در نوار پايين InDesign است )شکل 15ـ1(. 
می توانيد از هر يک از سطوح بزرگ نمايی از قبل تنظيم شده انتخاب كنيد يا سطح بزرگ نمايی سفارشی را وارد كنيد.

هنگام استفاده از فرامين يا ميانبرها برای بزرگ نمايی، به خاطر بسپاريد كه اگر چيزی در صفحه انتخاب نشده 
باشد، بزرگ نمايی از وسط نمای جاری اعمال می شود. اگر اشيا انتخاب شده باشند يا نقطه درج در متن باشد، 

سطح بزرگ نمايی از وسط آن عنصر انجام می شود.

شکل 15ـ1ـ منوی Zoom Level در نوار برنامه کاربردی
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 9ـ1ـ چگونگی استفاده از خط كش و خطوط راهنما

ديگر،  به روش  می شود.  استفاده   Ctrl+R كليد  صفحه  ميانبر  از  خط كش ها  كردن  غيرفعال  و  فعال  برای 
می توانيد به منوی View برويد و Show Rulers يا Hide Rulers را انتخاب كنيد )اين گزينه بسته به اينکه 
خط كش ها در حال حاضر قابل رؤيت باشند يا نباشند، تغيير می كند(. اين امر موجب آشکار يا پنهان شدن 
آن ها در سمت چپ و بالای سند می شود. هنگامی كه خط كش ها قابل رؤيت هستند، ويژگی های سند اصلی 
را خواهند گرفت. بنابراين، اگر سند را برحسب اينچ تنظيم كرده باشيد، آن گاه خط كش هم برحسب اينچ 
خواهد بود. برای تغيير دادن واحد اندازه گيری، روی يکی از خط كش ها كليک راست كنيد تا منوی بازشويی 
 Inchesو،Inchesو،Picasو،Points :به شما نشان داده شود كه اين گزينه ها را در اختيار شما قرار می دهد
Decimal،وMilimeters،وCentimeters،وCiceros،وAgates و Pixels )شکل 16ـ1(.  می توانيد در هر 
زمان بين اين گزينه ها جابه جا شويد. مقدار صفر هميشه به طور پيش فرض گوشه سمت چپ بالا در محل 
تقاطع خط كش هاست. اگر بخواهيد صفر خط كش شما در جای ديگری در سند شروع شود، كافی است روی 
مربع كوچک در محل تقاطع خط كش ها كليک كرده و صفر را به مکانی جديد بکشيد. در منوی بازشويی كه 
 Rulerو،Ruler Per Page هنگام كليک راست روی خط كش ظاهر می شود نيز می توانيد تنظيم گزينه های

Per Spread يا Ruler On Spine را انتخاب كنيد.

شکل 16ـ1ـ گزینه های مختلف خط کش ها

در  عمودی )چپ(  و  )بالا(  افقی  از خط كش های  را  راهنما  می توانيد خطوط  هنگام صفحه آرايی يک سند، 
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لبه های پنجره سند بکشيد )اين ها تنها مکان هايی هستند كه خط كش ها قابل رؤيت خواهند بود(. كافی است 
روی خط كش كليک كرده و در حين پايين نگه داشتن دكمه ماوس، مکان نما را به مکان مناسب بکشيد، 
سپس ماوس خود را رها كنيد تا خط راهنما در آن مکان قرار گيرد )شکل 17ـ1(. برای اعمال يک خط 
راهنما بر كل Spread، كليد Ctrl را فشار داده و در حين كشيدن يک خط راهنمای افقی، آن را نگه داريد. 
نگه داشتن كليد Alt در حين كشيدن يک خط راهنما از خط كش افقی، موجب تغيير آن به خط راهنمای 
عمودی می شود و برعکس. اگر می خواهيد قبل از رها كردن ماوس، دست از خط راهنما بکشيد، كافی است 

كليد Esc را فشار دهيد.
برای انتخاب همه خطوط راهنما در يک صفحه يا Spread،وCtrl+Alt+G را فشار دهيد. اگر می خواهيد 
تقاطع  نگه داريد و در محل  را فشرده و   Ctrl افقی و عمودی رسم كنيد، كليد  هم زمان خطوط راهنمای 
خط كش ها در سمت چپ بالای پنجره سند، كليک كرده و ماوس را بکشيد )چنانچه خط كش ها قابل رؤيت 
نيستند، Ctrl+R را فشار دهيد(. اگر در حال كشيدن يک خط راهنمای عمودی هستيد ولی می خواهيد 
سريعاً آن را به يک خط راهنمای افقی تبديل كنيد )يا برعکس(، كليد Alt را هنگام كشيدن فشرده و نگه 
داريد. چنانچه می خواهيد همه خطوط راهنما را حذف كنيد، روی يکی از خط كش ها كليک راست كرده و 
Delete All Guides on Spread را انتخاب كنيد. هم چنين می توانيد از ويژگی Smart Guides تعبيه شده 
در Indesign استفاده كنيد كه خطوط راهنمای قابل رؤيتی را به شما ارائه می دهد كه برای تراز كردن اشيا 
 View>Grid & از آن ها استفاده كرده ايد. برای فعال يا غيرفعال كردن اين خطوط راهنما، كافی است به

برويد.  Guides>Smart Guides

شکل 17ـ 1ـ استفاده از خطوط راهنما
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شکل 18ـ1ـ تغییرات در خطوط راهنما
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واحد كار دوم

مدیریت صفحات اسناد
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  از منوی Layout برای مديريت صفحات استفاده كند.

  پنل Page را به كار گيرد.

كليات

است.  نشر  دنيای  برای  موجود  ابزارهای  قوی ترين  با  اسناد  از  صفحاتی  ساخت   ،InDesign قضيه  اصل 
تا يک كتاب بزرگ است. صفحات و اسپريدها به  ابزاری برای ساخت يک سند تک صفحه ای   InDesign
شما اجازه می دهند سند خود را به طور حرفه ای و كارآمد تنظيم كنيد. در اين واحد كار، نگاهی به تنظيم 
اولين سند شما خواهيم داشت و طيفی از تنظيمات موجود را بررسی خواهيم كرد كه بايد قبل از شروع يک 
پروژه بدانيد. هم چنين بررسی می كنيم كه چگونه صفحات اصلی بسيار مهم را تنظيم كنيم، چگونه آن ها را 
ويرايش كنيم، بازآرايی كنيم، تغيير اندازه بدهيم و حتی به آن ها كد رنگی بدهيم تا شناسايی آن ها در سند 
آسان شود. هنگامی كه برای اولين بار شروع به ساخت اسناد می كنيد، با تنظيمات پيش فرض بسياری شروع 
استفاده  بارها  را تنظيم كنيد كه  اسنادی  برای شما وجود دارد. می توانيد  اما گزينه های بسياری  می كنيد، 
شوند يا اسناد بسيار منحصربه فردی را تنظيم كنيد. البته بايد بدانيد كه InDesign فقط برای چاپ نيست؛ 
هنگامی كه درباره اسناد برای وب صحبت می كنيم، InDesign ابزاری بسيار قوی و عالی است. مجبور نيستيد 
فقط از اندازه های چاپی پيش فرض استفاده كنيد؛ می توانيد از اندازه های مختلف وب يا حتی اندازه های خاص 

دستگاه ها، مثلًا اندازه ای كه مناسب يک iPhone است، استفاده كنيد.

زمان آموزش

عملینظری

520
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1ـ2ـ ایجاد یک سند خالی جدید

به File>New>Document برويد تا كادر محاوره ای مربوطه باز شود. بسته به پيکربندی ترجيحات1 شما، 
يکی از اين دو كادر محاوره ای را خواهيد ديد )شکل 1ـ2(: كادر محاوره ای New Document قديمی )شکل 
 (Recent) است و اسناد اخير Start كه شبيه فضای كاری New Document سمت چپ( يا كادر محاوره ای
را نشان می دهد )سمت راست(. می توانيد با انتخاب يکی از اندازه های از قبل تعيين شده موجود در اين كادر 
محاوره ای سند خود را ايجاد كنيد )اگر از فضای كاری Start استفاده می كنيد( يا اندازه ای اختصاصی را ايجاد 
كنيد. اگر كادر انتخاب Preview را در پايين هر يک از كادرهای محاوره ای New Document در حالت 
تأييد قرار دهيد، سند جديد را در زير كادر محاوره ای خواهيد ديد. اگر نمی خواهيد از ابعاد استاندارد موجود 
استفاده كنيد، تنظيمات موردنظر خود را وارد كرده و روی OK كليک كنيد. پس از انجام اين كار می توانيد 

سند را ذخيره كنيد.

 2ـ2ـ تنظيم صفحات سند جدید

بيشتر تنظيمات سند جديد گويا و مشخص هستند، ولی بهتر است تعدادی از آن ها را توضيح دهيم. هم كادر 
محاوره ای New Document قديمی و هم فضای كاری Start، گزينه های مشابهی را ارائه می دهند، ولی 
اين گزينه های مشابه نيز ممکن است كار متفاوتی انجام دهند. بنابراين، اين دو روش را در صورت ضرورت 

برچسب گذاری می كنيم: (L)= قديمی؛ (N)= جديد.

شکل 1ـ2ـ ایجاد سند خالی جدید و تنظیم صفحات سند جدید

Preferences ـ1
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Document Presetـ اگر پيش تنظيم سندی را ايجاد كرده ايد كه دوست داريد استفاده كنيد، آن را در اينجا 
انتخاب كنيد.

Print/Web/Mobile Tabs (N)/Intent (L) در بالاـ قصد داريد خروجی محصول نهايی به چه صورتی 
باشد؟ گزينه پيش فرض Print است، ولی گزينه های Web و Mobile هم وجود دارند.

Primary Text Frameـ راستش را بخواهيد، اين برای اسناد پيچيده تر با تعداد زيادی متن شناور است. 
فعلًا نيازی نيست آن را تيک بزنيد.

Column Gutter (N)/Gutter (L)ـ اين دو فاصله های بين ستون ها هستند )اگر ستون هايی داشته باشيد(. 
بيشتر  در  ولی  باشد،  متن  نقطه ای  اندازه  با  مساوی  كه حداقل  تنظيم شود  مقداری  با  بايد   gutter عرض 

پروژه ها، می توانيد از چيزی استفاده كنيد كه برای چشم و اضح تر به نظر برسد.
Bleed and SlugـوBleed ناحيه ای اطراف لبه سند شما برای برش پس از چاپ است، استاندارد آن 0.125 
اينچ يا 3mm است )برای چاپ بنرهای بزرگ، اين مقدار بيشتر خواهد بود(. اين مقدار، اطمينان می دهد كه 
تصاوير با رنگ های لبه كاغذ، درست و كامل برش می خورند. Slug )كه كمتر استفاده می شود( ناحيه ای است 

كه می تواند شامل اطلاعات و يادداشت های سند باشد.

)Start 3ـ2ـ ایجاد و ذخيره سازی پيش تنظيمات سند سفارشی )با استفاده از فضای كاری

اگر از تنظيمات خاصی بيشتر استفاده می كنيد، 
بهتر است آن تنظيم را به عنوان يک پيش تنظيم 
ذخيره كنيد، بنابراين هر بار مجبور به انجام اين 
پيش تنظيم   يک  ايجاد  برای  نيستيد.  تنظيمات 
كنيد.  شروع   File>New>Document با 
 New Document محاوره ای  كادر  در 
در  كنيد.  وارد  را  خود  سند  نيازمندی های 
 (210mm*297mm) سند  يک  2ـ2،  شکل 
كرده ايم:  برنامه ريزی  تنظيمات  اين  با  را   A4
 Facing6،و Pagesو،Protrait Orientation
 3mm Column6،و Columnsو،Pages
 .3mm Bleed Gutter،و10mm Margins و 
آيکن  روی  خود،  تنظيمات  كردن  وارد  از  پس 
بالای  راست  سمت  گوشه  در  موجود  كوچک 
كادر محاوره ای )كه دايره روی آن كشيده شده( 
كليک كنيد، درست كنار محلی كه نام سند را 
می دهد  اجازه  شما  به  امر  اين  می كنيد.  اضافه 

شکل 2ـ2ـ ایجاد و ذخیره سازی پیش تنظیمات سند سفارشی 
 Start با استفاده از فضای کاری



واحد کار  دوم: مدیریت صفحات اسناد

2 3

تنظيمات خود را به عنوان يک Document Preset ذخيره كنيد. حال نامی به Document Preset بدهيد تا 
يافتن آن آسان شود و سپس روی Save Preset كليک كنيد. حال اين تنظيم سند ويژه در Saved items شما 

بود. خواهد  دسترس  در   New Document محاوره ای  كادر  در 

4ـ2ـ ایجاد و ذخيره سازی پيش تنظيمات سند سفارشی )با استفاده از كادر محاوره ای 
New Document قدیمی(

 New Document خود را برای استفاده از كادر محاوره ای Preferences اگر سند جديدی را ايجاد می كنيد و
 File>Document تنظيم كرده ايد، آن گاه زمان مناسبی برای ايجاد يک پيش تنظيم سند جديد است. به
Presets>Define برويد تا كادر محاوره ای Document Presets به شما ارائه شود )سمت چپ شکل 3ـ2(. 
 New باز شدن كادر محاوره ای  برای  از پيش تنظيم های موجود را خواهيد ديد.  اين قسمت، فهرستی  در 
 OK كليک كنيد )وسط شکل 3ـ2(. ترجيحات خود را تنظيم كرده و روی New روی ،Document Preset
كليک كنيد تا به كادر محاوره ای Document Presets برگرديد. خواهيد ديد كه پيش تنظيم جديد شما 
فهرست شده است. می توانيد هر پيش تنظيمی را با متمايز كردن آن در فهرست Presets و كليک كردن 
روی Edit ويرايش كنيد. هنگامی كه تغييرات خود را اعمال كرديد، روی OK كليک كنيد. حال هنگام ايجاد 
سندی جديد، كافی است به File>New Document برويد، منوی بازشو Document Presets را در بالای 
كادر محاوره ای New Document باز كنيد و پيش تنظيم سفارشی خود را در فهرست ببينيد )سمت راست 

شکل 3ـ2(. پيش تنظيم مدنظر خود را انتخاب كنيد تا تنظيمات مرتبط كادر محاوره ای را پر كند.

 New Document شکل 3ـ2ـ ایجاد و ذخیره سازی پیش تنظیمات سند سفارشی با استفاده از کادر محاوره ای
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5  ـ2ـ حركت بين اسناد باز

اگر چندين سند باز در InDesign داريد، حركت بين آن ها به سادگی صورت می گيرد. چندين روش برای 
 Window است. هم چنين می توانيد منوی Ctrl+~ انجام اين كار وجود دارد، ولی سريع ترين روش، فشردن
را باز كنيد كه فهرستی از اسنادی را كه هم اكنون در InDesign باز شده اند، در پايين منو نمايش می دهد. 
سند موردنظر خود را برای مشاهده انتخاب كنيد. سندی كه هم اكنون مشاهده می كنيد، دارای يک چک مارک 
در كنار نامش خواهد شد. روش سوم، كليک كردن روی برگه كنار بالای فضای كاری است كه حاوی نام سند 

موردنظر برای مشاهده است.

شکل 4ـ2ـ حرکت بین اسناد باز
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6ـ2ـ اضافه كردن صفحات سند اصلی

چندين روش برای افزودن صفحات اضافی به سند شما وجود دارد. ساده ترين روش كليک كردن روی آيکن 
Create New Page در پايين پنل Pages است. اگر حين انجام اين كار، كليد Ctrl را پايين نگه داريد، صفحه 
اصلی خالی جديدی اضافه می شود. اگر در حين كليک كردن روی آيکن Create New Page، كليد Alt را 
نگه داريد، كادر محاوره ای Insert Pages ظاهر می شود كه می توانيد چندين صفحه اضافه كرده و محلی را در 

سند برای افزودن صفحات انتخاب كنيد.
و تصميم   )At End of Document يا   At Start of Documentو،Before Page xو،After Page x(
بگيريد كه كدام صفحات اصلی را بر صفحات جديد اعمال كنيد. انتخاب های خود را انجام داده، سپس روی 
OK كليک كنيد. هم چنين می توان با كليک راست در پنل Pages و انتخاب Insert Pages از منوی زمينه 

به كادر محاوره ای Insert Pages دسترسی داشته باشيد.

شکل 5 ـ2ـ اضافه کردن صفحات به سند
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 7ـ2ـ بازآرایی و حذف صفحات سند

پنل  در  را  آن  آيکن  است  كافی  از سند،  برای حذف يک صفحه 
پنل  پايين  در  آشغال  سطل  آيکن  روی  و  كرده  متمايز   Pages
كليک كنيد. برای جابه جا كردن صفحه به مکانی جديد در سند، 
به پنل Pages رفته و روی آيکن آن صفحه كليک كنيد و آن را به 
مکانی بکشيد كه می خواهيد ظاهر شود. خطی ظاهر خواهد شد كه 

محل صفحه را در صورت رها شدن ماوس نشان می دهد.

شکل 6 ـ2ـ تغییر مکان و حذف صفحات سند
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واحد كار سوم

رسم و مدیریت اشکال و اشیا
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  شکل اشيا را تغيير دهد.

  فريم و اشکال را رسم كند.

  با منوی Object كار كند.

  انتخاب، جابه جايي، حذف، تغيير شکل و جايگزيني اشيا را انجام دهد.

  گروه بندی و قفل كردن اشيا را انجام دهد.

  گوشه هاي فانتزي را ايجاد كند.

  جلوه ها را براي اشيا به كار گيرد.

  جانمايي تصاوير در كادر را انجام دهد.

  چند تصوير را در يک كادر بچيند.

  تصاوير پيوند داده شده را مديريت كند.

  از Pathfinder در ساخت اشيا و كادر تركيبي استفاده كند.

  تنظيمات خط دور را انجام دهد.

  با پنل Link كار كند.

كليات

تا حالا InDesign وارد زندگی مان شده است، وقت آن است كه به  ويژگی های جديدی بپردازيم، فريم ها 
و اشيا، هر دوی آن ها، اشکالی هستند كه در آن ها می توانيم محتوا قرار دهيم. هر چيزی در يک فريم قرار 
می گيرد. اين دو ويژگی هستند كه باعث تفاوت در InDesign و Word می شوند. به هر حال، فريم ها و اشيا 
چيزی هستند كه صفحه آرايی1 را اينقدر ساده تر می كنند.  در اين واحدكار خواهيد ديد كه با فريم ها و اشيا، 
كنترل بيشتری برای ايجاد آن ها، رفتار آن ها، عملکرد آن ها و ميزان انعطاف پذيری آن ها برای ايجاد محتوا 
خواهيد داشت. می توانيد خطوط دور2 را به كار ببريد تا فريم ها و اشيای شما برجسته شوند و حتی می توانيد 
اشکال سفارشی را با ابزارهای Pen و Pencil ايجاد كنيد. می توانيد چندين فريم و شکل را در مشبک ها قرار 
دهيد، شيوه های با گوشه جالب را اعمال كنيد و آن ها را به زيبايی با هم تراز كنيد. هم چنين می توانيد شيوه ها 
را برای آن ها تنظيم كنيد. در اين واحدكار، عملکرد وظيفه ای پايه، خلاقيت و ويرايش فريم و شی ء را بررسی 

می كنيم. تا انتهای واحدكار، در فريم ها و اشيا ماهر خواهيد شد.

Layout ـ1

Strokes ـ2

زمان آموزش

عملینظری

621
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1ـ3ـ استفاده از فریم ها

در InDesign، هر چيزی را در نوعی فريم قرار می دهيم و هر فريم می تواند به طور مستقل ويرايش شود. به 
 Microsoft نسبت به يک برنامه كاربردی نظير InDesign اين دليل است كه ايجاد اسنادی با ظاهر عالی در
Word خيلی ساده تر است. سه نوع فريم وجود دارد: فريم های متنی، فريم های گرافيکی و فريم های نامعين. 
برای تمام فريم ها و شکل ها می توان خط دور و رنگ زمينه داد. فريم نامعين، شکلی است كه به طور دستی 
ايجاد شده است، بدين معنی كه با يک ابزار فريم ايجاد شده و با ابزار Pen (P) تغيير شکل داده شده است 
 (A) ايجاد شده است و متن يا گرافيکی ندارد. اندازه تمام اين فريم ها را می توان با ابزار Pen يا فقط با ابزار

Direct Selection يا ابزار Pen  تغيير داد.

شکل 1ـ3ـ فریم ها

2ـ3ـ ایجاد یک فریم

 (F) Rectangle ابزار  اين  باشيدـ  آن  روی   x يک  با  )پيش فرض(  مستطيل  آيکن  دنبال  به  ابزار،  نوار  در 
Frame است. برای باز شدن منوی شناور، روی اين آيکن كليک كرده و نگه داريد كه حاوی سه انتخاب 
است: Rectangle،وEllipse و Polygon. برای ايجاد يک فريم، شکل فريم موردنياز خود را انتخاب كنيد 
و سپس روی سند خود كليک كرده و فريم را به سمت بيرون بکشيد. به هنگام كشيدن، كليد Shift را فشار 
داده و نگه داريد تا تناسب شکل حفظ شود. مثلًا، در حين كشيدن با ابزار Ellipse Frame، نگه داشتن 
كليد Shift موجب ايجاد يک دايره می شود و انجام همين كار با ابزار Rectangle Frame موجب ايجاد يک 
مربع می شود. به طور پيش فرض، ابزار Polygon Frame يک شکل پنج ضلعی را ايجاد می كند. ولی اگر پنج 
ضلعی نخواستيد چه؟ تمام كاری كه بايد انجام دهيد، انتخاب اين ابزار و يک بار كليک كردن در محلی در 
 Polygon سند است تا يک كادر محاوره ای ظاهر شود و گزينه های فريم را به شما ارائه دهد. كادر محاوره ای
به شما اجازه می دهد در مورد تعداد اضلاع مدنظر برای فريم تصميم بگيريد. وارد كردن اندازه در اينجا خيلی 
مهم نيست، زيرا پس از قرار دادن آن، می توانيد اندازه آن را به صورت دستی تغيير دهيد. برای ايجاد يک فريم 
متنی، ابزار Type (T) را از نوار ابزار انتخاب كرده و شکلی را برای متن خود به بيرون بکشيد. در صورت نياز، 
پس از ايجاد آن، می توانيد اندازه اش را تغيير دهيد. هنگامی كه يک فريم متنی انتخاب می شود، می توانيد 
به File>PLace هم برويد و تصويری را برای قرار دادن در آن فريم انتخاب كنيد. InDesign فريم را به 
يک فريم گرافيکی تبديل می كند و از كل متن موجود در فريم صرف نظر می شود و متن با تصوير جايگزين 

می گردد. هم چنين می توانيد متن را حول يک فريم بچرخانيد.
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شکل 2ـ3ـ ایجاد فریم

3ـ3ـ ایجاد شکل

شکل ها شبيه فريم ها هستند، ولی می توانيد كارهای بيشتری با آن ها انجام دهيد. ابزارهای شکل Rectangle،و
ابزارهای فريم در نوار قرار دارند و يک X در آن ها وجود ندارد. برای ايجاد  Ellipse و Polygon در زير 
شکلی در سند خود، روی ابزار شکل در نوار ابزار كليک راست كرده و شکلی را از منوی شناور انتخاب كنيد، 
سپس شکل را به سمت سند خود بکشيد. در حين كشيدن، كليد Shift را نگه داريد تا تناسب ها حفظ شود. 
هم چنين می توانيد با انتخاب ابزار شکل خود و يک بار كليک كردن در سند، شکلی را ايجاد كنيد. اين امر 
موجب باز شدن يک كادر محاوره ای كنترلی می شود كه در آنجا می توانيد اندازه دقيق شکل خود را تعيين 
كنيد. روی OK كليک كنيد تا شکل به سند شما اضافه شود. هنوز آن را نخواهيد ديد، زيرا هيچ زمينه يا 
خط دوری ندارد؛ فقط هنگامی كه شکل انتخاب می شود، مسير شکل در نما وجود خواهد داشت. با استفاده از 
نکاتی كه قبلًا در مورد خطوط دور و زمينه ها گفتيم، می توانيد مقداری شخصيت به شکل خود بدهيد. ابزار 
Shape معمولاً برای ايجاد شکل های توپر استفاده می شود، ولی اين ها به سادگی می توانند برای پذيرش متن 
يا تصوير تبديل شوند. شکل به عنوان فريم نامعين هم شناخته می شود و مثلًا می تواند به طور دستی با استفاده 
از ابزار Pen (P) ايجاد شود. اين ها فريم هايی هستند كه واقعاً دربرگيرنده هيچ متن يا گرافيکی نيستند، ولی 
در صورت نياز می توانيد اين كار را انجام دهيد. ممکن است شکل هايی را به عنوان دكور در صفحه خود رسم 
كنيد؛ آن ها را با يک رنگ پس زمينه پر كنيد يا اگر به قدر كافی دلير هستيد، حتی می توانيد نوعی لوگو ايجاد 
كنيد، گويی كه در حال رسم در Adobe Illustrator هستيد. هم چنين می توانيد متن موجود در شکل را 

بچرخانيد.
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شکل 3ـ3ـ ایجاد شکل

4ـ3ـ به كار بردن خط دور

می توانيد خطوط دور1 را به كار ببريد كه به عنوان تنظيمات خط هم شناخته می شوند. خطوط دور بر هر 
انتخاب می شود،  اقلام  اين  از  اعمال هستند. هنگامی كه يکی  مسير، شکل، فريم و محيط های متنی قابل 
خصوصيات خط دور در دسترس شما قرار می گيرند. پنل Properties مکان خوبی برای شروع كار است. 
اولين كاری كه بايد انجام دهيد، دادن يک رنگ به خط دور است )بدون رنگ، خط دور اعمال نخواهد شد(. 
روی آيکن كوچک خط دور )فريم مربع كنار كلمه Stroke( در پنل Properties كليک كنيد تا انتخابگر 
رنگ باز شود. رنگ موردنظر خود را انتخاب كنيد تا خط دور بر فريم، شیء يا متن منتخب شما اعمال شود. 
من رنگ مشکی را در شکل 4ـ3 انتخاب كرده ام. هنگامی كه رنگی را انتخاب كرديد، ضخامت پيش فرض خط 

دور كه 1pt است تنظيم خواهد شد و اين نقطه شروع شماست.

Strokes ـ1
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شکل 4ـ3ـ تنظیم خط دور

5   ـ3ـ تغيير شيوه خط دور

را در پنل  برای خطوط دور وجود دارد كه می توانيد آن ها  بر ضخامت و رنگ(  اختياری )علاوه  تنظيماتی 
Stroke بيابيد (Window>Stroke). هم چنين می توانيد كلمه Stroke را در پنل Properties تايپ كنيد 
تا پنل بازشويی با تمام كنترل های اضافی موجود در پنل Stroke در اختيار شما قرار گيرد، بدين معنی كه 
شما ابداً مجبور به باز كردن پنل Stroke نيستيد. اين تنظيمات خط دور به شما اجازه می دهند ضخامت و 
نوع خط؛ نوع گوشه يا شکل پخ؛ چگونگی تلفيق بخش های خط دور: شکل های شروع و پايان خط دور )اگر 
انتهای باز وجود داشته باشد(؛ رنگ بين شکاف ها )اگر نوع خط را با شکاف ها انتخاب كرده باشيد(؛ و غيره 
را تعيين كنيد )گزينه های ديگری نيز وجود دارد(. در پنل Properties، حتی می توانيد جلوه های ويژه را با 
انتخاب آيکن fx در زير تنظيمات خط دور بر خط دور اعمال كنيد. ولی طبق قوانين طراحی عادی، فقط به 

اين دليل كه می توانيد كاری انجام دهيد، به اين معنی نيست كه بايد آن كار را انجام دهيد.
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شکل 5ـ3ـ انجام تنظیمات متنوع در خط دور

6 ـ3ـ اضافه كردن متن در یک فریم

كنيد.  ايجاد  متنی  فريم  يک   (T) Type ابزار  با  ماوس  كشيدن  با  می توانيد  شد،  ذكر  قبلًا  كه  همان گونه 
هنگامی كه ماوس خود را رها می كنيد، چشمک زن مکان نما را در گوشه سمت چپ بالای فريم خواهيد ديد 
و می توانيد شروع به تايپ كنيد )برای تايپ فارسی ابزار ME Type Tool را انتخاب می كنيم(. هم چنين 
می توانيد فريمی را با متن جايبانی )الگو(1 پر كنيد تا هنگام اضافه كردن يک كپی از متن خودتان، ظاهر سند 
را ببينيد. مکان نمای خود را در فريم متنی درج كرده و به Type>Fill with Placeholder Text برويد. 
در حالی كه فريم متنی انتخاب شده است، می توانيد به File>Place رفته و تصويری را برای قرار گرفتن در 
فريم انتخاب كنيد تا از همه متن در آن فريم صرف نظر شده و با تصوير جايگزين شود. اين بدان دليل است 

كه InDesign فريم را به يک فريم گرافيکی تبديل كرده است.

شکل 6ـ3ـ درج متن در فریم

Placeholder Text ـ1
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7ـ3ـ جایگزین كردن محتوا در فریم

اگر متنی را جايگزين می كنيد، كافی است متن جديد خود را كپی كرده و آن را مستقيماً روی متن موجود 
انتخاب كرده و به File>Place برويد، سپس  الصاق كنيد. اگر قصد جايگزينی تصويری را داريد، فريم را 
تصوير جديدی را انتخاب كنيد. توجه خواهيد داشت كه كادر انتخاب Replace Selected Item در پايين 
كادر محاوره ای Place به طور خودكار انتخاب شده است. از گزينه های Frame Fitting برای تنظيم محل 
هم   Edit>Paste Into از  می توانيد  می كنيد،  كپی  را  تصويری  اگر  كنيد.  استفاده  خود  تصوير  قرارگيری 
استفاده كنيد، ولی الصاق آن در اسناد InِِDesign توصيه نمی شود؛ قرار دادن آن هميشه روش بهتری است.

شکل 7ـ3ـ جایگزینی محتوا در فریم

8 ـ3ـ متناسب كردن تصویر با فریم

Frame Fitting Options به شما اجازه تنظيم فريم ها را متناسب با تصاويری كه در بردارند بر اساس نيازهای شما 
می دهد. برای دستيابی به Frame Fitting Options يا به Object>Fitting>Frame Fitting Options برويد 
يا روی خود فريم تصوير كليک راست كرده و گزينه های منوی مشابه را انتخاب كنيد. اين امر يک كادر محاوره ای 
،Fit Content to Frameو،None( را به همراه دارد كه می توانيد گزينه مناسب خود را از آن انتخاب كنيد 

Fit Content Proportionally يا Fill Frame Proportionally(. بالاخره، می توانيد به طور دستی مقدار 
برشی را كه ممکن است حول تصوير نياز داشته باشيد، انتخاب كنيد.



واحد کار  سوم: رسم و مدیریت اشکال و اشیا

3 5

شکل 8ـ3ـ گزینه های متناسب ساختن فریم

9ـ3ـ اصلاح شکل یک فریم یا شیء

اولين ابزار در جعبه ابزار شما برای تغيير دستی سريع شکل چيزی، ابزار Direct Selection است )[A]؛ 
آيکن فلش توپر در جعبه ابزار(. آن را از جعبه ابزار انتخاب كرده و روی فريم خود كليک كنيد. حال نقطه ای 
را در فريم كليک كنيد و آن را مستقل از نقاط ديگر جابه جا كنيد. هنگامی كه نقطه ای انتخاب می شود، 
را در هر  نقطه  از يک  بيش  تغيير خواهد كرد. می توانيد  رنگ  آبی  نقطه ای  به  نقطه سفيد كوچک  از يک 
زمان با فشردن و نگه داشتن كليد Shift انتخاب كنيد، در حالی كه نقاط ديگر خود را انتخاب می كنيد. از 
 Free كليدهای جهتی برای حركت دادن نقاط در فواصل كوچک استفاده كنيد. هم چنين می توانيد از كاركرد

Transform در جعبه ابزار، به گزينه های تبديل ديگر دسترسی پيدا كنيد، از جمله اين موارد:
  Free Transform Tool (E): به شما امکان تغيير دستی يک شکل را می دهد.

  Rotate Tool (R): به شما امکان چرخاندن شکل را از نقطه مرجع منتخب شما می دهد.

  Scale Tool (S): به شما امکان تغيير اندازه دستی يک شکل را از نقطه مرجع منتخب شما می دهد.

  Shear Tool (O): به شما امکان كوتاه كردن يک شکل را از نقطه مرجع منتخب شما می دهد.

شکل 9ـ3ـ تغییر شکل یک فریم یا شیء
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Transform شکل 10ـ3ـ استفاده از پنل

برای باز كردن پنل Transform به Window>Object & Layout>Transform برويد. می توانيد از اين 
پنل برای مشاهده و يا دادن ورودی اطلاعات هندسی خاص تر برای يک شکل يا فريم منتخب استفاده كنيد، 
از جمله مقاديری برای مکان )مختصات X و Y(، اندازه )درصد W و H(، دوران )برحسب زاويه( و كوتاه كردن 
)برحسب زاويه(. هم چنين مشبک نقطه مرجع )دايره ای در سمت چپ بالا( را خواهيد ديد. اين مشبک به شما 

اجازه می دهد مطمئن شويد كه تمام تبديل ها از يک نقطه ثابت يا نزديک شیء منشأ می گيرند.
آيکن به شکل ضربدر در نقطه مرجع در سند هنگامی نمايش داده می شود كه يک ابزار تبديل )از قبيل ابزار 
Scale [S]( برای نشان دادن محل تغيير مقياس شیء يا تغيير از آنجا فعال شود. هم چنين اگر بخواهيد 

تغييرات خود را به روشی متناسب انجام دهيد، يک لينک تناسب در پنل Transform وجود دارد.

10ـ3ـ تغيير گوشه های شکل

يک روش ساده برای تغيير شکل دادن به يک شکل، استفاده از گزينه های Convert Point )كه به آن نقاط 
با نقاط لنگری آشنا هستيد( برای تغيير دادن  لنگری هم می گويندـ اگر از Illustrator استفاده كرده ايد، 
را در آن  نقطه ای  را گردتر كنيد،  بخواهيد گوشه شکل چند ضلعی خود  اگر  گوشه های شکل است. مثلاً، 
گوشه انتخاب كرده و به Object>Convert Point>Smooth )يا Symmetrical( برويد. اين فقط يک 
نکته سريع است، ولی گاهی اوقات می تواند مفيد باشد، به ويژه هنگامی كه شکلی را می خواهيد كه گردتر از 
شکل های استاندارد است و می خواهيد آن ها را سريع تبديل كنيد. اگر با ابزار Pen (P) آشنا هستيد، خواهيد 

ديد كه داشتن نقاط Smooth و Corner در چگونگی تغيير دادن شکل با ابزار Pen متفاوت است.
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شکل 11ـ3ـ تغییر دادن گوشه های شکل

11ـ3ـ ایجاد مستطيل با گوشه های گرد

باشد.  گرد  آن ها  گوشه های  نيست  بد  اوقات  گاهی  می كنيد،  رسم  را  مستطيلی  يا  مربع  شکل  كه  هنگامی 
تنظيمات مورد استفاده برای ايجاد گوشه های گرد در دسترس شما قرار دارد. ما از آن در بخش قبلی برای 
گزينه های گوشه استفاده كرديم، ولی در اينجا به شما نشان خواهيم داد چگونه از آن برای جالب تر كردن 
گوشه های گرد و هم چنين در گوشه های مستقل استفاده كنيد. ابتدا شکل خودتان را رسم كنيد و سپس ابزار 
Selection (V) را از نوار ابزار انتخاب كنيد. مربع زرد كوچکی را در سمت راست فريم خواهيد ديد، درست 
نزديک گوشه سمت راست بالا. يک بار روی مربع زرد رنگ كليک كنيد تا تبديل به يک لوزی شود و به گوشه 
فريم بپرد. هم چنين لوزی های زرد رنگی را در سه گوشه ديگر فريم می بينيد. حال می توانيد هر يک از اين 
لوزی های زرد رنگ را به چپ يا راست بکشيد تا گردی گوشه ها را كم يا زياد كنيد. اگر كليد Alt را فشار داده و 
نگه داريد و روی يکی از لوزی های گوشه كليک كنيد، می توانيد شيوه گوشه را با چرخاندن از طريق گزينه های 
ديگر، يکی يکی تغيير دهيد. برای تغيير دادن فقط يک گوشه در يک زمان، كليد Shift را در حين كشيدن 
لوزی گوشه فشار داده و نگه داريد. Alt+Shift را فشار داده و نگه داريد و روی يک گوشه كليک كنيد تا فقط 

شيوه آن گوشه تغيير كند.

شکل 12ـ3ـ مستطیلی با گوشه های گرد
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 12ـ3ـ اعمال شيوه های گوشه

روش ديگر برای تغيير شکل فريم ها يا شکل ها به كارگيری شيوه های گوشه بر آن هاست. با ايجاد )يا انتخاب( 
فريم يا شکل خود شروع كنيد و سپس گزينه گوشه را از منوی بازشوی Corner در پنل Properties انتخاب 
انتخاب   Corner Options را در كادر محاوره ای  Object>Corner Options و سپس شيوه ای  يا  كنيد 
كنيد. سپس از ابزار Selection (V) برای انتخاب فريم يا شکل خود استفاده كنيد و سپس روی مربع زرد 
كوچک كه در سمت راست بالای فريم ظاهر می شود، كليک كنيد. اين امر باعث می شود مربع به گوشه های 
شکل شما بپرد. اگر اين مربع را به سمت چپ بکشيد، اندازه دكوراسيون گوشه را افزايش خواهد داد. كشيدن 

آن به سمت راست، موجب كاهش اندازه دكوراسيون گوشه می شود.

شکل 13ـ3ـ شیوه های گوشه

13ـ3ـ تركيب شکل ها یا فریم ها برای ایجاد شکل ها یا فریم های جدید

می توانيد  ولی  كنيد،  ايجاد  محتوا  برای  را  استاندارد  فريم های  و  شکل ها  چگونه  كه  كرديم  بيان  تاكنون 
شکل ها و فريم های سفارشی را با تلفيق كردن آن ها با يکديگر با استفاده از پنل Pathfinder ايجاد كنيد 

از: عبارت اند   Pathfinder گزينه های   .(Window>Object & Layout>Pathfinder)
  Add: اشيای منتخب را در يک شکل تركيب می كند.

  Subtract: اشيای جلويی را از شیء پشتی كم می كند.

  Intersect: نواحی مشترک شکل ها را اشتراک می گيرد.

  Exclude Overlap: نواحی روی هم افتاده شکل ها را كنار می گذارد.

  Minus Back: اشيای پشتی را از اشيای جلويی كم می كند.
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برای اعمال گزينه های Pathfinder، شکل های شما بايد در برخی نقاط روی هم افتادگی داشته باشند. سپس، 
همه آنچه كه بايد انجام دهيد، انتخاب شکل ها و كليک كردن روی يک از گزينه هاست. در مثال نشان داده 
شده در شکل 14ـ3، يک دايره و يک مستطيل را انتخاب كرده ايم و گزينه های Pathfinder زير را بر آن ها 
اعمال كرده ايم )از بالا به پايين(: Add،وSubtract و Minus Back. اين ها سه گزينه ای هستند كه برای 
ساخت شکل در InDesign بيشترين كاربرد را دارند. می توانيد از اين شکل ها برای اضافه كردن رنگ؛ اضافه 
كردن تصاوير يا متن برای يک شيوه بسيار هنری؛ يا حتی چرخاندن متن حول آن ها استفاده كنيد. بهترين 

راه يادگيری اين ابزارهای عالی، كار كردن با آن ها و مشاهده اتفاقاتی است كه رخ می دهد.

شکل 14ـ3ـ ترکیب کردن شکل ها یا فریم ها

Pencil 14ـ3ـ تغيير شکل یک فریم یا شکل با ابزار

اين تکنيک، شبيه استفاده از مداد در طراحی است. همه موارد نبايد تميز و متقارن باشد؛ گاهی قدری زبری 
هم لازم است. اگر احساس می كنيد يکی از شکل ها يا فريم های شما بايد قدری ناقص شود و از شکل بيفتد، 
می توانيد آن را با رسم لبه فريم با ابزار Pencil تغيير دهيد. برای انجام اين كار، كافی است شکل يا فريم را با 
ابزار Selection (V) انتخاب كنيد، سپس به ابزار Pencil (N) سوئيچ كنيد و شروع به رسم در سراسر لبه 
از نقطه ابتدا تا نقطه پايان كنيد. مطمئن شويد شروع يا پايان درست در لبه قرار دارند، در غير اين صورت 

چندان جالب نخواهد شد.

شکل 15ـ3ـ استفاده از ابزار Pencil برای تغییر شکل
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Pencil 15ـ3ـ ایجاد یک شکل سفارشی با ابزار

ابزار Pencil به شما اجازه رسم دستی و ايجاد مسيرهای باز و بسته را می دهد. اين ابزار برای ايجاد نوعی جلوه 
ترسيم دستی عالی است. مزيت ديگر آن اين است كه می توانيد آنچه را كه رسم كرده ايد، ويرايش كنيد. كافی 
است ابزار Pencil (N) را انتخاب كرده و شروع به رسم شکل شما می كند. هنگام رسم، مجموعه ای از نقاط 
آبی را خواهيد ديد كه ظاهر می شوند و هنگامی كه ماوس را رها می كنيد، مسير خصوصيات تنظيم شده توسط 
خط دور را خواهد گرفت. اگر انتهای شکل باز باشد، در هر انتها نقطه ای وجود خواهد داشت و همين طور 
 Pencil را فشار داده و نگه داريد، مکان نمای ابزار Alt نقاطی در سراسر مسير. اگر بعد از شروع رسم، كليد
دايرۀ كوچکی را نمايش می دهد تا به شما نشان دهد كه می خواهيد مسير بسته ای را ايجاد كنيد. هنگامی كه 

از شکل راضی بوديد، قبل از رها كردن كليد Alt، ماوس را رها كنيد تا دو نقطه باز به هم متصل شوند.

شکل 16ـ3ـ استفاده از ابزار Pencil برای ایجاد شکل های سفارشی

Pen 16ـ3ـ ایجاد شکل های سفارشی با ابزار

و   Illustratorو،Photoshop در  پركاربرد  ابزارهای  از  )يکی  بدانيد  را   Pen ابزار  با  كار  فن  و  فوت  اگر 
InDesign(، می توانيد از آن برای ايجاد شکل های خاص خود استفاده كنيد. اين ابزار اغلب توسط افراد با 
تجربه تر استفاده می شود ولی شما هم می توانيد نحوه استفاده از آن را ياد بگيريد. بيشتر اوقات، از شکل های 
ايجاد موردی سفارشی هستيد، ممکن  پايه در سند InDesign خود استفاده می كنيد. ولی اگر مجبور به 
است بخواهيد آن را امتحان كنيد. ابزار Pen (P) را انتخاب كرده و برای ايجاد اولين نقطه خود، روی سندتان 
كليک كنيد. می توانيد شکلی با اضلاع مستقيم )راست( را به سادگی و تنها با كليک كردن مجدد روی مکانی 
كه می خواهيد نقطه بعدی خود را قرار دهيد بسازيد و الی آخر. مطمئن شويد كه شکل خود را با كليک كردن 
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مجدد روی اولين نقطه ای كه قرار داده ايد، ببنديد. اگر تجربه كار با ابزار Pen را داريد، می توانيد منحنی هايی 
در شکل خود ايجاد كنيد، ولی اين امر نيازمند دستورالعمل های دقيقی است.

Pen شکل 17ـ3ـ استفاده از ابزار



4 2
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واحد كار چهارم

استفاده از متن
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  پنل كاراكتر و پاراگراف را در ويرايش متون به كار گيرد.

  سبک را براي كاراكتر و پاراگراف ها تهيه كند.

  Tab، Glyph و Bullet را به كار گيرد.

  متن روي مسير و تنظيمات آن را انجام دهد.

  حالت هاي مختلف چيدمان متن و اشيا را انجام دهد.

  با فريم هاي متني كار كند.

  تنظيمات قالب بندي را انجام دهد.

كلیات 

InDesign  مناسب ترين نرم افزار برای هر كسی است كه به دنبال ارائه هر نوع سند يا مطلب چاپی است. 
برای ارائه اين نوع اسناد نياز به استفاده از متن داريد كه در اين واحد كار به معرفی ابزارها و ويژگی های متنی 

می پردازيم. برای كار كردن با متن، ابتدا بايد بتوانيد فونت را تعريف كرده و تغيير دهيد.

زمان آموزش

عملینظری

410
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1ـ4ـ تغییر دادن فونت

تغيير دادن فونت خيلی ساده است. برای انتخاب متن موردنظر خود برای تغيير، ابزار Type (T) را انتخاب 
كرده و سپس منوی بازشوی فونت را در پنل Control، پنل Properties يا پنل Character انتخاب كنيد. 
متن نمونه را در كنار فونت های ديگر در منو خواهيد ديد. اين امر به شما كمک خواهد كرد فونت موردنظر 
خود را انتخاب كنيد. هم چنين در سند خواهيد ديد كه متن متمايز شده شما به صورت پيش نمايش زنده 

تغيير می كند و نمای بی درنگی از ظاهر طراحی را به شما می دهد.

شکل 1ـ4ـ تغییر دادن فونت

2ـ4ـ فریم متنی

تايپ بايد در فريم متنی انجام شود و البته گاهی همه تايپ شما در فريمی كه ايجاد كرده ايد، جای نمی گيرد. 
آنگاه بايد وقت بگذاريد و هنگام كار كردن، اندازه فريم متنی را تغيير دهيد. اما به يک ترفند می توان اين 
مشکل را حل كرد، برای تغيير اندازه خودكار فريم متنی هنگام وارد كردن متن، در برگه Auto-Size كليک 
كرده و سپس height Only را از منوی بازشوی Auto-Sizing انتخاب كنيد. در كادر مربعی زير، گزينه 
top-middle را انتخاب كنيد )فلش كوچک اشاره كننده به پايين(. اين بدان معنی است كه متن همواره در 
بالای فريم شروع می شود و به سمت پايين كار می شود. روی OK كليک كنيد. حالا اندازه كادر متنی شما 
هنگام تايپ تغيير می كند. برای اطمينان از اينکه اين اتفاق هميشه می افتد، قبل از ايجاد سند خود )هنگامی 
كه هيچ سندی باز نيست( اين تنظيم را اعمال كنيد تا در هر بار ايجاد يک فريم متنی، اين تنظيم پيش فرض 
باشد. تنظيمات ديگر اين بخش را هم امتحان كنيد، ممکن است پيش فرض مفيد ديگری را برای قرار دادن 

متن خود بيابيد.
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شکل 2ـ4ـ تنظیمات فریم متنی

3ـ4ـ تغییر تراز متن

هنگام صفحه بندی متن در سند، اين مرحله ساده بسيار مهم است. بسياری از اوقات، طراحان فقط از متن 
چپ چين يا وسط چين استفاده می كنند و از بقيه گزينه ها صرف نظر می كنند. بقيه هم بسيار مهم هستند 
 Control يا پنل Properties پنل ،Paragraph به ويژه در صفحه آرايی متون فارسی. تراز را می توان در پنل
تنظيم كرد. قبل از اضافه كردن متن، يک گزينه تراز را انتخاب كنيد تا پيش فرض شود. اگر بخواهيد تراز 
متن خود را تغيير دهيد، متن را متمايز كرده و روی گزينه جديدی كليک كنيد. گزينه های ذيل در دسترس 

قرار می گيرند:
Align Left  

Align Center  

Align right  

Justify with last line aligned left  

 Justify with last line aligned center  

Justify with last line aligned right  

Justify all lines  

Align towards spine  

Align away from spine  

در رديف پايين پاراگراف های بالا، می توانيد ببينيد كه بسته به محل قرارگيری متن، به طور خودكار از عطف 
يا به طرف عطف تراز می شود.
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شکل 3ـ4ـ ترازبندی متن

Glyph 4ـ4ـ مفهوم

Glyphها كاراكترهای ويژه هستند. اين كاراكترها شامل بولت ها، كادرهای انتخاب، موارد زينتی و كاراكترهای 
لهجه می شوند. افزودن Glyph به متن، كار بسيار ساده ای است. با استفاده از ابزار Type (T)، مکان نمای 
خود را در محلی قرار دهيد كه می خواهيد Glyph ظاهر شود و سپس Type>Glyph را انتخاب كنيد. اين 
امر موجب باز شدن پنل Glyphs می شود كه Glyph های موجود را برای فونت انتخابی فعلی شما نشان 
می دهد. برای يافتن فهرست گزينه های مرتب سازی از جمله ويژگی های OpenType، نمادها، اعداد و موارد 
زينتی، كسرها، نويسه های دوتايی و غيره، روی منوی بازشوی Show كليک كنيد. به دنبال Glyph موردنظر 
خود برای استفاده بگرديد و برای افزودن آن به متن خود روی آن دابل كليک كنيد. در مثال بالا، افزودن نماد 
 Symbolsو،Glyphs اضافه كنيد. در پنل “Queen’s Park Rangers” را پس از كلمات )TM( نشان تجاری
را از منوی Show انتخاب كرده، TM را پيدا كنيد و روی آن دابل كليک كنيد. اين امر موجب اضافه شدن 
نمادها به اين فضا می شود. همه Glyph های استفاده شده اخير در بالای پنل Glyphs نمايش داده می شوند. 

اين مسئله هنگامی مفيد است كه از يک Glyph به دفعات استفاده می كنيد.
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شکل 4ـ4ـ اضافه کردن Glyph به متن

Word 5 ـ4ـ درج كردن متن از یک سند

 InDesign را به منزله محتوا در Word افراد زيادی اين مسئله را نمی دانند، ولی شما می توانيد كل يک سند
قرار دهيد. بسياری از افراد فقط محتوا را از سند Word به سند InDesign كپی و الصاق می كنند. شما هم 
 File>Place می توانيد اين كار را انجام دهيد، ولی در اينجا شرح می دهيم كه چگونه سند واقعی را قرار دهيد. به
 Import Options موردنظر خود را برای استفاده پيدا كنيد. مطمئن شويد كه كادر انتخاب Word رفته و سند
در پايين كادر محاوره ای Place در حالت انتخاب است، در غير اين صورت اين روش درست كار نخواهد كرد 
)حداقل نه به روشی كه شما روی آن كنترل داشته باشيد(. روی بخش Formatting در نيمه پايينی اين كادر 

محاوره ای تمركز خواهيم كرد كه به شما دو گزينه را برای كار كردن با متن وارد شده به شما می دهد:
  Remove Styles and Formatting from Text and Tables: اين گزينه تمام فرمت بندی را از 

سند Word شما كنار گذاشته و از شيوه های پيش فرض تنظيمی شما در سند InDesign استفاده می كند.
  Preserve Styles and Formatting from Text and Tables: اين گزينه همه فرمت بندی اعمال 

شده بر سند Word را حفظ می كند. نکته مفيد اينجاست: اين گزينه امکان وارد كردن شيوه های Word را 
به شما می دهد.
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Microsoft Word Import شکل 5 ـ4ـ کادر محاوره ای

هنگامی كه انتخاب خود را انجام داديد، روی OK كليک كنيد تا مکان نمای شما با سند Word بارگذاری 
شود. حال جايی در سند InDesign خود كليک كنيد تا متن را از سند Word قرار دهيد.

6 ـ4ـ استفاده از بولت ها و شماره ها )یا حروف( برای متن

 Properties برای تأكيد بر يک ليست با افزودن بولت ها يا شماره ها )يا حروف(، متن را متمايز كرده و پنل
را باز كنيد )Window>Properties(. در نزديک پايين پنل، آيکن هايی برای بولت ها و شماره گذاری وجود 
دارد. انتخاب هر كدام موجب فرمت بندی ليست شما می شود و آنچه را كه انتخاب كرده ايد، دقيقاً بر متن شما 
اعمال می شود. در آنجا می توانيد شيوه كاراكتری خود، مکان بولت يا شماره را انتخاب كنيد. می توانيد از نماد 
متفاوتی برای بولت های خود استفاده كنيد يا می توانيد به جای اعداد، حروف يا اعداد رومی را انتخاب كنيد.
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شکل 6 ـ4ـ بولت ها و شماره گذاری

7ـ4ـ تایپ كردن روی یک مسیر

اگر تلاش كنيد كه تايپی را به يک منحنی اضافه كنيدـ از قبيل نمونه ای كه با ابزار Pen (P) در شکل 7ـ5 
نشان داده شده است ـ منحنی خود را رسم كنيد يا شکلی را با استفاده از يکی از ابزارهای شکلی انتخاب 

كنيد و سپس Type Tool را به Type on a Path Tool تغيير دهيد.

 برای داشتن Type on a Path Tool، روی ابزار Type در نوار ابزار كليک كرده و نگه داريد تا منوی 
را   Shift+T يا  كنيد  انتخاب  زمينه  منوی  از  را   Type on a Path Tool و سپس  باز شود  شناوری 

فشار  دهيد.

نکته

هنگامی كه مکان نما را روی مسيری نگه داشته  ايد كه می خواهيد روی آن تايپ كنيد، تغيير خواهد كرد و 
يک علامت + كوچک را نشان می دهد. هنگامی كه به علاوه را ديديد، برای قرار دادن مکان نما، يک بار كليک 
كنيد. حال می توانيد متن خود را تايپ كنيد تا مسير را دنبال كند. به خاطر داشته باشيد كه هر چه مسير 
زمخت تر باشد، متن روی مسير بدتر به نظر خواهد رسيد. محتاط بودن و دانستن دليل افزودن تايپ به مسير 

برای شکل و ظاهر طراحی بسيار مهم است.
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شکل 7ـ4ـ تایپ روی مسیر

 8  ـ4ـ تنظیم سبک های ترجیحی كاراكتر و پاراگراف

در واحد كارهای قبل چگونگی تنظيم پيش فرض ها برای فونت، خط دور و تنظيمات ديگر را بيان كرديم، ولی 
شما می توانيد سبک های ترجيحی كاراكتر و پاراگراف خود را تنظيم كنيد. ساده ترين روش انجام اين كار، 
وارد كردن سبک ها از يک سند موجود است. ابتدا مطمئن شويد هيچ سندی باز نيست. اين  مورد هميشه 
 Pragraph يا Type>Character Styles مهم ترين گام برای تنظيمات ترجيحات سبک است. سپس به
Styles برويد )اين نکته برای هر دو كار می كند(. از منوی پنل، Load All Text Styles را انتخاب كنيد. 
به سند موجودی برويد كه حاوی سبک های موردنظر شماست و روی Open كليک كنيد. سبک ها به سادگی 
از آن سند وارد می شوند و اين سبک ها هم اينک به عنوان سبک های ترجيحی پاراگراف و كاراكتر شما تنظيم 

شده اند. اين روشی عالی برای تنظيم سريع سبک هاست.
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شکل 8  ـ4ـ سبک های کاراکتر و پاراگراف

 9ـ4ـ تنظیم مقدار در پنل كاراكتر

فيلد  را در  نکنيد مکان نما  تغيير دهيد، سعی  Character سريعاً  را در پنل  نياز است مقداری  هنگامی كه 
كوچکی قرار دهيد، مقدار فعلی را حذف كنيد و سپس مقدار جديد خود را تايپ كنيد. در عوض، می توانيد 
كه  كاری  تنها  حالا،  شود.  متمايز  فيلد  تا  كنيد  كليک  تغيير  برای  خود  موردنظر  ويژگی  آيکن  روی  فقط 
ولی  نرسد،  نظر  به  مهم  چندان  است  ممکن  مسئله  اين  است.  مقدار جديد  كردن  تايپ  دهيد،  انجام  بايد 

چنانچه به كرات مقاديری را در پنل Character تنظيم می كنيد، 
تفاوت معناداری خواهد داشت. آيا می خواهيد سريع تر از اين هم 
عمل كنيد؟ بسياری از مواقع مجبوريد اين مقادير را بارها و بارها 
مقدار،  شدن  متمايز  هنگام  به  كار،  اين  تشريح  برای  كنيد.  تايپ 
يا  افزايش  برای  كليد  صفحه  در  پايين  و  بالا  جهتی  كليدهای  از 
موردنظر  مقدار  به  هنگامی كه  كنيد.  استفاده  مقدار  سريع  كاهش 

فشار دهيد. را   Enter خود رسيديد، 

Character شکل 9ـ4ـ پنل
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10ـ4ـ یافتن پنل های سبک ها

به Window>Styles برويد و اين پنل های موجود سبک ها را ببينيد:
Cell Styles  

Character Styles  

Object Styles  

Paragraph Styles  

Table Styles  

شکل 10ـ4ـ منوی Styles و پنل های مرتبط

پنل موردنظر خود را برای باز شدن انتخاب كنيد تا در فضای كاری شما نمايان شود. اين فرايند را برای باز 
كردن پنل ديگری تکرار كنيد. هر پنلی كه در كنار نامش در منو علامت چک مارک باشد، هم اكنون باز است. 
هنگامی كه پنلی را باز كرديد، می توانيد آن را شناور رها كنيد يا می توانيد آن را به پنل های ديگر وصل كنيد. 
اگر از سبک هايی در سند خود استفاده می كنيد، پشته بندی همه پنل های سبک ها با يکديگر ايده خوبی است.

 11ـ4ـ ایجاد یک سبک كاراكتری

پنل Character Styles برای ايجاد، نام گذاری و به كارگيری سبک های كاراكتری برای متن در يک پاراگراف 
استفاده می شود. اين سبک ها با سندی كه برای آن ايجاد شده اند، ذخيره می شوند و هر بار كه آن سند خاص 
از  می توانيد  ايجاد يک سبک،  برای  داده خواهد شد.  نمايش   Character Styles پنل  در  باز می كنيد،  را 
مشخصات تايپی كه هم اكنون در صفحه فرمت بندی كرده ايد، استفاده كنيد يا سبک جديدی را از طريق منوی 
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پنل Character Styles از ابتدا بسازيد. برای انجام روش دوم، مطمئن شويد مکان نمای شما در متنی قرار 
 Character دارد كه برای آن سبک ايجاد می كنيد، روی آيکن منوی پنل در گوشه سمت راست بالای پنل
 New Character را انتخاب كنيد. در كادر محاوره ای New Character Styles كليک كنيد و Styles

Styles، به بخش Style Settings برويد و ويژگی های منتخب خود را مرور كنيد. 

New Character Style شکل 11ـ4ـ کادر محاوره ای

اگر می خواهيد چيزی را تغيير دهيد، روی گزينه های موجود در منو در سمت چپ پنل كليک كنيد تا به 
تنظيمات مختلف ويژگی های متنی دسترسی پيدا كنيد. پس از رضايت از تنظيمات، روی OK كليک كنيد تا 
سبک جديد شما در پنل Character Styles نمايان شود. اين فرايند را برای هر يک از سبک های ديگر كه 
می خواهيد ايجاد كنيد، تکرار كنيد، سپس سند را ذخيره كنيد. هم چنين می توانيد متن دارای سبک را كپی 
كرده و آن را در سند جديدی الصاق كنيد تا آن سبک ها روی متن شما سوار شوند يا می توانيد سبک ها را در 
سند ديگری وارد كنيد. بهتر است پروژه ای را كه شروع می كنيد، سند جديدی را ايجاد كنيد و عناصر متنی 
مختلف خود را در فريم های متنی مجزا بچينيد )سرصفحه ها، متن اصلی، عناوين و غيره(. سپس سبک گذاری 
را به طور دستی بر هر عنصر متنی اعمال كنيد )فونت، اندازه، وزن، رنگ و غيره(. پس از رضايت از تنظيمات 

خود، سبک های كاراكتری را برای هر نوع متن ايجاد كنيد.

 12ـ4ـ اعمال یک سبک كاراكتری

انجام اين كار واقعاً آسان است. متنی را كه می خواهيد سبک كاراكتری را روی آن اعمال كنيد، متمايز كنيد، 
 Apply برويد و روی نام سبک كليک كنيد يا روی آن كليک راست كنيد و Character Styles سپس به پنل

”[name of style]“ را انتخاب كنيد. اين امر موجب اعمال خودكار سبک بر متن منتخب می شود.
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شکل 12ـ4ـ اعمال سبک بر متن

 13ـ4ـ ایجاد یک سبک پاراگرافی

سبک های پاراگرافی به شما اجازه اعمال و به روزرسانی كلی فرمت بندی متن را برای كل پاراگراف ها می دهد 
و نه فقط كاراكترهای منتخب. آن ها تمام عناصر فرمت بندی متن شما را شامل می شوند، بنابراين، علاوه بر 
پاراگرافی  پاراگرافی شامل ويژگی های  اندازه، رنگ و ضخامت، سبک های  از قبيل فونت،  ويژگی های متنی 
نيز می شوند، از جمله تورفتگی ها، tabها، تراز و گذاشتن خط پيوند1. به هر حال، می توانيد بعضی از عناصر 
سبک های كاراكتری را لغو كنيد. برای ايجاد يک سبک پاراگراف پايه از ابتدا، مطمئن شويد هيچ متنی در 
حال حاضر انتخاب نشده است و روی آيکن Create New Style در پايين پنل Paragraph Styles كليک 
كنيد )شبيه برگه ای كاغذی با گوشه تاخورده است(. روی سبک ايجاد شده جديدـ Paragraph Styles 1ـ 

دابل كليک كنيد تا InDesign كادر محاوره ای Paragraph Styles Options را باز كند.

چنانچه هنگام كليک كردن روی آيکن Create New Style، كليد Alt را فشار داده و نگه داريد، سبکی 
را ايجاد خواهيد كرد و كادر محاوره ای Paragraph Styles Options با يک كليک باز می شود.

توجه

Hyphenation ـ1
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 Basic Character كافی است سبک پايه ای را ايجاد كنيد و فعلًا از تنظيمات ديگر صرف نظر كنيد. روی 
Formats در سمت چپ كادر محاوره ای كليک كنيد و سبک فونتی را برای پاراگراف پايه خود تنظيم كنيد. 
نامی به سبک خود بدهيد و روی OK كليک كنيد. حالا يک سبک پاراگراف پايه را ايجاد كرده ايد. هم چنين 
می توانيد سبک پاراگراف جديدی را از يک خط متنی ايجاد كنيد كه هم اكنون فرمت بندی كرده ايد. متن 
 Paragraph Styles در پايين پنل Create New Style انتخاب كرده و روی آيکن فرمت بندی شده را 
اعمال می كند.  بر سبک  را  و آن ها  را می گيرد  تمام ويژگی های منتخب  ـ  كليک كنيد. خيلی ساده است 

می توانيد نام سبک را با دابل كليک كردن روی نام آن تغيير دهيد.

شکل 13ـ4ـ سبک های پاراگراف

14ـ4ـ اعمال كردن سبک پاراگراف

مکان نمای خود را در پاراگرافی قرار دهيد كه می خواهيد سبک پاراگراف را بر آن اعمال كنيد.

برخلاف هنگام اعمال سبک كاراكتر، نبايد تمام متنی را كه می خواهيد سبک پاراگراف را بر آن اعمال 
كنيد، متمايز كنيد. فقط بايد مکان نمای خود را جايی در پاراگراف قرار دهيد يا فريم متنی را انتخاب 

كنيد، اين كار باعث بازنويسی سبک های كاراكتری موجود نمی شود.

توجه

 Apply برويد و روی نام سبک كليک كنيد يا روی آن كليک راست كرده و Paragraph Styles به پنل
”[name of style]“ را انتخاب كنيد. اين امر موجب اعمال خودكار سبک ـ با تمام سبک گذاری ايجاد شده  ـ 

بر كل پاراگرافی می شود كه مکان نما در آن قرار دارد.
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شکل 14ـ4ـ اعمال سبک پاراگراف

15ـ4ـ بارگذاری سبک ها از سندی دیگر

همانگونه كه قبلًا بيان شد، قصد داريم اسنادی را با سبک های متنی خاص ايجاد كنيم و سپس آن سبک ها 
با  را  خود  سند  طريقی،  هر  به  كنيم.  ذخيره  مربوطه  پنل های سبک های  در  واقعی  به عنوان سبک های  را 
سبک های تنظيمی اش ذخيره می كنيم و می توانيم آن سبک ها را قرض بدهيم و بر سند جديدی اعمال كنيم. 

به عنوان يک مثال، بعضی از سبک های كاراكتری موجود را در سندی جديد بارگذاری خواهيم كرد.

هم چنين می توانيد از مراحل مشابه برای بارگذاری هر نوع سبک ديگری استفاده كنيد؛ كافی است از پنل 
مربوط به نوع سبک واردشونده استفاده كنيد. 

نکته

 Load Character كليک كرده و Character Styles روی آيکن منوی پنل در گوشه سمت راست بالای پنل 
Styles را انتخاب كنيد. فايلی را بيابيد كه حاوی سبک های موردنظر شما برای ورود است و روی OK كليک 
ورودی  سبک های  مورد  در  می توانيد  كه  می شود  جديد  محاوره ای  كادر  شدن  باز  موجب  امر  اين  كنيد. 
تصميم گيری كنيد. روی كادر انتخاب كنار هر سبکی كه می خواهيد وارد كنيد، كليک كنيد و سپس روی 
OK كليک كنيد. حالا آن سبک ها را در پنل  Character Styles خود خواهيد ديد. كافی است اين مراحل 

را برای هر سند ديگری تکرار كنيد يا هر سبک ديگری را وارد كنيد.
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شکل 15ـ4ـ بارگذاری سبک ها

16ـ4ـ حذف كردن سبک

اگر ذهنيت شما درباره سبکی تغيير كندـ شايد ديگر نيازی به آن نداشته باشيد يا بخواهيد از اول شروع 
كنيد  ـ روش های ساده متعددی برای خلاص شدن از آن وجود دارد. ابتدا، می توانيد يک بار روی نام سبکی 
كليک كنيد تا متمايز شود و سپس روی آيکن سطل آشغال در گوشه سمت راست پايين پنل سبک ها كليک 
كنيد يا می توانيد روی نام سبک در پنل سبک ها كليک راست كرده و Delete Style را انتخاب كنيد يا 
می توانيد نام سبک را متمايز كنيد، منوی پنل سبک ها را باز كنيد و Delete Style را از آن جا انتخاب كنيد.

شکل 16ـ4ـ حذف کردن سبک
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واحد كار پنجم

کار با Master و کاربرد آن در صفحه آرایی
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  از Master استفاده كند و تنظيمات آن را انجام دهد.

  شماره صفحات را با استفاده از Master ايجاد كند.

  فهرست مطالب را ايجاد كند و تنظيمات آن را انجام دهد.

  پانويس ها را اضافه كند.

  راهنماي موضوعي را ايجاد كند.

  فهرست مطالب را ايجاد كند.

  فصل ها و كتاب ها را چاپ كند.

زمان آموزش

عملینظری

410
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Master 1ـ5  ـ مفهوم 

صفحات Master عناصر مشترک طراحی را در صفحات سند شما اعمال می كنند. اين امر موجب صرفه جويی 
در وقت شما برای افزودن اين عناصر به تک تک صفحات و تضمين انسجام می شود و روشی آسان را برای 

سراسری كردن تغييرات در يک سند فراهم می كند.
يا  طراحی  عناصر  می توانيد  آيا  بزنيد.  ورق  را  آن  صفحات  داريد،  صفحه ای  چند  نشريه  يا  مجله  يک  اگر 
ويژگی های صفحه بندی آن را مشخص كنيد؟ كدام عناصر طراحی در چندين صفحه در صفحه بندی كتاب 

هستند. تکراری  گزارش  يا 
مجله حاوی مثال های متعددی از اقلام Master است كه در صفحات Master فعال هستند. سرصفحه ها 
)ناحيه بالای حاشيه بالايی صفحه( و پانويس ها )ناحيه زير حاشيه پايين(، نواحی ای در صفحه هستند كه 
عناصر تکراری را در صفحات مختلف قرار می دهيد )شکل 1ـ5(. برخی مثال های عناصر تکراری سرصفحه و 

پانويس، شماره صفحات، لوگوهای شركت و كنترل های پيمايش هستند.

شکل 1ـ5  ـ نمونه دو صفحه روبه روی هم از صفحه آرایی یک مجله و صفحه اصلی که برای افزودن نوارهای قرمز، سرصفحه و 
پانویس به کار گرفته شده است.

اگر قرار است عنصر موردنظر شما در صفحات متعددی ظاهر شود، آن آيتم را به يک صفحه Master اضافه 
كنيد. سپس، هنگامی كه آن صفحه Master را بر صفحات سند اعمال می كنيد، آن اقلام Master به طور 

خودكار در آن صفحات سند ظاهر می شوند.
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Master 2ـ5  ـ ایجاد و ویرایش صفحات

هنگام ايجاد يک سند جديد، سندی خالی با تعداد صفحات مشخص شده باز می شود. تمام صفحات به طور 
خودكار برمبنای صفحه Master پيش فرض به نام MasterـA هستند. اين صفحه Master پيش فرض بر 
همه صفحات خالی اعمال می شود و در تنظيمات سند جديد اصلی از قبيل اندازه صفحه، جهت صفحه )افقی 

يا عمودی بودن(، حاشيه ها، ستون ها و تنظيمات bleed به كار گرفته می شود.
قبل از افزودن اقلام به صفحه Master، صفحه Master با انجام يکی از موارد ذيل نمايش داده می شود:

  در ناحيه صفحات Master پنل Pages، روی نام صفحه Master )در اين مورد، MasterـA( دابل كليک كنيد.

  در نوار وضعيت، نام صفحه Master( MasterـA( را از منوی Go To Page انتخاب كنيد.

  Layout>Go to Page را انتخاب كنيد و نام صفحه Master( MasterـA( را از منوی Page برگزينيد 

)شکل 2ـ5(.

Pages پنل Master قابل انتخاب از نوار وضعیت در پایین پنجره سند و در ناحیه صفحه AـMaster شکل 2ـ5 ـ

حالا اسپريد يا صفحه MasterـA در پنجره سند نمايان می شود و می توانيد افزودن اقلام Master مشترک 
را شروع كنيد.

هنگام استفاده از صفحات روبه رو، يک اسپريد صفحه Master حاوی صفحه Master چپ و راست است، 
بنابراين می توانيد اقلام را فقط به يک صفحه هر اسپريد اضافه كنيد.
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نشانگر ويژه شماره صفحه اغلب اولين آيتم Master است كه به يک صفحه Master اضافه می كنيد، به ويژه 
برای اسناد طولانی مثل كتاب، گزارش يا مجله. اين نشانگر برای نمايش شماره صفحه فعلی به طور خودكار 

بهنگام رسانی می شود.
برای افزودن نشانگر شماره صفحه )شکل 3ـ5(:

1 با استفاده از ابزار Type، يک فريم متنی در صفحه MasterـA در ناحيه پانويس بکشيد و داخل فريم كليک كنيد.
Type>Insert Special Character>Markers>Current Page Number 2 را انتخاب كنيد. نشانگر 
ويژه شماره صفحه درج شده به صورت حرف A ظاهر می شود كه با پيشوند صفحه Master منطبق است. 
شماره صفحه در MasterـB به صورت حرف B نمايان می شود. چنانچه بخواهيد متن بيشتری به فريم متنی 

پانويس اضافه كنيد كه حاوی نشانگر شماره صفحه است، از قبيل نام مجله، دست به كار شويد.
3 هنگام بازگشت به صفحه سند، آيتم Master جديدی را در هر صفحه استفاده كننده از آن Master خواهيد ديد.

شکل 3ـ5 ـ نشانگرهای شماره صفحه فعلی در سمت چپ MasterـA )بالا( و چگونگی ظهور نشانگر در صفحه 4.

اگر از صفحات روبه رو استفاده می كنيد و می خواهيد آيتم Master را در هر صفحه ببينيد، به خاطر داشته 
باشيد كه آيتم Master را هم به صفحات چپ و هم به صفحات راست اسپريد Master اضافه كنيد.

به همان روش، می توانيد هر متن يا گرافيک ديگری را به اسپريد Master اضافه كنيد، از قبيل عنوان سند 
يا تاريخ صدور.

صفحات Master فقط برای اشيايی نيستند كه در هر صفحه ظاهر می شوند. آن ها برای چيدمان هايی نيز كه 
به كرات استفاده مجدد می شوند، مفيدند. به جای هر بار بازسازی چيدمان، يک صفحه Master آماده خواهيد 

داشت كه به هر صفحه ديگری اضافه خواهند شد.
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Master 3ـ5 ـ افزودن صفحات 

مثلًا، در صفحه بندی يک مجله،  نيستند.  واحد   Master اسپريد  يا   Master به يک صفحه  اسناد محدود 
استفاده كنند. متفاوتی  استاندارد  صفحه بندی های  از  است  ممکن  مختلف  بخش های 

برای ايجاد يک صفحه Master، يکی از موارد ذيل را انجام دهيد:
  با صفحه يا اسپريد Master انتخاب شده، روی دكمه Create New Page در پايين پنل Page كليک كنيد.

  New Master را از منوی پنل Pages انتخاب كنيد.

  روی ناحيه صفحه Master در پنل Pages كليک راست كرده و New Master را انتخاب كنيد.

اگر فرمان New Master را انتخاب كنيد )يا فرمان Master Options هنگام انتخاب Master(، می توانيد 
تنظيمات را برای Master تغيير دهيد )شکل 4ـ5(:

  Prefix: راه كوتاه شناسايی Master هنگامی كه فضای كافی برای نمايش كامل نام Master وجود ندارد.

.Master نام :Name  

تغييرات است.  برای مديريت  بر ديگری، روشی عالی   Master Based on Master: مبنا گرفتن يک    

مثلًا، اگر در دو بخش يک كاتالوگ، مستطيل های يکسانی در سرصفحه وجود دارد به استثنای رنگ زمينه 
مستطيل، می توانيد Master دوم را برمبنای اولی قرار دهيد و فقط رنگ مستطيل را تغيير دهيد. هنگام 
ويرايش اولين Master، تغييرات بر دومی هم اعمال می شود )به استثنای رنگ زمينه(، بنابراين برای تغيير هر 

دو Master، كافيست فقط يکی را ويرايش كنيد.
 Master می تواند بيش از دو صفحه داشته باشد، مثلًا، می توانيد يک Master يک :Number of Pages  

را برای صفحه آرايی خود طراحی كنيد.
علاوه بر داشتن اشيا و راهنماهای متفاوت، هر Master می تواند اندازه صفحه، تنظيمات حاشيه و تنظيمات 

ستون خودش را داشته باشد.

New Master جدید با فرمان Master شکل 4ـ5  ـ افزودن صفحه
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Master 4ـ5 ـ كپی كردن صفحات

می توانيد يک صفحه Master موجود را كپی كنيد تا به منزله پايه ای برای صفحه Master جديدی عمل 
 Master موجود سريع تر از ساخت يک Master مرتبط، كپی كردن يک Master كند. هنگام ايجاد چندين

جديد از يک صفحه خالی است.
برای كپی كردن يک اسپريد يا صفحه Master، يکی از موارد ذيل را انجام دهيد:

  در حالی كه يک Master انتخاب شده است، Duplicate Master Spread را از منوی پنل Pages انتخاب كنيد.

  روی يک Master كليک راست كرده و Duplicate Master را انتخاب كنيد.

  Master را به دكمه Create New Page در پايين پنل Pages بکشيد.

پس از كپی كردن يک اسپريد، می توانيد از فرمان Master Options برای سفارشی كردن نام و ويژگی های 
آن استفاده كنيد. سپس می توانيد اقلام موجود در كپی را در صورت لزوم اضافه يا حذف كنيد.

برای ايجاد يک صفحه Master جديد كه طراحی صفحه يک سند را كپی كند، صفحه سند را در 
 Master را از منوی پنل Master Pages>Save As Master انتخاب كرده و سپس Page پنل

انتخاب كنيد.

نکته

Master 5ـ5 ـ عملیاتی كردن صفحات

بر  را   Master می توانيد صفحات  نيز  و  كنيد  اعمال  بر همه صفحات سند  را   Master می توانيد صفحات 
كنيد. اعمال  می كنيد،  اضافه  كه  جديد  صفحات 

Master 6ـ5 ـ به كارگیری صفحات

هنگام اعمال صفحات Master بر صفحات سند، حرف پيشوند )مثلًا A برای MasterـA( در نمونه تصويری 
صفحه در پنل Pages نمايان می شود. اين كار مشاهده اينکه كدام صفحه Master بر يک صفحه سند اعمال 

شده است را آسان می كند. 
برای اعمال يک صفحه Master بر يک صفحه سند )شکل 5ـ5(:

1 در پنل Pages، صفحات سند را برای اعمال صفحه master انتخاب كنيد.
Apply Master to Pages 2 را از منوی پنل Pages انتخاب كنيد.

3 در كادر محاوره ای Apply Master، يک Master را برای اعمال صفحه سند از منوی Apply Master انتخاب كنيد.
4 روی OK كليک كنيد.
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Pages بر صفحات سند منتخب در پنل Master شکل 5ـ5 ـ اعمال یک صفحه

میانبر: برای انتخاب محدوده پيوسته ای از صفحات در پنل Pages، روی اولين صفحه در محدوده 
كليک كرده و سپس روی صفحه آخر در محدوده Shift كليک كنيد. برای انتخاب صفحات ناپيوسته، 

روی آيکن صفحات Ctrl كليک كنيد.

همچنين می توانيد Master را در پنل Pages با كشيدن نمونه تصويری Master و انداختن آن روی نمونه 
تصويری صفحات در پنل Pages اعمال كنيد.

Master 7ـ5 ـ افزودن صفحات بر مبنای صفحات 

هنگام افزودن صفحه ای جديد، آن صفحه از همان Master صفحه ای استفاده می كند كه در زمان افزودن 
صفحه جديد انتخاب كرده ايد.

می توانيد با انتخاب Insert Pages از منوی پنل Pages، كادر محاوره ای Insert Pages را باز كنيد 
يا روی دكمه Create New Page در پنل Alt، Layer كليک كنيد.

نکته

 Layout>Pages>Insert Pages ،برای صفحه جديد شما استفاده شود Master اگر می خواهيد انتخاب كنيد كه كدام
5ـ(. در كادر محاوره ای Insert Pages، می توانيد مشخص كنيد كه صفحات جديد را كجا اضافه  را انتخاب كنيد )شکل 6
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 Pages پنل Masters را از ناحيه Master استفاده كنند. هم چنين می توانيد يک Master می كنيد و آن ها بايد از كدام
قبل يا بعد از هر يک از صفحات در ناحيه صفحات سند پنل Pages بکشيد.

Master شکل 6ـ5 ـ افزودن یک یا چند صفحه و اعمال صفحه

8ـ5 ـ حذف Master ها

حذف يک Master تقريباً شبيه ايجاد آن است. در پنل Pages، به سادگی می توانيد يک اسپريد يا صفحه 
( بکشيد. هنگام انتخاب يک Master، می توانيد روی  ( Delete Selected Pages را به آيکن Master
آيکن Delete Selected Pages كليک كنيد يا Delete Master را از منوی پنل Pages انتخاب كنيد. 

9ـ5 ـ ایجاد فهرست مطالب

فهرست مطالب )TOC( معمولاً بخشی از محتوای ابتدای يک نشريه است. فهرست مطالب معمولاً تيترهای 
متفاوت مورد استفاده در سراسر نشريه را فهرست می كند )مثلًا، عناوين و زيرعناوين دستورعمل يا عناوين 
دارای  كه  كنيد  پيدا  را  كتابی  تمرين،  يک  به عنوان  فصل ها(.  اين  در  استفاده  مورد  زيرتيترهای  و  فصل ها 
فهرست مطالب است، حتی شايد كتابی كه در حال حاضر در حال مطالعه آن هستيد. آيا رابطه ای بين متن 

فهرست مطالب و تيترهای مورد استفاده در سراسر كتاب را می توانيد ببينيد؟
كليد ساخت فهرست مطالب، استفاده از شيوه های پاراگراف برای هر تيتر يا متن ديگری است كه می خواهيد 
در فهرست مطالب باشد. مثلًا، اگر شيوه هايی به نام Heading1 و Heading2 داريد و آن ها را بر آن سطوح 
مطالب  فهرست  در  شيوه  دو  اين  كه  بگوييد   InDesign به  می توانيد  كرده ايد،  اعمال  خود  سند  در  تيتر 
با شيوه های  پاراگراف های تگ گذاری شده  از  مراتبی  فهرستی سلسله  نتيجه،  مطالب  فهرست  باشند.  شما 

Heading1 و Heading2 است.
معمولاً،  كرد.  خواهيد  استفاده  نتيجه  مطالب  فهرست  قالب بندی  برای  پاراگراف  شيوه های  از  همچنين 
مجموعه ای از شيوه هايی را طراحی می كنيد كه چگونگی ظهور متن فهرست مطالب را كنترل كنند. اين دو 
كاربرد شيوه ها در فهرست مطالب ممکن است كمی گيج كننده باشد، پس اجازه دهيد آن را روشن كنيم؛ 
شما يک مجموعه از شيوه های پاراگرافی را انتخاب می كنيد كه ويژگی Table of Contents می گويد كدام 
پاراگراف ها را لحاظ كند و مجموعه ديگری از شيوه های پاراگرف را برای قالب بندی متن توليد شده برای 

انتخاب می كنيد )شکل 7ـ5(. فهرست مطالب 
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شکل 7ـ5 ـ فهرست مطالبی که به طور خودکار از شیوه های سند تولید شده است.

قبل از تعريف فهرست مطالب:
  هميشه شيوه های پاراگراف را بر متن در پروژه طراحی خود اعمال كنيد، به ويژه عناوين و تيترها، زيرا ايجاد 

فهرست مطالب متکی به اين قالب بندی است.
  يک صفحه بندی مدل برای طراحی فهرست مطالب ايجاد كنيد.

  شيوه های پاراگراف را برای عنوان فهرست مطالب برای سطوح مختلف ايجاد كنيد.

  تعيين كنيد كه كدام متن از سند شما بايد در فهرست مطالب باشد و بررسی كنيد كه كدام شيوه های 

پاراگراف بر آن متن اعمال می شوند، نام شيوه ها را يادداشت كنيد و همين طور سطح اهميتی كه آن ها دارند. 
بگيريد )پيش غذاها،  نظر  را در  انواع مختلف دستورعمل ها  برای يک كتاب دستورعملی، ممکن است  مثلًا 
نام  بالا )سطح 1( در فهرست مطالب و در زير هر يک می توانيد  به عنوان سطح  يا دسرهاـ  غذاهای اصلی 

دستورعمل های مختلف را فهرست كنيد )سطح 2((.
  مشخص كنيد كدام شيوه های پاراگراف برای قالب بندی متن سند شما استفاده می شوند كه بايد در فهرست 

مطالب ظاهر شوند. اين ها شيوه هايی هستند كه در شيوه فهرست مطالب شما خواهند بود.

10ـ5 ـ تعریف شیوه فهرست مطالب

هنگامی كه شيوه هايی را برای قالب بندی متن فهرست مطالب ايجاد كرديد و تعيين كرديد كه كدام متن بايد 
به آن اضافه شود، شما آماده تعريف شيوه فهرست مطالب هستيد. شيوه فهرست مطالب متن مندرج، سلسله 

مرتبه و قالب بندی نهايی فهرست مطالب را تعيين می كند.
برای تعريف شيوه فهرست مطالب:

Layout>Table of Contents Styles 1 را انتخاب كنيد.
2 روی New كليک كنيد. كادر محاوره ای New Table of Contents Style باز می شود.

3 برای بسط دادن اين كادر محاوره ای، روی More Options كليک كنيد )شکل 8ـ5(.
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4 يک نام توصيفی برای شيوه فهرست مطالب در فيلد TOC Style وارد كنيد.
5 عنوانی را در فيلد Title تايپ كنيد كه در بالای فهرست مطالب ظاهر می شود )مثلًا »فهرست«( و يک 
شامل  هم اكنون  شما  فهرست  اگر  كنيد.  انتخاب  متن  قالب بندی  برای   Style منوی  از  را  پاراگراف  شيوه 
شيوه ای نيست كه برای عنوان TOC كار كند، New Paragraph Style را از فهرست برای تعريف شيوه 

جديد پاراگراف انتخاب كنيد.
 Include Paragraph Styles حالا آماده افزودن تعدادی شيوه مورد استفاده در پروژه خود هستيد. اين كار در فهرست

در قسمت Styles in Table of Contents انجام می شود.
 Add شيوه ای را انتخاب كنيد كه می خواهيد در فهرست مطالب باشد و روی ،Other Styles 6 در قسمت
 Include كليک كنيد. اين گام را برای هر شيوه ای تکرار كنيد كه می خواهيد اضافه كنيد. شيوه ها در قسمت

Paragraph Styles نمايان می شوند.
پس از اضافه شدن همه شيوه ها، می توانيد قالب بندی و سطوح را برای هر يک از شيوه های پاراگراف مشمول 

تنظيم كنيد.
7 شيوه ای را در فهرست Include Paragraph Styles انتخاب كرده و سلسله مرتبه ای را از منوی Level برگزينيد.

 New Table of Contents Style شکل 8ـ5 ـ کادر محاوره ای

سطح، ترتيب متن در فهرست مطالب را تعيين می كند. Level 1 بالاترين سطح و شيوه های Level 2 پس 
از متن Level 1 می آيند.

8 از منوی Entry Style، شيوه پاراگرافی را انتخاب كنيد كه متن موجود در فهرست مطالب را قالب بندی می كند.
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 Between Entry شماره صفحات مورد استفاده هر مدخل را سفارشی كنيد. از فيلد ،Page Number 9 از منوی
and Number و منوهای Styles برای سفارشی سازی بيشتر مکان و ظاهر شماره صفحات استفاده كنيد.

10 مراحل 7 تا 9 را برای هر شيوه موجود در فهرست Include Paragraph Styles تکرار كنيد.
11 برای ايجاد خودكار نشانه های پيمايشی كه در پنل Adobe Acrobat Reader’s Bookmarks ظاهر 

می شوند، Create PDF Bookmarks را انتخاب كنيد.
12 روی OK كليک كرده و سپس مجدداً روی OK كليک كنيد.

11ـ5 ـ پر كردن متن فهرست مطالب

پس از تعريف شيوه فهرست مطالب، حالا آماده افزودن متن فهرست مطالب به صفحه مطالب در پروژه خود هستيد.
برای افزودن فهرست مطالب به سند خود: 

Layout>Table of Contents 1 را انتخاب كنيد.
2 شيوه فهرست مطالب خود را از منوی TOC Style انتخاب كنيد.

3 روی OK كليک كنيد.
4 برای ايجاد يک فريم متنی پر شده با متن فهرست مطالب، روی آيکن متن بارگذاری شده كليک كنيد 
يا بکشيد )شکل 9ـ5( يا روی يک فريم جايبان1 خالی كه قبلًا برای درج فهرست مطالب كنار گذاشته شده 

است، كليک كنيد.

شکل 9ـ5 ـ افزودن خودکار متن فهرست مطالب تولید شده به سند

Placeholder ـ1
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12ـ5 ـ به روزرسانی فهرست مطالب

هنگامی كه تغييراتی در اسناد InDesign خود می دهيد، به خاطر داشته باشيد كه فهرست مطالبی كه قبلًا 
توليد كرده ايد، به طور خودكار به روزرسانی نمی شود. تيترهايی كه در  فهرست مطالب گنجانده شده اند، ممکن 
است به عنوان بخشی از درخواست های تغيير كارفرما تغيير كرده باشند يا ممکن است پس از اضافه كردن 

مطالب اضافی يا حذف برخی از مطالب، شماره صفحه آن ها تغيير كرده باشد.
برای به روزرسانی فهرست مطالب:

1 با استفاده از ابزار Type، كليک كنيد تا نقطه درج متن جايی در متن فهرست مطالب قرار گيرد.
Layout>Update Table of Contents 2 را انتخاب كنيد.

 ـ5 ـ نحوه ایجاد كتاب 13

بسيار  ويژگی   InDesign كنيد.  از كجا شروع  را  كتاب  ايجاد  كه  باشيد  نداشته  تصوری  است هيچ  ممکن 
 File .مفيدی برای ايجاد اسناد طولانی كتاب به شما ارائه می دهد؛ اين موارد را فايل های كتاب می نامند
Book مجموعه ای از اسناد )معمولاً فصل ها( است كه با هم جمع شده اند. ايجاد يک فايل به جای ايجاد كتاب 

به عنوان يک سند بزرگ InDesign، مزايايی دارد: 
  اول اينکه، می توانيد سبک ها را در فصل های File Book به اشتراک بگذاريد و توالی شماره صفحه از يک 

فصل به فصل ديگر ادامه خواهد يافت. 
  همچنين وقتی از File Book استفاده می كنيد می توانيد با سرعت و سهولت بيشتری در كتاب خود تغييراتی 

با  باز كردن يک فايل واحد  ايجاد كنيد. به جای 
تعداد زيادی صفحه، می توانيد فقط بخش يا فصلی 
باز كنيد كه اين  را كه می خواهيد ويرايش كنيد 
امر پيمايش در كتاب شما را بسيار آسان می كند.

  File>New>Book به ،File Book برای ايجاد يک
در InDesign برويد. از شما خواسته می شود به 
كتاب نامی دهيد و آن را ذخيره كنيد. وقتی فايل 
،Book كتاب را ايجاد كرديد، از منوی اصلی پنل 

اينجا،  از  كنيد.  انتخاب  را   Add Document
می توانيد فايل های InDesign را به كتاب اضافه 
هستند  فصل  فايل های  معمول  به طور  كه  كنيد 

غيره(. و   2 فصل   ،1 فصل  مثال  )به عنوان 

 InDesign برای اطمينان از اينکه متن فهرست مطالب جديدترين ويرايش است، قبل از تبديل فايل
به PDF يا پکيج گرفتن از آن برای چاپ، فهرست مطالب را به روزرسانی كنيد.

نکته

File Book شکل10ـ5  ـ اضافه کردن سند به
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كه  است  مهم  كتاب،  فايل  تنظيم  از  پس 
به درستی  را  خود  كتاب  صفحات  شماره گذاری 
باشد،  اين می تواند كمی محرمانه  تنظيم كنيد. 
بنابراين بياييد به يک مثال نگاه كنيم. در اينجا، 
می خواهم كتاب خود را تنظيم كنم تا صفحه 1 
از صفحه اول فصل آغازين شروع شود. بنابراين 
من صفحه فصل ابتدايی را انتخاب می كنم )كه 
گزينه های  و  است(   13 صفحه  حاضر  حال  در 
از  را   Numbering & Section Options

می كنم. انتخاب  پنل  اصلی  منوی 
در پنجره New Section، شماره صفحه شروع 
را بررسی كرده و آن را با 1 تنظيم كنيد. از منوی

Style، قبل از كليک روی OK،و’...4 ,3 ,2 ,1‘ 
را انتخاب كنيد.

 ـ5 ـ انتخاب سبک شماره صفحات شکل 12

Numbering a Section Options شکل11ـ5 ـ انتخاب گزینه
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من می خواهم 12 صفحه اول كتابم با حروف ابجد شماره گذاری شود. برای اين كار، من اولين صفحه سند را 
انتخاب می كنم و دوباره Numbering & Section Options را انتخاب می كنم. مانند قبل، شماره صفحه 
شروع را بررسی كرده و آن را با 1 تنظيم می كنم. اما اين بار از منوی Style،وArabic Abjad  را انتخاب 

كرده و روی OK كليک می كنم.

شکل 13ـ5 ـ انتخاب Arabic Abjad برای شماره گذاری صفحات ابتدایی کتاب با حروف

كنيد.  اضافه  خود  كتاب  آخر  به صفحات  را  متفاوت  شماره  با  قسمت  يک  بخواهيد  است  ممکن  همچنين 
 File Book ،هنگامی كه شماره های صفحه را به روز می كنيد يا صفحات كتاب خود را اضافه يا حذف می كنيد

شماره صفحه را در تمام اسناد )فصل ها( به روز می كند. 

 14ـ5 ـ آماده سازی كتاب برای چاپ

پس از تکميل جلد و صفحات داخل كتاب، آماده صادر كردن آن برای چاپ هستيد. قالب استاندارد فايل آماده 
چاپ برای بيشتر چاپگرها PDF است. در InDesign به File>Export برويد و Adobe PDF (Print) را 
از منوی Format انتخاب كنيد. برای اطمينان از اينکه آثار هنری شما با كيفيت بسيار بالايی صادر می شود، 

از گزينه های Preset،وPress Quality را انتخاب كنيد. 
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15ـ5 ـ نحوه كار با بخش ها در فصول

شماره گذاری و بخش های صفحه شايد مفيدترين جنبه از ويژگی كتاب در InDesign است كه شماره صفحه 
را برای شما رديابی می كند و هنگام اضافه كردن صفحات يا حذف آن ها از شماره يا هنگام اضافه كردن سند 
جديدی بين دو سند ديگر، شماره صفحه را به روز می كند. البته، اين تنها در صورتی جواب می دهد كه شماره 
صفحات خودكار را در صفحات سند خود قرار داده باشيد. فرض كنيد شما قبلًا يک سند 16 صفحه ای در پنل 
كتاب خود داشته ايد. وقتی سند ديگری اضافه می كنيد، InDesign به طور خودكار شماره صفحه اول سند 
 ،Numbering and Section Options جديد خود را با 17 تنظيم می كند )به شرطی كه در كادر محاوره ای
صفحه اول را به عنوان شروع بخش مشخص نکرده باشيد(. اگر بعداً سند اول را باز كنيد و دو صفحه به آن 
اضافه كنيد، InDesign سند دوم را به طور خودكار تغيير می دهد، دفعه بعدی كه آن را باز می كنيد، می بينيد 
 Numbering and Section Options كه از صفحه 19 شروع می شود. از طرف ديگر، اگر از كادر محاوره ای
برای ايجاد شروع بخش استفاده كنيد )می توانيد با دابل كليک كردن روی شماره صفحه در صفحه كتاب، 
به سرعت به اين ويژگی برويد(، پنل كتاب به آن احترام می گذارد. اسناد بعدی در پنل كتاب شماره گذاری 
صفحه را از جايی كه شماره صفحه سند قبلی متوقف شده است ادامه می دهند. اگر از شماره صفحات خودكار 
از  احتمالاً  كرده ايد،  كتاب خود مشخص  در  سند  هر  برای  را  دستی  شماره صفحات  يا  نمی كنيد  استفاده 
 Book Page شماره گذاری مجدد صفحات كتاب خود خسته خواهيد شد. خوشبختانه، می توانيد با انتخاب
 Automatically Update Page and و برداشتن علامت Book از منوی پنل Numbering Options

Section Numbers اين ويژگی را غيرفعال كنيد )به شکل 14ـ5 مراجعه كنيد(.
 

Book Page Numbering Options شکل 14ـ5 ـ

جلد و صفحات داخلی خود را به عنوان فايل PDF جداگانه صادر كنيد. جلد بايد به صورت يک تصوير 
كامل )شامل پشت جلد، روی جلد و عطف( صادر شود، در حالی كه صفحات داخلی بايد به صورت 

صفحات جداگانه صادر شوند )نه اسپريد(.

نکته
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16ـ5 ـ صفحات زوج و فرد

اول فصل 3  را به صفحه  InDesign چه شماره صفحه ای  پايان می رسد،  به  وقتی فصل 2 در صفحه 45 
اختصاص می دهد؟ اگر در كار كتاب هستيد، احتمالاً می خواهيد فصل 3 از صفحه 47 شروع شود، زيرا اين 
يک صفحه دست راست است. ناشران كاتالوگ و مجله می خواهند فصل سوم در صفحه 46 آغاز شود، حتی 
اگر يک صفحه سمت چپ باشد. می توانيد با انتخاب Book Page Numbering Options از منوی پنل 
 Continue from :انجام دهد، تعيين كنيد. شما سه گزينه داريد InDesign آنچه را كه می خواهيد ،Book
Previous Document،وContinue on Next Odd Page و Continue on Next Even Page. وقتی 
بين  تا فضای خالی  اضافه می كند  InDesign يک صفحه  فعال می كنيد،  را   Insert blank page گزينه 
 Continue on Next فصل ها را پر كند. به عنوان مثال، اگر فصل 2 در صفحه 45 به پايان برسد و شما
Odd Page را فعال كنيد، InDesign يک صفحه خالی را در انتهای فصل 2 اضافه می كند. اين صفحه واقعاً 
 Master خالی است. اگر می خواهيد صفحات پشت سر هم بيايند و صفحه خالی نداشته باشيد، بايد صفحه

خود را اعمال كنيد. 

17ـ5 شماره گذاری فصل

دهيد  اجازه   InDesign به  می توانيد  كنيد،  شماره گذاری  خود  كتاب  در  را  سندی  هر  می خواهيد  اگر 
شماره گذاری را برای شما با استفاده از شماره های فصل انجام دهد. برای تنظيم شماره گذاری فصل، اولين 
صفحه را در سند انتخاب كنيد، سپس Numbering & Section Options را از منوی Layout يا از منوی 
پنل Pages انتخاب كنيد. در بخش Document Chapter Numbering در كادر محاوره ای )شکل 15ـ5 
را ببينيد(، يک سبک شماره گذاری )مانند regular numerals،وroman numerals يا letters( را انتخاب 
كنيد. سپس انتخاب كنيد كه آيا می خواهيد برای اين كتاب شماره فصل مشخص كنيد يا شماره را از شماره 
فصل سند قبلی در صفحه كتاب قرار می دهيد. توجه داشته باشيد كه حتی اگر يک سند واحد بتواند چندين 

بخش داشته باشد، می تواند فقط يک شماره فصل داشته باشد.

Chapter Numbering شکل 15ـ5 ـ
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پس از تنظيم كادر محاوره ای Numbering & Section Options، می توانيد با اضافه كردن متغير متنی شماره 
فصل، شماره فصل را در يک متن »تايپ« كنيد. توجه داشته باشيد كه وقتی شماره فصل شما تغيير می كند )به 
 Update All Numbers عنوان مثال، اگر ترتيب اسناد را در صفحه كتاب تنظيم مجدد كنيد(، تا زمانی كه گزينه
يا Update Chapter & Paragraph Numbers from the Update Numbering را در زيرمنوی منوی پنل 
كتاب انتخاب نکنيد، شماره های فصل در اسناد شما به روز نمی شوند. اگر اين كار را انجام می دهيد و شماره موجود 
روی صفحه مقابل باز هم به روز نمی شود، به ياد داشته باشيد كه متغيرهای متنی فقط هنگامی تغيير می كنند كه 

صفحه نمايش را مجبور به ترسيم دوباره كنيد. 

18ـ5 ـ چاپ و صدور كتاب

بايد از اين فرصت استفاده كرده و مواردی را كه مخصوص چاپ، ساخت پکيج يا صدور كتاب است، ذكر كنيم. 
 Book در پنل Modified يا Availableو،Open ابتدا، برای چاپ سند، هر فصل از يک كتاب بايد به صورت
فهرست شود. اين بدان دليل است كه InDesign به صورت نامرئی هر سندی را در زمان چاپ يا زمان صدور 

باز می كند )سند را روی صفحه باز نمی بينيد، اما باز می شود(. 
دوم، اگر فقط می خواهيد اسناد خاصی در يک كتاب چاپ يا صادر شود، آن ها را در صفحه Book انتخاب 
كنيد. به ياد داشته باشيد كه می توانيد با نگه داشتن كليد Shift، اسناد مجاور را در ليست و اسناد ناپيوسته 
را با Ctrl انتخاب كنيد. اگر هيچ سندی انتخاب نشده باشد، همه آن ها چاپ می شوند )برای لغو انتخاب همه 

اسناد، روی قسمت خالی پايين پنل كليک كنيد(. 
يا   Print Book يا  كنيد  كليک   Book پنل  در   Print Book دكمه  روی  هستيد،  چاپ  آماده  وقتی 
محاوره ای  كادر  در  كه  تنظيماتی  كنيد.  انتخاب  پنل  منوی  از  را   (Print Selected Documents)

می شود.         اعمال  كتاب  در  سندی  هر  برای  می كنيد،  انتخاب   Print
با انتخاب Export Book to PDF يا Export Selected Documents to PDF از منوی پنل، می توانيد 
 Create Acrobat كادر PDF صادر كنيد. اگر هنگام صدور Acrobat PDF كتاب خود را به عنوان فايل
Layers در حالت تأييد باشد، InDesign تمام لايه هايی را كه نام يکسان دارند، در يک لايه PDF واحد 
ادغام می كند. با وجود اين، اگر ابتدا Merge Identically Name Layers on Export را از منوی پنل 

كتاب غيرفعال كنيد، PDF شامل لايه های جداگانه برای هر سند خواهد بود. 
به همين ترتيب، برای ساخت پکيج از تمام اسناد موجود در كتاب، به علاوه فونت های موردنياز و تصاوير 
متصل، می توانيد از منوی پنل، Package Book for Print را انتخاب كنيد. هنگامی كه پکيج يک كتاب 
ساخته شد، تمام تصاوير متصل در يک پوشه Links كپی می شوند. اگرچه در اسناد شما تصاويری قرار داده 
شده باشند كه متفاوت هستند ولی نام آن ها يکسان است، InDesign به اندازه كافی هوشمند است كه به طور 

خودكار نام آن ها را تغيير  دهد.

 19ـ5 ـ انتخاب و ایجاد رنگ های جدید

پنل Color را باز كنيد )به Window>Color>Color برويد يا F6 را فشار دهيد( و روی نمونه رنگ در 
گوشه سمت چپ بالای پنل كليک كنيد تا كادر محاوره ای Color Picker باز شود. صبر كنيد، قبل از اينکه 
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 Color برويد، نکته ظريفی وجود دارد، روی نوار طيف رنگ در پايين پنل Color Picker به كادر محاوره ای
شيفت كليک كنيد تا از بين RGB،وCMYK و Lab دست به انتخاب بزنيد. هنگامی كه حالت رنگ موردنظر 
خود را برگزيديد، كادر محاوره ای Color Picker را باز كنيد تا بتوانيد از فضای رنگ ارائه شده دست به 

انتخاب بزنيد .

برای CMYK، باز هم RGB Color Space View را در بالای اين كادر محاوره ای خواهيد ديد، ولی 
خواهيد ديد كه يکی از دكمه ها Add CMYK Swatch است.

توجه

حالا از يکی از دو روش ذيل برای ايجاد رنگ جديد استفاده كنيد:
  روی علامت به علاوه در فيلد رنگ كليک كرده و آن را به مکان جديدی بکشيد. مقادير رنگ تعريف شده 

در فيلدهای RGB،وCMYK،وLab و Hex نشان داده خواهد شد.
  مثلث های اسلايدر را در هر يک از سمت های طيف رنگ به بالا و پايين بکشيد تا ته رنگِ رنگ منتخب را تغيير دهيد.

  به طور دستی مقادير را در هر يک از فيلدهای مقدار رنگ )RGB،وCMYK يا Lab( وارد كنيد.

شکل 16ـ5 ـ انتخاب و ایجاد رنگ های جدید

 Add CMYK Swatchو،Add RGB Swatch برای ذخيره كردن رنگ جديد به عنوان يک نمونه رنگ، روی
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يا Add Lab Swatch در كادر محاوره ای Color Picker كليک كنيد. دكمه ای كه در دسترس است وابسته 
به اين مسأله است كه فيلدهای مقدار رنگ در حال حاضر در كادر محاوره ای Color Picker انتخاب شده اند 
 InDesign را خواهيد ديد. سپس Add RGB Swatch ،كليک كنيد RGB مثلًا، اگر روی يکی از فيلدهای

رنگ جديد را به پنل Swatches شما با مقادير رنگ به عنوان نام آن اضافه می كند. روی OK كليک كنيد.

Swatches 20ـ5 ـ یافتن پنل

پنل Swatches جايی است كه رنگ های سند ما فعال هستند. كافی است آن را بيابيد: بيشتر پنل ها در 
قسمت منوی Window قرار دارند و اين هم استثنا نيست. برای باز شدن پنل Swatches كافی است به 
تا آن را به هر يک  باز شدن، می توانيد آن را شناور كنيد  از  Window>Color>Swatches برويد. پس 
از پنل های باز ديگر متصل كنيد. پنل Swatches به شما اجازه خواهد داد رنگ ها را به خط دور و زمينه 
كانتينرها )فريم ها و شکل ها( و متن نسبت دهيد. هم چنين می توانيد ته رنگ را برای هر رنگ تنظيم كنيد.

Swatches شکل 17ـ5 ـ پنل

21ـ5 ـ اعمال سریع رنگ  زمینه یا خط دور

در پنل Swatches يا در هر پنلی كه می توانيد رنگی را انتخاب كنيد، دو آيکن نمونه رنگ وجود دارد كه 
آيکن  است.  توپری  مربع  و  بالاست  نمونه رنگ سمت چپ   ،Fill آيکن  نشان می دهند.  را   Stroke و   Fill
Stroke نمونه رنگ سمت راست پايين است و شبيه يک قاب خالی است. آيکنی كه در جلو قرار دارد، نشان 
می دهد رنگ آن كجا بر متن يا شیء منتخب اعمال خواهد شد )يعنی، آيا بر زمينه اعمال خواهد شد يا خط 
دور(. روی آيکن back to bring كليک كنيد تا به جلو بيايد. می توانيد با كليک كردن روی آيکن برعکس 
)فلش خميده دوسر( رنگ های Fill و Stroke را با هم عوض كنيد. برای هر يک، كادر سفيدی با يک خط 



واحدکارپنجم:کارباMasterوکاربردآندرصفحهآرایی

7 9

قرمز ضربدری به اين معنی است كه زمينه يا خط دوری وجود ندارد. دو روش سريع برای اعمال زمينه يا 
خط دور بر يک شیء وجود دارد. اول اينکه، شیء يا متنی را كه می خواهيد رنگ بر آن اعمال شود، انتخاب 
كنيد، روی آيکن Fill و Stroke كليک كنيد و سپس روی نمونه رنگ موردنظر خود برای اعمال كليک كنيد. 
InDesign سابقه رنگ توپر اخيراً استفاده شده، زمينه فعلی يا آخرين گراديان مورد استفاده را نگه می دارد، 
بنابراين می توانيد از ميانبری برای اعمال سريع آخرين رنگ مورد استفاده بر شیء بعدی استفاده كنيد. كافی 
است كليد ويرگول را فشار دهيد تا رنگ زمينه يا خط دوری كه اخيراً استفاده شده اند بر آنچه كه هم اكنون 

در سند شما انتخاب شده است، اعمال شوند

مطمئن شويد كه آيکن نمونه رنگ Fill قبل از استفاده از اين ميانبر انتخاب شده است، البته چنانچه 
زمينه را اعمال می كنيد يا چنانچه خط دور را اعمال می كنيد، آيکن Stroke انتخاب شده باشد.

توجه

شکل 18ـ5 ـ اعمال رنگ خط دور و زمینه

 ـ5 ـ اعمال پروفایل ها بر تصاویر 22

می توانيد پروفايل های مناسب را هنگام ورود تصاوير بر آن ها اعمال كنيد. هنگام قرار دادن تصوير گرافيکی 
 Show Import Optionsو،)Ctrl+D يا فشردن File>Placeا( Place در كادر محاوره ای InDesign در
را انتخاب كنيد. در كادر محاوره ای Image Import Options به پيشخوان Color رفته و پروفايل مناسب 

را از منوی Profile انتخاب كنيد.
می توانيد با انتخاب يک تصوير قرار گرفته و انتخاب Object>Image Color Settings پروفايلی را بر آن 
اعمال كنيد يا آن را تغيير دهيد. با انجام اين كار، كادر محاوره ای Image Color Settings باز می شود و در 
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آن می توانيد پروفايل جديد را از طريق منوی Profile اعمال كنيد )هم چنين می توانيد برای باز كردن كادر 
محاوره ای Image Color Settings،وGraphics>Image Color Settings را از منوی زمينه انتخاب كنيد(.
هنگام باز كردن يک سند، InDesign تمام تصاوير وارد شده در آن سند را بررسی می كند تا ببيند آيا در آن 

پروفايل مديريت رنگ تعبيه يا به كار گرفته شده است.
برمبنای تنظيمات تعريف شده در كادر محاوره ای Color Settingsو(Edit>Color Settings) را انتخاب 
كنيد(، ممکن است پروفايل های پيش فرض را بر آن ها اعمال كنيد، چنانچه پروفايلی برای آن ها تنظيم نشده 
باشد يا از شما سؤال می شود كه چه كاری می خواهيد انجام دهيد. اگر هيچ پروفايل رنگ تعبيه شده ای در 
 Color Settings در كادر محاوره ای Ask When Opening سند وجود نداشته باشد و اگر كادر انتخاب
در حالت تأييد باشد، هنگام باز كردن سند، كادر محاوره ای Missing Profile نمايان می شود. هنگام باز 
كردن سند، ممکن است دو كادر محاوره ای اين چنينی دريافت كنيد، يکی برای پروفايل RGB و يکی برای 
پروفايل CMYK، بسته به اينکه چه چيزی در تصاوير سند تعبيه شده است.انتخاب های شما به اين صورت 

خواهد بود:
  )Leave as Is )Use Current Working Space. اين گزينه از پروفايل پيش فرض سند برای تصوير 

استفاده می كند، ولی آن پروفايل را در تصوير تعبيه نمی كند.
  Assign Current Working Space. اين گزينه پروفايل پيش فرض سند را بر تصوير اعمال می كند، 

آن پروفايل را در تصوير تعبيه می كند، بنابراين حتی اگر پروفايل پيش فرض سند بعداً تغيير كند، پروفايل 
تصوير تغيير نمی كند.

  Assign Profile. اين گزينه به شما اجازه انتخاب پروفايل مناسب را برای تعبيه شدن در اين تصوير 

از منوی بازشو در سمت راست می دهد. از اين گزينه هنگامی استفاده می شود كه دليل خاصی برای عدم 
استفاده از پروفايل پيش فرض سند داشته باشيد.

از هر كدام از روش ها كه برای اعمال پروفايل ها استفاده كنيد، فقط پروفايل های مناسب برای نوع تصوير در 
اين ها دستگاه های خروجی  CMYK )معمولاً،  بازشو نمايان می شود. مثلًا، فقط پروفايل های  اين منوهای 
هستند( برای يک فايل CMYK TIFF نمايان می شود، حتی اگر تصوير با استفاده از اسکنر RGB اسکن 
كه  دارد  وجود  دليل  اين  به  محدوديت  اين  باشد.  شده  تبديل   CMYK به   Photoshop با  بعداً  و  شده 
InDesign فرض می كند تصوير برای خروجی آن چاپگر خاص طراحی شده است و بنابراين، آن را با آن 
مقصد كاليبره می كند. برای فايل های RGB،وInDesign به شما اجازه می دهد پروفايل های مانيتورمحور و 

پروفايل های اسکنرمحور را به كار گيرد.
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  مفهوم مدل های رنگ RGB و CMYK را بيان كند.

  مفهوم پروفايل رنگ را بيان كند.

  نحوه تنظيم شدت رنگ را بداند.

  پنل های Color و Swatch را به كار گيرد.

  يک شيب رنگ ايجاد كند.

  جوهرهای تركيبی را ايجاد كند.

  ويژگی خط دور را تغيير دهد.

 كليات

برآورده ساختن  برای  به عنوان قدرت فوق العاده ای  رنگ و جلوه ها همان چيزی است كه طراحان گرافيک 
درخواست های مشتريان می شناسند. توانايی استفاده از رنگ و جلوه ها در واقع شما را از حركت بين برنامه های 
Swatches و  از پنل های  با استفاده  آثار هنری و محتوای خيره كننده نجات می دهد.  ايجاد  برای  مختلف 
Color می توانيد تمام رنگ های موجود در پروژه های خود را كنترل كنيد. البته، اين رنگ می تواند بر فريم ها، 
زمينه ها، متن ها، خطوط دور، گراديان ها،  هايلايت ها يا موارد ديگر اعمال شود. شما می توانيد چندين نمونه را 
به صورت دستی يا با استخراج رنگ از تصاوير قرار داده شده ايجاد كرده و در كتابخانه های CC خود ذخيره كنيد.

زمان آموزش

عملینظری

49
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RGB و CMYK 1ـ6 ـ مفهوم مدل های رنگ 

مقايسه روش های مختلف توليد رنگ برای مواد وب و چاپی مفيد است. دو نوع تركيب رنگ را در نظر بگيريد. 
رنگ افزودنی فرايند ايجاد رنگ با مخلوط كردن روشنی دو يا چند رنگ است. قرمز، سبز و آبی، رنگ های 
اصلی هستند كه در سيستم رنگ افزودنی برای نمايش رنگ ها در صفحه رايانه استفاده می شوند. هر چه 
شدت روشنی بيشتری اضافه  كنيد، رنگ حاصل روشن تر می شود. اين امر نشان می دهد كه چگونه رنگ ها 
در طراحی وب نمايش داده می شوند. رنگ افتراقی فرايند ايجاد رنگ با مخلوط جوهر دو يا چند رنگ است. 
جوهرها و يا رنگدانه های فيروزه ای، بنفش، زرد و سياه روی كاغذ لايه بندی می شوند. هرچه جوهر بيشتری 

اعمال كنيد، رنگ حاصل تيره تر می شود. اين توصيف نحوه چاپ رنگ است.
معمولاً اسناد چاپی را با استفاده از حالت رنگ CMYK، نه RGB ايجاد می كنيد. اما اگر عکس ها را در 
Pho toshop با استفاده از حالت رنگ RGB ويرايش كرده باشيد، تصاوير حاوی آرايه وسيع تری از مقادير 
رنگ نسبت به CMYK خواهند بود. همواره برای تأييد مطالب با ليتوگرافی خود تماس بگيريد. اگر ليتوگرافی 
از RGB پشتيبانی می كند، ممکن است توصيه هايی را برای تنظيم تصاوير قرار داده شده به RGB ارائه كند، 
زيرا تصاوير نقش بيتی با جزئيات رنگ بيشتری چاپ می شوند. هنگام پر كردن يک فضای توپر با رنگ سياه 
)مانند يک مستطيل پر از سياه(، از سياه تيره استفاده كنيد كه تركيبی از رنگ های CMYK است كه روی 
يکديگر قرار دارند. اين مقادير به طور معمول با C=60،وM=40،وY=40 و K=100 تنظيم می شوند، هرچند 

اين مقادير را می توان برای ايجاد يک رنگ گرم تر )قرمزتر( يا سردتر )آبی تر( تغيير داد. 
اگر فقط از K=100 استفاده كنيد، ناحيه سياه بزرگ به هنگام چاپ، به ويژه در مقايسه با رنگ های ديگر 
توليد شده در چندين فرايند مقادير رنگ، كمی خاكستری ديده می شود. برای مواردی كه در مطبوعات افست 
منتشر می شوند، از ليتوگرافی خود بخواهيد كه چه مقاديری را برای محصولات مشکی تيره توصيه می كند. 

برای چاپ ديجيتال مبتنی بر تونر، مشکی تيره لازم نيست.

2ـ6 ـ مفهوم پروفایل رنگ

سازوكاری كه سيستم مديريت رنگ )CMS( برای انجام كاليبراسيون از آن استفاده می كند، پروفايلی است 
كه شامل اطلاعات مربوط به مدل های رنگی و طيف های پشتيبانی شده توسط يک خالق خاص )مانند برنامه 
تصويرگری يا اسکنر(، صفحه نمايش و چاپگر است. InDesign ده ها پروفايل از پيش تعريف شده را شامل 
می شود. CMS از يک فضای رنگی مستقل از دستگاه برای تطبيق اين پروفايل ها با يکديگر استفاده می كند. 
فضای رنگی يک روش رياضی برای توصيف روابط بين رنگ ها است. با استفاده از يک مدل رنگی مستقل از 
دستگاه )استاندارد CIE XYZ كه توسط كميسيون بين المللی روشنايی تعريف شده است(، CMS می تواند 
طيف وسيعی از مدل های ديگر وابسته به دستگاه مانند RGB و ساير مدل ها را مقايسه كند. معنی اين امر 
اين است كه CMS می تواند رنگ های موجود در تصاوير وارد شده و رنگ های تعريف شده شما را بررسی 
كند، آن ها را با قابليت های مانيتور و چاپگر مقايسه كند و رنگ ها را برای نزديک ترين نمايشگر و چاپ ممکن 

تنظيم كند.
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3ـ6 ـ جوهرهای تركيبی

از نظر فنی   مبحث رنگ به طور كلی و موضوع رنگ در گرافيک رايانه ای و تصاوير ديجيتال به طور خاص، 
مبحثی پيچيده و مفصل است. پرداختن به تمام جوانب تکنيکی آن در اينجا عملی نيست. به ناچار در اين 

 بخش، تنها به آن مواردی اشاره خواهيم كرد كه برای هنرجويان از نظرِ كاربردی مفيد است.
رنگ موضعی جوهر ويژه از قبل تركيب شده است كه به جای جوهرهای پردازشی CMYK يا علاوه بر آن 
استفاده می شود. هر رنگ موضعی به پليت چاپ مخصوص خود در يک ماشين چاپ نياز دارد، بنابراين وقتی 
رنگ های كمی مشخص شده و دقت رنگ بسيار مهم است از رنگ موضعی استفاده می شود. جوهرهای رنگی 
موضعی می توانند رنگ های خارج از طيف رنگ های پردازشی را با دقت توليد كنند. با اين حال، شکل دقيق 
رنگ موضعی چاپی با تركيبی از مركب كه توسط چاپگر تجاری و كاغذی كه روی آن چاپ شده، تعيين 

می شود و نه با توجه به مقادير رنگی كه شما تعيين كرده ايد و يا با مديريت رنگ.
رنگ پردازشی با استفاده از تركيبی از چهار جوهر پردازشی استاندارد چاپ می شود: فيروزه ای، بنفش، زرد 
و سياه )CMYK(. از رنگ های پردازشی در مواقعی استفاده كنيد كه كار به تعداد زيادی رنگ نياز دارد و 

استفاده از جوهرهای موضعی جداگانه، گران يا غيرعملی خواهد بود، مانند چاپ عکس های رنگی.
مقادير  از  استفاده  با  را  پردازشی  رنگ های  بالا،  كيفيت  با  شده  چاپ  سند  يک  در  نتيجه  بهترين  برای    

CMYK چاپ شده در نمودارهای مرجع رنگ پردازشی، مانند موارد موجود در چاپگر تجاری، مشخص كنيد. 
  مقادير نهايی رنگ پردازشی، مقادير آن در CMYK است، بنابراين اگر با استفاده از RGB رنگ پردازشی 

را تعيين كنيد، هنگام چاپ، آن مقادير رنگ به CMYK تبديل می شوند. اين تبديل ها براساس تنظيمات 
مديريت رنگ و پروفايل سند شما متفاوت هستند.

  رنگ پردازشی را بر اساس شکل ظاهری آن روی مانيتور مشخص نکنيد، مگر اينکه مطمئن باشيد سيستم 

مديريت رنگ را به درستی تنظيم كرده ايد و محدوديت های آن را برای پيش نمايش رنگ درک نکرده ايد. 
  از به كارگيری رنگ های پردازشی در اسنادی كه برای مشاهده روی صفحه در نظر گرفته شده خودداری 

كنيد زيرا طيف رنگ CMYK نسبت به صفحه نمايش معمول كوچک تر است.
بعضی اوقات استفاده از مركب های پردازشی و موضعی در يک كار عملی است. به عنوان مثال، ممکن است 
از يک جوهر موضعی برای چاپ دقيق رنگ آرم شركت در همان صفحات گزارش سالانه استفاده كنيد كه 
در آن عکس ها با استفاده از رنگ پردازشی توليد می شوند. شما همچنين می توانيد از يک پليت چاپ رنگی 
برای استفاده از روغن جلا در نواحی كار رنگ پردازشی استفاده كنيد. در هر دو مورد، در كار چاپ شما از 

پنج جوهر استفاده می شود )چهار جوهر پردازشی و يک جوهر موضعی يا روغن جلا(. 
كلی،  به طور  می كند.  ايجاد  چاپ  برای  اضافی  موضعی  چاپی  پليت  می كنيد  ايجاد  كه  موضعی  رنگ  هر 
چاپگرهای تجاری يا كاری دو رنگ )با استفاده از سياه و يک رنگ( و يا چهار رنگ CMYK توليد می كنند، 
البته، با امکان افزودن يک يا چند رنگ موضعی. استفاده از رنگ های موضعی معمولاً هزينه چاپ را افزايش 

می دهد. بهتر است قبل از استفاده از رنگ های موضعی در يک سند، با چاپچی خود مشورت كنيد. 
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4ـ6 ـ شدت رنگ

ايجاد شدت رنگ )درصدی از رنگ اصلی( بسيار ساده است. رنگ مدنظر خودتان را در پنل Swatch انتخاب 
كرده و سپس روی فلش سمت راست فيلد Tint در بالای پنل كليک كنيد تا اسلايدری باز شود. اسلايدر را 
از 100 درصد به تعداد كمتری حركت دهيد تا شدتی از رنگ منتخب ايجاد شود. برای جلوگيری از افت اين 
شدت )به اين دليل كه ممکن است برای استفاده از رنگ اصلی مجدداً اسلايدر را به 100 درصد بکشيد(، بايد 
آن را به عنوان نمونه خاص خود ذخيره كنيد. هنگامی كه اسلايدر Tint در درصد موردنياز شما قرار گرفت، 
نمونه  به عنوان  را  Swatches كليک كرده و شدت رنگ جديد  پايين پنل  New Swatch در  روی آيکن 
رنگی كاملًا جديد و مجزا ذخيره كنيد. مشکل اينجا اين است كه اين نمونه از شدت رنگ به نمونه رنگ اصلی 
متصل است، بنابراين اگر رنگ نمونه اصلی را تغيير دهيد، شدت رنگ براساس آن رنگ جديد تنظيم خواهد 
شد و اگر رنگ اصلی را حذف كنيد، شدت رنگ نيز حذف خواهد شد. برای جلوگيری از چنين اتفاقی، روی 
نمونه شدت رنگ كليک راست كرده و New Color Swatch را انتخاب كنيد. مطمئن شويد كه همه موارد 
در كادر محاوره ای New Color Swatch خوب هستند و بعد روی OK كليک كنيد. اين امر موجب ايجاد 
نمونه رنگ مستقل جديدی با مقادير رنگ از شدت رنگ می شود، به اين معنی كه اگر نمونه اصلی را تغيير 

دهيد يا حذف كنيد، اين نمونه شدت رنگ مستقل تحت تأثير قرار نخواهد گرفت.

شکل 1ـ6 ـ شدت رنگ

5ـ6 ـ شيب رنگ

به  رفتن  با  قرار دهيد. می توانيد  يکديگر  كنار  را  آن ها  و  كنيد  باز  را   Gradient و   Swatches پنل های 
Window>Color>Gradient به پنل Gradient برويد يا روی ابزار Gradient Swatch در نوار ابزار 
به صورت  كنيد. شيب خطی  انتخاب  را   Radial يا   Linearو،Type بازشوی  منوی  از  كنيد.  كليک  دابل 
خطی از يک سمت به سمت ديگر شیء جابه جا می شود. شيب شعاعی از مركز شیء شروع شده و از تيره 
به روشن تبديل می شود يا برعکس شيب پيش فرض، سياه به سفيد است )ممکن است آخرين شيب ايجاد 
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شده خود را نيز ببينيد(. ولی می توانيد هر رنگ دلخواه خود را هم انتخاب كنيد. برای انجام آسان اين كار، 
روی نمونه شيب در پنل Gradient كليک كنيد تا توقف های رنگی در زير نوار شيب در پايين پنل فعال 
Swatches كليک كرده و آن را به يکی از توقف های  شود. سپس روی اولين رنگ انتخابی خود از پنل 
رنگی در پنل Gradient بکشيد. هنگامی كه آماده انداختن رنگ شديد، علامت + كوچکی را خواهيد ديد 
كه به  شما اجازه می  دهد كه از جايگزينی رنگ مطلع شويد. اگر آن را نديديد، بدان معنی است كه رنگ 

جديد را به محل های موجود اضافه كرده ايد. همين كار را برای رنگ دوم انجام دهيد.

هنگامی كه از شيب ها خاطر جمع تر شديد می توانيد بيش از دو رنگ را به نوار شيب اضافه كنيد.
توجه

 حالا می توانيد توقف های رنگ را در سراسر نوار شيب به صورت اسلايدی جابه جا كنيد تا تأثير تغيير 
شيب را ببينيد. هم چنين می توانيد برای جابه جا كردن رنگ ها روی آيکن Reverse كليک كنيد.

شکل 2ـ6 ـ شیب رنگ
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6ـ6 ـ اعمال شيب جدید بر شیء

كنيد.  اعمال  هر شيئی  بر  را  آن  به سادگی  می توانيد  حالا  كرديد،  ايجاد  را  قبل شيب جديدی  قسمت  در 
از  اعمال كنيد(  را  به محلی كه می خواهيد شيب  )بسته  را   Stroke يا   Fill و  انتخاب كرده  را  شیء خود 
نوار ابزار انتخاب كنيد و روی نمونه شيب رنگ در پنل Gradient كليک كنيد. آيا می خواهيد از اين شيب 
استفاده كنيد؟ با كليک راست روی نمونه در پنل Gradient و انتخاب Add to Swatches يا با  مجدداً 
كشيدن نمونه از پنل Gradient به پنل Swatches، آن را به پنل Swatch اضافه كنيد. هنگامی كه در پنل 
Swatches قرار گرفت، می توانيد با كليک روی آن و انتخاب آن، نامی به آن بدهيد و سپس مجدد روی آن 

كليک كنيد تا فيلد نام آن فعال شود.

استفاده از ميانبر صفحه كليد برای اعمال يک شيب
نکته

ما فقط شيب را بر يک شیء اعمال كرديم. حالا اجازه دهيد همان شيب را با انتخاب شيئی جديد، بر آن شیء 
اعمال كنيم. Fill يا Stroke را از نوار ابزار انتخاب كرده و كليد نقطه ).( را فشار دهيد. اين امر موجب اعمال 

شیء تنظيم شده جاری در پنل Gradient بر شیء منتخب می شود.

شکل 3ـ6 ـ اعمال شیب جدید بر شیء
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هدف رفتاري

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  جداول و تنظيمات آن را بسازد.

  نوشته هاي درون يک جدول را ويرايش كند.

  رنگ زمينه و خط دور را به خانه هاي جدول اضافه كند.

  سبک را در جدول به كار گيرد.

كليات

روش های متعددی برای دستيابی به گزينه های جدولی مختلف وجود دارد كه در اين واحدكار مورد بحث قرار 
می دهيم، بنابراين بر روش ها، منوها و پنل هايی تمركز خواهيم كرد كه بيشتر مورد استفاده قرار می گيرند. 
يکی از مزايای متعدد ايجاد جداول در InDesign اين است كه می توانيد به روش های متعددی، سبک ها را 
بر محتوای خود اعمال كنيد. كار با جداول در InDesign بسيار جالب است و به شما اجازه می دهد داده ها 
را از Excel هم وارد كنيد. اصولاً، هر داده جدولی كه در يک سند InDesign نياز داريد، می توانند وارد و 

سبک گذاری شوند.

زمان آموزش

عملینظری

410
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1ـ7ـ ایجاد جدول

همه ما يک جدول خوب را دوست داريم. در واقع، منوی كاملی در InDesign فقط برای جداول وجود دارد. 
 Table>Insert Table برای قرار دادن سريع يک جدول پايه با سبک بندی پيش فرض در سند خود، به
برويد. يک كادر محاوره ای به شما نشان داده می شود كه می توانيد تعداد ستون ها و رديف های موردنظر خود 
را انتخاب كنيد و اينکه آيا می خواهيد رديف های سرستون يا پانويس داشته باشيد يا خير. هم چنين فرصت 
بارگذاری شود.  با جدول  تا مکان نمای شما  OK كليک كنيد  داريد. روی  را  اعمال هرگونه سبک جدولی 
حالا جايی در سند خود كليک كنيد و جدول را قرار دهيد. به محض قرار گرفتن، می توانيد با كليک كردن 
و كشيدن هر يک از نقاط در فريم آن به سمت داخل يا بيرون، اندازه آن را تغيير دهيد. فونت پيش فرض 

هنگامی استفاده خواهد شد كه شروع به تايپ كردن در جدول می كنيد.

Create Table شکل 1ـ7ـ کادر محاوره ای

جدولی درون جدولی دیگر
شما حتی می توانيد جدولی را در خانه ای در يک جدول ايجاد كنيد. كافی است درون خانه ای كليک 

كرده و سپس به Table>Insert Table برويد، ابعاد خود را انتخاب كرده و روی OK كليک كنيد.

نکته

2ـ7ـ اضافه كردن جدول در یک فریم متنی

و  ستون ها  تعداد  برويد.   Table>Insert Table به  سپس  و  كنيد  رسم  خود  صفحه  در  متنی  فريم  يک 
پانويس داشته  يا  آيا می خواهيد رديف های سرستون  سطرهای موردنظر خود را وارد كنيد، مشخص كنيد 
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باشيد يا خير و روی OK كليک كنيد. جدول به طور خودكار خودش را به فريم متنی اضافه می كند. در مثال 
 1pt شکل 2ـ7، رنگ خط دور سرخابی را به فريم متنی می دهيم تا برجسته شود و جدول دارای خط دور

مشکی پيش فرض است كه می توان آن را پس از قرار گرفتن در فريم متنی تغيير داد.

شکل 2ـ7ـ کادر محاوره ای Insert Table و افزودن جدول 

3ـ7ـ تبدیل متن به جدول

ممکن است هم اكنون مقداری متن به شکلی داشته باشيد كه ما به آن »متن جدا شده با Tab« يا »متن جدا 
شده با ويرگول« می گوييم و اغلب در فايلی با نوع CSV ذخيره شده است. اين مورد زمانی اتفاق می افتد كه 
ستون هايی از داده ها داريد كه با كاراكترهای Tab يا ويرگول از هم جدا شده باشند و رديف های داده ای كه 
با نشانه پاراگراف جدا شده اند. اين متن را در يک فريم متنی الصاق كرده و سپس كل متن را متمايز كنيد. 
به Table>Convert Text to Table برويد و از منوی Column Seperator برای مشخص كردن  اينکه 
داده های ستونی شما با Tab، ويرگول يا نشانه های پاراگراف جدا شده اند، استفاده كنيد. سپس، مشخص كنيد 
كه آيا داده های رديفی شما در يک جدول پايه آشفته سازمان دهی شود )مگر اينکه بخواهيد از سبک جدولی 
خاص استفاده كنيد كه می توانيد از اين كادر محاوره ای قبل از كليک كردن OK استفاده كنيد(. در مثال 

شکل 3ـ7، داده های ستونی من با ويرگول و داده های رديفی من با نشانه های پاراگراف از هم جدا شده اند.
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شکل 3ـ7ـ تبدیل متن به جدول

4ـ7ـ اعمال كردن رنگ زمينه به یک خانه

اجازه دهيد تعدادی از خانه ها را رنگی كنيم. به عنوان مثال، از روش بسيار پايه ای برای ايجاد يک خانه رنگی 
واحد استفاده خواهيم كرد. خانه مدنظر برای افزودن رنگ را متمايز كنيد و به هر پنلی برويد كه نمونه رنگی 
آنجا پيدا می شود )من علاقه دارم از پنل Swatches استفاده كنم، ولی شما می توانيد رنگی را به خانه از 
Control Panel، پنل Properties يا نوار ابزار اعمال كنيد(. مطمئن شويد كه Fill را تنظيم می كنيد )آيکن 
مربع كوچک(، نه Type )آيکن T كوچک(، رنگ خود را انتخاب كنيد و خانه واحدی را رنگی كنيد. اين يک 
روش سريع و واقعاً پايه ای برای اعمال رنگ بر خانه است. سپس، نحوه افزودن يک زمينه رنگی به چندين 

خانه را بررسی كنيد.

Swatches شکل 4ـ7ـ اعمال رنگ زمینه به یک خانه از طریق پنل
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5ـ7ـ ویرایش خط دور و زمينه خانه های جدول

يک  طريق  از  را  جدول  خانه  زمينه های  و  دور  خطوط  می توان  چگونه  كه  كنيم  بررسی  دهيد  اجازه 
و  كنيد  انتخاب  تغيير،  برای  را  نظر خود  مورد  خانه های  كرد.  ويرايش  به سرعت  واحد  محاوره ای  كادر 
Table>Cell Options>Strokes and Fills برويد. در كادر محاوره ای كه باز می شود، می توانيد  به 
تغييراتی در جدول خود بدهيد. در اين كادر محاوره ای می توانيد ضخامت خط دور، رنگ خط دور، رنگ 

تنظيم كنيد. را  موارد ديگری  و  نوع خط  زمينه، 

Cell Options شکل 5ـ7ـ کادر محاوره ای

6 ـ7ـ ایجاد سبک جدول پایه

اگر قصد داريد چندين جدول را با فرمت بندی يکسان در سند خود قرار دهيد و نمی خواهيد در هر بار و 
برای هر جدول وقتی را صرف فرمت بندی كنيد، كافی است يک سبک جدول را ايجاد كنيد. در اين روش 
می توانيد هنگام ايجاد جدول جديد، سبکی را انتخاب كنيد تا فرمت بندی صحيح به طور خودكار اعمال شود. 
برای ايجاد يک سبک جدول جديد، به Window>Styles>Table Styles برويد تا پنل Table Styles باز 
 New را انتخاب كنيد. در كادر محاوره ای New Table Style شود. سپس، روی منوی پنل كليک كرده و
Table Style، می توانيد گزينه های فرمت بندی موردنياز را اضافه كنيد. روی برگه های سمت چپ پنل كليک 
كنيد تا به انواع گزينه ها دسترسی پيدا كنيد: General )سبک های خانه ای كه ممکن است هم اكنون داشته 
 Column Strokes شامل الگوهای خط دور رديف(؛( Row Strokes ؛)حاشيه ها( Table Setup ؛)باشيد
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)شامل الگوهای خط دور ستون(؛ و Fills )شامل نيازمندی های رنگ(. هنگامی كه فرمت بندی دلخواه خود را 
تنظيم كرديد، نامی به سبک داده و روی OK كليک كنيد. حالا سبک در پنل Table Styles در دسترس 
خواهد بود. می توانيد با انتخاب جدول و كليک كردن روی نام سبک در پنل Table Styles، آن سبک را بر 
 Table جدول موجود اعمال كنيد. يا اگر جدول جديدی را ايجاد می كنيد، می توانيد سبک را از منوی بازشوی

Styles در كادر محاوره ای Create Table انتخاب كنيد.

شکل 6ـ7ـ دادن سبک به جدول
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هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  نحوه ايجاد يک فايل Interactive را بداند.

  Hyperlink را به كارگيرد.

  Animation را به كارگيرد.

  Transition را به كارگيرد.

  دكمه و فرم را بسازد.

  از فايل های Interactive خروجی بگيرد.

كلیات

اگر در اينترنت چرخی زده باشيد، قطعاً مفهوم  هايپرلينک ها را می دانيد. هر بار كه روی يک تگ a )مربوط به 
يک دكمه يا متن( كليک كرده ايد، به مکان جديد فرستاده شده ايد و يک مقصد  هايپرلينک را تجربه كرده ايد.  
هايپرلينک ها دارای دو بخش هستند: منبع و مقصد. در InDesign، منبع شما می تواند متن، فريم متنی، 
تصوير، شیء، عناصر تعاملی و فريم های شیء باشند. مقصد برای  هايپرلينک ها می تواند يک URL، اجرای يک 
برنامه ايميل پيش فرض، صفحه ای در يک سند، لنگری موجود در يک سند و لينک هايی به اسناد داخلی باشد.

همانگونه كه می بينيد، برای  هايپرلينک های InDesign كارهای بيشتری بايد غير از باز كردن صفحات وب 
انجام دهيد. در اين واحدكار، بررسی می كنيم چگونه  هايپرلينک ها از منابع مختلف ايجاد می شوند و چگونه 

آن ها را برای مقاصد مختلف تنظيم كنيم.

زمان آموزش

عملینظری

410
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همانگونه كه در ادامه بحث خواهيم كرد، هنگام صدور اسناد PDF تعاملی، بايد از ايجاد  هايپرلينک ها 
 Acrobat از ابزارهای ،PDF خودداری كنيم. برای ايجاد تمام  هايپرلينک ها در فايل های InDesign در

استفاده می شود.

نکته

1ـ8 ـ شناخت برخی از اصول  هایپرلینک ها

 هايپرلينک های InDesign می توانند به URLها، فايل های خارجی، كلاينت های ايميل، صفحات در يک 
سند، لنگرهای متنی و مقاصد مشترک لينک شوند. مقصد مشترک دو يا چند منبع را به اشتراک می گذارد. 
هنگامی كه مقاصد به اشتراک گذاشته می شوند، در سلسله مرتبه ای در پنل Hyperlinks ظاهر و در يک 
پوشه تودرتو می شوند. در صورت عدم اشتراک گذاری، هر مقصدی به طور مجزا در اين پنل فهرست می شود.

 Hyperlinks 1ـ1ـ8 ـ آشنایی با پنل 
همه  هايپرلينک ها در سند InDesign شما در پنل Hyperlinks ظاهر می شوند، همانگونه كه در شکل 1ـ8 
نشان داده شده است. برای باز كردن اين پنل، Window>Interactive>Hyperlinks را انتخاب كنيد. اين 

پنل شامل تعدادی گزينه برای كار كردن با  هايپرلينک هاست.
  URL: دو آيکن كنار يکديگر را در سمت راست Name می بينيد. اولی، آيکن Page است. هر  هايپرلينک 

در اين پنل با يک آيکن نشان دهنده نوع  هايپرلينک قرار دارد. در كنار اين آيکن، عددی است كه متناظر با 
شماره صفحه ای است كه  هايپرلينک وجود دارد. اگر روی اين شماره كليک كنيد، InDesign به آن صفحه 

می پرد و منبع را انتخاب می كند.
  هر  هايپرلينک دارای كد رنگی نيز هست. يک دايره سبز رنگ نشان می دهد كه URL معتبر است. يک 

دايره قرمز نشان می دهد كه URL نامعتبر است. كليک كردن روی آيکن های معتبر شما را به مقاصد می برد.

شکل 1ـ8 ـ برای باز کردن پنل Hyperlinks،وWindow>Interactive>Hyperlinks را انتخاب کنید.
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  Refresh URL Status: كليک كردن روی اين دكمه موجب نوسازی اين فهرست می شود.

  Create new hyperlink: چيزی كه بايد در سند برای اين آيکن انتخاب كنيد تا فعال شود. هنگامی كه 

متن يا يک شیء انتخاب شد، برای ايجاد  هايپرلينک جديد، روی اين آيکن كليک كنيد.
در  برای حذف  خود  موردنظر  هايپرلينک  روی   هايپرلينک،  يک   كردن  برای حذف  زباله:  آیکن سطل    

فهرست Name كليک كرده و روی آيکن Trash كليک كنيد.
پنل Hyperlinks تعداد جامعی فرمان منو دارد، همان گونه كه در شکل 2ـ8 نشان داده شده است. برای 
باز كردن اين منو، روی گوشه سمت راست بالا در پنل Hyperlinks كليک كنيد. اين منو باز می شود و 

گزينه های ذيل در اختيار شما قرار می گيرند:
  New Hyperlink: برای ايجاد  هايپرلينک جديد، روی اين آيتم منو كليک كنيد. رفتار آن، شبيه كليک كردن 

روی آيکن Create new hyperlink در پايين پنل Hyperlinks است.
  New Hyperlink from URL: اگر يک URL را در متنی در سند انتخاب كنيد، كليک كردن روی 

اين آيتم منو موجب ايجاد  هايپرلينک جديدی به URL می شود.
  Convert URLs to Hyperlinks: از اين آيتم با احتياط استفاده كنيد. InDesign بين URLهای 

ايجاد   URL يک   InDesign داريد،   realize.It مثل  متنی  اگر  نمی شود.  قائل  تمايزی  غيرمعتبر  و  معتبر 
 URL ، InDesign خواهد كرد. هر متنی كه فاصله بين انتهای جمله با نقطه و كلمه بعدی وجود نداشته باشد، در

در نظر گرفته می شود.

شکل 2ـ8 ـ برای دستیابی به گزینه های  هایپرلینک، منوی پنل Hyperlinks را باز کنید.

  Delete Hyperlink: نتيجه استفاده از اين فرمان با استفاده از آيکن Trash در پنل Hyperlinks يکی است.

  New Hyperlink Destination: روی اين آيتم منو كليک كنيد. يک كادر محاوره ای باز می شود كه 

می توانيد مقصدی را برای صفحه، لنگر متن يا URL انتخاب كنيد.
  Edit Hyperlink:  هايپرلينکی در پنل Hyperlinks انتخاب كنيد و روی اين آيتم منو كليک كنيد تا 
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كادر محاوره ای Edit Hyperlink باز شود. در كادر محاوره ای Edit Hyperlink، می توانيد يک URL را 
ويرايش كنيد يا مقصد را تغيير دهيد، سبک های كاراكتر را انتخاب كنيد و گزينه های PDF را ويرايش كنيد.  
 Hyperlink روی اين آيتم منو كليک كنيد تا كادر محاوره ای :Hyperlinks Destination Options  

Destination Options باز شود. در بين تغييرات ديگر، می توانيد نام  هايپرلينک را تغيير دهيد )توجه داشته 
باشيد كه می توانيد نام  هايپرلينک را با كليک كردن روی نام، لحظه ای درنگ، كليک كردن مجدد و سپس 
تايپ كردن متن جديد برای نام در پنل Hyperlinks تغيير دهيد(. نام  هايپرلينک ها هيچ تأثيری بر مقصدها 
ندارد. ممکن است هنگام كار كردن و افزودن نام های توصيفی تر برای آنچه كه  هايپرلينک انجام می دهد، نام  

هايپرلينک ها را تغيير دهيد.
  Delete Unused Destinations: هنگامی كه كارتان به پايان رسيد و آماده انتشار شديد، استفاده از اين 

فرمان عادت خوبی است. InDesign تمام مقاصد استفاده نشده در سند را حذف می كند.
Hyper� اين گزينه شبيه كليک كردن روی عدد سمت راست نام  هايپرلينک ها در پنل :Go to Source  

links است. هنگامی كه اين فرمان را انتخاب می كنيد، InDesign به صفحه ای می پرد كه منبع پيدا می شود 
و منبع را انتخاب می كند.

  Go to Destination: كليک كردن روی اين فرمان موجب احضار اقدام  هايپرلينک می شود. اگر  هايپرلينک 

يک URL باشد، URL در مرورگر وب پيش فرض شما باز می شود. اگر مقصد صفحه باشد، InDesign به 
صفحه مقصد می پرد و الی آخر.

  Rename Hyperlink: اين گزينه كمی اضافی است، زيرا شما دو روش برای تغيير نام  هايپرلينک ها 

داريد. هنگامی كه روی آيتم منو كليک می كنيد، كادر محاروه ای ساده ای باز می شود كه می توانيد نام جديد 
را در آن تايپ كنيد. 

  Reset Hyperlink: فرض كنيد كه  هايپرلينکی داريد كه منبع آن مقداری متن است. منبع جديد را 

انتخاب كرده و سپس  هايپرلينک را در پنل Hyperlinks برگزيده و Reset Hyperlink را انتخاب كنيد. 
منبع جديد از مقصد  هايپرلينکی استفاده می كند كه از منبع اصلی توليد شده است.

  Update Hyperlink: از اين آيتم منو هنگامی استفاده كنيد كه به اسناد خارجی لينک می دهيد )چيزی 

مثل يک فايل PDF(. اگر نام يا مکان فايل را تغيير داده ايد،  هايپرلينک را در پنل Hyperlinks انتخاب كرده 
و روی Update Hyperlink كليک كنيد.

اگر  البته،  كنيد.  جابه جا   Hyperlinks پنل  در  را  هايپرلينک ها  نمی توانيد   پيش فرض،  به طور   :Sort   

Sort>Manually را در منو انتخاب كنيد، می توانيد با كشيدن ماوس، آيتم ها را در اين ليست بالا و پايين 
نام   برحسب  را  ليست  می توانيد  كه  By Type هستند  و   By Name مرتب سازی  ديگر  گزينه های  كنيد. 

هايپرلينک ها يا برحسب نوع مقصد مرتب سازی كنيد.
می شود،  ليست كوچک تر  در  نوع  می كنيد،  انتخاب  را  فرمان  اين  كه  هنگامی   :Small Panel Rows   

بنابراين می توانيد ليست بلندتری را در پنل ببينيد.
  Auto Update URL Status: به طور پيش فرض، اين آيتم انتخاب نشده است. اگر به صورت آنلاين كار 

می كنيد، ممکن است اين آيتم را از حالت انتخاب خارج كرده باشيد و سپس به هنگام آنلاين شدن آن را فعال 
كنيد. InDesign وضعيت URL را به طور خودكار هنگام فعال شدن به روزرسانی می كند و بازخورد بی درنگی 

را در مورد URLهای معتبر و غيرمعتبر می دهد.
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 2ـ1ـ8 ـ استفاده از سبک های  هایپرلینک 
هنگام ايجاد اولين  هايپرلينک خود در يک سند InDesign، ممکن است بلافاصله از آن مطلع نشويد، ولی 

InDesign يک Character Style را برای شما ايجاد می كند.
پنل Character Styles را باز كنيد (Window>Style>Character Styles). پنل Character Style باز 
 Character Style در پنل Hyperlink می شود. اگر بخواهيد ويژگی ها را برای سبک تغيير دهيد، روی سبک
 Character Style نام Hyperlink ،را انتخاب كنيد )كه در اين مورد Edit Hyperlink كليک راست كرده و
است(. كادر محاوره ای Character Style Options باز می شود، همان گونه كه در شکل 3ـ8 نشان داده شده 
است كه می توانيد از طريق اين كادر محاوره ای، فونت، اندازه فونت، Leading، رنگ متن و غيره را تغيير دهيد.

شکل 3ـ8 ـ هنگام ایجاد اولین  هایپرلینک خود، InDesign به طور خودکار یک Character Style ایجاد می کند.

 3ـ1ـ8 ـ ویرایش  هایپرلینک ها
كنيد،   ويرايش   PDF ظاهر  يا  كاراكتر  سبک   ،URL مقصد،  دادن  تغيير  برای  را  هايپرلينک  بخواهيد   اگر 
 Hyperlinks پنل  منوی  در  را   Edit Hyperlink و  كرده  انتخاب   Hyperlinks پنل  در  را  هايپرلينک 
برگزينيد. كادر محاوره ای Edit Hyperlink باز می شود، همان گونه كه در شکل 4ـ8 نشان داده شده است.

برای  انتخابی  باشيد، كادر  به دنبال آن   Edit Hyperlink يک چيزی كه ممکن است در كادر محاوره ای 
Shared Hyperlink Destination است. اگر اين كادر در حالت تأييد نباشد و شما فهرستی طولانی از  
هايپرلينک هايی داشته باشيد كه همگی از مقصد يکسانی استفاده می كنند، ممکن است بخواهيد آن ها را 
 Hyperlinks ويرايش كنيد و اين كادر انتخاب را در حالت تأييد قرار دهيد.  هايپرلينک ها در پوشه ای در پنل
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تودرتو می شوند و چنانچه سند شما حاوی  هايپرلينک های بسيار متفاوتی باشد، مديريت آن ها آسان تر می شود.

شکل 4ـ8 ـ روی Edit Hyperlink در منوی پنل Hyperlinks کلیک کنید.

 4ـ1ـ8 ـ ویرایش های مقصدهای  هایپرلینک
محاوره ای  كادر  تا  كنيد  كليک   Hyperlinks پنل  منوی  در   Hyperlink Destination Options روی 
Hyperlink Destination Options باز شود. هنگامی كه مقصدهای جديدی را اضافه می كنيد، آن ها به طور 

پويا به منو اضافه می شوند.

شکل 5ـ8 ـ روی Hyperlink Destination Options در منوی پنل Hyperlinks کلیک کنید.

در اين كادر محاوره ای، می توانيد نوع مقصد را تغيير دهيد، نام  هايپرلينک را تغيير دهيد و URL را تغيير 
دهيد، البته چنانچه مقصد URL باشد.
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2ـ8 ـ لینک شدن به URLها

همانگونه كه می بينيد، InDesign مجموعه بسيار گسترده ای از ويژگی ها و فرامينی را به شما ارائه می دهد 
كه با  هايپرلينک ها كار می كنند. حالا كه با كادر های محاوره ای و پنل Hyperlinks آشنا شده ايد، وقت آن 

است كه  هايپرلينک هايی در سند ايجاد كنيد.

 1ـ2ـ8 ـ ایجاد  هایپرلینک
برای ايجاد  هايپرلينکی كه يک URL را باز می كند، اين موارد را انجام دهيد:

1 مقداری متن، يک شیء يا تصويری را انتخاب كنيد يا با ماوس بکشيد تا يک Rectangle Frame باز شود. 
در مثال من، مقداری متن را انتخاب كرده ام، همانگونه كه در شکل 6ـ8 نشان داده شده است. اگر چند فريم 

.)Ctrl+G( متنی داريد و می خواهيد از آن ها استفاده كنيد، آن ها را انتخاب و گروه بندی كنيد

Hyperlinks شکل 6ـ8 ـ انتخاب متن یا تعدادی فریم متنی گروه بندی شده و باز کردن پنل

 Create new hyperlink را باز كنيد. روی آيکن Hyperlinks 2 اقلام گروه بندی شده را انتخاب كرده و پنل
كليک كنيد. URL ای را برای  هايپرلينک در كادر متنی URL اضافه كرده و Enter را فشار دهيد.

3  پنل Hyperlinks را امتحان كنيد. به هنگام تايپ اشتباه URL،وInDesign با تغيير دادن آيکن دايره ای 
به رنگ قرمز، گزارش URL را به شما برمی گرداند. مطمئن شويد كه دايره سبز رنگ باشد.

4 نام  هايپرلينک را تغيير دهيد. به طور پيش فرض، نام  هايپرلينک از آدرس URL مشتق می شود. اگر يک 
URL طولانی داريد، ممکن است بهتر باشد نام آن را به نامی توصيفی تر تغيير دهيد. يک بار روی نام در 
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پنل Hyperlinks كليک كنيد، لحظه ای درنگ كرده و مجدداً كليک كنيد. هنگامی كه متن انتخاب شد، نام 
جديدی تايپ كنيد. به  روش ديگر، می توانيد Rename Hyperlink را در پنل Hyperlinks انتخاب كنيد.

5 مقصد لينک را بررسی كنيد. روی دايره سبز رنگ در پنل Hyperlinks كليک كنيد. اگر URL شما را 
به جايی برد كه انتظار داريد، URL درست كار می كند. اگر نتيجه غيرمنتظره ای دريافت كرديد، URL را در 

پنل Hyperlinks بازبينی كنيد.

3ـ8 ـ لینک شدن به كلاینت های ایمیل

ايجاد می شود.  ايميل پيش فرض شما  پيام جديدی در كلاينت  ايميل،  به يک كلاينت  لينک شدن  هنگام 
Hyper�  می توانيد آدرس ايميل مقصد، موضوع و حتی محتويات ايميل را كنترل كنيد. هر چيزی در پنل

links شروع می شود كه  هايپرلينک جديدی را به يک آدرس ايميل ايجاد می كند.
ممکن است سندی داشته باشيد كه بخواهيد از خوانندگان درباره محتوا بازخورد بگيريد، بخواهيد اطلاعات 
اضافی را به اشتراک بگذاريد كه در لينک يک فايل ظاهر می شوند يا روش ديگری برای برقراری ارتباط با 
خوانندگان خود داشته باشيد. ايجاد يک  هايپرلينک ايميل، نسبتاً آسان است. هنگامی كه مجبوريد يک خط 

طولانی متن را در كادر متنی Hyperlink وارد كنيد، كارها كمی پيچيده تر می شود.

 1ـ3ـ8 ـ ایجاد یک  هایپرلینک ایمیل
برای شروع، ابتدا ايجاد  هايپرلينک ايميل نسبتاً ساده را بخوانيد. 

ایجاد یک  هایپرلینک ایمیل
برای ايجاد اولين  هايپرلينک ايميل خود، اين مراحل را دنبال كنيد:

1 يک شیء، متن يا آيتم ديگری را در سند انتخاب كرده و روی آيکن Create new hyperlink در پنل 
Hyperlinks كليک كنيد. كادر محاوره ای New Hyperlink باز می شود.

Email 2 را از منوی Link To انتخاب كنيد. يک آدرس ايميل معتبر را در فيلد Address تايپ كنيد. 
موضوع را تايپ كنيد )اختياری(، همان گونه كه در شکل 7ـ8 نشان داده شده است. روی OK كليک كنيد.

شکل 7ـ8 ـ Email را از منوی Link To انتخاب کنید.
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3 به URL در پنل Hyperlinks توجه كنيد. مقداری كد در آدرس ايميل می بينيد )شکل 8ـ8 را ببينيد(.

شکل 8ـ8 ـ پنل Hyperlinks بعد از افزودن لینک

4 برای امتحان كردن آدرس، روی تصوير ايميل در پنل Hyperlinks كليک كنيد. بايد پنجره پيام جديدی 
را ببينيد كه در كلاينت ايميل پيش فرض شما باز می شود. اگر همه چيز درست كار كند، وظيفه لينک ايميل 

را كامل كرده ايد.
اين لينک ايميل وظيفه ساده ای است. برای بررسی گزينه های بيشتر با لينک های ايميل، می توانيد توضيحی را در 
فيلد پيام اضافه كنيد، لينکی را به فايلی خارجی ايجاد كنيد و آن را به نام URL در پنل Hyperlinks اضافه كنيد.

 2ـ3ـ8 ـ ایجاد یک  هایپرلینک ایمیل با پیام
يک خط برای تايپ كردن يک لينک URL در InDesign خيلی كوچک است و هيچ راهکاری برای افزودن 
اطلاعات URL نيست. حتی كادرهای محاوره ای كه به شما اجازه ويرايش URL را می دهند فقط دارای يک 
خط واحد برای يک كادر متنی هستند. اگر يک URL طولانی داشته باشيد و نياز به ويرايش اطلاعات داشته 
 URL ايجاد كنيد و آن را در خط متنی InDesign pasteboard باشيد، ايده بدی نيست كه متنی را در

كپی و الصاق كنيد.
در شکل 9ـ8، متنی را در InDesign pasteboard می بينيد. اين متن حاوی  هايپرلينکی است كه يک سند 
PDF می تواند از طريق آن دانلود شود. تعدادی بازگشت به ابتدای خط برای كمک به سهولت خواندن و 
مفهوم تر كردن آن اضافه كرده ايم. پس از نوشتن كد، بايد بازگشت ها به ابتدای خط را حذف كنيد و سپس 

نتيجه را در يک خط متن واحد داشته باشيد.

شکل 9ـ8 ـ اطلاعاتی را برای محتوای ایمیل در InDesign Pasteboard تایپ کنید.
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هنوز كار انجام نشده است. بايد تمام فاصله ها را حذف كنيد و بايد آن ها را با 20 درصد جايگزين كنيد. ممکن است 
آدرس های وب را ديده باشيد كه شبيه اين به نظر می رسند، زيرا فاصله ها در خطوط آدرس URL مجاز نيستند.

 URL مجاز نيستند. 20 درصد يک مقدار رمزگذاری شده برای فاصله در يک رشته URL فاصله ها در خطوط
است.

توجه

Keith Gilbert یک مؤلف، سخنران همایش و مشاور حرفه ای در InDesign و Adobe DPS است. 
نشر دیجیتال  درباره  ارزشمندی  اطلاعات  میزبان   (www.gilbertconsulting.com) او  وب سایت 
 Digital( است که او نوشته است. دو مجموعه از اسکریپت های او InDesign و اسکریپت های عالی
Publishing pack 1 و Digital Publishing pack 2( ابزارهایی عالی برای کار کردن با DPS و 

نشریات دیجیتال هستند و اکیداً توصیه می کنم نگاهی به آن ها بیندازید.

توجه

به جای انجام دستی اين كار، می توانيد از اسکريپتی برای انجام اين فرمت بندی استفاده كنيد. اين اسکريپت از 
Keith Gilbert در آدرس www.gilbertconsulting.com وجود دارد. من اسکريپت Keith را بارگذاری 

كرده و آن را در متن در pasteboard اجرا كرده ام. نتيجه در شکل 10ـ8 نشان داده شده است.

شکل 10ـ8 ـ بعد از اجرای اسکریپت Replace Spaces With Entity از Keith Gilbert، تمام فاصله ها با کد مناسب 
جایگزین می شوند.

پس از اجرای اين اسکريپت، متن را كپی كرده و آن را در فيلد متنی URL الصاق كنيد.

4ـ8 ـ لینک شدن به صفحات

ممکن است بخواهيد مراجع متقابلی را در يک فايل برای خوانندگان ايجاد كنيد تا خواندن محتوای مربوط به 
موضوعی معين را شاخه بندی كنيد يا صفحه محتوياتی را ايجاد كنيد كه به فصل ها لينک هستند.

لينک شدن به صفحات با استفاده از پنل Hyperlinks ساده است:
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1 برای لينک شدن به صفحه ای در يک سند، پنل Hyperlinks را باز كرده و منبعی را انتخاب كنيد. اين منبع 
می تواند متن يا گرافيک باشد. روی دكمه Create new hyperlink در پنل Hyperlinks كليک كنيد. كادر 

محاوره ای New Hyperlink Destination باز می شود، همان گونه كه در شکل 11ـ8 نشان داده شده است.

شکل 11ـ8 ـ انتخاب Page و گزینش شماره صفحه

Page 2 را در منوی Link To انتخاب كرده و شماره صفحه را در منوی Page برگزينيد. تمام صفحات سند 
شما در اين منو فهرست می شوند. برای ايجاد  هايپرلينک، روی OK كليک كنيد.

نوع ديگری از پيمايش صفحه، به لنگرها لينک می شود.

 1ـ4ـ8 ـ لینک شدن به لنگرها
برای لينک شدن به لنگرها، اين موارد را انجام دهيد:

Page 1 را در منوی Link To انتخاب كرده و شماره صفحه را در منوی Page برگزينيد. تمام صفحات سند 
شما در اين منو فهرست می شوند. برای ايجاد  هايپرلينک، روی OK كليک كنيد.

انتخاب كنيد. كادر محاوره ای  باز كرده و New Hyperlink Distenation را  2 منوی Hyperlinks را 
New Hyperlink Destionation باز می شود.

Text Anchor  3 را از منوی Type انتخاب كرده و نامی را برای متن لنگر تايپ كنيد )شکل 12ـ8 را 
لنگرهای  برای  است.  آخر  الی  و   Anchor3و،Anchor2 آن  از  پس  و   Anchor1 پيش فرض  نام  ببينيد(. 
اضافی، به سند اضافه كنيد. بهتر است نامی توصيفی به لنگر بدهيد، به ويژه هنگامی كه لنگرهای متعددی در 

سند خود داريد.
تاكنون مقصد را ايجاد كرده ايم، ولی هنوز منبع را مشخص نکرده ايم.

4 فريمی را ايجاد كنيد، شيئی را انتخاب كرده يا متنی را برای منبع برگزينيد. 
5 در پنل Hyperlinks، روی دكمه Create new hyperlink كليک كنيد.

6 هنگامی كه كادر محاوره ای Create new hyperlink باز می شود، Anchor را در منوی Link To انتخاب 
كرده و نام لنگر را در منوی Text Anchor برگزينيد.
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شکل 12ـ8 ـ ایجاد یک لنگر به عنوان مقصد، روی مکان نما کلیک کنید یا متنی را انتخاب کنید یا Text Anchor را در کادر 
محاوره ای New Hyperlink Destination برگزینید.

هنگامی كه هايپرلينکی به لنگر متن ايجاد كرديد، آن هايپرلينک در پنل Hyperlinks با نماد لنگری نمايش 
داده می شود. می توانيد با كليک كردن روی نماد لنگر در پنل Hyperlinks، هايپرلينک را به سادگی امتحان 

كنيد. اگر اين لينک را به درستی تنظيم كرده باشيد، InDesign به صفحه ای می پرد كه مقصد را می يابد.

 5ـ8 ـ كار كردن با انیمیشن

Adobe InDesign ابزار انيميشن نيست. شما می توانيد فرصت های بسيار بيشتری را برای ايجاد انيميشن ها 
با Adobe Animate CC و Adobe After Effects بيابيد. به هر حال، شما مجموعه جذابی از ويژگی ها را 

در Adobe InDesign خواهيد داشت كه به شما امکان ايجاد انواع انيميشن ها را می دهد.
انيميشن ها از InDesign می توانند به EPUBهای چيدمان ثابت، PDFهای تعاملی )با يک راه حل ـ ولی 
فقط در رايانه های روميزی( و Adobe Publish Online صادر شوند. انيميشن ها در EPUBهای جريان پذير 

مجدد و اسناد DPS/AEMM پشتيبانی نمی شوند.
در اين بخش، ايجاد انيميشن ها را بررسی می كنيم و آن ها را برای پخش در اسنادی كه از انيميشن پشتيبانی 
از  استفاده  سرعت،  و  زمان  مدت  تنظيم  انيميشن،  پيش تنظيمات  از  استفاده  می كنيم.  تنظيم  می كنند، 
مسيرهای متحرک و استفاده از انيميشن ها را با اشيای چند حالته بررسی می كنيم. هم چنين تعدادی ايده 

پروژه را ارائه می دهيم و شما را در گام های لازم برای ايجاد طراحی های مشابه هدايت می كنيم.

Animation 1ـ5ـ8 ـ شناخت پنل 
در واقع، شما هنگام ايجاد انيميشن های InDesign دو پنل برای استفاده داريد: پنل Animation و پنل 

Timing. در اين بخش، درباره استفاده از پنل Animation صحبت می كنيم.
هنگامی كه روی متحرک سازی متن و اشيا در InDesign كار می كنيد، بايد هر دو پنل را باز كنيد. آن ها 
برای كمک به شما در توليد انيميشن هايی به كار می روند كه به اسناد خود اضافه می كنيد. هم چنين از پنل 
Layers به دفعات استفاده می كنيد، بنابراين بهتر است محيط كاری خود را طوری تنظيم كنيد كه بتوانيد 

به راحتی بين اين سه پنل حركت كنيد.
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 2ـ5ـ8 ـ استفاده از پیش تنظیمات انیمیشین
سند جديدی در InDesign و يک شیء )مستطيل، بيضی يا چند ضلعی( ايجاد كنيد. شیء را انتخاب كرده و 
پنل Animation را باز كنيد، همان گونه كه در شکل 13 ـ 8 نشان داده شده است. پنل Animation حاوی 
هستند:  اين ها  شامل  كه  می كنند  كنترل  را  انيميشن  پايه  تنظيم  پنج  كه  است  پيش تنظيم   48
پنل،  اين  در   .Opacity و   Scaleو،Rotationو،Easing )speed and duration(و،Motion Paths

از: عبارت اند  شما  انتخاب  داريد.  انيميشن ها  برای  صفات  تنظيم  برای  متعددی  انتخاب های 

شکل 13ـ8 ـ شیئی را در پنجره سند انتخاب کرده و پنل Animation را باز کنید.

A. منوی پنل Animation: روی آيکن موجود در گوشه سمت راست بالای پنل كليک كنيد تا منويی باز 
شود. در بالا، Save را پيدا كنيد. پس از انتخاب گزينه های مختلف در اين پنل، می توانيد تنظيمات خود را 

به عنوان يک پيش تنظيم ذخيره كنيد.
B. پيش نمايش: بخش بالای انيميشن، يک پيش نمايش بارز را برای انيميشنی به شما نشان می دهد كه از 

منوی Preset انتخاب كرده ايد.
C.وName: نام گرفته شده از پنل Layers. شما بايد اشيا و فريم های متنی را هنگام ايجاد انيميشن ها در پنل 

Layers نام گذاری كنيد. يا، چنانچه نام شیء را در اينجا تغيير می دهيد، اين نام در پنل Layers تغيير می كند.
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D.وPreset: منوی Preset فهرستی طولانی از انيميشن های مختلف را در اختيار شما قرار می دهد. هنگام انتخاب 
انيميشنی از منوی Preset، پنجره پيش نمايش در بالای پنل Animation، نمای بارزی از انيميشن را نمايش می دهد.
E.وEvents: به فلش رو به پايين كنار متن توجه كنيد. برای باز شدن منو، روی فلش كليک كنيد تا بتوانيد 
تريگر رويداد را انتخاب كنيد. به طور پيش فرض، تريگر رويداد با On Page Load تنظيم شده است، بدين 

معنی كه هنگام ديده شدن صفحه، انيميشن پخش خواهد شد.
در سمت راست اين منو، آيکنی وجود دارد. برای ايجاد دكمه تريگركننده رويداد، روی اين آيکن كليک كنيد.
F.وDuration: در اين كادر متنی، می توانيد مقدار حداقل قابل قبول 0/125 را تنظيم كنيد كه به انيميشن 

سرعت می بخشد يا آن را با 60 ثانيه تنظيم كنيد كه آن را كند می كند.
G.وPlay: انتخاب هايی برای تعداد دفعاتی داشته باشيد كه می خواهيد انيميشن با وارد كردن مقدار بين 1 

و 99 پخش شود.
H.وLoop: برای تکرار انيميشن جهت پخش چندين باره، اين كادر را در حالت تأييد قرار دهيد.

 Ease In and و Ease Outو،Ease Inو،Noneو،From Preset گزينه هايی برای ،Speed در منوی :Speedو.I
Out داريد. Easing به انيميشن سرعت می بخشد. هنگام انتخاب Ease In، انيميشن ابتدا كند است و سپس سرعت 
می گيرد. Ease Out برعکس است. Ease In and Out كند شروع می شود، شتاب می گيرد و سپس پايان كندی دارد.

J.وAnimate: منوی Animate شامل سه گزينه است:
 From Appearance ،اگر توپی را متحرک می كنيد كه كوچک می شود :From Current Appearance  

با اندازه توپ هنگام قرار گرفتن آن در InDesign شروع می شود. با پيشرفت انيميشن، توپ كوچک می شود.
  To Current Appearance: انيميشن از يک ظاهر به ظاهر جاری اجرا می شود. مثلًا، اگر با توپ كوچکی 

شروع كنيد و توپ در صفحه بزرگ شود، تغيير مقياس توپ از شيئی كوچک تر به ظاهر بزرگ تر كنونی است.
  To Current Location: اگر توپ جهش داشته باشد، انيميشن در مکان جاری به پايان می رسد، مکانی 

كه توپ در طراحی در آن جا بوده است.
K.وRotate: يک شیء را تا º 7.200 می چرخاند.

L.وScale: تغيير اندازه يک شیء )بزرگ و كوچک كردن آن(. بزرگ ترين اندازه موجود 7.200  درصد است.
M.وOpacity: فقط دو انتخاب برای Opacity داريد. Fade In و Fade Out. محدوده آن از 0 درصد تا 

100 درصد است )يا 100 درصد تا 0 درصد(.
N.وVisibility: می توانيد مشخص كنيد كه انيميشن تا زمان پخش پنهان باشد و می توانيد انيميشن را پس 

از اتمام متحرک سازی با فعال كردن كادرهای انتخاب مرتبط پنهان كنيد.
O. پيش نمايش: برای پيش نمايش انيميشن در پنل EPUB Interactivity، روی اين آيکن در گوشه سمت 
چپ پايين كليک كنيد. برای پيش نمايش انيميشن در پنل SWF Preview،وAlt را فشار داده و كليک كنيد.

است.  مفيد  بسيار  دارد،  قرار  پيش نمايش  آيکن  راست  سمت  در  كه  آيکن  اين   :Animation Proxyو.P
هنگامی كه روی اين آيکن كليک می كنيد، يک كادر خاكستری مربعی به عنوان نماينده ای برای نشان دادن 

نقاط ابتدا و انتهای انيميشن به شما نشان داده می شود.
Q. پنل Timing: روی آيکن بعدی در سمت راست Animation Proxy كليک كنيد تا پنل Timing باز شود.

R. تبديل به Motion Path: در سمت راست پايين اين پنل، Convert to Motion Path را می يابيد. هر 
خطی كه در يک سند رسم كنيد، چه مستقيم چه منحنی بزيه، می تواند به عنوان يک مسير حركت استفاده 
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شود. هنگامی كه يک شیء و مسيری را انتخاب می كنيد و سپس روی اين آيکن كليک می كنيد، ضخامت خط 
مسير ناپديد شده و شیء در امتداد مسير متحرک می شود.

S.وRemove Animation: شیء منتسب به انيميشن را انتخاب كرده و روی آيکن سطل زباله كليک كنيد. 
اين عمل موجب حذف انيميشن می شود )شیء شما باز هم در پنجره سند باقی می ماند(.

T. نقطه مبدأ: روی يکی از نهُ نقطه برای محور يا نقطه مبدأ كليک كنيد. مثلًا، اگر بخواهيد يک شیء را از 
مركز بچرخانيد، روی مربع وسط كليک كنيد.

دومين آيتم در منوی Animation Panel،وManage Presets است. اين گزينه را انتخاب كنيد تا پنجره ای 
باز شود كه تمام پيش تنظيمات در آن فهرست شده اند. می توانيد پيش تنظيمات سفارشی را حذف كنيد، 
آن ها را كپی كنيد، يک فايل پيش تنظيم را بارگذاری كنيد و پيش تنظيمات را در فايل جديدی ذخيره كنيد. 

پيش تنظيمات پيش فرض InDesign را نمی توان حذف كرد.
موارد باقيمانده در منوی پنل Animation مشابه موارد بحث شده در اين فهرست هستند، البته به استثنای 
Preview Selection SWF. می توانيد يک شیء را انتخاب كنيد و فقط انيميشن آن شیء را در پنجره 

پيش نمايش SWF پيش نمايش دهيد.

 3ـ5ـ8 ـ ایجاد انیمیشن ها
حال كه با همه سوئيچ ها و تاگل ها1 در پنل Animation آشنا شديد، اجازه دهيد چند انيميشن ساده جالب 

را ايجاد كنيم.
1 سند جديدی را در InDesign ايجاد كنيد. از يکی از اندازه های صفحه EPUB استفاده كنيد. در اين 

مثال، Intent را با Mobile،وPage Size را با iPad و Orientation را با Landscape تنظيم می كنيم.
File>Place 2 را انتخاب كرده و شيئی را در صفحه قرار دهيد. اگر نياز به تصوير پس زمينه داريد، پس زمينه 
را قرار داده و سپس شیء را قرار دهيد. اين شیء می تواند يک تصوير يا توضيح باشد. اين انيميشن را از يک 

پيش تنظيم می سازيم تا از سمت چپ شناور گردد، سپس به سمت راست وسط صفحه برود.

شکل 14ـ8 ـ در حالی که شیئی انتخاب شده است، ویژگی هایی را برای انیمیشن در پنل Animation تنظیم کنید. 

Toggles ـ1
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3 شیء را انتخاب كرده و پنل Animation را باز كنيد.
 Fly in from را باز كنيد و Preset تنظيم كنيد. منوی Animation 4 ويژگی های انيميشن را در پنل
 To Current Locationو،Animate Properties را تايپ كنيد. در Duration را انتخاب و 2 را برای Left
را از منو انتخاب كنيد، Opacity را با Fade In تنظيم كنيد و كادر انتخاب Hide Until Animated را در 

حالت تأييد قرار دهيد. تنظيمات بايد همانند شکل 14ـ8 باشد.
5 انيميشن را پيش نمايش دهيد. روی آيکن Preview Spead:EPUB در پنل Animation )در گوشه سمت 
چپ پايين پنل( كليک كنيد. در برخی موارد، ممکن است نياز باشد روی دكمه Play )فلش اشاره كننده به سمت 

راست( در گوشه سمت چپ پنل EPUB Interactivity Preview كليک كنيد تا انيميشن پخش شود.
هنگامی كه فايل را به يک EPUB با صفحه آرايی ثابت صادر می كنيد، انيميشن به هنگام بارگذاری صفحه 
 Opacity است. آنچه كه می بينيد، انيميشن كوتاهی از Timing پخش می شود. اين تنظيم پيش فرض در پنل

0 درصد است و شیء از سمت راست حركت كرده و در Opacity 100 درصد محو می شود.

6ـ8 ـ ایجاد فایل های PDF تعاملی

نوع  دارای  رايانه ای  و  تبلت  همراه،  تلفن  هر  كرد.  مشاهده  تمام دستگاه ها  در  می توان  را   PDF1 فايل های 
 Adobe Reader رايگان  نرم افزاری  برنامه   لپ تاپ ها،  و  روميزی  رايانه های  در  است.   PDF نمايش دهنده 
نمايش دهنده غالب PDF است. در تلفن های همراه و تبلت ها، طيف گسترده ای از نمايش دهنده ها چه رايگان 

و چه پولی وجود دارد.
بدون توجه به نمايش دهنده PDF مورد استفاده شما، فايل های PDF معمولاً اسناد را دقيقاً همان گونه كه 
ايجاد شده اند، شامل تصاوير، فرمت بندی متن و تعبيه فونت نمايش می دهند. ايراد استفاده از PDFها اين 
است كه چندين ويژگی تعاملی در تلفن های همراه و تبلت ها پشتيبانی نمی شود. در رايانه های روميزی و 

لپ تاپ ها، طيف گسترده تری از پشتيبانی برای ويژگی های تعاملی وجود دارد.
انجام  و  تعامل پذيری  افزودن   ،Adobe InDesign از  تعاملی   PDF فايل های  درباره صدور  اين بخش،  در 

می كنيم. صحبت   Adobe Acrobat به  تعامل پذيری  مستقيم  افزودن  مختلف  وظايف 

Acrobat 1ـ6ـ8  ـ آماده سازی فضای کاری 
اگر اولين بار است كه وارد محيط Acrobat می شويد، ممکن است متعجب شويد كه آيا اين برنامه واقعاً 
از رابط كاربری بسيار   Creative Cloud توسعه يافته است. تمامی برنامه های Adobe Systems توسط
مشابهی استفاده می كنند. البته، تيم Adobe Acrobat راه خودش را رفته است و Acrobat با استانداردهای 

طراحی رابط كاربری همانند همه برنامه های ديگر Creative Cloud سازگار نيست.

 ایجاد یک رابط سفارشی
در Adobe Acrobat، بايد يک فضای كاری سفارشی ايجاد كنيد كه به شما امکان انتخاب سريع ابزارهای 
مختلف را می دهد كه با PDFهای تعاملی استفاده خواهيد كرد. برای شروع، Adobe Acrobat را باز كنيد. 
Portable Document Format ـ1
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نياز به اين نيست كه سندی در پيشخوان Document باز باشد.

شکل 15ـ8 ـ روی Tools در سمت چپ بالای پنجره Acrobat کلیک کنید تا پنجره Tools باز شود.

به دسته Edit PDF برويد و روی Add كليک كنيد. روی Open كليک كنيد تا ابزارهای ويرايش در نوار ابزار 
در بالای پنجره Acrobat نمايان شوند، همان گونه كه در شکل 16ـ8 نشان داده شده است.

شکل 16ـ8 ـ برای ویرایش متن در سند، روی Edit کلیک کنید.

ابزارهايی كه باز می كنيد، در پيشخوان سمت راست نمايان می شود و هنگام باز كردن فايل های PDF ديگر 
در دسترس هستند.
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 2ـ6ـ8 ـ تنظیم ترجیحات
را  Preferences آن ها   تنظيمات ترجيحی دارد كه می توانيد در كادر محاوره ای  زيادی  تعداد   Acrobat
انتخاب كنيد يا Ctrl+K را فشار دهيد. انتخاب كنيد. برای باز كردن ترجيحات، Edit>Preferences را 

 Gereral هنگام شروع كار تغيير دهيد. روی General يک قلم  ترجيحی وجود دارد كه بايد در پيشخوان
در پيشخوان سمت چپ كليک كنيد و بالاترين آيتم، Use Single Key Accelerators، را برای دستيابی 
به ابزارها بيابيد. اين امر به شما اجازه می دهد از ميانبرهای صفحه كليد برای دستيابی به ابزارها هنگام كار با 

Adobe Acrobat استفاده كنيد.
ايجاد رابط سفارشی و تنظيم يک قلم ترجيحی به شما اجازه می دهد با مجموعه حداقلی از ابزارها و ترجيحات 
برای كار روی اسناد PDF تعاملی شروع كنيد. هنگامی كه به ويرايش فايل های PDF ادامه داديد، ممکن است 
بخواهيد ابزارهای بيشتری را اضافه كنيد يا ترجيحات اضافی را تغيير دهيد. اين ها گزينه هايی برای استفاده 
 ،Adobe Acrobat شخصی هستند. به منوها برگرديد و بسته به نوع كار مدنظر خود برای انجام دادن در

دست به انتخاب بزنيد.

InDesign از PDF 7ـ8 ـ خروجی

هنگام انتخاب File>Export در InDesign، دو گزينه متفاوت برای نوعی PDF  داريد كه می خواهيد صادر 
كنيد. در بالای منوی Save as Type در كادر محاوره ای Export،وAdobe PDF (Interactive) را در كنار 
Adobe PDF (Print) خواهيد ديد. برای اسناد تعاملی، بديهی است كه بايد از گزينه Interactive استفاده 

كنيد. اگر می خواهيد يک سند PDF را برای چاپ صادر كنيد، از گزينه Print استفاده كنيد.

Export to Interactive PDF 1ـ7ـ8 ـ استفاده از کادر محاوره ای 
هنگام انتخاب File>Export با فشردن Ctrl+E و انتخاب Adobe PDF (Interactive) و سپس كليک كردن 
روی Save، كادر محاوره ای Export to Intractive PDF باز می شود، همان گونه كه در شکل 17ـ8 نشان 

داده شده است.
در اين كادر محاوره ای، گزينه های متعددی داريد، از جمله:

A.وPage Range: اگر می خواهيد محدوده ای از صفحات را صادر كنيد، روی دكمه راديويی Range كليک كرده 
و شماره صفحات را تايپ كنيد. چيزی شبيه 5ـ3 برای صدور صفحات 3 تا 5.

و  داريد  مقابل  صفحات  اگر  كنيد.  استفاده   Pages از  تکی،  صفحه آرايی های  برای   :Pages/Spreadsو.B
 Spreads به صورت يک صفحه عريض واحد ديده شوند، روی  نهايی   PDF می خواهيد صفحات مقابل در 

كليک كنيد.



1 1 6

Export to Interactive PDF شکل 17ـ8 ـ کادر محاوره ای

C.وView: از اين منو، می توانيد گزينه های مختلف بزرگ نمايی را انتخاب كنيد. اگر می خواهيد كل صفحه 
اندازه  به  توجه  بدون  را  كاربران كل صفحه  تمام  كنيد.  انتخاب  را   Fit Page گيرد،  قرار  در صفحه نمايش 

صفحه نمايش، در پيشخوان سند می بينند.
D.وLayout: اگر Default را از اين منو انتخاب كنيد، نمايش PDF به گزينه های ترجيحی در هر رايانه 
تک  اسناد  به عنوان  PDFها  مشاهده  برای  را  ترجيحی  تنظيمات  می توانند  كاربران  بود.  خواهد  پايبند 
صفحه ای يا پيوسته تنظيم كنند )هنگامی كه در صفحات حركت می كنيد، بالای صفحه بعدی را در پايين 
صفحه قبلی می بينيد كه به خارج از نما پيمايش دارد(. اگر هميشه می خواهيد اسناد PDF شما به صورت 
صفحات تکی نمايش داده شوند، به طوری كه هنگامی كه كاربران در صفحات حركت می كنند، به صفحه 
بعدی )يا هر نمای صفحه آرايی ديگری( می روند، اين گزينه را از منو انتخاب كنيد. هنگامی كه گزينه ای غير 
از Default انتخاب می شود، نمای Layout ترجيحات تک تک رايانه ها را بازنويسی می كند و تمام كاربران 

را مجبور می كنيد PDFهای شما را در نمای صفحه آرايی يکسانی ببينند.
كاربری  رابط  عناصر  تمام  كه  است  نمايی   Full Screen Modeو:Open in Full Screen Modeو.E
باز  ايراد  پنهان می شوند.  از ديد  نوارهای پيمايش و غيره  ابزارها، منوها،  نوار  از قبيل   ،PDF نمايش دهنده 
كردن PDFها در Full Screen Mode اين است كه كاربران كادر محاوره ای هشداری را می بينند كه بايد در 
هر بار باز شدن PDF آن را ناديده بگيرند. متأسفانه، بسته به تعداد اقدامات امنيتی كه Adobe برای جلوگيری 
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از تغيير PDFها در رايانه شما انجام می دهد، اين يک شيطنت ضروری است، بدون اينکه شما آن را بدانيد.
F.وFlip Pages. آيا با فعال بودن Full Screen Mode، می توانيد چرخش خودكار صفحات را داشته باشيد. 

با تايپ كردن مقدار در اين كادر متنی، فاصله را تعيين كنيد.
G.وPage Transitions: ترانزيشن ها هنگامی روی می دهند كه در صفحات حركت می كنيد. می توانيد طوری 
ترانزيشن صفحات موجود در PDF را داشته باشيد كه آبرومند باشد يا از تعدادی از آثار ترانزيشن در منو 

انتخاب كنيد.
 InDesign برای در برگرفتن همه فايل های رسانه و فيلدهای فرمی كه در صفحات :Forms and Mediaو.H

شما قرار گرفته، روی دكمه راديويی Include All كليک كنيد.
نمونه های  نکنيد.  فعال  را  آن  هرگز  است.  غيرفعال  هميشه  گزينه  اين   :Embed Page Thumbnailsو.I
تصويری در يک سند تصويری، تصاوير نمونه هر صفحه را هنگام مشاهده صفحه آرايی در صفحه Pages در 
پيشخوان Navigation نشان می دهد. از Acrobat 6 به بعد، نمونه های تصويری هنگام باز شدن يک سند 
PDF به طور شناور توليد می شوند. اگر نمونه های تصويری صفحات را تعبيه كنيد، سربار بيشتری را اضافه 

كرده و اندازه فايل نهايی بزرگ تر می شود.
       Acrobat نمايش دهنده  يک  در  را  شده  صادر   PDF سند  بخواهيد  اگر   :View After Exportingو.J
Adobe Acrobat يا Adobe Reader( باز كنيد )به طور خودكار پس از تکميل صدور(، اين كادر را در حالت 

تأييد قرار دهيد.
لايه ها  از  كه  هستند  مواردی  تنها  PDFها  تعاملی،  اسناد  انواع  تمام  از   :Create Acrobat Layersو.K
پشتيبانی می كنند. اگر يک سند چند زبانه داريد، به عنوان يک مثال، می توانيد از تمام گرافيک ها و تصاوير در 
يک لايه استفاده كنيد و متن را در لايه های مجزا ايجاد كنيد. سپس، می توانيد از دكمه ها استفاده كنيد تا به 

خواننده سند شما اجازه می دهند نماهای لايه را تغيير دهد.
L.وTagged PDF: روی Create Tagged PDF كليک كنيد تا كاربران خواننده های صفحه نمايش بتوانند 
سند شما را كامل بخوانند. روی Use Structure for the Tab Order كليک كنيد كه ترتيب Tab مواردی 

مثل فيلدهای فرم را به ارث می برد.
M.وSecurity: برای باز شدن كادر محاوره ای Security، روی دكمه Security كليک كنيد. می توانيد با 

اضافه كردن محافظت گذرواژه ای برای باز شدن PDF، ويرايش آن را محدود كنيد.

InDesign 8ـ8 ـ آماده سازی صفحه آرایی ها در

هنگام كار كردن با فايل های PDF تعاملی، روال های خاصی وجود دارند كه نيازمند ساخت نتايج تعاملی است 
كه می توانيد به دست آوريد. در اين بخش، هر دو را ارائه می دهيم.  روش های  عالی برای استفاده با PDFهای 
تعاملی خواهيد يافت و نبايد هنگام ايجاد صفحه آرايی ثابت و اسناد Adobe Publish Online نگران باشيد.

يک جلوه جالب كه می توانيد با فايل های PDF تعاملی ايجاد كنيد، طراحی سندی با اشيا يا تصاويری است كه 
حاشيه صفحه را قطع می كنند. اين امر تنها با اسناد PDF انجام می شود و تنها برنامه ای كه می تواند اين نتيجه 
را حاصل كند، Adobe InDesign است. در شکل 18ـ8، يک صفحه PDF را می بينيد كه در Acrobat نمايش 
داده شده است. به آناناس در سمت چپ صفحه توجه كنيد. اين تصوير، حاشيه صفحه را قطع كرده است. اين 

شبيه يک جلوه خارج از محدوده است كه می توانيد با Adobe Photoshop Elements ايجاد كنيد.

(
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شکل 18ـ8 ـ فقط اسناد PDF تعاملی می توانند عناصری داشته باشند که از حاشیه های صفحه بیرون می زنند.

ممکن است دوچرخه ای داشته باشيد كه از صفحه نمايش بيرون برود، فوتباليستی كه به توپ ضربه می زند، 
موج سواری كه سوار بر موج است يا عنصر طراحی ديگری كه بخواهيد بعُد كوچکی به سند نهايی اضافه كنيد. 

اين كارها بسيار ساده است كه می توانيد با انجام مراحل ذيل، آن ها را انجام دهيد:
1 يک شیء روی يک صفحه Master قرار دهيد. بايد شيئی داشته باشيد كه در صفحه Master قرار داشته 
و از حاشيه بيرون بزند. پنل Pages را باز كرده و روی Master Page دابل كليک كنيد كه برای عناصر 

طراحی ديگر در صفحه استفاده می شود.
2 مطمئن باشيد كه نقطه وسط شیء در مرز صفحه است. بايد نقطه وسطی در مرز صفحه داشته باشيد. اگر 
بخواهيد عنصر كوچکی را خارج از مرز صفحه قرار دهيد، فريمی بدون خط دور و زمينه داخل ناحيه صفحه 

ايجاد كنيد و آن را با شیء كوچک گروه بندی كنيد.
3 شیء را به يک دكمه تبديل كنيد. شیء را انتخاب كرده و پنل Buttons and Forms را باز كنيد. دكمه 
جديدی برای شیء ايجاد كنيد. نگران انتساب يک عمل نباشيد، فقط بايد مطمئن شويد كه شیء يک دكمه است.
 Adobe و  دهيد(  فشار  را   Ctrl+E )يا  كنيد  انتخاب  را   File>Export كنيد.  صادر  تعاملی   PDF به   4
PDF Interactive را برگزينيد. اگر View After Exporting را در حالت تأييد قرار داده باشيد، PDF در 

نمايش دهنده پيش فرض PDF باز می شود. از اينجا، برای تکميل كار نياز به Adobe Acrobat داريد.
5 دكمه را قفل كنيد. اگر كاربر كليک كند و مرتب ماوس را تکان دهد، ممکن است دكمه حركت كند و 
كاملًا در ناحيه صفحه قرار گيرد. برای جلوگيری از چنين رخدادی، در Adobe Acrobat، در حالی كه ابزار 
Object را انتخاب كرده ايد، روی دكمه كليک راست كنيد تا منوی بازشويی باز شود )برای دستيابی به ابزار 
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Select Object،وR را روی صفحه كليد فشار دهيد(. Properties را از منو انتخاب كنيد. به طور پيش فرض، 
كادر محاوره ای General Properties باز می شود. در گوشه سمت چپ پايين، كادر Locked را در حالت 

تأييد قرار دهيد، همان گونه كه در شکل 19ـ8 نشان داده شده است.
می توانيد  باز شود،  تمام صفحه  حالت  در  نمی خواهيد سند  اگر  )اختياری(.  كنيد  تنظيم  را  كاربر  رابط   6
تعدادی از گزينه های رابط را پنهان كنيد. File>Properties را انتخاب كنيد يا Ctrl+D را فشار دهيد. كادر 
محاوره ای Document Properties باز می شود. روی برگه Initail View كليک كرده و گزينه هايی را در 
ناحيه User Interface Options انتخاب كنيد كه می خواهيد پنهان باشند. نمی توانيد هر سه گزينه رابط 
را پنهان كنيد. معمولاً، اقلامی كه می خواهيد بررسی كنيد، Hide Menu Bar و Hide Toolbars هستند. 
گرچه اگر طرحی با اشيايی ايجاد كنيد كه از حاشيه های صفحه بيرون می زنند، ممکن است بخواهيد فايل ها 

را در حالت تمام صفحه نمايش دهيد.

شکل 19ـ8 ـ قفل کردن دکمه برای جلوگیری از حرکت های تصادفی

Acrobat 9ـ8 ـ ایجاد  هایپرلینک ها در

همان گونه كه قبلًا بيان شد، شما نبايد  هايپرلينک ها را در Adobe InDesign ايجاد كنيد و بايد آن ها را 
به عهده Acrobat بگذاريد. دو انتخاب برای ايجاد دكمه های پيمايشی داريد: می توانيد از يک دكمه يا يک 

لينک استفاده كنيد.
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 1ـ9ـ8 ـ استفاده از دکمه ها برای پیمایش صفحه
دكمه ها نسبت به لينک ها اين مزيت را دارند كه می توانند در چندين صفحه تکرار شوند. بنابراين، اگر بخواهيد 
دكمه ای را ايجاد كنيد كه كاربر را به صفحه بعدی بفرستد، دكمه ای را با عمل دكمه ايجاد كرده و سپس آن 

را در چندين صفحه تکرار كنيد.
برای ايجاد يک دكمه تعاملی برای پيمايش صفحه، اين موارد را انجام دهيد:

1 يک سند چند صفحه ای را در Acrobat باز كنيد.
2 دكمه ای را در صفحه اول ايجاد كنيد. روی ابزار دكمه كليک كرده و دكمه ای را در محلی رسم كنيد كه 

می خواهيد دكمه ظاهر شود.
3 زمينه دكمه را اضافه كنيد )اختياری(. اگر نماد يا آيکنی در صفحه داريد، نبايد دكمه ای با يک ظاهر 
ايجاد كنيد. اگر هيچ نشانه ای نداريد كه پيمايش از طريق كليک دكمه صورت می گيرد، بايد دكمه ای را به 
شيوه رايج ايجاد كنيد طوری كه برای كاربر آشکار باشد كه اين عنصر، يک دكمه است. می توانيد رنگ زمينه 
محتويات دكمه را پر كنيد يا می توانيد يک تصوير گرافيکی به دكمه اضافه كنيد. لحظه ای كه دكمه را ايجاد 
 Go روی دكمه باز می شود. نامی را برای دكمه تايپ كنيد، مثلًا Button Field Name می كنيد، پنجره

Next، و سپس روی All Properties كليک كنيد.
 Fill Color كليک كرده و روی آيکن Appearance روی برگه ،Button Properties 4 در كادر محاوره ای
 ،Layout كليک كنيد. در منوی Options را از منوی بازشو انتخاب كنيد. روی برگه No Color .كليک كنيد
می توانيد مشخص كنيد كه يک Label و يک Icon داشته باشيد. Label Only يا Icon Only را هم داريد. 

در اين مثال، از Icon Only استفاده خواهيم كرد.
5 پس از انتخاب Icon Only و Acrobat كمی اشکال دارد كه در آن نمی توانيد آيکنی را انتخاب كنيد، 
دكمه  سپس  و  كرده  انتخاب   Behavior منوی  از  را   Push دهيد.  تغيير  را   Behavior ابتدا  اينکه  مگر 
Choose Icon را فعال كنيد. روی Choose Icon كليک كنيد تا كادر محاوره ای Select Icon باز شود. 
برای باز شدن پنجره Open و پيمايش به هارد درايو برای يافتن آيکن مدنظر خود روی Browse كليک كنيد. 

در پنجره Open كليک كرده و روی Open كليک كنيد )شکل 20ـ8 را ببينيد(.

شکل 20ـ8 ـ شیئی را که می خواهید برای ظاهر دکمه استفاده کنید، یافته و روی Open کلیک کنید.
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گزينه های متعددی در پنجره Advanced برای اشاره به آيکنی در فيلد button داريد.
6 روی Advanced در برگه Button Properties Options كليک كنيد تا اندازه و مقياس تنظيم شود.

7 عملی را تنظيم كنيد. در حالی كه هم چنان در كادر محاوره ای Button Properties هستيد، روی برگه 
Actions كليک كنيد. Execute a Menu Item را در منوی Select Action انتخاب كرده و روی Add كليک 
كنيد. كادر محاوره ای Menu item باز می شود. آيتم View>Page Navigation>Next Page را يافته و آن را 
انتخاب كنيد. روی OK كليک كنيد و با كليک كردن دكمه Close، كادر محاوره ای Button Properties را ببنديد.

8 دكمه دومی ايجاد كنيد. روال مشابه مراحل 3 و 4 را برای ايجاد دكمه دوم طی كنيد. برای اين دكمه، 
صفحه View>Page Navigation>Previous Page را در منوی Menu Item انتخاب كنيد.

10ـ8 ـ تنظیم فضای كاری برای فرم ها

هنگام ايجاد يک فرم پر شدنی، با صفحه ای شروع خواهيد كرد كه هم اكنون طراحی كرده ايد. در مرحله گرفتن 
يک فرم طراحی شده و تبديل آن به فرمی كه می تواند در PDF پر شود، از ابزارهای خاصی استفاده می شود. 
فضای كاری Interactive For PDF تعدادی ابزار دارد كه شما نياز داريد و در دسترس شما هستند. اگر 

فضای كاری را كمی سفارشی كنيد، كارآمدتر خواهد بود.
 Pasteboard 1 ابتدا، پنل هايی را كه برای فرم ها نياز نداريد، جدا كنيد. هر يک از پنل ها را به سمت چپ
بکشيد. اين پنل ها برای انواع ديگر PDFهای تعاملی مفيد هستند ولی برای فرم ها نيازی به آن ها نداريم. 
نمی شوند.  استفاده  فرم ها  برای  زيرا  بکشيد،   Pasteboard به  نيز  را   Gradient و   Colorو،Link پنل های 
عملکرد وظيفه ای فرم را به سندی اضافه خواهيد كرد كه هم اكنون طراحی و ساخته شده است. مهم نيست 

كه اگر هنگام كشيدن پنل ها، تعدادی از آن ها به هم چسبيده باشند.
2 هر يک از پنل هايی را كه كشيده ايد، از حالت اتصال خارج كنيد.

 InDesign بکشيد. اين كتابخانه Buttons and Forms را به زير پنل Sample Buttons and Forms 3 پنل
شامل فيلدهای فرم از قبل ساخته شده و دكمه هايی برای كادرهای انتخاب، دكمه های راديويی و دكمه هايی 

است كه می توانند برای واگذاری يا چاپ فرم استفاده شوند.
4 برای باز كردن پنل Properties،وWindow>Properties را انتخاب كنيد. سپس آن را به پايين پنل داک 
بکشيد به طوری كه بتوانيد هنگام نياز آن را باز و بسته كنيد، در عين حال كه فضای صفحه نمايش را حفظ كنيد.

 Window>Workspace>New .5 اين فضای كاری را ذخيره كنيد تا بعداً بتوانيد مجدد از آن استفاده كنيد
Workspace را انتخاب كنيد. از نامی مثل PDF Forms-Basic يا هر نام با معنی ديگری استفاده كنيد 
ابزارهای اضافی ذخيره  با  )برای فرم های پيچيده تر و طولانی تر، ممکن است بخواهيد فضای خالی مجزا را 
Articles(. روی  و   Object Styles Paragraph Styles،وCharacter Styles، پنل های  از جمله  كنيد، 

OK كليک كنيد.
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شکل 21ـ8 ـ مرتب سازی پنل ها

 1ـ10ـ8 ـ افزودن فیلدهای فرم
مقداری از كارهای تنظيمی فيلدهای فرم هم اكنون انجام شده است. با افزودن فيلدهای ديگر و سپس اصلاح 

بعضی از آن ها، فرم را كامل خواهيم كرد.

 2ـ10ـ8 ـ افزودن فیلدهای متنی
در يک فرم PDF، فيلد متنی مخزنی است كه در آن، افراد پركننده فرم می توانند متن در آن وارد كنند. همه 
فريم ها به جز دو فريم هم اكنون به فيلدهای متنی تبديل شده اند. شما دو فريم جديد اضافه خواهيد كرد و 

آن ها را به فيلدهای متنی تبديل می كنيد.
( در پنل داک، پنل Layers را باز كنيد. توجه داشته باشيد كه اين فايل  1 با كليک كردن روی آيکن )
با لايه جداگانه ای تنظيم شده است، Form Elements، برای اشيايی كه بخشی از فرم هستند. لايه ديگر، 

Layer1، را قفل كنيد، به طوری كه بتوانيد با اشيای فرم بدون جابه جايی احتمالی آن ها كار كنيد.
( برای بزرگ نمايی روی ناحيه ای در نيمه بالايی صفحه كه حاوی اشيای فرم است،  ( Zoom 2 از ابزار

استفاده كنيد. اين محلی است كه تمام كار شما در اين بخش انجام می شود.
( اشاره گر را به روی فيلد متنی و زير First Name ببريد. توجه داشته  ( Selection 3 با استفاده از ابزار
باشيد كه خط نقطه چين قرمز، حول شیء و يک آيکن كوچک در سمت راست پايين نمايش داده می شود. 
 PDF است؛ آيکن فريم متنی نوع عنصر فرم PDF اين خط نقطه چين نشان می دهد كه شیء يک عنصر فرم

يک فيلد متنی است. برای انتخاب شیء، روی فيلد متنی كليک كنيد.
( در پنل داک برای نمايش Buttons and Forms كليک كنيد.  ( Buttons And Forms 4 روی آيکن
به تنظيمات مربوط به فيلد متنی توجه كنيد. Text Field در منوی Type انتخاب شده است و نام اين 
عنصر، First Name است. فيلد Description هنگامی به كاربر فرم نمايش داده می شود كه اشاره گر را روی 
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 Description فيلدی ببريد، بنابراين می توانيد توضيحی اضافه به كاربران بدهيد تا فرم را تکميل كنند. فيلد
با First Name تنظيم شده است. Printable به طور پيش فرض انتخاب شده است تا امکان چاپ اين فرم 

فراهم شود. تنظيم فونت و اندازه را به صورت پيش فرض رها كنيد.

شکل 22ـ8 ـ انواع متفاوت فیلدهای فرم آیکن های متفاوتی در گوشه سمت راست پایین دارند. این یک آیکن فیلد متنی است.

5 فريم فيلد فرم First Name را انتخاب كنيد، كليد Alt را فشار داده و با كشيدن ماوس، يک كپی از آن 
در زير Last Name قرار دهيد. اندازه فيلد را تغيير دهيد تا بزرگ تر شود، آن را با فيلدهای زيری تراز كنيد 
)با كشيدن دستگيره سمت راست و وسط به سمت راست(. هنگام تراز شدن اشاره گر Smart Guides ظاهر 

خواهد شد.
6 در پنل Buttons And Forms، توجه داشته باشيد كه نام اين فيلد First Name 1 است. اين يک رفتار 
InDesign است كه هنگام ايجاد فرم ها بايد از آن آگاه باشيد: هيچ دو فيلدی نبايد نام يکسان داشته باشند. 
InDesign با افزودن شماره های ترتيبی به نام فيلدهای تکراری، اين قانون را تقويت می كند. برای اينکه اين 
فيلد را فيلدی منحصربه فرد با اطلاعات صحيح كنيم، فيلدهای Name و Description را به Last Name تغيير 

می دهيم.
( را در پنل Tools انتخاب كنيد و فريمی در قسمت فريم  ( Rectangle 7 برای ايجاد فرم از ابتدا، ابزار
 Email در بالا و لبه بالا را با پايين فريم متنی City رسم كنيد. لبه سمت راست را با فريم Email Address
Address تراز كنيد. از Smart Guides برای هم اندازه كردن ارتفاع اين فريم با فريم City استفاده كنيد. 
می توانيد هر نوع فريمی )متنی، گرافيکی يا نسبت داده نشده( را به فيلد فرم PDF تبديل كنيد. يک فيلد 

متنی نبايد از يک فريم متنی ساخته شود.
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شکل 23ـ8  ـ توجه کنید که چگونه Smart Guides به شما کمک می کند اشیا را تراز کرده و اندازه آن ها را تنظیم کنید.

8 حالا زمينه و خط دوری مشابه فيلدهای متنی ديگر نسبت می دهيم. يک سبک شیء برای كادرهای فيلد 
متنی هم اكنون ايجاد كنيد. برای باز كردن پنل Object Styles،وWindow>Styles>Object Styles را 
( را انتخاب كرده و روی كادری كه رسم كرده ايد، كليک كنيد )چنانچه  ( Selection انتخاب كنم. ابزار
 Object كليک كرده و سپس پنل Text Field Box نام  به  انتخاب نشده است(. روی سبک شیء  هنوز 
Styles را ببنديد. حالا زمينه و خط دور مشابهی بر فريم جديد اعمال می شود. سپس، ارتفاع و عرض فيلد 
 Smart ،بکنيد. برای نمايش مجدد City متنی را با كشيدن كامل دستگيره های مستطيل هم اندازه با فيلد
Guides را ببينيد. اندازه كاملًا تغيير كرده است، زيرا سبک شیء به خط دور فريم اضافه شده است. تأييد 
 Properties يا Control است. اين كار را با بررسی اندازه ها در پنل City كنيد كه اندازه اين فيلد مشابه فيلد

انجام دهيد.
 Email نام و شرح  و  انتخاب كنيد   Type از منوی  را   Text Fieldو،Buttons And Forms 9 در پنل 
Address را به آن بدهيد. Font Size را با Auto تنظيم كنيد. Auto انتخاب خوبی برای فيلدهايی نظير 
آدرس های ايميل است كه خيلی طولانی هستند؛ اين تنظيم در صورت لزوم برای پر كردن فريم، اندازه فونت 

را كاهش می دهد. اين عملکرد وظيفه ای از بريده شدن متن هنگام چاپ صفحه جلوگيری می كند.
File>Save 10 را انتخاب كنيد.
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كلیات

 InDesign اكنون به آخرهای كتاب رسيده ايم. ما همه مهارت های عالی را ياد گرفته ايم تا تبديل به كارشناس
شويم. برای اينکه ديگران كار ما را ببينند، بايد از آن خروجی بگيريم. همان طور كه در سراسر كتاب گفتيم، 
InDesign ابزاری برای ايجاد اسناد است. ما اين شانس را داريم كه در يادگيری InDesign در اين كسب وكار 
بهترين باشيم. البته گفتيم كه InDesign فقط برای چاپ نيست. ما هنوز هم می توانيم اسناد عالی را به همراه 
تعامل پذيری برای وب آماده كنيم. اجازه دهيد با چاپ شروع كنيم. در اين واحدكار شما را در مورد چگونگی 
ذخيره سازی اسناد و نحوه استفاده از فرمت ها هدايت می كنيم. نحوه ايجاد PDFهای حرفه ای، نحوه چاپ 
صفحات انتخابی از يک سند، نحوه ذخيره سازی قالب ها برای استفاده های آتی، اشتراک گذاری فايل ها با ديگران 
با ساخت پکيج، مواردی هستند كه در اين واحدكار بررسی می شوند. هم چنين ذخيره سازی، صادر كردن و وارد 
كردن بخش های مهمی از كار شما هستند. اما مهم تر از همه كنترل نحوه ذخيره سازی و ذخيره كار است. به 

شما توصيه می كنيم در مورد PDF بيشتر بدانيد، زيرا ابزاری ضروری و فوق العاده قدرتمندی است.

هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  نحوه ذخيره سازی اسناد را بداند.

  نحوه صدور اسناد را بداند.

  روش های وارد كردن اسناد را بداند.

  روش های وارد كردن تصاوير گرافيکی را بداند.

  مفهوم اصول چاپ را درک كند.

  مفاهيم اوليه صفحه آرايی را بداند.

  انواع كاغذ برای چاپ را بشناسد.

  استانداردهای طراحی بروشور، كاتالوگ، كتاب و مجله را بشناسد.

  با مفاهيم مربوط به وب آشنا باشد.

زمان آموزش

عملینظری

23
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INDD 1ـ9ـ ذخیره سازی سند به عنوان

فايل INDD چيست؟ INDD نوعی فايل پيش فرض برای نگارش های اخير InDesign است. برای ذخيره سازی 
 Save برويد تا كادر محاوره ای File>Save/Save As/Save a Copy به ،INDD سند خود به عنوان يک فايل
نمايان شود. در اين كادر محاوره ای، نام و مکان ذخيره سازی فايل را مشخص می كنيد، البته، گزينه های فرمت 
فايل متعددی وجود دارد كه از طريق منوی بازشوی پايين اين كادر محاوره ای در دسترس قرار می گيرند: 
 .InDesign CS4 or Later (IDML)و،InDesign CC 2021Template، InDesign CC 2021 document
اولين گزينه را انتخاب كنيد تا سند شما به عنوان يک فايل INDD عادی ذخيره شود. اين بدان معنی است 
كه اين فايل را فقط می توانيد با نگارش فعلی InDesign باز كنيد. برای ذخيره سازی فايلی كه در نگارشی 

قديمی تر از InDesign باز می شود، بخش بعدی را مطالعه كنيد.

2ـ9ـ ذخیره سازی سند به طوری كه در نگارش قدیمی تر InDsign باز شود

يکی از ويژگی های غيرعادی InDesign اين است كه يک فايل INDD ذخيره شده در نگارش فعلی اين نرم افزار 
 InDesign نمی تواند در نگارش های قديمی تر باز شود. به منظور ذخيره سازی سند ايجاد شده در نگارش فعلی
به طوری كه بتواند توسط نگارش قديمی تر اين نرم افزار باز شود، اين سند بايد به صورت يک فايل IDML ذخيره 
 Adobe InDesign Markup مخفف IDML :شود. اگر دليلی فنی برای اين مسئله می خواهيد، اين است
Language است. IDML يک نمايش XML از سند InDesign يا مؤلفه های آن است. اين فرمت، فرمت 
مبادله برای Adobe InDesign است. دانستن اين اطلاعات فنی باعث نمی شود كه شما عاقل تر شويد، ولی 
با آن ها كار می كنيد، از يک نگارش InDesign استفاده  به شما كمک می كند كه بدانيد همه كسانی كه 
و   رفته   File>Save As به  است  كافی  كنيد.  ذخيره  را   IDML فايل  يک  بايد  هميشه  شما  و  نمی كنند 
InDesign CS4 or Later (IDML) را از منوی بازشوی Format (Save as Types) در نزديکی انتهای 
 InDesign اين كادر محاوره ای انتخاب كنيد. البته برعکس اين قضيه درست نيست. آخرين نگارش نرم افزار
می تواند فايل های INDD ايجاد شده و ذخيره شده در نگارش های قديمی تر Creative Cloud را باز كند.

INDD شکل 1ـ9ـ ذخیره سازی به فرمت
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IDML شکل 2ـ9ـ ذخیره سازی به فرمت

3ـ9ـ چاپ تک تک صفحات یا اسپریدها

آيا تاكنون روی يک سند چند صفحه ای كار كرده ايد كه خواسته باشيد به جای كل سند، يک يا دو صفحه 
را چاپ كنيد؟ در كادر محاوره ای Print، می توانيد مشخص كنيد كدام صفحات را می خواهيد چاپ كنيد؛ 
با وجود اين، چنانچه ندانيد چگونه محدوده صفحات را برای اسناد چندصفحه ای انتخاب كنيد، مسئله كمی 
 Pages ترفندآميز می شود. ولی نگران نباشيد، ترفند جالبی برای ساده تر كردن اين فرايند با استفاده از پنل
وجود دارد. كافی است پنل Pages را باز كنيد )Window>Pages( و روی اولين صفحه مدنظر خود برای 
چاپ  كليک كنيد تا انتخاب شود. روی صفحات ديگری كه می خواهيد چاپ كنيد، Ctrl+كليک كنيد )البته، 
اگر قصد چاپ كل سند را نداريد(. هنگامی كه صفحات خود را انتخاب كرديد، روی يکی از صفحات منتخب 
 Print محاوره ای  كادر  نمايان شدن  موجب  امر  اين  كنيد.  انتخاب  را   Print Pages و  كرده  راست  كليک 
می شود و شما صفحات انتخابی خود را خواهيد ديد كه به طور خودكار در فيلد range فهرست شده است. از 

آنجا می توانيد هر تغيير ديگری را در كار چاپی خود بدهيد، از قبيل كپی ها، اندازه چاپ و غيره.

شکل 3ـ9ـ چاپ صفحات انتخابی
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4ـ9ـ ذخیره یک سند به عنوان یک PDF چاپی استاندارد

دنيای PDFها و قبل از چاپ، بسيار گسترده است و خارج از گستره اين كتاب است. در اينجا، قصد داريم به 
شما نشان دهيم چگونه فايل را به عنوان يک PDF با تنظيمات پيش فرض ذخيره كنيد. اگر می خواهيد دنيای 
PDFها را بيشتر دنبال كنيد، پيشنهاد می كنيم يک چاپخانه محلی خوب و يک كتاب جامع درباره چاپ 
بيابيد. اجازه دهيد فايل مان را به PDF صادر كنيم. دو روش برای انجام اين كار وجود دارد، ولی ما از روش 
 Adobe PDF و Export :وجود دارد File پيش فرض استفاده می كنيم. دو گزينه برای اين كار در منوی
Presets. ما به Export می پردازيم و به شما نشان می دهيم چگونه فايل PDF داشته باشيد. هنگامی كه 
Export را انتخاب می كنيد، يک كادر محاوره ای Save As نمايان می شود كه می توانيد نامی به فايل بدهيد و 
 PDF Printو،Format (Save as Type) محل صدور را انتخاب كنيد )يعنی، فايل كجا ذخيره می شود(. در منوی
 Export Adobe كليک كنيد. اين امر موجب باز شدن كادر محاوره ای Save را انتخاب كرده و سپس روی
PDF می شود. اين ممکن است شما را بترساند، ولی نترسيد! ابتدا، هميشه منوی Adobe PDF Preset را 
باز كرده و High Quality Print را انتخاب كنيد. من می خواهم PDF با كيفيتی داشته باشم و اين روزها 
 PDF/X1ـa:2001 برويد و Standard ارسال فايل های بزرگ تر كار چندان مشکلی نيست. سپس، به منوی

را انتخاب كنيد، زيرا بهترين شروع  برای تضمين اين مسئله است كه PDF تمام عناصر موردنياز را دارد.

تنها مورد ديگری كه بايد انجام دهيد، قرار دادن يک چک مارک كنار View PDF after Exporting است. 
روی Export كليک كنيد تا سند شما به PDF صادر شده و در مکان موردنظرتان ذخيره شود و پيش نمايش 

آن در Acrobat بازگردد.

PDF شکل 4ـ9ـ ذخیره کردن سند به صورت

PDF 5ـ9ـ صدور تک تک صفحات

با عرضه InDesign CC 2018 و نگارش های بعدی، توانايی صدور يک سند InDesign به PDFهای جداگانه 
برای هر صفحه يا اسپريد مهيا شد. ديگر نيازی نيست كه PDF ذخيره شده را در Adobe Acrobat باز كنيد و 

)برای 1aـPDF/X، تمام فونت ها بايد تعبيه شوند و تصاوير بايد CMYK يا رنگ های موضعی باشند(. 
توجه
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آن را به صورت دستی به چند فايل تقسيم بندی كنيد. برای ايجاد فايل های PDF مجزا، File>Export را انتخاب 
 Adobe PDF باز كرده و فرمت  كرده و در كادر محاوره ای Save As، منوی Format (Save as Type) را 
در  می كند.  كار  حالت  دو  هر  در  روش  اين  كنيد؛  انتخاب  را   Adobe PDF (Interactive) يا   (Print)
كادر محاوره ای Export Adobe PDF، يک چک مارک كنار Create Separate PDF بگذاريد. استفاده 
می شود،  اضافه  صادرشونده   PDF فايل  نام  انتهای  به  اطلاعاتی  چه  اينکه  تعريف  برای   Suffix فيلد  از 
كوچک  فلش  روی  شماست.  موردنظر  صفحات  كدام  كنيد  مشخص  می توانيد  بنابراين،  است،  ايده آل 
،Incremental Numbers از  می خواهيد  آيا  كنيد  مشخص  و  كرده  كليک   Suffix فيلد  راست   سمت 

 Suffix استفاده كنيد. فيلد نام فايل به طور خودكار به سمت راست فيلد Page Size يا Page Number
اضافه می شود؛ البته نام فايل از سند اصلی گرفته شده است ولی در صورت لزوم می توان آن را ويرايش كرد.

شکل 5ـ9ـ صدور صفحات مجزا

)PNG یا JPG 6ـ9ـ صدور به فرمت های تصویری )مثل

گاهی اوقات ممکن است نياز به صدور سند يا صفحاتی از سند به فرمتی غير از PDF مثلًا يک فايل تصويری 
داشته باشيد. شما چندين گزينه در فرمان Export داريد. به File>Export برويد. سند خود را نام گذاری 
كنيد و از منوی Format (Save as Type)، می توانيد JPEG يا PNG را برای ذخيره سند خود به عنوان 
يک تصوير انتخاب كنيد. اگر JPEG را انتخاب كنيد، كادر محاوره ای Export JPEG به شما ارائه می شود 
كه به شما اجازه می دهد كدام صفحات را می خواهيد صادر كنيد؛ كيفيت و وضوح فايل؛ فضای رنگ مورد 
استفاده و غيره را مشخص كنيد. اين روشی واقعاً مفيد برای ايجاد نگارش های فايل با اندازه كوچک از سند 
شما برای ايميل به ديگران يا حتی طراحی چيزی در InDesign به ويژه برای صدور به يک فرمت تصويری 

است كه می تواند در رسانه های اجتماعی يا وب پست شوند.
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شکل 6ـ9ـ صدور به فرمت های تصویری

7ـ9ـ ساخت پکیج از فایل ها

ساخت پکيج از فايل InDesign تمام عناصر مختلف )از جمله تصاوير، لوگوهای برداری، كليه فايل های فرمت 
گرافيکی ديگر و فونت ها( را گرد هم می آورد و همه موارد را در يک پوشه ذخيره می كند. اصولاً شبيه گرفتن 
كپی هايی برای ارسال با فايل است، ولی جامعيت لينکی را به وجود می آورد كه هنگام باز شدن فايل در هر 
 ،Package برويد. در كادر محاوره ای   File>Package به  فرايند،  اين  برای شروع  جايی، كار خواهد كرد. 
مقداری اطلاعات درباره فايل خود خواهيد ديد، هم چنين برگه هايی در سمت چپ اين كادر محاوره ای برای 
عناصر ديگر سند وجود دارد، از قبيل Font Info، Links Info، Colors and Inks، Print Settings و 
غيره. قبل از ساخت پکيج از فايل خود، مطمئن شويد كه چراغ سبز رنگ No Errors را در پايين فضای 
Package كليک كنيد و در كادر محاوره ای بعد، از شما خواسته می شود  InDesign داريد! روی  كاری 
پوشه پکيج را نام گذاری كنيد و محل ذخيره سازی آن را مشخص كنيد. هم چنين بايد مشخص كنيد كدام 
 Use عناصر سند را می خواهيد داشته باشيد. هميشه همه موارد را در حالت تأييد رها كنيد، به استثنای
 High را با Select PDF Preset من معمولاً تنظيم Document Hyphenation Exceptions Only
Quality Print توصيه می كنم، ولی می توانيد هر پيش تنظيمی را برای آن سند انتخاب كنيد. حالا روی 
Package كليک كنيد. روی OK كليک كنيد، ولی به خاطر داشته باشيد كه فقط فونت های دارای مجوز در 
سند تعبيه می شوند. حالا به پوشه ای برويد كه پکيج خود را ذخيره كرده ايد و بررسی كنيد تا مطمئن شويد 
همه اقلام در آنجا وجود دارد. شما يک PDF، فايل INDD و فونت ها و تصاوير در پوشه های خاص خود را 

داريد. چيزی را جابه جا نکنيد، چون لينک ها گسسته می شوند.
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شکل 7ـ9ـ ساخت پکیج

8ـ9ـ انتشار سند به صورت آنلاین

می توانيد هر سند InDesign را به صورت آنلاين منتشر كنيد و آن را با شبکه های اجتماعی، از طريق ايميل 
يا حتی به عنوان يک صفحه وب مستقل به اشتراک بگذاريد. هم چنين می توانيد سند را در هر صفحه وب يا 
وبلاگی تعبيه كنيد. نگارش HTML سند شما در تمام رايانه های روميزی، تبلت ها و تلفن های هوشمند قابل 
مشاهده است و از همه انواع تعامل پذيری كه ممکن است در سند InDesign داشته باشيد، پشتيبانی می كند. 
ابتدا، مطمئن شويد سند شما كامل و عاری از خطاست و سپس روی دكمه Share در نزديکی گوشه سمت 
راست بالای فريم برنامه كاربردی كليک كنيد )يا به File>Publish Online برويد(. در كادر محاوره ای كه 
نمايان می شود، روی برگه General كليک كرده و Publish Online  را از منو انتخاب كنيد نام و شرح 
مختصری به سند خود بدهيد. محدوده صفحات را انتخاب كنيد )صفحات خاصی يا كل سند( و تصميم بگيريد 
آيا نمايش دهنده ها صفحات تکی را نمايش دهند يا اسپريدها را. سرانجام، می توانيد گزينه ای را در حالت تأييد 
قرار دهيد كه به بيننده اجازه دانلود سند را به عنوان يک PDF می دهد و اينکه گزينه های به اشتراک گذاری 
و تعبيه برای اشتراک گذاری در دسترس نمايش دهنده خواهد بود. حالا روی برگه Advanced كليک كرده و 
تصوير موردنظر خود را برای استفاده در پيش نمايش يا تصوير جلد انتخاب كنيد. تنظيمات كيفيت تصوير را 
 OK موجود. برای شروع انتشار، روی PDF برای همه تصاوير در سند انتخاب كنيد و همين طور كيفيت دانلود
كليک كنيد. هنگامی كه فايل شما آپلود شد، برای مشاهده آن در مرورگر، روی View Document كليک 
كنيد. هم چنين می توانيد برای كپی كردن يک لينک به فايل، روی Copy كليک كنيد، بنابراين می توانيد 
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آن را با ديگران به اشتراک بگذاريد و می توانيد سند آنلاين را در كانال های رسانه های اجتماعی از قبيل 
Facebook يا Twitter يا از طريق ايميل با كليک كردن روی دكمه های موجود به اشترک  بگذاريد.

شکل 8ـ9ـ انتشار آنلاین سند

9ـ9ـ وارد كردن فایل های اسناد

اگرچه شما می توانيد از InDesign به عنوان واژه پرداز اصلی خود استفاده كنيد، اما اين كار بسيار ناكارآمد است.
در نشر، حداقل پيش نويس اوليه معمولاً در واژه پردازی نظير Microsoft Word نوشته می شود. در صورتی 

كه پيش نويس اوليه را در InDesign تايپ كنيد، غلط گيری آن بسيار وقت گير می شود.
اگرچه پيش نويس خود را در Word ايجاد كرده باشيد يا نه، متن در يک نشريه InDesign وارد می شود 
تا صفحه آرايی و حروف چينی خوبی بر آن اعمال شود. علاوه بر وارد كردن فايل ها در InDesign، می توانيد 
متن را به صفحه آرايی خود بکشيد و از طريق استفاده از Windows Clipbord )كپی و الصاق( می توانيد 

.InDesign فرمت های فايل را به ميزان محدودی وارد كنيد البته نه تحت پشتيبانی مستقيم

برای ممکن ساختن گزينه های به اشتراک گذاری، به كانال های رسانه اجتماعی خود وارد شويد.
توجه
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10ـ9ـ تعیین محل فرمت كردن اسناد

قابليت های ورود InDesign ممکن است شما را اغوا كند مقدار زيادی از فرمت بندی متن خود را خارج از 
اين برنامه انجام دهيد، البته، اين مسئله هميشه پيشنهاد نمی شود.

به دليل اينکه قابليت های فرمت بندی واژه پرداز كاملًا با ويژگی های حروف نگاری InDesign مطابقت ندارد، 
انجام فرمت بندی جامع در واژه پرداز، اغلب بی ارزش است. اين حقيقت ويژه فرمت بندی مبتنی بر صفحه آرايی 
است. مثلًا، چند ستونی و شماره صفحات در سند InDesign نهايی از استاندارد بسيار بالاتری نسبت به 
آنچه كه در واژه پرداز ديگری ايجاد كرده ايد، برخوردار است. روی هم رفته، حتی ويژگی های فرمت بندی در 

واژه پردازهای امروزی چندان به آنچه كه برای نشر واقعی لازم است، نزديک نيست.
اين واقعيت را در نظر داشته باشيد كه برنامه های صفحه آرايی از بيشتر فرمت بندی پيشرفته، از قبيل جداول در طی وارد 
كردن فايل صرف نظر می كنند، ولی اين مسئله در InDesign واقعيت ندارد. شما می توانيد جداول، پانويس ها و حتی 
سبک های پاراگراف خاص خودتان را در Microsoft Word يا در برنامه هايی را كه می توانند فايل هايی كه از 
style های متعددی در آن ها استفاده شده است به فرمت Word يا RTF صادر كنند، توليد كنيد. با وجود اين،  وقت 
زيادی روی چنين فرمت بندی پيچيده ای صرف نمی كنيد، زيرا می خواهيد از ابزارهای پيشرفته تر InDesign استفاده كنيد.
در عوض، از InDesign برای صفحه آرايی خود و فرمت بندی متنی پيچيده )فونت ها، فاصله دو خط كرسی1 

و خط تيره گذاری( استفاده كنيد و از واژه پرداز خود برای انجام اين وظايف استفاده كنيد:
  تنظيم جدول پايه )فرمت بندی عالی را به عهده InDesign بگذاريد(

  پاورقی ها، ويرايش پايه متن، انتساب های سبک پاراگراف )شناسايی تيترها، كپی بدنه و غيره(

  فرمت بندی كاراكتری پايه )بولد، ايتاليک و ديگر فرمت بندی های مفهوم محور(

فرمت بندی واژه پرداز خود را محدود به نوع فرمت بندی كنيد كه درک خواننده را بهبود دهد يا بيانگر مفهومی 
باشد. در چنين فرمت بندی، ممکن است مثلًا از حالت ايتاليک يا بولد برای تأكيد بر كلمه ای استفاده كنيد يا 
از سبک ها برای تنظيم عناوين و نام نويسنده مقاله در اندازه ها و فونت های مختلف استفاده كنيد. اجازه دهيد 

ويراستاران شما بر كلمات تمركز كنند و وظايف ارائه را به صفحه آراهای شما واگذار كنند.
به  متنی  فايل های  تبديل  باشيد،  داشته  آن  انجام  به  نياز  است  ممکن  كه  فايل  آماده سازی  از  نوع  يک 
،Microsoft Word فرمت های  از  فقط   InDesign است.   InDesign پشتيبانی  تحت   فرمت های 
Rich Text Format (RTF) و فقط متن )ASCII( پشتيبانی می كند. اگر از Corel WordPerfect يا 
Apple iWork Pages )يا هر واژه پرداز ديگری( استفاده می كنيد، بايد آن را به يکی از اين فرمت های ديگر 

تبديل كنيد. در صورت امکان، بايد آن را به فرمت RTF يا Microsoft Word ذخيره كنيد.

InDesign هم چنين فايل های InCopy را وارد می كند. InCopy يک برنامه افزودنی از Adobe است كه 
برای ويراستاران، ويراستاران كپی و ساير هنرمندان غير از صفحه آراهاست كه به آن ها اجازه می دهد ويرايش 

متنی پايه فايل های صفحه آرايی را بدون به هم ريختن صفحه آرايی انجام دهند.

Leading ـ1

InDesign از هر دو نگارش doc. و docx. فايل های Microsoft Word پشتيبانی می كند. هم چنين، با 
احتمال بسياری، Adobe از فرمت های فايل بعدی Word نيز كه عرضه می شوند، پشتيبانی خواهد كرد.

نکته
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بديهی است كه چرا شما در بيشتر موارد از فايل های متنی دوری می كنيد، آن ها فرمت بندی ندارند.
 ،InDesign دست به انتخاب می زنيد؟ برای بيشتر كاربران RTF و Word به هر حال، چگونه از بين فرمت های
آن ها يکسان هستند و از همه فرمت بندی موردنظر شما كه می خواهيد به صفحه آرايی های InDesign خود 

بياوريد، پشتيبانی می كنند.
تفاوت واقعی در قابليت واژه پردازی آن هاست. فرمت RTF از ويژگی های كمتری نسبت به Word پشتيبانی 
می كند؛ آنچه كه برای بيشتر افراد مهم است اين است كه فايل RTF نمی تواند اطلاعات رهگيری تغيير را 
داشته باشد، در حالی كه فايل Word می تواند. اگر گردش كار ويرايش شما وابسته به رهگيری تغييرات است، 

از فرمت RTF استفاده نکنيد.

11ـ9ـ حفظ ویژگی های خاص در فایل های متنی

واژه پردازهای امروزی به شما اجازه می دهند كارهای بيشتری از تايپ و ويرايش متن انجام دهيد. هم چنين 
می توانيد كاراكترهای خاص، جداول، سرصفحه ها و پاصفحه ها و عناصر ديگر سند را ايجاد كنيد. بعضی از اين 

ويژگی ها هنگام وارد شدن به يک برنامه نشر كار می كنند، ولی بقيه كار نمی كنند.
InDesign فرمت بندی Word ذيل را وارد می كند:

  تمام حروف بزرگ

  بولد

  فهرست های شماره دار

  رنگ

  تقسيم بندی ستون ها

  فاصله گذاری فشرده/ بسط يافته

  خط زدن كلمات با دو خط

  خطوط زير دوبل

  حروف اول بزرگ در متن ها

  فونت

  پاورقی ها و يادداشت های پايانی

  تورفتگی ها

  متن فهرست مطالب و نمايه

  گرافيک های درونی )اگر به فرمت تحت پشتيبانی InDesign باشند(

  ايتاليک

  رئوس كلی

  شکست های صفحات

  شيوه نامه های پاراگراف و كاراكتر

  اندازه نقطه ای

)InDesign نه InCopy رهگيری بازبينی ها/ خط قرمزها )برای استفاده در  
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  حروف كوچک

  خط زدن حروف و كلمات

  انديس ها و زِبرَوندها

  جداول

  كادرهای متنی

  گزينه های خط زير

  خطوط زير

فرمت های ذيل به طور جزئی پشتيبانی می شوند يا در طی ورود تبديل می گردند:
  متن برجسته

  متن كنده كاری شده

  خط زير كلمات

فرمت های زير پشتيبانی نمی شوند و هر متنی كه از آن ها استفاده كند، به عنوان متن ساده وارد می شود:
  حالت های متمايز

  حروف سايه دار

  جلوه های متنی، از قبيل حالت چشمک زن

فرمت های ذيل پشتيبانی نمی شود و هر متنی كه از آن ها استفاده كند، در طی ورود حذف می شود:
  حاشيه نويسی ها و توضيحات

  متن پنهان )حذف شده در طی ورود(

  شکست های بخش ها

  اقلام OLE/ اشتراكی

  شکست های كلمات در انتهای خطوط

 1ـ11ـ9ـ جداول
واژه پردازها ويراستارهای جدول بسيار توانمندی را توسعه داده اند كه به شما اجازه می دهند اطلاعات جدولی 
برابری می كنند.  برنامه های صفحه گسترده اختصاصی  با  اغلب  را خيلی سريع و آسان فرمت بندی كنيد و 
InDesign می تواند جداول ايجاد شده در Word يا Excel و همين طور جداول موجود در اسناد RTF را 

وارد كند.

 2ـ11ـ9ـ سرصفحه ها و پانویس ها
سرصفحه ها و پانويس ها مسئله صفحه آرايی هستند نه مسئله متن، بنابراين دليلی ندارد كه اين عناصر را در 
برنامه واژه پردازی خود داشته باشيد. به دليل اينکه شماره صفحات برمبنای صفحه آرايی InDesign تغيير 

می كند، نبايد سرصفحه ها و پانويس ها را در سند واژه پرداز انجام دهيد. 
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 3ـ11ـ9ـ پاورقی ها و یادداشت های انتهایی
 InDesign  ،اگر از ويژگی پاورقی يا يادداشت انتهايی واژه پرداز استفاده كرده باشيد و فايل متنی را وارد كنيد
به درستی پاورقی ها را در پايين ستون و يادداشت های انتهايی را در انتهای متن وارد شده قرار می دهد. اعداد 

يا كاراكترهای زِبرَوند شده در يادداشت ها نيز معمولاً به درستی ترجمه می شوند.

 4ـ11ـ9ـ هایپرلینک ها
باشيد،  را در متن خود داشته  اجازه می دهند هايپرلينک ها  به شما   Word از قبيل  امروزی،  واژه پردازهای 
بنابراين هنگام صدور به فرمت های HTML يا PDF، خواننده می تواند روی لينک كليک كند و به صفحه 
وارد  هايپرلينک هايی  چنين  با  را  متنی  فايل های  هنگامی كه  بپرد.   eBook فايل  با  ديگری   PDF يا  وب 
می كنيد، InDesign فرمت بندی بصری و لينک واقعی آن ها را حفظ می كند، هايپرلينک ها معمولاً به رنگ 

داده می شوند. نشان  زيرخط دار  آبی 

 5ـ11ـ9ـ کادرهای متنی و گرافیک های داخلی
واژه پردازهای امروزی معمولاً از گرافيک های داخلی پشتيبانی می  كنند و به شما اجازه می دهند گرافيک را در 
سند واژه پرداز خود وارد كنيد و آن را در متن تعبيه كنيد. مثلًا، Word به شما اجازه وارد كردن گرافيک را 
می دهد و InDesign نيز می تواند گرافيک ها را با متن شما وارد كند، مادامی كه InDesign از فرمت هايشان 
وارد   InDesign در   1 OLE طريق  از  شما  واژه پرداز  سند  در  تعبيه شده  گرافيک های  ولی  كند.  پشتيبانی 

نمی شود، البته اين فناوری اين روزها نادر است و خيلی نگران آن نباشيد.
InDesign از كادرهای متنی درون يک فايل Word به عنوان فريم های متنی مجزا پشتيبانی می كند. اگر 
اين كادرهای متنی Word به بخشی خاص از متن گره خورده باشند به طوری كه با آن متن جريان پيدا  كنند، 

InDesign از آن لينک ها پشتيبانی كرده و به شما اجازه می دهد آن ها را تنظيم كنيد.

 6ـ11ـ9ـ افزودن متن
مهم نيست كه متن از كجا می آيدـ از ذهن شما، از ايميل، از وب، از يک واژه پردازـ می توانيد آن را به سادگی 
در يک سند InDesign وارد كنيد. می توانيد مستقيماً در InDesign متن را تايپ كنيد، آن را الصاق كنيد، 

بکشيد و بيندازيد يا آن را وارد كنيد.
 InDesign با متن داخل فريم ها كار می كند كه می توانيد در ابتدا ايجاد كنيد يا اجازه دهيد InDesign

هنگام وارد كردن متن، آن را برای شما ايجاد كند.

Type 7ـ11ـ9ـ استفاده از ابزار 
شما بدون ابزار Type نمی توانيد كاری با متن انجام دهيد. بعد از انتخاب ابزار Type، می توانيد در بلوک متن 

Object Linking and Embedding ـ1
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 Type موجودی كليک كنيد يا برای ايجاد فريم متنی جديدی، كليک كنيد و بکشيد. حتی می توانيد با ابزار
در هر فريم گرافيکی خالی يا فريم نسبت داده نشده كليک كنيد تا آن را به يک فريم متنی تبديل كنيد.

 Master كليک كنيد )فريم های متنی قرار گرفته در صفحه با صفحه Master نمی توانيد در فريم های متنی
در حال استفاده( و به سادگی شروع به تايپ كنيد. برای انتخاب فريم متنی Master و افزودن متن به آن، 

Shift+Click يا Ctrl+Shift+Click كنيد.
از اين لحظه، برای ورود متن شروع به تايپ كنيد يا متن را از برنامه های ديگر بياوريد. اگر می خواهد متن 
جايبانی1 را اضافه كنيد )متن تصادفی كه مثلًا ممکن است برای امتحان فرمت بندی خود استفاده كنيد(، 
Type>Fill with Placeholder Text را انتخاب كنيد. InDesign متن لاتين جعلی را به فريم متنی اضافه 

می كند تا وقتی كه آن را پر كنيد.
 [Basic Paragraph است  تنظيم شده  آن  برای  را كه  ويژگی سبکی  تايپ كردن متن جديد، هر  هنگام 
[Style می گيرد، يک سبک از پيش تعريف شده در InDesign. می توانيد اين سبک از قبل تعريف شده را 

تغيير دهيد، زيرا می توانيد هر سبکی را ايجاد كنيد.

 8ـ11ـ9ـ الصاق متن
هنگامی كه متن در كليپ بورد Windows قرار دارد و ابزار Type در InDesign فعال است، می توانيد متن 
را در محل مکان نما )نقطه درج متن( الصاق كنيد يا متن متمايز شده را با آن جايگزين كنيد. اگر هيچ فريم 
متنی فعال نيست، InDesign يک فريم متنی مستطيلی برای در برگرفتن متن الصاق شونده ايجاد می كند.

InDesign از فرامين منوی استاندارد و فرامين صفحه كليد برای بريدن و كپی كردن متن در كليپ بورد و 
برای الصاق متن استفاده می كند. از Ctrl+X برای بريدن، Ctrl+C برای كپی كردن و Ctrl+V برای الصاق 

استفاده می شود.
به طور پيش فرض، متن الصاق شونده فرمت بندی خود را حفظ می كند )مثلًا بولد بودن و اندازه فونت(. با وجود 
اين، InDesign به شما اجازه می دهد كنترل كنيد آيا متن الصاق شده فرمت بندی خود را حفظ كند، به اين 

صورت:
  هنگام الصاق متن از InDesign، می توانيد با انتخاب File>Paste without Formatting )يا با فشردن 

Ctrl+Shift+V(، فرمت بندی آن را برداريد.
  هنگام الصاق متن از خارج InDesign، گزينه Paste with Formatting مشابهی داريد و يک گزينه هم 

 Clipboard برای لغو خودكار فرمت بندی داريد. برای فعال كردن حذف خودكار فرمت بندی، به پيشخوان
را   Edit>Preferences>Clipboard Handling( برويد   Preferences محاوره ای  كادر  از   Handling

انتخاب كنيد يا Ctrl+K را فشار دهيد( و دكمه راديويی Text Only را برای تنظيم Paste انتخاب كنيد.
 All برای اطمينان از حفظ فرمت بندی در متن كپی شونده از برنامه های كاربردی ديگر، دكمه راديويی  

Information را در حالت تأييد قرار دهيد.
همچنين هنگام الصاق متن، InDesign به قدر كافی هوشمند است كه بداند فاصله های اضافی را حذف كند يا 
 Adjust Spacing Automatically آن ها را به متن الصاق شونده اضافه كند. می توانيد با عدم انتخاب گزينه
When Cutting and Pasting Words در پيشخوان Type كادر محاوره ای Preferences را غيرفعال كنيد.

Placeholder ـ1
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 9ـ11ـ9ـ کشیدن و انداختن متن
همچنين می توانيد متن انتخابی را از فريم يا سند ديگری بکشيد و در يک فريم متنی در سند جاری بيندازيد. 
اگر در حين كشيدن Alt را فشار داده و نگه داريد، يک كپی از متن انتخابی را می كشيد و متن اصلی جابه جا 

نمی شود.
Story Editor می دهد. برای فعال كردن  InDesign اجازه كشيدن و انداختن را در  به طور پيش فرض، 
برويد   Preferences محاوره ای  كادر  از   Type پيشخوان  به  خود،  صفحه آرايی  در  انداختن  و  كشيدن 
 Enable in Layout را فشار دهيد( و گزينه   Ctrl+K يا  انتخاب كنيد  را   Edit>Preferences>Type(
 Enable in Story Editor را انتخاب كنيد. همچنين می توانيد كشيدن و انداختن را با انتخاب گزينه View

در Story Editor انجام دهيد.
همچنين می توانيد متن را از منابع خارجی به InDesign بکشيد:

  می توانيد آيکن فايل متنی يا فايل واژه پردازی تحت پشتيبانی را مستقيماً از Windows Explorer به 

صفحه InDesign بکشيد.
  می توانيد متن متمايزشده از يک سند ايجادشده با برنامه ديگری )مثلًا، Microsoft Word( را به پنجره 

سند InDesign بکشيد.
 InDesign در هر دو حالت، فريم متنی جديدی ايجاد می شود و همه سبک ها در فايل های منبع نيز به 
آورده می شوند. برخلاف وارد كردن فايل از طريق فرمان Place )كه در ادامه اين واحد كار بيان می شود(، 
هيچ كنترلی بر فرمت بندی چنين ورودی نداريد؛ در عوض، تمام فرمت بندی وارد می شود يا هيچ كدام وارد 

نمی شود كه اين مسئله وابسته به تنظيمات ترجيحات InDesign است.
همانند كپی و الصاق، InDesign به شما اجازه می دهد روی حفظ فرمت بندی متن كشيده شده كنترل داشته باشيد:

  هنگام كشيدن متن در InDesign، برای حذف فرمت بندی متن كليد Shift را فشرده و نگه داريد. سپس 

متن كشيده شده فرمت بندی متن موجود را به خودش می گيرد.
  هنگام كشيدن متن خارج از InDesign، از گزينه Text Only در پيشخوان Clipboard Handling كادر 

محاوره ای Preferences استفاده كنيد تا فرمت بندی كل متن كشيده شده از بين برود.

Place 10ـ11ـ9ـ وارد کردن متن با کادر محاوره ای 
روی  بيشتری  كنترل  دهيد(  فشار  را   Ctrl+D يا  كنيد  انتخاب  را   File>Place(وPlace محاوره ای  كادر 

می دهد. شما  به  متن  كردن  وارد  چگونگی 
متن واردشونده از طريق كادر محاوره ای Place برطبق انتخاب جاری شما قرار می گيرد:

  اگر مکان نما )اشاره گر درج متن( در متن در يک فريم متنی فعال باشد، متن در آن مکان درج می شود.

  اگر فريم متنی انتخاب شده باشد، ولی در متن فريم كليک نشده باشد، متن در فريم وارد شده و جايگزين 

همه متن موجود می شود.
  اگر دو يا چند فريم متنی انتخاب شده باشند، يک آيکن متن بارگذاری شده نمايان می شود.

  اگر هيچ فريم متنی انتخاب نشده باشد، آيکن متن بارگذاری شده به شما اجازه رسم فريم متنی مستطيلی 

برای دربرگرفتن متن، كليک كردن در فريم خالی موجود يا كليک كردن در هر ناحيه خالی در صفحه آرايی 
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شما را برای ايجاد يک فريم متنی می دهد.
برای قرار دادن متن، اين مراحل را دنبال كنيد:

File>Place 1 را انتخاب كنيد يا Ctrl+D را فشار دهيد.
2 فايل های متنی موردنظر خود را برای ورود پيدا كنيد.

3 گزينه های ورود مناسب را برای فايل های متنی تعيين كنيد.
  اگر بخواهيد چگونگی مديريت فرمت بندی فعلی را در فايل مشخص كنيد، گزينه Show Import Options از 

كادر محاوره ای Place را انتخاب كرده و روی Open كليک كنيد. انجام اين كار موجب باز شدن كادر محاوره ای 
Import Options مناسب برای فرمت فايل متنی می شود. برای وارد كردن متن، روی OK كليک كنيد )كادر 
محاوره ای Import Options در ادامه اين واحد كار بررسی می شود(. اگر گزينه Show Import Options را 

انتخاب نکنيد، كليک كردن Open موجب وارد شدن متن با استفاده از تنظيمات پيش فرض می شود. 
  اگر يک فريم متنی يا محدوده ای از متن را انتخاب كرده باشيد و بخواهيد آن را با متن قرارگيرنده جايگزين 

كنيد، گزينه Replace Selected Item را انتخاب كنيد.
  از گزينه Create Static Captions در اينجا صرف نظر می شود، زيرا فقط بر گرافيک ها اعمال می شود كه 

در ادامه اين واحد كار بررسی خواهد شد.
4 اگر قبل از شروع به وارد كردن متن، فريمی را انتخاب نکرده باشيد، با كليک كردن و كشيدن آيکن متن 
بارگذاری شده، محل متن را مشخص كنيد تا يک فريم متنی مستطيلی ايجاد شود يا در يک فريم موجود 

كليک كنيد يا در هر فريم خالی كليک كنيد.
روی  كردن  كليک  و   Ctrl گرفتن  با  يا  محدوده  يک  روی  كردن  كليک  و   Shift گرفتن  با  می توانيد  شما 
تک تک فايل ها، چندين فايل )متن يا گرافيک( را در كادر محاوره ای Place انتخاب كنيد. InDesign به شما 
اجازه قرار دادن هر فايل در يک فريم مجزا را می دهد. كافی است هر فايل يک بار وارد شود، كليک كنيد يا 
Ctrl+Shift را نگه داشته و كليک كنيد تا InDesign را مجبور كنيد همه فايل ها را در صفحه در فريم های 
مجزا قرار دهد. اگر در يک زمان بيش از يک فايل را قرار دهيد، آيکن متن بارگذاری شده، تعداد فايل های 

قرارگيرنده و همين طور پيش نمايشی از هر فايل را نمايش می دهد.
انتخاب كنيد. برای لغو يک فايل خاص در يک ورود  ابزار متفاوتی را  برای لغو كل ورود متن، كافی است 
چندفايلی، هنگام نمايان شدن پيش نمايش كوچک آن فايل، Esc را فشار دهيد )بقيه فايل ها هم چنان برای 

قرار گرفتن در دسترس هستند(.

Microsoft Word و RTF 12ـ9ـ گزینه های ورود برای فایل های

InDesign گزينه های زيادی برای كنترل چگونگی ورود فايل های RTF و Word از طريق كادر محاوره ای 
Place ارائه می دهد. گزينه های متعددی وجود دارد كه واقعاً می توانيد ترجيحات ورود خود را به عنوان يک 

فايل پيش تنظيم برای استفاده تکراری ذخيره كنيد.
شکل 9ـ9 كادر محاوره ای Import Options را برای Microsoft Word نشان می دهد. اين كادر محاوره ای، 

چهار گروه گزينه دارد )گزينه های ورود برای فايل های RTM نيز يکسان است(.
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Microsoft Word Import Options شکل 9ـ9ـ کادر محاوره ای

در بالای اين پيشخوان، منوی بازشوی Preset وجود دارد كه به شما اجازه انتخاب از مجموعه های ذخيره شده ای 
از گزينه های ورود را می دهد. اگر هر يک از گزينه های موجود در اين كادر محاوره ای را تغيير دهيد، منوی 
بازشويی نشان داده می شود ]Custom[، بنابراين می دانيد كه همه تنظيمات پيش تنظيم منتخب برای ورود 
Save Preset، تنظيمات را ذخيره كنيد و  با كليک كردن روی  اين فايل خاص تغيير كرده اند. می توانيد 
می توانيد يک پيش تنظيم را به عنوان رفتار ورود پيش فرض با كليک كردن Set as Default تنظيم كنيد؛ 
انتخاب  اينکه پيش فرض جديدی را  اين تنظيمات برای ورود تمام فايل های Word استفاده می شود، مگر 
كرده باشيد يا تغييراتی در اين كادر محاوره ای داده باشيد. اين ويژگی به شما اجازه می دهد از به كارگيری 

كادر محاوره ای Import Options برای ورودهای روتين خود اجتناب كنيد.
 Table of :كنار بگذاريد Word به شما اجازه می دهد انواع خاصی از متن را از فايل ،Include ،بخش بعدی
Contents Text،وIndex Text،وFootnotes و Endnotes. هر يک از اقلام منتخب وارد می شوند.  وارد 
 InDesign كردن متن فهرست مطالب يا نمايه متداول نيست، زيرا شما معمولاً فهرست مطالب و نمايه ها را در

ايجاد می كنيد.
بخش سوم، Options، فقط يک گزينه دارد: Use Typographer’s. در صورت انتخاب، اين گزينه علائم 
گيومه صفحه كليد )’ و ”( را به علائم گيومه حروف نگاری منحنی شکل تبديل می كند )’ و’، ”و”(. توجه 
داشته باشيد كه InDesign دو خط تيره پشت سرهم را به يک em dash تبديل نمی كند )بعضی برنامه ها 

اين كار را انجام می دهند(.
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بخش چهارم، Formatting، نسبتاً پيچيده است.
 InDesign برای حذف فرمت بندی در طی ورود، به طوری كه متن تازه ای داشته باشيد و بتوانيد سبک های
خودتان را بر آن اعمال كنيد، گزينه Remove Styles and Formatting را از بخش Formatting انتخاب 

كنيد. در صورت انتخاب اين گزينه، دو كنترل اضافی در دسترس قرار می گيرند:
  Preserve Local Overrides: انتخاب اين گزينه فرمت بندی محلی از قبيل ايتاليک و بولد بودن را 

در حين صرف نظر از ويژگی های سبک پاراگراف حفظ می كند. شما معمولاً اين گزينه را انتخاب می كنيد تا 
فرمت بندی وابسته به معنا حفظ شود.

  Convert Tables To: می توانيد از اين منوی بازشو برای انتخاب چگونگی عدم فرمت بندی جداول در 

طی ورود استفاده كنيد. آيتم منوی Unformatted Tables ساختار خانه جدول را حفظ می كند، ولی از 
فرمت بندی متن و خانه صرف نظر می كند، در حالی كه آيتم منوی Unformatted Tabbed Text جدول را 
به متن Tab دار تبديل می كند )با جداسازی Tab آنچه كه برای خانه ها و پاراگراف و هم چنين برای رديف ها 
استفاده می شود( و همه فرمت بندی را از بين می برد. اگر  قصد داريد جداول را به صورت جدول نگه داريد ولی 

آن ها را در InDesign فرمت بندی كنيد، Unformatted Tables را انتخاب كنيد.
برای حفظ فرمت بندی متن در طی ورود، به طوری كه سند InDesign حداقل استفاده از تنظيمات انجام 
شده در Word را شروع كند، گزينه Preserve Styles and Formatting from Text and Tables را 
انتخاب كنيد. دو دليل برای انتخاب اين گزينه وجود دارد. متداول ترين دليل اين است كه شما از شيوه نامه ها 
در Word با نام های مشابه در InDesign استفاده می كنيد. انجام اين كار، مانع از اعمال دستی شيوه های 
ويراستاری  هنگام  )ويراستاران  می شود  شما  طراحان  توسط  صفحه آرايی ها  روی  كردن  كار  هنگام  صحيح 
معمولاً در Word كار می كنند(. دليل ديگر اين است كه فايل Word شما واقعاً يک قالب ابتدايی از فايل 
InDesign نهايی شماست، بنابراين شما بايد تمام تلاش خود در Word را حفظ كنيد و از آن به عنوان پايه 

و اساسی برای پالايش در InDesign استفاده كنيد.
گزينه Preserve Styles and Formating from Text and Tables چند كنترل دارد: 

 Word اين منوی بازشو به شما اجازه می دهد شکست های صفحه وارد شده در :Manual Page Breaks  

را حفظ كنيد، آن ها را به شکست های ستون تبديل كنيد يا آن ها را حذف كنيد. گزينه شکست انتخابی شما 
وابسته به چگونگی سازمان دهی صفحه آرايی شما در مقايسه با صفحه آرايی فايل Word است.

  Import Inline Graphics: اين گزينه، در صورت انتخاب، تصاوير قرار گرفته در متن Word را وارد 

می كند.
 InDesign را در Word اين گزينه، در صورت انتخاب، تمام شيوه نامه های :Import Unused Styles  

بارگذاری می كند، به جای اينکه فقط آن هايی را وارد كند كه واقعاً در متن فايل به كار گرفته ايد. شما به طور 
عادی نمی خواهيد تمام شيوه های Word را وارد كنيد، زيرا اين برنامه صدها شيوه از پيش تعريف شده دارد 

كه می توانند پنل های Paragraph Styles و Character Styles برنامه InDesign را مسدود كنند.
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  Track Changes: اين گزينه، در صورت انتخاب، تمام تغييرات رهگيری شده توسط Word را ذخيره 

كرده و آن را در دسترس كاربران InCopy و InDesign قرار می دهد كه روی فايل InDesign كار می كنند.
فهرست های  تمام  انتخاب،  صورت  در  گزينه،  اين   :Convert Bullets & Numbers to Text   

شماره گذاری و بولت گذاری خودكار در Word را حذف می كند و بولت ها و شماره ها را به كاراكترهای واقعی 
تبديل می كند. اگر اين گزينه را انتخاب كنيد و آيتمی را در يک ليست شماره گذاری شده وارد شده درج 

نمی شود. شماره گذاری  دوباره  خودكار  به طور  ليست  اين  كنيد، 
مشابه  نام  با  شيوه هايی   Word فايل  كه  دهد  تشخيص   InDesign اگر   :Style Name Conflicts   

شيوه های موجود در سند InDesign شما دارد، از تعداد نام شيوه های تکراری كه می يابد در برچسب سمت 
راست Style Name Conflicts يادداشت برمی دارد. بنابراين شما دو روش برای مديريت اين تضادها داريد، 

با منوهای بازشوی مجزا برای شيوه های پاراگراف و شيوه های كاراكتری.
  اگر گزينه Import Styles Automatically را انتخاب كنيد، سه گزينه برای شيوه های پاراگراف و كاراكتر 

 Character Style و Paragraph Style Conflicts( دريافت می كنيد، البته با استفاده از دو منوی بازشوی مجزا
Conflicts(. آيتم منوی Use InDesign Style Definition شيوه های جاری InDesign را حفظ می كند 
و آن ها را بر تمام متن Word اعمال می كند كه از شيوه نامه ای با نام مشابه استفاده می كند. اين رايج ترين 
گزينه است، زيرا به ويراستاران شما اجازه می دهد نشان دهند چه شيوه هايی در InDesign استفاده شده اند، 

ولی متکی به تنظيمات حروف نگاری دقيق تر InDesign هستند.
  اگر آيتم منوی Redefine InDesign Style را انتخاب كنيد، فرمت بندی شيوه نامه Word به طور دائمی 

جايگزين شيوه نامه های InDesign می شود. اگر آيتم منوی Auto Rename را انتخاب كنيد، نام شيوه نامه 
امر  اين  Character Styles اضافه می شود.  يا   Paragraph Styles Word تغيير می كند و به پنل  فايل 
شيوه های موجود InDesign شما را حفظ می كند، در حالی كه شيوه نامه های وارد شده از فايل Word را نيز 

حفظ می كند.
بگيريد كه كدام شيوه های  انتخاب كنيد، می توانيد تصميم  را   Customize Style Import اگر گزينه    

 InDesign شيوه های ،Word با نام مشابه را لغو كنند و كدام شيوه های Word شيوه های ،InDesign خاص
با نام مشابه را لغو كنند و نام كدام شيوه های Word در طی ورود تغيير كند تا از هر گونه لغوی جلوگيری 
 Style كه در شکل 10ـ9 نشان داده شده است، روی Style Mapping شود. برای باز كردن كادر محاوره ای
Mapping كليک كنيد. تصميمات بيان شده را در اين كادر محاوره ای می گيريد. هم چنين می توانيد روی 
Auto�rename Conflicts در آن كادر محاوره ای كليک كنيد تا نام تمام شيوه های Word دارای تضاد به 
 Import در منوهای بازشوی Auto Rename نام های جديدی تغيير كند )انتخاب اين گزينه شبيه انتخاب

Styles Automatically است(.
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Style Mapping شکل 10ـ9ـ کادر محاوره ای

 13ـ9ـ گزینه های ورود برای فایل های فقط متنی

گزينه های فايل های فقط متنی )ASCII( خيلی ساده تر هستند، همان گونه كه شکل 11ـ9 نشان می دهد:

شکل 11ـ9ـ سمت چپ: کادر محاوره ای Text Import Options برای فایل فقط متنی
Microsoft Excel Import Options سمت راست: کادر محاوره ای

  منوی بازشوی Character Set: اين منو به شما اجازه می دهد نوع رمزگذاری فايل متن را تغيير دهيد. اين 

 Central ، Chinese، European منو 33 گزينه دارد كه عمدتاً برای زبان های مختلف و گروه های زبانی از قبيل
Baltic، Turkish ، Greek و Japanese هستند. در بيشتر موارد، شما اين منو را در حالت پيش فرض ANSI يا 
يکی از فرمت های UTF رها می كنيد. تنها در صورتی كه می دانيد فايل با چيز ديگری رمزگذاری شده است، 

گزينه ديگری را انتخاب كنيد.
  منوی بازشوی Platform: اين منو به شما اجازه می دهد تا از بين Macintosh و Windows دست به 

انتخاب بزنيد. هر كدام كه برای فايل منبع مناسب است، انتخاب كنيد. 
  منوی بازشوی Set Dictionary To: اين منو به شما اجازه می دهد هجی پيش فرض و زبان فرهنگ 
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لغات را نسبت دهيد. می توانيد اين گزينه را در حالت پيش فرض رها كنيد، مگر اينکه روی چند زبان يا منطقه 
كار می كنيد. اين گزينه وابسته به زبانی است كه هنگام نصب InDesign انتخاب كرده ايد.

كنترل  را  مديريت سرخط ها  می توانيد چگونگی  بخش،  اين  در   :Extra Carriage Returns بخش    

 Remove at End of Every كنيد. در صورتی كه فايل منبع يک سرخط در انتهای هر خط دارد، گزينه
Line را انتخاب كنيد )اين مورد اغلب نتيجه كپی كردن متن از وب يا از يک فايل PDF است(. چنانچه فايل 
 Remove Between منبع از دو سرخط سخت برای نشان دادن پاراگراف های جديد استفاده می كند، گزينه
Paragraphs را انتخاب كنيد. می توانيد هيچ كدام، يکی يا دوتا را كه مناسب فايل منبع شما هستند، انتخاب كنيد.
  بخش Formatting: در اين بخش، می توانيد گزينه Replace را انتخاب كنيد تا چندين فاصله پی در پی 

تبديل به يک Tab شود )می توانيد تعداد حداقل فاصله ها را در فيلد مربوطه مشخص كنيد(.
هم چنين می توانيد گزينه Use Typographer’s Quotes را برای تبديل علائم گيومه صفحه كليد به علائم 

گيومه حروف نگاری انتخاب كنيد. اين گزينه به طور عادی انتخاب شده است.

InCopy 1ـ13ـ9ـ فایل های 
هنگام وارد كردن فايل های InCopy هيچ گزينه ای وجود ندارد. به دليل اينکه آن ها حاوی فرمت بندی اعمال 

شده به عنوان بخشی از يک چيدمان InDesign هستند، InDesign آن ها را به همان صورت وارد می كند.

Microsoft Excel 14ـ9ـ گزینه های ورود برای فایل های

هنگام وارد كردن صفحات گسترده Microsoft Excel، گزينه های متعددی داريد، همان گونه كه در شکل 
11ـ9 نشان داده شد. در بخش Options، می توانيد تنظيمات ذيل را كنترل كنيد:

  منوی بازشوی Sheet: می توانيد مشخص كنيد كدام برگه را در يک كارپوشه وارد می كنيد. پيش فرض، 

Sheet1 ناميده می شود مگر اينکه شما نام آن را در Excel تغيير داده باشيد  اولين برگه است كه معمولاً 
)اگر می خواهيد چندين برگه را وارد كنيد، بايد چندين مرتبه صفحه گسترده يکسانی را وارد كنيد و هر بار 

برگه متفاوتی را انتخاب كنيد(.
  منوی بازشوی View: می توانيد نماهای سفارشی را كه در Excel برای آن صفحه گسترده تعريف كرده ايد، 

وارد كنيد. اگر سند Excel دو نمای سفارشی دارد، می توانيد با انتخاب ]Ignore View[ از منوی بازشو، از 
نماهای سفارشی صرف نظر كنيد. اگر هيچ نمای سفارشی نداريد، اين منوی بازشو غيرفعال خواهد بود.

 Excel می توانيد محدوده خانه های استفاده كننده از نمادگذاری استاندارد :Cell Range منوی بازشوی  

يعنی Sx:Ey را مشخص كنيد كه S اولين رديف، x اولين ستون، E آخرين رديف و y آخرين ستون هستند، 
از قبيل A1:G89. می توانيد محدوده را مستقيماً در منوی بازشو تايپ كنيد كه به عنوان يک فيلد ورود متن 

نيز عمل می كند يا می توانيد از محدوده وارد شده قبلی از منوی بازشو انتخاب كنيد.
  Import Hidden Cells Not Saved in View: با انتخاب اين گزينه، تمام خانه های پنهان نيز وارد 

می شوند. هنگام انجام اين كار، مواظب باشيد، زيرا معمولاً به دليلی پنهان شده اند )معمولاً، آن ها منابع داده 
بی اهميت يا محاسبات ميانی را نشان می دهند(.
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در بخش Formatting، می توانيد اين تنظيمات را كنترل كنيد:
را  كه صفحه گسترده  می كنيد  انتخاب  را   Formatted Table منوی  آيتم  Table: شما  بازشوی  منوی    

به عنوان جدول وارد می كند و فرمت بندی متن و خانه را حفظ می كند؛ آيتم منوی Unformatted Table كه 
 Unformatted صفحه گسترده را به عنوان جدول وارد می كند، ولی فرمت بندی را حفظ نمی كند؛ يا آيتم منوی
Table Text كه صفحه گسترده را به عنوان متن Tab دار وارد می كند )Tab خانه ها و پاراگراف ها، رديف ها 

را از هم جدا می كنند( و هيچ فرمت بندی را حفظ نمی كند.
  منوی بازشوی Table Styles: در اينجا، می توانيد يک شيوه جدولی InDesign را برای اعمال بر جدول 

.)]No Table Style[ وارد شده انتخاب كنيد يا آن را تنها رها كنيد )با انتخاب
  منوی بازشوی Cell Alignment: می توانيد به InDesign بگوييد چگونه متن را در خانه ها تراز كند. 

انتخاب  با  يا  را حفظ كنيد  فعلی صفحه گسترده  ترازبندی   ،Current Spreadsheet انتخاب  با  می توانيد 
Left، Right يا Center، آن ها را لغو كنيد.

  Include Inline Graphics: اين گزينه، در صورت انتخاب، به شما امکان وارد كردن هر گرافيک قرار 

گرفته در خانه های Excel را می دهد.
تايپ  را  اعداد  برای  اعشار  ارقام  تعداد  فيلد،  اين  در   :Number of Decimal Places to Include   

مقدار   InDesign هستند،   n مقدار  حاوی  كه  خانه هايی  و  كنيد  تايپ  را   4 فيلد  اين  در  اگر  مثلًا،  كنيد. 
نمايش می دهد  را  اعشار  تا 10 رقم   Excel اگرچه صفحه گسترده  وارد می كند، حتی  را   3.1415 عددی 
(3.1415926535). توجه داشته باشيد كه InDesign هيچ فرمولی را وارد نمی كند و فقط نتايج متنی يا 

وارد می كند. را  آن ها  عددی 
  Use Typographer’s Quotes: اين گزينه را برای تبديل علائم گيومه صفحه كليد به علائم گيومه 

حروف نگاری انتخاب كنيد. اين گزينه به طور عادی انتخاب شده است.

Tagged Text 15ـ9ـ گزینه های ورود برای فایل های

InDesign يک فرمت فايل متنی مخصوص به خود را ارائه می دهد: Adobe InDesign Tagged Text.و
Tagged Text واقعاً متن ASCII )فقط متن( است كه حاوی كدهای تعبيه شده برای گفتن اين مسئله به 
InDesign است كه از كدام فرمت بندی استفاده كند. شما اين كدها را تعبيه می كنيد كه شبيه ماكروهاست، 

هنگامی كه فايل ها را در واژه پرداز خود ايجاد می كنيد.
كادر  در  را   Show Import Options انتخاب  كادر  Tagged Text، چنانچه  فايل های  وارد كردن  هنگام 

داريد: تعدادی گزينه  قرار دهيد،  تأييد  Place در حالت  محاوره ای 
حروف نگاری  گيومه های  به  كليد  صفحه  گيومه های  تبديل  برای   :Use Typographer’s Quotes   

می شود. استفاده 
  Remove Text Formatting: در صورت انتخاب، همه فرمت بندی متن از جمله شيوه ها از متن حذف 

می شوند.
 Tagged يا Publication Definiition ،در اين منوی بازشو :Remove Style Conflicts Using  

Text Definition را انتخاب كنيد. اولی، فرمت بندی شيوه سند را بر همه متن وارد شده كه از شيوه ها با 
نام های مشابه استفاده می كند، اعمال می كند و فرمت بندی ذخيره شده با فايل Tagged Text را لغو می كند؛ 
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دومی تعاريف شيوه فايل Tagged Text را بر همه متن وارد شده اعمال می كند كه از شيوه هايی با اسامی 
مشابه استفاده می كنند و فرمت بندی مشخص شده در سند را لغو می كند.

  Show List of Problem Tags Before Place: اين گزينه، در صورت انتخاب، يک كادر محاوره ای 

را نمايش می دهد كه همه شيوه نامه ها را در فايل وارد شده كه نام آن ها با اسامی موجود در سند تضاد دارد، 
فهرست می كند.

16ـ9ـ وارد كردن گرافیک

شما می توانيد به روش های مختلف، انواع تصاوير گرافيکی را در اسناد InDesign وارد كنيد. InDesign به طور 
ويژه تصاوير گرافيکی ايجاد شده به فرمت های محبوب را می پذيرد و از طريق كليپ بورد )كپی و الصاق( می توانيد 

فرمت های فايل را وارد كنيد )البته تا اندازه محدودی( كه InDesign مستقيماً از آن ها پشتيبانی نمی كند.
 InDesign دارای ويژگی های گرافيکی تعبيه شده است، ممکن است اغوا شويد كه از InDesign به دليل اينکه
به عنوان برنامه گرافيکی خود استفاده كنيد، اين كار را نکنيد. ابزارهای InDesign برای بعضی كارها عالی 
ولی  ـ  اشکالی كه متن دور آن ها می پيچد، حاشيه ها و همين طور شيب های رنگ  ايجاد  از جمله  هستند، 
InDesign كلًا در خلق گرافيک حرفه ای نيست. در واقع، ويژگی های حرفه ای گرافيکی نرم افزارهايی مانند 

Adobe Illustrator و Phoroshop مکمل InDesign در صفحه آرايی هستند.
InDesign به ويژه برای تصاوير نقش بيتی از قبيل فايل های اسکن شده و عکس ها، قابليت هايی برای اعمال 
جلوه های ويژه يا در غير اين صورت دستکاری محتوای تصوير دارد، بنابراين شما بايد قبل از وارد كردن فايل 
در InDesign، كارهای لازم را در ويرايشگر تصوير خود انجام دهيد. مثلًا، می توانيد اندازه تصوير وارد شده 
در InDesign را تغيير دهيد، دور آن را ببريد، آن را بچرخانيد يا آن را كج كنيد، ولی نمی توانيد آن را از يک 

تصوير كاملًا رنگی به duotone تبديل كنيد يا روشنايی يا تباين آن را تغيير دهيد.
نتيجه اينکه، از برنامه گرافيکی خود برای ايجاد و ويرايش عکس ها و تصاوير اصلی استفاده كنيد. از ويژگی های 

گرافيکی InDesign برای تزيين صفحه آرايی خود استفاده كنيد و نه ايجاد اثر هنری اصل.
 InDesign به شما اجازه باز كردن يک برنامه گرافيکی را برای ويرايش تصاوير قرار گرفته از درون InDesign
Alt را فشار  يا می توانيد  Edit>Edit Original را برگزينيد  انتخاب كنيد و  را  می دهد. می توانيد تصاوير 
داده و نگه داريد و سپس روی تصاوير دابل كليک كنيد. InDesign برنامه هايی را اجرا می كند كه گرافيک ها 
را ايجاد كرده اند؛ اگر اين برنامه ها را نداشته باشيد، InDesign برنامه های سازگار را اجرا می كند، البته اگر 
آن ها را داشته باشيد. مثلًا، اگر كليد Alt را نگه داشته و روی يک فايل EPS در صفحه آرايی خود دابل كليک 
كنيد كه در Adobe Illustrator ايجاد شده است، ولی شما در عوض CorelDraw داريد، InDesign،و

CorelDraw را روی سيستم شما اجرا می كند.
InDesign به شما اجازه می دهد كه مشخص كنيد از كدام برنامه می خواهيد برای ويرايش گرافيک استفاده 
 Edit>Edit آن را برای شما انتخاب می كند. اين كار با انتخاب گرافيک و سپس انتخاب InDesign كنيد و
with انجام می شود. زيرمنويی كه نمايان می شود، تمام برنامه هايی را فهرست می كند كه InDesign فکر 
می كند می توانند گرافيک را ويرايش كنند، يکی را انتخاب كنيد يا Others را برای مرور رايانه برای برنامه ای 

متفاوت برگزينيد.
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 1ـ16ـ9ـ آماده سازی فایل های گرافیکی
InDesign از تعدادی فرمت فايل گرافيکی اصلی پشتيبانی می كند. بعضی از فرمت ها برای انواع خاصی از 

وظايف مناسب تر از بقيه هستند. قوانين پايه برای ايجاد فايل های گرافيکی عبارت اند از:
،(WMF) Windows Metafileو،EPS، PDF،Adobe Illustrator قبيل  از  فرمتی  به  را  خطی  هنر    

Enhanced Metafile (EMF) يا PICT ذخيره كنيد )اين فرمت های شیء گرا فرمت های برداری ناميده 
هستند(.  مختلف  اشيای  رسم  چگونگی  مورد  در  دستورعمل هايی  از  متشکل  برداری  فايل های  می شوند. 

بهتر كار می كند.  Illustrator فايل های  وPDF و   EPS با   InDesign
PNG، Adobe Photoshop،TIFF، قبيل از  فرمتی  به  را  اسکن ها(  و  )عکس ها  نقش بيتی ها    

 PICT يا (SCT) Scitex Continuous Toneو،(BMP) Windows Bitmap، GIFو، PCX ، JPEG 
ذخيره كنيد )اين فرمت های پيکسلی، نقش بيتی يا فرمت های پويشی ناميده می شوند. آن ها متشکل از مجموعه ای 
از نقاط يا پيکسل ها هستند كه تصوير را می سازند(. InDesign با TIFF و فايل های Photoshop بهتر كار 

می كند.
توجه داشته باشيد كه فايل های PICT می توانند بسته به تصوير اصلی و برنامه ای كه در آن ايجاد يا  صادر 
شده اند، به فرمت برداری يا نقش بيتی باشند. اگر يک تصوير PICT را بزرگ كنيد و شروع به بلوک  بلوک 
شدن كرد، يک نقش بيتی است. به طور مشابه، فايل های EPS و PDF می توانند حاوی تصاوير نقش بيتی و 

باشند. برداری 
يک سند  ورود  هنگام  گرافيک هستند؛  كه  گويی  كند،  وارد  را   InDesign فايل های  می تواند   InDesign
چند صفحه ای، صفحه موردنظر برای ورود را انتخاب می كنيد، همان گونه كه در مورد فايل های PDF انجام 
می دهيد. توجه داشته باشيد كه فايل های InDesign كه به عنوان گرافيک وارد می شوند نمی توانند مستقيماً 
در صفحه آرايی InDesign كه در آن قرار گرفته اند، ويرايش شوند؛ بايد در عوض فايل اصلی در پنجره ای 

مجزا به روزرسانی شود.
پيشنهاد می كنيم فرمت های EPS و TIFF را استاندارد خود كنيد، زيرا اين فرمت ها، فرمت های گرافيکی 
می توانيد  می كنيد،  كار   Adobe نرم افزارهای  با  انحصاراً  شما  دفتر  و  شما  اگر  هستند.  نشر  در  استاندارد 
و    Illustrator )فرمت های  اضافه كنيد  آميخته  اين  به  را   Photoshop و   Illustratorو،PDF فرمت های 
PDF گونه هايی از EPS هستند(. اگر از شفافيت در گرافيک خود استفاده كرده ايد، بهتر است آن ها را به 
 )TIFF و EPS ذخيره كنيد، زيرا فرمت های ديگر )به ويژه  PDF يا Illustratorو،Photoshop فرمت های
بيشتر داده های لايه بندی شفافيت را حذف می كنند كه اين امر به تصويرنگار كمک می كند تا اين فايل های 

شفاف را به طور بهينه دوباره توليد كند.

 2ـ16ـ9ـ گرافیک های تعبیه شده در فایل های متنی
واژه پردازهای امروزی معمولاً از گرافيک درونی پشتيبانی می كنند و به شما اجازه وارد كردن گرافيک موجود 
در سند واژه پرداز و تعبيه آن در متن را می دهند. مثلًا، Word، به شما اجازه وارد كردن گرافيک را می دهد 
و InDesign هم می تواند گرافيک ها را با متن شما وارد كند. به هر حال، گرافيک های تعبيه شده در سند 
به ندرت  امروزه  فناوری  اين  وارد نمی شوند.   InDesign به   Windows OLE در  از طريق  واژه پرداز شما 
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استفاده می شود، بنابراين در كار كردن با فايل های متنی قديمی ممکن است دچار مشکل شويد.
گرافيک های درونی به عنوان تصاوير پيش نمايشی خود وارد می شوند و نه به عنوان فايل های اصلی. اين بدان 
معنی است كه در بيشتر موارد، موارد تصويری با وضوح كمتری را در صفحه آرايی InDesign خود داريد. 
علی رغم اين محدوديت ها، استفاده از تصاوير درونی در واژه پرداز شما زمانی می تواند مفيد باشد كه يک سند 
 InDesign را سرهم می كنيد: از گرافيک های درونی كه پيش نمايش های آن ها به عنوان جايبان ها در InDesign
وارد می شوند، استفاده كنيد، به طوری كه صفحه آرا بداند شما گرافيک ها را تعبيه كرده ايد. سپس، صفحه آرا می تواند 

پيش نمايش را با گرافيک های اصلی با كيفيت بهتر جايگزين كند.
InDesign فرمت های فايلی متعددی را وارد می كند. اگر فرمت برنامه گرافيکی شما، يکی از موارد فهرست 
شده در اينجا نيست، می توانيد آن را به عنوان يکی از اين فرمت ها ذخيره يا صادر كنيد. در فهرست ذيل، متن 

در حالت تک فونتی است و پرانتزها انشعاب نام فايل رايج برای اين فايل ها هستند.
فرمت های فايل گرافيکی كه InDesign وارد می كند، عبارت اند از:

.)dib، .bmp)Windows فرمت نقش بيتی طبيعی :BMP  

 DCS كه مورد علاقه ناشران حرفه ای است. گونه ای از آن Encapsulated PostScript فرمت فايل :EPS  

.).dcsو،.eps( است Desktop Color Separation ناميده می شود، گونه ای با رنگ های مجزا كه نام كامل آن
.(.gif) كه در اسناد وب رايج است Graphics Interchange Format :GIF  

(.ai). EPS شبيه Adobe Illustrator فرمت طبيعی در :Illustrator  

  InDesign: شما می توانيد اسناد InDesign ديگر را وارد كنيد، گويی كه گرافيک هستند؛ شما حتی 

.(.indd) می توانيد مشخص كنيد كدام صفحات وارد شوند، گويی كه گرافيک های مجزا هستند
استفاده  وب  در  اغلب  كه   Joint Photographic Expert Group فشرده  نقش بيتی  فرمت   :JPEG   

.).jpegو،.jpg( می شود 
  PCX: فرمت PC Paintbrush كه در برنامه های DOS و نگارش های اوليه Windows بسيار محبوب 

.).rleو،.pcx( بود؛ فرمت های ديگر در حال حاضر جانشين پيدا كرده اند
  Portable Document Format :PDF كه گونه ای از PostScript )يا EPS( است و برای اسناد تحت 

.(.pdf) استفاده می شود CD وب، شبکه و
  Photoshop: فرمت طبيعی Adobe Photoshop .(psd.) توجه داشته باشيد كه InDesign نمی تواند 

فايل های فرمت photoshop RAW (raw.) را وارد كند.
  PICT: مخفف Picture، فرمت گرافيک عادی mac كه كمتر در اسناد حرفه ای استفاده می شود و حتی 

.(.pct) برای كليپ آرت های ارزان هم نادر شده است
  PNG: فرمت Portable Network Graphics كه به عنوان جايگزين توانمندی برای GIF معرفی شده 

.(.png) است
.(.ct) استفاده می شود Scitex فرمت نقش بيتی با تنُ پيوسته كه در سيستم های قبل از چاپ :Scitex CT  

  Tagged Image File Format :TIFE كه يک استاندارد نقش بيتی برای ناشران و ويرايشگرهای تصوير 

.).tiff يا .tif( حرفه ای است
.).wmf، .emf( كه كمتر در اسناد حرفه ای استفاده می شود Windows فرمت طبيعی :Windows Metafile  
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InDesign از فرمت های تا حد محبوب پشتيبانی نمی كند، از جمله:
(DXF) AutoCAD Document Exchange Format  

(CGM) Computer Graphics Metafile  

CorelDraw  

Eastman kodak’s Photo CD  

(SVG) Scalable Vector Graphics  

 CorelDraw ،فرمت های برداری هستند كه عمدتاً در مهندسی و معماری استفاده می شوند CGM و DXF
فرمت طبيعی از برنامه تصويرسازی تحت Windows مصرف كننده محور پيشتاز است، Photo CD فرمت 
نقش بيتی است كه برای عکس های توزيع شونده به صورت الکترونيکی استفاده می شود و SVG فرمت تحت 

وبی برای گرافيک های برداری غنی است.

 3ـ16ـ9ـ مشکلات موجود در فایل های برداری
تصاوير برداری پيچيده هستند، زيرا آن ها می توانند چندين عنصر را تركيب كنند )منحنی ها، خطوط، رنگ ها، 
فونت ها، تصاوير نقش بيتی و حتی تصاوير برداری وارد شده ديگر(. اين بدان معنی است كه شما از روی عدم 
آشنايی، فايلی را ايجاد می كنيد كه ممکن است موجب مشکلاتی شود. اين مشکلات هنگامی به وجود می آيند 
كه سعی در گرفتن خروجی از فايل صفحه آرايی InDesign استفاده كننده از آن داريد. بنابراين، هنگام كار با 

فرمت های برداری، بايد چندين معضل را در ذهن داشته باشيد.

 4ـ16ـ9ـ فونت های تعبیه شده
هنگام استفاده از فونت ها در متن موجود در فايل های گرافيکی، معمولاً گزينه ای برای تبديل متن به منحنی 
)گرافيک( داريد. اين گزينه اطمينان می دهد كه متن شما روی هر چاپگری چاپ می شود )اگر از اين تبديل 
استفاده نمی كنيد، مطمئن شويد كه چاپگر شما يا دفتر خدماتی فونت های مورد استفاده در گرافيک را دارند. در 
غير اين صورت، متن با فونت صحيح چاپ نمی شود؛ در عوض احتمالاً با Courier يا Helvetica چاپ می شود(.

اگر گرافيک شما متن زيادی دارد، متن را به منحنی ها تبديل نکنيد، تصوير بسيار پيچيده می شود و چاپ آن 
خيلی كُند انجام می شود. در اين مورد، مطمئن شويد دستگاه خروجی دارای همان فونت های گرافيک شما هست.

PDF و Illustrator ،DCS ،EPS :PostScript 5ـ16ـ9ـ فایل های 
فايل های مبتنی بر PostScript چندين گونه هستندـ EPS،وDCS،وIllustrator و PDFـ و به دليل اينکه 

اين فرمت، فرمت پيچيده ای است، معضلات بيشتری نسبت به مسئله فونت دارد.

 PDF و Illustrator، Photoshop وارد می شوند كه تصاوير InDesign رنگ های موضعی هنگامی به
را در InDesign قرار می دهيد و همين طور اسناد InDesign كه به عنوان گرافيک وارد می شوند.

نکته
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 EPS 

گرفتاری معمول فايل های EPS هدر پيش نمايش است. پيش نمايش يک كپی قابل نمايش از فايل EPS است. 
به دليل اينکه فايل های EPS واقعاً از مجموعه ای از فرامين تشکيل شده اند كه نحوه رسم تصوير را به چاپگر 
می گويند، آنچه كه روی صفحه نمايش می بينيد، گرافيک واقعی نيست. بيشتر برنامه ها تصوير پيش نمايشی را 
برای فايل های EPS ايجاد می كنند، ولی بسياری از برنامه ها در خواندن آن ها مشکل دارند، به ويژه اگر فايل 
EPS در پلت فرم متفاوتی توليد شده باشد. در اين موارد، آن ها يک X يا يک كادر خاكستری را به جای تصوير 
نمايش می دهند )فايل EPS به درستی روی يک چاپگر PostScript چاپ می شود(. به اين دليل است كه چرا 
InDesign هنگام وارد كردن فايل های EPS، تصوير پيش نمايش خاص خودش را ايجاد می كند و احتمال 

قرار گرفتن X يا كادر خاكستری به جای پيش نمايش EPS را كاهش می دهد.
هنگامی كه فايل های EPS را وارد می كنيد، InDesign به شما اجازه می دهد روی بعضی از تنظيمات كنترل 
باشيد،  انتخاب كرده   Place را در كادر محاوره ای   Show Import Options البته چنانچه  باشيد،  داشته 
می توانيد مسيرهای برش Photoshop را در فايل اعمال كنيد، فرمت پيش نمايش را انتخاب كنيد، اطلاعات 
يا  پويشی سازی1 گفته می شود(  فرايند،  اين  به  تبديل كنيد )كه  به يک نقش بيتی  را   PostScript برداری 

لينک ها را به تصاوير منبع با وضوح بالای OPT تعبيه كنيد.

 DCS 

گونه DCS از EPS مجموعه ای از پنج فايل است: يک فايل پيش نمايش EPS كه چهار فايل مجزا را به هم 
لينک می كند )يکی برای فيروزه ای، يکی برای بنفش، يکی برای زرد و يکی برای سياه(. استفاده از اين فرمت، 
جداسازی صحيح رنگ ها را هنگام گرفتن خروجی نگاتيو برای استفاده از چاپ تجاری تضمين می كند. دفاتر 
خدماتی كه تصحيح رنگ را انجام می دهند، اغلب اين فايل ها را نسبت به فايل های EPS استاندارد ترجيح 
می دهند. يک گونه از فرمت فايل DCS،وDCS 2.0 است كه آن هم از پليت های رنگی موضعی علاوه بر 

پليت های استاندارد برای فيروزه ای، سرخابی، زرد و مشکی پشتيبانی می كند.
چنانچه قصد داريد فايل های تأييد تركيبی با جداسازی های in�RIP را از InDesign ايجاد كنيد، نبايد از 
DCS استفاده كنيد. InDesign از فايل های جداسازی DCS صرف نظر می كند و فقط از فايل پيش نمايش 

برای خروجی استفاده می كند )RIP مخفف پردازنده تصوير پويشی است(.

 Illustrator 

فايل های Adobe Illustrator خيلی شبيه فايل های EPS هستند به استثنای اينکه آن ها هدر پيش نمايش 
 Illustrator ندارند و از تنظيمات شفافيت در گرافيک بهتر پشتيبانی می كنند. هيچ نگرانی خاصی برای فايل های
وجود ندارد، فقط مطمئن شويد كه به مسائل فونت و رنگ كه قبلًا در اين بخش بيان شد، توجه كرده ايد. 
همان گونه كه بعداً در اين واحدكار بيان می شود، InDesign می تواند بين لايه ها در فايل Illustrator تمايز قائل 

شود كه اين امر به شما اجازه می دهد مشخص كنيد كدام لايه ها در صفحه آرايی شما نمايش داده شوند.

Rasterization ـ1
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 InDesign 

فايل های InDesign حاوی تمام انواع عناصر هستند )متن، گرافيک و حتی صدا، هايپرلينک و فيلم( كه در 
يک يا چند صفحه ارائه می شوند. هنگامی كه يک فايل InDesign را وارد می كنيد، InDesign با آن به مثابه 
يک گرافيک رفتار می كند و می تواند آن را در يک يا چند صفحه از فايل در سند شما به عنوان يک گرافيک 
)البته اگر بيش از يک صفحه باشد( قرار دهد. می توانيد دور آن گرافيک را ببريد، اندازه اش را تغيير دهيد و 
هر كار ديگری كه روی گرافيک ها قابل انجام است، انجام دهيد، ولی برای تغيير دادن متن يا مؤلفه های ديگر 

آن، بايد فايل InDesign اصلی را ويرايش كنيد.

 PDF 

فايل های PDF می توانند حاوی تمام انواع عناصر باشند )متن، گرافيک، صدا، هايپرلينک و فيلم(. هنگامی كه 
يک فايل PDF را وارد می كنيد، InDesign با آن به عنوان يک گرافيک رفتار می كند و می تواند يک يا چند 
صفحه از فايل PDF )البته اگر بيش از يک صفحه باشد( را به عنوان يک گرافيک غيرقابل ويرايش در سند 
شما قرار دهد. می توانيد دور آن را ببريد، اندازه اش را تغيير دهيد و هر كار ديگری كه روی گرافيک ها قابل 

انجام است، انجام دهيد، ولی نمی توانيد با متن يا ديگر مؤلفه های فايل PDF وارد شده كار كنيد.

 فرمت های برداری دیگر
اگر خروجی شما نگاتيوهايی برای چاپ حرفه ای است، بايد از فرمت های برداری غير PostScript خودداری 

كنيد، ولی آن ها برای چاپ جوهرافشان و ليزری عالی هستند.

 PICT 

فرمت استاندارد Mac برای ترسيمات، PICT، از نقش بيتی ها هم پشتيبانی می كند. InDesign فايل های 
PICT، بدون هيچ مشکلی وارد می كند، ولی نمی تواند برای خروجی گرافيکی، تفکيک رنگ را انجام دهد. 
به دليل اينکه فونت های گرافيک های PICT برداری به طور خودكار به منحنی تبديل می شوند، نبايد نگران 

فونت های مورد استفاده در گرافيک های خود در چاپگرتان باشيد.

Windows Metafile 

فرمت استاندارد Windows Metafile برای ترسيمات، Windows Metafile شبيه PICT است كه حاوی 
 Windows از اطلاعات نقش بيتی در InDesign ،تصاوير نقش بيتی و ترسيمات برداری با هم است. با وجود اين

Metafile صرف نظر می كند و در طی ورود، آن را كنار می گذارد.
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 معضلات فرمت های نقش بیتی
فرمت های نقش بيتی )كه به آن ها پويشی1 هم گفته می شود( ساده تر از فرمت های برداری هستند، زيرا آن ها 
از رديف هايی از نقاط )پيکسل ها( تشکيل می شود، نه دستورعمل هايی در مورد نحوه رسم شکل های مختلف.

 فرمت های نقش بیتی سطح حرفه ای
اگرچه InDesign از انواع فرمت های نقش بيتی پشتيبانی می كند، فقط يکی از آن ها موجب نگرانی است و 
 Scitex CT هم چنين ممکن است از فرمت( TIFF :آن هنگام توليد اسناد حرفه ای برای خروجی چاپی است

استفاده كنيد، چنانچه از تجهيزات خروجی Scitex برای توليد نگاتيوهای خود استفاده می كنيد(.
 Adobe Photoshop و Corel Photo�Paint( پيشنهاد می كنم فرمت های ديگر را با استفاده از ويرايشگر تصوير
دو مورد از بهترين ويرايشگرهای تصوير و وارد كردن و صادر كردن بيشتر فرمت ها هستند( يا يک برنامه 

تبديل به TIFF تبديل كنيد.

 Photoshop 

 Photoshop می تواند فرمت فايل اين ويرايشگر محبوب تصوير را وارد كند. هنگامی كه فايل های InDesign
را در InDesign قرار می دهيد، می توانيد روی چگونگی ورود كانال آلفا كنترل داشته باشيد و مطمئن شويد 

برای داشتن اين كنترل، Show Import Options را در كادر محاوره ای Place انتخاب كرده ايد.
هم چنين می توانيد هر مسير برش تعبيه شده ای را اعمال كنيد و كليه پروفايل های رنگ تعبيه شده را وارد 
كنيد يا كنار بگذاريد. همان گونه كه در ادامه فصل بيان خواهد شد، InDesign بين لايه ها در يک تصوير 
Photoshop تمايز قائل می شود و به شما اجازه می دهد تا مشخص كنيد كدام لايه ها در صفحه آرايی شما 

نمايش داده شوند.

 Scitex CT 

فرمت Scitex CT با تنُ پيوسته در دستگاه های با وضوح بالای خروجی Scitex استفاده می شوند و معمولاً 
 Scitex بايد روی سيستم اين فرمت استفاده می كنيد،  از  اسکنرهای Scitex آن ها را توليد می كنند. اگر 

خروجی بگيريد. در غير اين صورت، نمی توانيد از مزيت وضوح بالای آن بهره بگيريد.

 TIFF 

را  آن   Adobe Systems بعداً  )كه   Aldus كه  است   TIFF ناشران،  برای  نقش بيتی  فرمت  محبوب ترين 
خريداری كرد( و مايکروسافت، آن را توسعه داده اند. TIFF تا 24 بيت رنگ )16/7 ميليون رنگ( در هر دو 
مدل RGB و CMYK پشتيبانی می كند و هر برنامه عمده ويرايشگر عکس از TIFF پشتيبانی می كند. 

TIFF هم چنين از فايل های سياه و سفيد و مقياس خاكستری پشتيبانی می كند.

Raster ـ1
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بزرگ ترين مزيت استفاده از فايل های TIFF نسبت به فرمت های ديگر اين است كه از رنگ پشتيبانی می كند 
و InDesign از اين مزيت آن بهره می برد. مثلًا، در يک ويرايشگر تصوير، می توانيد مسيرهای برش را در يک 
فايل TIFF تنظيم كنيد كه به عنوان ماسکی برای تصوير استفاده می شود. InDesign مسير را می بيند و از 
آن به عنوان مرز تصوير استفاده می كند و ناحيه خارج از آن را غيرقابل رؤيت می كند. اين مسئله هم به شما 
اجازه می دهد تصاوير نقش بيتی غيرمستطيلی را در صفحه آرايی خود داشته باشيد و مسير برش مرز قابل رؤيت 
برای تصوير TIFF شما می شود. InDesign هم چنين از كانال های آلفای تعبيه شده و پروفايل های رنگ در 

فايل های TIFF پشتيبانی می كند. 
فايل های TIFF گونه های متعددی دارند كه InDesign از آن ها پشتيبانی می كند، ولی به دليل اينکه از 

برنامه های ديگر دريافت می شوند، برای اطمينان از تعامل هموار، اين دستورعمل ها را دنبال كنيد:
 Windows استفاده كنيد كه برنامه های LZW فشرده سازی نشده و فشرده سازی شده TIFF از فايل های  

از آن ها پشتيبانی می كنند. InDesign حتی از روش فشرده سازی Zip هم برای فايل های TIFF پشتيبانی 
می كند، اگرچه اين روش كمتر مورد استفاده قرار می گيرد. بايد از به كارگيری فايل های TIFF فشرده سازی 
شده LZW در برنامه های رايج مطمئن باشيد، ولی اگر به مشکل برخورديد، توصيه می كنيم از فايل های 
 LZW فشرده سازی نشده استفاده كنيد. هم چنين هميشه با دفتر خدماتی خود درباره پشتيبانی از TIFF
صحبت كنيد قبل از اينکه فايل ها را برای خروجی ارسال كنيد. بسياری از تصويرنگارهای قديمی تر فشرده سازی 

LZW را مديريت نمی كنند و در گرفتن خروجی تصاوير استفاده كننده از آن ناموفق خواهند بود.
  از ترتيب بايتی برای پلت فرمی استفاده كنيد كه فايل TIFF برای آن اختصاص يافته است. ترتيب بايت 

مورد استفاده در Mac و PC برعکس است. اگرچه InDesign هر دو ترتيب را می خواند، برنامه های ديگر 
)معمولاً قديمی تر( ممکن است اين طور نباشند، بنابراين چرا سردرگمی ايجاد كنيم؟ البته، اگر فقط كاربران 

InDesign و Photoshop روی فايل های TIFF شما كار كنند، ترتيب بايتی اصلًا مهم نيست.

 فرمت های نقش بیتی وب محور
در سال های اخير، فرمت های متعددی برای استفاده در اسناد HTML موجود در وب توسعه يافته اند. اين 
فرمت هاـ GIF،وJPEG و PNGـ اندازه كوچکی دارند )برای دانلود سريع تر و نمايش در مرورگر( كه اين كار 

با محدود كردن جزئيات تصوير و رنگ و غنای آن حاصل شده است.
اگرچه شما می توانيد از هر فرمت گرافيکی تحت پشتيبانی برای اسناد استفاده كنيد كه انتظار داريد به فرمت 
سند HTML وب صادر كنيد، اگر بدانيد سند شما فقط برای وب است، ممکن است از فرمت گرافيک وب از 
 GIF به HTML تمام تصاوير را هنگام صدور به InDesign شروع كار استفاده كنيد )توجه داشته باشيد كه

يا JPEG تبديل می كند(.

 GIF 

GIF قديمی ترين فرمت وب است. برای كمک به كاهش اندازه فايل، اين فرمت فايل محدود به 256 رنگ 
است. اين امر موجب كاهش اندازه فايل می شود، ولی آن را برای عکاسان و گرافيک هايی با تركيبات رنگی 
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نامناسب می كند. با وجود اين، رويکرد فشرده سازی آن هيچ جزئياتی از تصوير را از دست نمی دهد، بنابراين 
برای طرح های اوليه، كارتون ها و تصاوير ساده ديگر با جزئيات دقيق خوب هستند.

 JPEG 

فرمت تصوير رنگی فشرده سازی شده JPEG برای تصاوير خيلی بزرگ و تصاوير تکی كه انيميشن يا فيلم را 
تشکيل می دهند، استفاده می شود. تصاوير فشرده سازی شده به اين فرمت ممکن است جزئياتی را از دست 
بدهند و به اين دليل است كه ناشران فايل های TIFF را ترجيح می دهند. JPEG حتی می تواند به طور مؤثر 
در خروجی اسناد در چاپگر جوهرافشان استفاده شود، زيرا می توانيد سطح اتلاف را در طی صدور با هيچ 
 JPEG استفاده نمی شود. به اين دليل است كه تصاوير JPEG تنظيم كنيد، ولی در چاپ حرفه ای از تصاوير
 CMYK چاپ استاندارد. اگرچه ايجاد فايل های CMYK استفاده می كنند و نه از مدل RGB از مدل رنگ
JPEG با Photoshop امکان پذير است، اين فايل های CMYK JPEG در برنامه های كاربردی مرورگرهای 

وب نمايش داده نخواهند شد و مشکل زا خواهند بود.
هنگام وارد كردن فايل های JPEG،وInDesign به طور خودكار مقياس تصوير را تغيير می دهد تا با صفحه 
متناسب شود. اين امر به تعامل با تصاوير گرافيکی دوربين ديجيتال كه معمولاً خيلی بزرگ هستند و هنگام 
باز هم  ورود عرض بيشتری را نسبت به عرض صفحه اشغال می كنند، كمک می كند. اگر چه شما احتمالاً 
بايد مقياس تصوير را تغيير دهيد تا با صفحه آرايی شما متناسب شود، حداقل می توانيد قبل از انجام كار، كل 

تصوير را ببينيد.
JPEG در وب مفيد است كه وضوح محدود يک مانيتور رايانه موجب می شود جزئيات زيادی از JPEG از 
 JPEG .بين برود و توازن قابل قبولی از كيفيت كاملًا مبهم در برابر اندازه فايل بسيار كوچک تر ارائه می دهد

به طور ويژه برای عکاسان مناسب است، زيرا جزئيات از دست رفته، چندان قابل توجه نيست.
اگر از JPEG برای كار چاپی استفاده می كنيد، توجه داشته باشيد كه می توانيد مسير برش را برای آن در 
برنامه هايی مثل Photoshop آماده كنيد. مسير برش به تصوير اجازه می دهد يک مرز خلاف عرف داشته 
نظير   InDesign جلوه های  از  می توانيد  بنابراين  می شود(  رندر  شفاف  به صورت  آن  پس زمينه  )بقيه  باشد 

استفاده كنيد. پيچش متن 

 PNG 

فرمت PNG برای ارائه فشرده سازی بدون اتلاف GIF است، ولی از رنگ 24 بيتی پشتيبانی می كند. ويژگی 
مهم ديگر فرمت PNG پشتيبانی از شفافيت كامل با يک كانال آلفای تعبيه شده است )به اين دليل است كه 
InDesign در كادر محاوره ای Image Import Options به شما اجازه می دهد شفافيت را با سفيد عوض 
كنيد يا رنگ پس زمينه را نگه داريد، همان گونه كه در ادامه واحدكار به اين مسئله می پردازيم(. شفافيت 

هم چنين در بيشتر مرورگرهای وب امروزی كار می كند.
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 فرمت های نقش بیتی دیگر
فرمت های تحت پشتيبانی ديگر، فرمت هايی هستند كه بايد از آن ها اجتناب كنيد، مگر اينکه چاپ را روی 
چاپگرهای جوهرافشان يا ليزری انجام می دهيد. اگر تصاويری به يکی از اين فرمت ها داريد، تصاوير را قبل از 

استفاده در InDesign به TIFF تبديل كنيد: 
  BMP: همانند TIFF، فرمت نقش بيتی BMP Windows از تصاوير رنگی، مقياس خاكستری و سياه و 

سفيد پشتيبانی می كند.
  PCX: همانند PCX ، TIFF از تصاوير رنگی، مقياس خاكستری و سياه و سفيد پشتيبانی می كند.

  PICT:وPICT، فرمت قديمی Macintosh برای ترسيمات است كه از نقش بيتی ها هم پشتيبانی می كند. 

InDesign فايل های PICT را بدون مشکل وارد می كند.

6  ـ16ـ9ـ شناسایی معضلات رنگ
قبلًا وارد كردن رنگ از فايل های گرافيکی به برنامه های نشر، پيشنهادی بديهی بود: رنگ ها حتی اگر روی 
صفحه نمايش درست باشند، اغلب چاپ درستی نخواهند داشت. اين بختک ها در گذشته مشکل بزرگی بودند، 
زيرا نرم افزار صفحه آرايی امروزی مثل InDesign تعاريف رنگ را در گرافيک منبع شما به دقت تشخيص 
برنامه های  برای  اطلاعات  آن  دادن  قرار  دسترس  در  تصوير  ويرايش  و  تصويرسازی  برنامه های  و  می دهد 
صفحه آرايی بهتر هستند. بنابراين، كافی است برای اطمينان از ورود هموار رنگ، به توصيه ذيل توجه كنيد.
اگر تصاوير رنگی را در يک برنامه تصويرسازی يا ويرايش تصوير ايجاد می كنيد، مطمئن شويد كه آن ها را 
 CMYK ايجاد می كنيد يا از رنگ موضعی معين استفاده می كنيد. اگر از CMYK با استفاده از مدل رنگ
استفاده می كنيد، در نتيجه، رنگ از قبل جدا شده است. با InDesign، همه رنگ های موضعی كه در يک 
Swatches برای سند شما اضافه می شوند و به عنوان  EPS تعريف می شوند، به طور خودكار به پنل  فايل 

تنظيم می گردند. رنگ های موضعی 
 ACD و CorelDraw ، Adobe Illustrator( تبعيت می كند Adobe EPS اگر برنامه شما از مشخصات
Canvas همگی چنين هستند(، InDesign رنگ های فايل EPS شما را جدا می كند و مهم نيست كه شما 
از رنگ پردازشی استفاده می كنيد يا رنگ موضعی. Canvas به طور خودكار رنگ های موضعی Pantone را به 
رنگ های پردازشی در مدل های RGB و CMYK انتخابی شما تبديل می كند. برای برنامه های ديگر، رنگ های 
خود را در مدل CMYK ايجاد كنيد تا مطمئن شويد به عنوان رنگ های جدا شده در InDesign چاپ می شوند.

7ـ16ـ9ـ سیستم های رنگ
چندين سيستم يا مدل رنگ وجود دارد كه از آن ها استفاده می شود و InDesign از آن ها پشتيبانی می كند، 
 Dainippon Ink & Chemical (DIC)و،Focoltoneو،Pantoneو،RGB ،)پردازشی( CMYK از جمله
Toyo،وTrumatch و وب. يک سيستم رنگ مجموعه ای از رنگ های مجزا را تعريف می كند كه به طور ويژه 
 RGB تركيبی از جوهرها يا طيفی از رنگ هايی هستند كه می توان با تركيب تعداد جوهر محدود )از قبيل

برای قرمز، سبز و آبی و CMYK برای فيروزه ای، سرخابی، زرد و مشکی( ايجاد كرد.
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Pantone استفاده كنيد،  RGB و  CMYK )پردازشی(،  از سه سيستم  برای وارد كردن فايل، بهتر است 
زيرا كاربرد جهانی دارند و معمولاً هنگام ارسال اطلاعات از يک سيستم به سيستمی ديگر قابل اتکاتر هستند.

8  ـ16ـ9ـ رنگ کالیبره شده
با فعال بودن ويژگی سيستم مديريت رنگ InDesign (CMS)، اين برنامه رنگ های خروجی را )چه روی 
يک چاپگر رنگی چاپ شوند يا همراه با جداسازی رنگ ها برای چاپ سنتی( برمبنای دستگاه منبع و دستگاه 
خروجی مقصد در تلاش برای تضمين اين امر كه آنچه روی صفحه نمايش می بينيد، تقريباً همان را روی 
صفحه چاپ شده خواهيد ديد، كاليبره می كند. اگرچه كاليبراسيون رنگ، علمی ترفندآميز است كه به ندرت 
رنگ دقيق منطبق بر تمام دستگاه های ورودی و خروجی را به همراه خواهد داشت، به حداقل كردن تفاوت ها 

در سير تصاوير در طی مسير ايجاد و توليد كمک می كند.
با  كه  ببريد  كار  به  را  رنگ  پروفايل های  می دهند  اجازه  شما  به  تصوير  ويرايش  برنامه های  بيشتر  امروزه، 
 ICC 1 مطابقت دارند. اگر از كاليبراسيون رنگ استفاده می كنيد، اعمال اين پروفايل های ICC استانداردهای

بر تصوير هنگام ايجاد آن ها، بهترين كار ممکن است.
اگر نمی توانيد يا فراموش كرديد، پروفايل ICC را هنگام ايجاد تصوير اعمال كنيد، نگران نباشيد، می توانيد 
يک پروفايل )چنانچه تصاوير را در برنامه ای ايجاد كرده ايد كه از پروفايل های ICC پشتيبانی نمی كنند( را 

اضافه كنيد يا پروفايل متفاوتی را از InDesign اعمال كنيد.

9ـ16ـ9ـ بررسی روش هایی برای وارد کردن گرافیک
شما می توانيد يک گرافيک را در هر نوعی از فريم يا شکل )از جمله يک خط منحنی شکل ايجاد شده با ابزار 

Pen( به استثنای خط مستقيم با استفاده از فرمان Place، كپی و الصاق يا كشيدن و انداختن وارد كنيد.

هارددرايو شما  )روی  فايل هستيد  دانستن محل  مسئول  است، شما  گرافيک  كردن  وارد  زمان  هنگامی كه 
.)DVD يا CD ذخيره شده يا روی يک درايو فلش كه دوستتان به شما داده يا يک سرور فايل شبکه ای يا
اگر يک فايل گرافيکی ذخيره شده در هر نوع رسانه برداشتنی را وارد كنيد، لينک بين سند و فايل گرافيک 
هنگام برداشتن رسانه از بين می رود. معمولاً، بهتر است فايل های گرافيکی را در هارددرايو خود يا در يک 

سرور فايل شبکه ای كپی كنيد، قبل از اينکه آن ها را در سند InDesign وارد كنيد.

International Color Committee ـ1

مواظب باشيد: چنانچه هنگام استفاده از كادر محاوره ای Place برای وارد كردن گرافيک در يک فريم 
متنی منتخب، ابزار Type انتخاب شده باشد، يک گرافيک درونی در محل درج متن ايجاد كنيد.

هشدار
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Place 10ـ16ـ9ـ استفاده از کادر محاوره ای
اگرچه InDesign روش های متعددی را برای افزودن فايل گرافيکی به سند ارائه می دهد )كه همه آن ها را در 
اين واحدكار بررسی می كنيم(، كادر محاوره ای Place )با انتخاب File>Place يا فشردن Ctrl+D( روشی 
است كه اغلب مورد استفاده قرار می گيرد. هنگام استفاده از كادر محاوره ای Place،وInDesign گزينه های 
ورود را برای فرمت های فايل گرافيکی متنوع ارائه می دهد كه در صورت استفاده از روش های ديگر ورود، اين 

گزينه ها در دسترس شما نخواهد بود.
هنگام وارد كردن تصاوير، مطمئن شويد كه Show Import Options در كادر محاوره ای Place انتخاب 
ورود  گزينه های  به  نگاهی  است  بهتر  بوديد،  خشنود  پيش فرض  ورود  گزينه های  از  اگر  حتی  است.  شده 
بيندازيد، بنابراين هنگامی كه گزينه غيرپيش فرض معنا پيدا می كند، از دستيابی به آن اطلاع خواهيد داشت.

نحوه استفاده از كادر محاوره ای Place برای وارد كردن گرافيک از اين قرار است:
File>Place 1 را انتخاب كنيد يا Ctrl+D را فشار دهيد. اگر می خواهيد گرافيکی را در فريم موجودی وارد 
كنيد، فريم مدنظر را با استفاده از يکی از ابزارهای انتخاب، برگزينيد )قبل يا بعد از انتخاب File>Place(. اگر 
می خواهيد InDesign هنگام وارد كردن گرافيک، فريم جديدی ايجاد كند، مطمئن شويد كه هنگام انتخاب 

Place، هيچ شيئی انتخاب نشده است. در هر صورت، كادر محاوره ای Place نمايان می شود.
2 از كنترل های موجود در كادر محاوره ای Place برای يافتن و انتخاب فايل گرافيکی مدنظر برای ورود 
استفاده كنيد. در كادر محاوره ای Place، می توانيد با فشردن Shift و كليک كردن روی يک محدوده يا با 

فشردن Ctrl و كليک كردن روی تک تک فايل ها چند فايل را انتخاب كنيد )گرافيک و يا متن(. 
3 تصميم بگيريد از كدام گزينه های ورود قصد استفاده داريد و آن ها را انتخاب كنيد:

  اگر بخواهيد گزينه های ورودی را نمايش دهيد كه به شما اجازه كنترل نحوه ورود فايل گرافيکی منتخب 

 Open را انتخاب كنيد و سپس روی Show Import Options :را می دهد، يکی از اين موارد را انجام دهيد
كليک كنيد؛ Shift را فشار داده و نگه داريد و روی نام فايل دابل كليک كنيد؛ يا Shift را نگه داشته روی 
Open كليک كنيد. اگر Show Import Options را انتخاب كنيد، بسته به نوع گرافيکی كه وارد می كنيد، 
 Image Options يا   Place InDesign Document، Place PDF، EPS Import Options كادر محاوره ای
نمايان می شود. گزينه های ورود مطلوب را در صورت كاربردی بودن مشخص كنيد و سپس روی OK كليک كنيد 

)اين گزينه ها را در ادامه اين واحدكار بررسی خواهيم كرد(.
  برای جايگزين كردن گرافيکی كه هم اكنون انتخاب شده است، Replace Selected Item را انتخاب كنيد 

)حتی اگر فريم گرافيکی را انتخاب نکرده باشيد، اين گزينه در دسترس است(.
  برای ايجاد يک عنوان ايستا، گزينه Create Static Caption را انتخاب كنيد. اگر گزينه های فراداده را 

تنظيم نکرده ايد، انتخاب اين گزينه موجب ايجاد عنوانی برای تصويری می شود كه حاوی نام فايل آن است.
4 می توانيد گرافيک را در يک فريم موجود قرار دهيد يا در فريمی جديد، به اين صورت:

  اگر يک فريم خالی انتخاب شده است، InDesign به طور خودكار گرافيک را در فريم قرار می دهد. گوشه 

سمت چپ بالای گرافيک در گوشه سمت چپ بالای فريم قرار می گيرد و فريم به عنوان شیء برش دهنده 
گرافيک عمل می كند.

 Replace Selected اگر فريمی كه هم اكنون گرافيکی را نگه می دارد، انتخاب شود، در صورت انتخاب گزينه  
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Item در كادر محاوره ای InDesign، Place گرافيک موجود را با گرافيک جديد جايگزين می كند. در غير 
اين صورت، InDesign فرض می كند كه شما می خواهيد گرافيک جديد را در فريم جديدی قرار دهيد.

  برای قرار دادن گرافيک در فريم جديد، روی آيکن گرافيک بارگذاری شده )كه در شکل 12ـ9 نشان داده 

شده است( در اين بخش خالی از صفحه يا در Pasteboard كليک كنيد. نقطه ای كه كليک كرده ايد، گوشه 
سمت چپ بالای فريم گرافيکی حاصله را توليد می كند كه اندازه آن مشابه گرافيک وارد شده است و به عنوان 

يک شکل برش گرافيکی عمل می كند.

شکل 12ـ9ـ آیکن گرافیک بارگذاری شده، تصویر پیش نمایشی از گرافیک وارد شده و تعداد گرافیک های آماده قرار گرفتن 
را نمایش می دهد.

  برای قرار دادن گرافيک در فريم انتخاب نشده موجود، در فريم با آيکن گرافيک بارگذاری شده كليک كنيد. 

گوشه سمت چپ بالای گرافيک در گوشه سمت چپ بالای فريم قرار می گيرد و فريم به عنوان يک شکل 
برش دهنده عمل می كند.

  InDesign به شما اجازه می دهد هنگام قرار دادن گرافيک ها، فريمی را رسم كنيد. InDesign فريمی 

متناسب با تناسب های گرافيک می سازد. مگر اينکه Shift را فشار داده و نگه داريد كه در آن حالت، اين 
فريم ممکن است ابعاد موردنظر شما را داشته باشد. به هر حال، آن گاه گرافيک جاری به طور متناسب در آن 

مستطيل قرار می گيرد. هنگام ورود چندين گرافيک، می توانيد فريم مجزايی برای هر يک رسم كنيد.
برای لغو ورود كامل گرافيک ها، كافی است ابزار متفاوتی را انتخاب كنيد. برای لغو يک فايل خاص در يک ورود 
چند فايلی، هنگام نمايان شدن پيش نمايش كوچک آن فايل، Esc را فشار دهيد )فايل های ديگر باز هم برای 
قرار گرفتن در دسترس هستند(. برای جابه جايی ميان فايل ها در يک فرمت چند فايلی به طوری كه بتوانيد 
آن ها را به ترتيب ترجيحی خود قرار دهيد،  يا  را در ليست فايل ها برای عقب يا جلو بردن آن ها فشار 

دهيد؛ هنگام جابه جا كردن فايل ها، پيش نمايش تغيير می كند.
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هنگامی كه چندين گرافيک را هم زمان قرار می دهيد، InDesign به شما اجازه می دهد هر فايل را در فريم 
جدايی قرار دهيد. كافی است برای هر فايل واردشونده يک بار كليک كنيد يا Shift را نگه داريد و كليک 
كنيد يا Ctrl+Shift را نگه داشته و كليک كنيد تا InDesign را مجبور كنيد تمام فايل ها را در صفحه در 
فريم های مجزا قرار دهد. اگر بيش از يک فايل را در يک زمان قرار دهيد، آيکن متن بارگذاری شده، تعداد 

فايل های قرار گرفته و پيش نمايش كوچکی از هر يک از فايل ها را نمايش می دهد )شکل 12ـ9(.
اگر Shift يا Ctrl+Shift را هنگام قرار دادن چند تصوير فشرده و نگه داريد، InDesign هر تعداد گرافيکی 
را كه جا می شود در صفحه در زير مکان اشاره گر ماوس قرار می دهد و آن ها را در يک مشبک مرتب می كند. 
اگر هنگام قرار دادن گرافيک ها و در حين استفاده از گزينه Shift يا Ctrl+Shift، فريمی رسم كنيد، آن گاه 
تعداد  می توانيد  رسم شده شما جا می گيرند.  فريم  در  كه  قرار می دهد  در مشبکی  را  تصاوير   InDesign
رديف ها در مشبک را با فشردن يا  افزايش يا كاهش دهيد، البته پس از نمايان شدن آيکن گرافيک های 

بارگذاری شده. ضمناً با فشردن  يا  می توانيد تعداد ستون ها را افزايش يا كاهش دهيد.
بعد از قرار دادن يک گرافيک، در فريمی نمايان می شود كه حاوی آن است و فريم انتخاب می شود. اگر ابزار 
 Direct Selection انتخاب شود، هشت دستگيره كادر محصوركننده آن نشان داده می شوند؛ اگر ابزار Selection
انتخاب شود، دستگيره ها فقط در گوشه ها نمايان می شوند. در اين لحظه، می توانيد فريم يا گرافيک موجود 

در آن را تغيير دهيد يا می توانيد به كار ديگری بپردازيد.

 استفاده از گزینه های ورود
اگر تا حالا از يک برنامه گرافيکی استفاده كرده باشيد )مثلًا يک برنامه ويرايش تصوير مثل Adobe Photoshop يا 
يک برنامه تصويرسازی مثل Adobe Illustrator يا CorelDraw(، احتمالاً مطلع هستيد كه هنگام ذخيره 
يک فايل گرافيکی، چندين گزينه داريد كه مواردی از قبيل فرمت فايل، اندازه تصوير، عمق رنگ، كيفيت 
پيش نمايش و غيره را كنترل می كنند. هنگام ذخيره يک فايل گرافيکی، تنظيماتی كه مشخص می كنيد، 
به طريقی تعيين  می شوند كه در آن تصوير استفاده خواهد شد. مثلًا، می توانيد از Photoshop برای ذخيره 
نگارش TIFF با وضوح بالا از يک گرافيک اسکن شده برای استفاده در يک گزارش سالانه تمام رنگی حرفه ای 
يا نگارش GIF با وضوح پايين از همان گرافيک برای استفاده در صفحه وب شركت استفاده كنيد يا می توانيد 
از  اندازه های مختلف در بسياری  از  لوگوی شركتی استفاده كنيد كه می توانيد  ايجاد  برای   Illustrator از 

نشريات چاپی خود استفاده كنيد.
انتخاب های شما  را مشخص می كنيد،  ورود سفارشی  تنظيمات  گرافيکی،  فايل  وارد كردن يک  اگر هنگام 
 72dpi وابسته به ماهيت نشريه دارد. مثلًا، اگر مقيد به وب هستيد، نبايد با گرافيکی كار كنيد كه وضوح آن از

مانيتور رايانه تجاوز كند يا آن را ذخيره كنيد.
اگر نشريه شما چاپ خواهد شد، تنظيمات ورود تصوير كه برای يک روزنامه چاپ شده روی كاغذ روزنامه در 
يک چاپ SWOP 1 مشخص می كنيد، متفاوت از تنظيماتی است كه برای يک مجله چهار رنگ چاپی روی 

كاغذ Coated با استفاده از چاپ Sheetfed انجام می دهيد.
انتخاب كنيد، گزينه های نشان داده شده در  اگر هنگام قرار دادن گرافيک، Show Import Options را 

Specifications for Web Offset Publications ـ1
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كادرهای محاوره ای حاصله به فرمت گرافيک انتخابی وابسته است. هنگام تنظيم گزينه ها برای فايلی خاص، 
اگر  را تغيير دهيد.  تا وقتی كه آن ها  باقی می مانند  فايل  برای آن فرمت  گزينه هايی كه مشخص می كنيد 
هنگام قرار دادن گرافيک، Show Import Options را انتخاب نکنيد، جديدترين تنظيمات برای فرمت فايل 

گرافيک انتخابی استفاده می شود.

17ـ9ـ گزینه های ورود برای گرافیک های نقش بیتی

،TIFF می دهد:  شما  به  ذيل  نقش بيتی  تصاوير  انواع  برای  ورود  گزينه  مجموعه  دو   InDesign 
GIF،وJPEG،وScitex CT،وBMP و PCX. سه گزينه برای فايل های PNG و مجموعه متفاوتی از سه 
 PICT يا QuickTime داريد. هيچ گزينه ورودی برای فايل های فيلم Photoshop گزينه برای فايل های

نداريد. شکل 13ـ9 چهار پيشخوان احتمالی را برای تصاوير نقش بيتی نشان می دهد.

 .Image برای فرمت های نقش بیتی سمت چپ بالا: پیشخوان Image Import شکل 13ـ9ـ پیشخوان های کادر محاوره ای
سمت چپ پایین: پیشخوان Color. سمت راست بالا: پیشخوان Layers که برای فایل های Photoshop نمایان می شود. سمت 

راست پایین: پیشخوان PNG Settings که برای فایل های PNG نمایان می شود.

Image پیشخوان
اگر يک فايل Photoshop،وTIFF يا EPS را وارد می كنيد كه حاوی يک مسير برش تعبيه شده و يا كانال 
آلفا برای ماسک گذاری تصوير يا بخشی از تصوير است )در غير اين صورت، اين گزينه ها غيرفعال خواهند بود(، 
گزينه Apply Photoshop Clipping Path را برای وارد كردن مسير برش به همراه تصوير انتخاب كنيد 
و يک كانال آلفا را از منوی بازشوی Alpha Channel برای وارد كردن كانال آلفا همراه با تصوير برگزينيد.
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Color پیشخوان 
در پيشخوان Color، می توانيد مديريت رنگ را برای تصوير فعال و چگونگی نمايش تصوير را كنترل كنيد.

گزينه Enable Color Management را برای فعال كردن مديريت رنگ انتخاب كنيد. با استفاده از منوی 
بازشوی Profile، پروفايل منبع رنگی را انتخاب كنيد كه با طيف رنگ دستگاه )اسکنر، دوربين ديجيتال 
و غيره( يا نرم افزار مورد استفاده برای ايجاد فايل مطابقت داشته باشد. InDesign تلاش می كند رنگ های 
موجود در فايل را به رنگ هايی تبديل كند كه دستگاه خروجی قادر به توليد آن باشد )اين پروفايل ها توسط 

.)InDesign برنامه های ديگر روی سيستم عامل نصب شده اند و نه
استفاده از منوی بازشوی Rendering Intent برای تعيين چگونگی تبديل رنگ در فايل گرافيک انتخابی در 
 Perceptual ،است. اگر گرافيک، عکس اسکن شده ای است InDesign طيفی از دستگاه های خروجی توسط
و   Relative Colorimetricو،Saturation (Graphics) ديگرـ  گزينه های  كنيد.  انتخاب  را   (Images)
Absolute Colorimetricـ برای تصاويری مناسب هستند كه بيشتر نواحی آن ها رنگ پرُی دارد، از قبيل 

فايل های Illustrator EPS كه در Photoshop باز شده اند و به فرمت TIFF ذخيره شده اند.

PNG Settings پیشخوان 
از اين پيشخوان )تنها در صورتی در دسترس است كه فايل PNG را قرار می دهيد( برای استفاده از اطلاعات 
شفافيت در يک فايل PNG استفاده می كنيد، با اين فرض كه پس زمينه شفافی دارند. شما دو انتخاب برای 
كنترل شفافيت داريد: White Background و File�defined Background Color. اولی موجب نمايش 
بخش شفاف به صورت سفيد در InDesign می شود؛ دومی از همان رنگ پس زمينه مشخص شده در خود 

فايل PNG استفاده می كند.
كه  است  تنظيمی  گاما  می دهد.  ورود  در طی  را  گاما  مقدار  تنظيم  اجازه  شما  به  هم چنين  پيشخوان  اين 
 PNG فايل  برای  را  گاما  تنظيم  بازتوليد،  دقيق ترين  تضمين  برای  و  می كند  توصيف  را  دستگاه  روشنايی 
می خواهيد كه با گامای دستگاه شما )چاپگر يا مانيتور( يکسان باشد. اين تنظيم برای تصحيح فايل ايجاد شده 
در نوع خاصی از مانيتور لازم است. با وجود اين، برای استفاده از اين ويژگی، بايد تنظيم گاما را برای دستگاه 

خروجی نهايی بدانيد. در غير اين صورت، آن را رها كنيد.

Layers پیشخوان 
 Illustrator يا فايل  برداری( Photoshop از اين پيشخوان ـ تنها در صورتی در دسترس است كه يک تصوير
يا PDF( را قرار می دهيدـ برای انتخاب لايه های مدنظر خود برای ورود به InDesign استفاده كنيد. سپس 
می توانيد كنترل كنيد كه كدام لايه های وارد شده در InDesign نمايش داده شوند، اگرچه نمی توانيد ترتيب 

آن ها را تغيير دهيد. شما بايد به Photoshop برگرديد و ترتيب لايه ها را آنجا تغيير دهيد.

اگرچه می توانيد فايل تصوير را با لايه ها به عنوان TIFF ذخيره كنيد، InDesign توانايی مديريت 
لايه ها را از يک فايل TIFF وارد شده به InDesign نمی دهد.

توجه
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از منوی بازشوی Layer Comp برای انتخاب از ميان تركيبات مختلف لايه ها در فايل منبع استفاده كنيد 
)در صورت وجود(. تركيب لايه لزوماً يک تصوير فوری از پنل Photoshop Layers است كه به شما اجازه 
گروه بندی تنظيمات مختلف قابليت رؤيت لايه و ذخيره آن ها برای استفاده آتی را می دهد. يک گزينه هم در 
منوی بازشوی When Updating Link برای كنترل نحوه مديريت تغييرات فايل از نظر مديريت لايه وجود 
 Photoshop تمام لايه های InDesign ،را انتخاب كنيد Use Photoshop’s Layer Visibility دارد. اگر
 Keep Layer Visibility قابل رؤيت می كند. اگر InDesign را هنگام به روزرسانی لينک به گرافيک در
Overrides را انتخاب كنيد، InDesign فقط لايه های انتخابی در اين كادر محاوره ای را وارد می كند، البته 

اگر بعداً گرافيک را در Photoshop به روزرسانی كرده باشيد.
از قرار گرفتن چنين تصاوير لايه بندی شده ای در InDesign، می توانيد لايه هايی را كه نمايش داده  پس 
می شوند، تغيير دهيد، اگرچه نمی توانيد ترتيب لايه ها را تغيير دهيد. توجه داشته باشيد كه كنترل ها برای 

اصلاح لايه ها برای ورود آن ها خيلی شبيه هستند.
برای تغيير دادن نمايش لايه ها، شيئی را با ابزار Selection يا Direct Selection انتخاب كنيد و سپس 
Object>Object Layer Options را برگزينيد. هم چنين می توانيد كليد Ctrl را نگه داشته و روی گرافيک 
كليک كنيد يا روی آن كليک راست كنيد و Graphics>Object Layer Options را از منوی زمينه انتخاب 
كنيد. به هر طريق، كادر محاوره ای  Object Layer Options نمايان می شود. اين كادر شبيه پيشخوان 
Layers در كادر محاوره ای Image Import Options است و مثل آن كار می كند. اين پيشخوان در شکل 

13ـ9 نشان داده شد.

 وارد کردن گزینه ها برای فرمت های فایل برداری
اگر فايل های برداری را وارد می كنيد، انتخاب كادر انتخاب Import Options موجب نمايان شدن يکی از 
نگارش قديمی  تر  اگر  برداری بستگی دارد.  فايل  نوع  به  نوع كادر محاوره ای  و  كادرهای محاوره ای می شود 
فايل های EPS يا Illustrator را وارد می كنيد، كادر محاوره ای Place PDF كه دو پيشخوان دارد نمايان 
می شود )هر دو كادر محاوره ای در شکل 14ـ9 نشان داده شده اند(. هيچ گزينه ورودی برای گرافيک های 

ندارد. وجود   Windows Metafile

شکل 14ـ9ـ کادر محاوره ای Place PDF )سمت چپ( و کادر محاوره ای EPS Import Options )سمت راست(. کادر 
محاوره ای Place PDF دو پیشخوان دارد: General و Layers )پیشخوان Layers برای فایل های PDF تقریباً با پیشخوان 

layers برای فایل های Photosop که در شکل 13ـ9 نشان داده شد، یکسان است(.
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EPS Import Options کادر محاوره ای 
اگر از يک گردش كار پروكسی مبتنی بر OPI استفاده می كنيدـ يعنی، اگر يک ارائه دهنده سرويس مبتنی 
بر OPI، نگارش های با وضوح پايين از فايل های گرافيکی را در اختيار شما می گذارد كه در نهايت در طی 
خروجی با فايل های با وضوح بالا جايگزين خواهند شدـ در صورتی كه می خواهيد InDesign و نه ارائه دهنده 
 Read Embedded OPS Image سرويس شما، جايگزينی تصوير را در طی خروجی انجام دهد، گزينه
Links را انتخاب كنيد. هم چنين اين گزينه را در صورتی بايد انتخاب كنيد كه فايل های گرافيکی را وارد 
می كنيد كه حاوی توضيحات OPI برای فايل های گرافيک وارد شده ديگر باشد؛ مثلًا، يک فايل EPS كه 
حاوی اطلاعات OPI برای يک گرافيک TIFF تعبيه شده است. در صورتی كه از يک گردش كار مبتنی بر 
OPI استفاده نمی كنيد يا چنانچه می خواهيد ارائه دهنده سرويس شما جايگزينی تصوير را در حين خروجی 

مديريت كند، اين گزينه را انتخاب نکنيد.
 OPI مؤلفه های InDesign ،انتخاب نشده باشد Read Embedded OPI Image Links هنگامی كه گزينه
را حفظ می كند ولی از آن ها استفاده نمی كند. هنگامی كه سند را چاپ )يا صادر( می كنيد، تصوير نماينده و 

اطلاعات لينک ارسال می شوند.
هم چنين از اين پيشخوان برای وارد كردن مسيرهای برش تعبيه شده در تصاوير در فايل  EPS استفاده كنيد. 

برای فعال سازی اين امر، گزينه Apply Photoshop Clipping Path را انتخاب كنيد.
سرانجام، از اين پيشخوان برای كنترل چگونگی ظهور فايل EPS روی صفحه نمايش در InDesign استفاده 
كنيد. اگر گزينه Use TIFF or PICT Preview را انتخاب كنيد، InDesign از تصوير نماينده با وضوح 
پايين كه در فايل EPS برای نمايش روی صفحه نمايش تعبيه شده استفاده می كند و گرافيک را با استفاده از 
 Rasterize the PostScript با وضوح بالای تعبيه شده چاپ می كند. اگر گزينه PostScript دستورعمل های
را انتخاب كنيد، InDesign فايل PostScript را در طی ورود به تصوير نقش بيتی تبديل می كند. به ندرت 

دليلی برای پويشی كردن يک فايل EPS ورودی وجود دارد.

Place PDF کادر محاوره ای 
هنگامی كه از فرمان Place PDF برای وارد كردن فايل PDF استفاده می كنيد و Show Options را انتخاب 
می كنيد، كادر محاوره ای Place PDF file كه در شکل 14ـ9 نشان داده شده است، نمايان می شود. در دو 

پيشخوان آن ـ General و Layers ـ چندين كنترل برای مشخص كردن چگونگی ورود فايل را می بينيد.
در پيشخوان General، دو مجموعه گام ها از گزينه ها برای ورود PDF داريد. اولين مجموعه كنترل می كند 

كه كدام صفحات وارد شوند:
 Previewed Page ،All ،برای تعيين اينکه كدام صفحات را برای ورود مدنظر داريد ،Pages 1 در بخش

يا Range را انتخاب كنيد.
2 صفحه پيش نمايش داده شده را با كليک كردن روی دكمه های فلشی در قسمت پيش نمايش تصوير در 

سمت چپ يا تايپ كردن شماره صفحه خاصی در فيلد زير تصوير پيش نمايش تغيير دهيد.
3 اگر می خواهيد محدوده ای را وارد كنيد، از ويرگول ها برای جداسازی صفحات و از خط تيره برای نشان 

دادن محدوده استفاده كنيد. مثلًا، اگر 13, 9-5, 3 را تايپ كنيد، صفحات 3، 5 تا 9 و 13 وارد می شوند.
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مجموعه دوم گزينه ها به شما اجازه می دهند چگونگی تنظيم صفحات را در طی ورود مشخص كنيد:
 Bounding انتخاب كنيد. اگر Crop To يکی از گزينه های برش را از منوی بازشوی ،Options 1 در بخش
Box را انتخاب كنيد، كادر محصوركننده صفحه )يا در صورتی كه در فايل PDF چيزی تعريف نشده باشد، 
مستطيلی كه تمام اقلام را دربرمی گيرد، شامل علائم صفحه خواهد بود( برای ساختن فريم گرافيکی استفاده 
می شود. انتخاب Art موجب قرار گرفتن ناحيه تعريف شده توسط خالق فايل )در صورت وجود( به عنوان اثر 

هنری قابل قرارگيری می شود.
 Trim را قرار می دهد. انتخاب Adobe Acrobat ناحيه نمايش داده شده و چاپ شده توسط Crop انتخاب
 Bleed موجب قرار گرفتن گرافيک موجود در يک ناحيه برابر با قطعه آراسته شده نهايی می شود. انتخاب
موجب قرار گرفتن ناحيه صفحه به علاوه هر ناحيه bleed مشخص شده می شود. انتخاب Media موجب قرار 
از جمله علائم  PDF می شود،  برای سند  اندازه كاغذ مشخص شده  تعريف شده توسط  ناحيه  گرفتن يک 

صفحه.
 Transparent شفاف باشد، گزينه PDF در صورتی كه می خواهيد نواحی سفيد صفحه ،Options 2 در بخش
Background را انتخاب كنيد. در صورتی كه می خواهيد پس زمينه صفحه سفيد يکدست باشد، اين گزينه 

را انتخاب نکنيد.
چگونگی كار با كنترل های موجود در پيشخوان Layers به اين صورت است:

  فهرستی از لايه های تصوير را می بينيد. همه لايه هايی كه با آيکن چشم علامت خورده اند، به InDesign وارد 

خواهند شد و شما می توانيد با كليک كردن در كادر سمت راست نام لايه برای نمايان ساختن يا پنهان كردن 
آيکن چشم، لايه ها را انتخاب كنيد يا از حالت انتخاب خارج كنيد. سپس می توانيد نمايش لايه های وارد شده 

به InDesign را كنترل كنيد، اگرچه نمی توانيد ترتيب لايه ها را تغيير دهيد.
  از منوی بازشوی When Updating Link برای كنترل چگونگی مديريت تغييرات در فايل از نظر مديريت 

لايه استفاده كنيد. اگر Use PDF’s Layer Visibility را انتخاب كنيد، InDesign كل لايه ها را هنگام 
 Keep اگر  ياAcrobat  قابل رؤيت می كند.   Illustrator InDesign در  از  به روزرسانی لينک به گرافيک 
 Photoshop در  را  گرافيک  بعداً  چنانچه   InDesign كنيد،  انتخاب  را   Layer Visibility Overrides

به روزرسانی كنيد، فقط لايه هايی را كه در اين كادر محاوره ای انتخاب كرده ايد، وارد می كند.

 Place InDesign Document کادر محاوره ای 
هنگامی كه فايل های InDesign را برای استفاده به عنوان گرافيک وارد می كنيد، گزينه هايی مشابه فايل های 
PDF داريد. كادر محاوره ای Place InDesign Document مشابه كادر محاوره ای Place PDF است كه 

در بخش قبل توضيح داده شد، البته به استثنای نام اين كادر محاوره ای.

 استفاده از روش های دیگر برای وارد کردن گرافیک
چنانچه می خواهيد گزينه های ورود سفارشی را برای  فايل گرافيکی واردشونده مشخص كنيد، بايد از فرمان 
Place استفاده كنيد. با وجود اين، اگر نياز به اين سطح از كنترل نداريد، می توانيد از يکی از سه گزينه ديگر 

InDesign برای وارد كردن گرافيک ها استفاده كنيد:
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  می توانيد از فرامين Copy و Paste رايانه برای انتقال فايل گرافيکی بين دو سند InDesign يا از يک 

سند ايجاد شده با برنامه ای ديگر به سند InDesign استفاده كنيد.
  می توانيد آيکن های فايل گرافيکی را از دسک تاپ رايانه خود كشيده و به اسناد InDesign بيندازيد.

از Illustrator به InDesign بکشيد يا كپی    در مورد فايل های Illustrator، می توانيد اشيا را مستقيماً 

و الصاق كنيد. بسته به ترجيح كليپ بورد خود، اين اشيا ممکن است فقط در PDFها تعبيه شوند كه در 
InDesign قابل ويرايش نيستند.

به   ،InDesign به   Illustrator از  برداری  اشيای  كشيدن  يا  كردن  كپی  برای  خود  ترجيح  تنظيم   برای 
 Edit>Preferences>File Handling( برويد Preferences از كادر محاوره ای File Handling پيشخوان
 InDesign را فشار دهيد(. اگر می خواهيد اشيای برداری كاملًا قابل ويرايش را در Ctrl+K را انتخاب كنيد يا
 Prefer PDF When برويد و گزينه Clipoard Handling از پيشخوان Clipboard قرار دهيد، به بخش
Pasting را از حالت انتخاب خارج كنيد. چنانچه ترجيح می دهيد PDFهای تعبيه شده غيرقابل ويرايش را 

در InDesign كپی كنيد يا بيندازيد، آن را در همان حالت انتخاب شده رها كنيد.
در صورتی كه بايد يک گرافيک لوگوی برداری را در يک قالب بيندازيد، قرار دادن اشيای برداری قابل ويرايش 
كاملًا موجود در InDesign، نياز به پرش بين برنامه های گرافيکی را برای انجام تغييراتی هم چون ويرايش 

رنگ های لوگو و شکل های برداری كاهش می دهد.
اگر از اين روش ها برای افزودن گرافيک به سند InDesign استفاده می كنيد، بعضی از ويژگی های گرافيک 
اصلی ممکن است در اين انتقال باقی نمانند. سيستم عامل، فرمت فايل و قابليت های برنامه كاربردی اصلی 
همگی ممکن است در تعيين اين مسئله كه كدام ويژگی ها حفظ شوند، نقش داشته باشند. برای آسودگی 
در  قابل ويرايش  كاملًا  برداری  اشيای  جابه جايی  برای  قبلی  بيان شده  روش  از  يا   Place فرمان  از  خاطر، 

InDesign استفاده كنيد.

 کپی و الصاق 
كنيد،  الصاق  متفاوتی   InDesign به سند  و سپس  كرده  كپی   InDesign در يک سند  را  اگر يک شیء 
اين كپی تمام ويژگی های اصلی را حفظ می كند. در مورد گرافيک كپی و الصاق شده، تمام تنظيمات ورود، 

اصلاحات فريم و اصلاحات گرافيک حفظ می شود، زيرا اين لينک به فايل گرافيک اصلی است.
اصلی  فايل گرافيک  بين  لينکی  الصاق می كنيد،  و  InDesign كپی  را در يک سند  گرافيکی  هنگامی كه 
استفاده  با  را  آن  زيرا  می شود،   InDesign سند  از  بخشی  گرافيک  نمی شود.  برقرار   InDesign سند  و 
صورتی  در  تنها  الصاق شده  گرافيک  قبيل  از  برداری  تصوير  يک  كرده ايد.  ايجاد   InDesign ابزارهای  از 
كادر  از   Clipboard Handling پيشخوان  در  را   Prefer PDF When Pasting كه  است  قابل ويرايش 

بيان شد. قبلی  بخش  در  كه  همان گونه  باشيد،  كرده  خارج  انتخاب  حالت  از   Preferences محاوره ای 

 کشیدن و انداختن 
با  با هر فرمت فايل تحت پشتيبانی  باز است، می توانيد فايل گرافيکی را   InDesign هنگامی كه يک سند
كليک كردن و كشيدن آيکن فايل به پنجره سند InDesign وارد كنيد. هنگامی كه يک فايل گرافيکی را 
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كشيده و در يک سند می اندازيد، لينک بين فايل گرافيک اصلی و سند برقرار می شود، درست مثل زمانی كه 
از فرمان Place استفاده می كنيد.

اگر آيکن يک فايل Illustrator را بکشيد و در يک پنجره سند InDesign بيندازيد، گرافيک شبيه زمانی 
رفتار می كند كه از فرمان Place استفاده می كنيد. يعنی، تک تک عناصر در گرافيک در InDesign قابل 
انتخاب يا اصلاح پذير نيستند. با وجود اين، اگر اشيای Illustrator را از پنجره سند Illustrator بکشيد و 
در پنجره سند InDesign بيندازيد، هر يک از اشيا جدا می شوند و به عنوان شیء InDesign قابل ويرايش 

خواهند بود، درست مثل اينکه در InDesign ايجاد شده اند.
اين روش مفيدی برای جابه جايی اشيايی است كه ممکن است بخواهيد بين Illustrator و InDesign اصلاح 
كنيد. مثلًا، می توانيد متنی را روی يک مسير در يک سند Illustrator ايجاد كنيد و سپس شیء را بکشيد و 
در يک سند InDesign بيندازيد. هر كاراكتر به يک شکل قابل ويرايش تبديل می شود كه می توانيد با استفاده 
از ويژگی های InDesign به آن خط دور يا زمينه بدهيد يا آن را كج و معوج كنيد. با وجود اين، نمی توانيد متن 
روی مسير را پس از كشيده شدن و انداختن آن در InDesign ويرايش كنيد )بايد به Illustrator برگرديد، 

متن اصلی را ويرايش كنيد، مجدداً آن را بکشيد و بيندازيد و سپس تمام تغييرات را دوباره انجام دهيد(.
استفاده از فرامين Copy و Paste برای افزودن اشيای Illustrator به اسناد InDesign شبيه كشيدن و 
انداختن اشيا بين برنامه هاست. اشيای كپی شده دقيقاً شبيه اشيای ايجاد شده در InDesign رفتار می كنند، 

هنگامی كه Paste را انتخاب می كنيد و هيچ لينکی برقرار نمی شود.

18ـ9ـ مفهوم اصول چاپ

چاپ، فرايند تکثير متن و تصوير با استفاده از فرم اصلی يا الگو است. چاپ در لغت به معنای اثر، نقش و 
نشان و فشردن يک سطح بر سطح ديگر است. چاپ در اصطلاح به عمل، فن و صنعت تکثير و ايجاد نقش های 
دوبعدی مانند ارقام، خط ها، حروف و تصويرها بر پارچه، كاغذ يا مواد ديگرگفته می شود. رايج ترين نوع كار 
چاپی، چاپ روی كاغذ است. امروزه با پيشرفت فناوری چاپ، اين عمل روی مواد نايلونی، سلولوزی، پارچه ای، 

چرمی، مواد شيميايی، فلزی، شيشه ای يا اشکال صاف يا ناهموار، مقعر يا محدب صورت می گيرد. 
از  و شيوه های چاپی،  است  به محصولات چاپی  تصاوير ديجيتال  تبديل  از روش های  يکی  چاپ ديجيتال، 
تصوير ديجيتالی تا انواع رسانه ها را در بر می گيرد. از جمله ويژگی های چاپ ديجيتال اين است كه معمولاً، 
هزينه چاپ ديجيتال برای هر صفحه بيشتر از چاپ معمولی است و تصاوير توسط چاپگر ليزری و جوهرافشان 
حرفه ای چاپ می شوند. اين نوع از چاپ، مستلزم رعايت و در نظر گرفتن اصول چاپ ديجيتال به منظور ايجاد 

و توليد تصوير مطلوب و دلخواه است. 
تفاوت بين چاپ ديجيتال و چاپ های سنتی مانند ليتوگرافی، لترپرس، گراور، افست و فلکسوگرافی، استفاده 
نکردن از پليت های چاپی است كه نتيجه آن ارزان تر شدن مراحل آماده سازی قبل از چاپ است. اما بيشترين 
تفاوت چاپ ديجيتال با چاپ لترپرس و افست است. برخی از اين تفاوت ها عبارت اند از: كوتاه شدن فرايند 
چاپ به دليل حذف مراحل قبل از چاپ، ثبات قيمت برای هر نسخه چاپی، كاهش اتلاف كاغذ و مواد به دليل 
عدم نياز به تنظيمات رنگ چاپ تصوير و متن متفاوت در هر نوبت چاپ به دليل عدم استفاده از پليت، پايين 

بودن هزينه چاپ ديجيتال سياه و سفيد.
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 ـ 18ـ9ـ پوستر  1 
پوستر، به يک قطعه كاغذ چاپی طراحی شده گفته می شود كه معمولاً آن را روی ديوار يا سطح عمودی نصب 
می كنند. پوستر معمولاً از دو بخش متن و گرافيکی تشکيل شده و حتی امکان دارد كه كاملًا گرافيکی يا متنی 
باشد. پوستر ها ممکن است برای اهداف مختلفی مانند تبليغات، انتقال پيام و ايجاد آثار هنری كه هزينه های 

آن ها نسبت به اثر اصلی كمتر است، مورد استفاده قرار بگيرند.

 مؤلفه های مهم در طراحی پوستر 
1 توازن: به وجود آوردن ارتباط بصری بين مؤلفه های تشکيل دهنده پوستر كه شامل توازن متقارن و غير 

متقارن است. 
2 وحدت و انسجام: تمام بخش های پوستر بايد با هم هماهنگ بوده و انسجام داشته باشند. برای وحدت و 
انسجام پوستر بايد به مواردی مانند استفاده از رنگ های متناسب و هماهنگ با موضوع و به كارگيری شيوه های 

خلاقانه تركيب عناصر تصويری هماهنگ با موضوع توجه داشت. 
3 حرکت: شکل دادن به اجزای تصوير به گونه ای كه بيننده را جذب كند. مواردی كه نقش مهمی در ايجاد 
حركت دارند شامل استفاده از خطوط جهت دار برای هدايت چشم، اضافه كردن تصوير تداعی كننده حركت 

و دسته بندی عناصر است. 
4 تأکید: به درجات متفاوت اهميت هر يک از مؤلفه های تشکيل دهنده پوستر تأكيد می كند. اين كيفيت، 
حاصل عواملی مانند استفاده از فضای خالی، استفاده از اشکال و فرم های جذاب، تركيب و ايجاد يک عنصر 

تأكيدی، استفاده خلاقانه از فونت ها و استفاده از رنگ های متضاد برای ايجاد عناصر تصويری است. 

 ـ 18ـ9ـ چاپ افست  2 
در واقع، كلمه افست به معنی غيرمستقيم و متعادل كردن بوده و در نتيجه توسعه چاپ برجسته غيرمستقيم 
به وجود آمده است. چاپ افست، معمول ترين نوع چاپ است كه در آن، تصوير جوهری شده از يک صفحه 
به روكش پلاستيکی و سپس به سطح چاپی منتقل می شود. در اين نوع چاپ، نوشته يا عکس را روی سطح 
لاستيکی يک استوانه ) سيلندر( برگردان می كنند و سپس، آن را روی سطح كاغذ فشار داده و تصوير را چاپ 
می كنند. در چاپ افست، چيزی را كه قرار است چاپ شود روی يک صفحه فلزی به نام زينک منتقل كرده و 
صفحه را به گونه ای با مواد شيميايی حساس می كنند كه فقط نوشته های روی صفحه به خود رنگ بگيرند. در 
كل، ماشين چاپ افست، شامل سه استوانه است. هنگامی كه نوشته روی صفحه زينک به خود رنگ گرفت، 
زينک به دور استوانه اول پيچيده می شود. سپس، استوانه دوم با استفاده از فشار وارده روی پوشش پلاستيکی 
می چرخد. كاغذ سفيدی كه به طور متوالی به دور استوانه سوم پيچيده می شود، مطالب را از روی پوشش 
پلاستيکی استوانه گرفته و در نهايت، چاپ می كند. قابل ذكر است كه سرعت كار ماشين های چاپ افست 

بيش از چاپ مسطح )حروفی( است. 
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 ـ 18ـ9ـ انواع خدمات چاپ   3 
چاپخانه ها سعی می كنند كه با استفاده از سيستم های نوين چاپ و دستگاه های باكيفيت، انواع خدمات چاپ 

را ارائه دهند. اين خدمات عبارت اند از: 

خدمات چاپ افست 
1 چاپ شیت عمومی برای انواع کارت ویزیت افست

  چاپ كارت ويزيت لمينت شيشه ای / براق 

  چاپ كارت ويزيت سلفون براق / مات 

 PVC چاپ كارت ويزيت  

  چاپ كارت ويزيت سه بعدی 

2 چاپ شیت عمومی برای انواع تراکت، سربرگ، فاکتور و کاتالوگ 
  چاپ كاغذ A6 / گلاسه 

  چاپ كاغذ A4 / گلاسه 

  چاپ كاغذ A5/ گلاسه 

3 چاپ شیت اختصاصی 
  چاپ سربرگ 

  چاپ تراكت و برگه های تبليغاتی 

  چاپ كاتالوگ و بروشور 

  چاپ پوستر 

  خدمات چاپ ديجيتال 

4 چاپ انواع کارت ویزیت گلاسه 
  چاپ انواع كارت ويزيت سلفون براق/ مات 

  چاپ انواع كارت ويزيت لمينت براق/ مات 

  چاپ كاتالوگ، پوستر، تراكت، بروشور و كارت پستال 

  چاپ ريسوگرافی 

  چاپ سيلک روی انواع اجسام 

  طراحی و ساخت انواع آلبوم های تبليغاتی 

  طراحی و ساخت انواع هدايای تبليغاتی

 19ـ9ـ مفاهیم اولیه صفحه آرایی

مجموع آماده سازی صفحات جهت چاپ را صفحه آرايي می گويند كه رفته رفته به مرور زمان پيشرفته شده و 
با چاشنی خلاقيت به مسئله ای مهم در جذب مخاطب برای مطالعه بيشتر رسانه مبدل شده است. با پيشرفت 
علم و فناوری و حضور رسانه های نوين از قبيل سايت های خبری، كتاب های الکترونيک، تلويزيون، راديو و… 
كتاب و مجله هنوز مخاطب خود را از دست نداده و همچنان به سرانه مطالعه به مهم ترين عامل پيشرفت 
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كشورها ياد می شود. برای افزايش اين سرانه، يکی از راه ها صفحه آرايي جذاب و هنرمندانه برای جذب و لذت 
بردن بيشتر مخاطبان است.

در كل صفحه آرايي، هنر انتخاب فونت، اندازه كلمات، فواصل خطوط، فاصله از حاشيه ها، زيباسازی و طراحی 
گرافيکی صفحات، جاگذاری مناسب عکس ها و … است. به طور كلی می توان گفت كه صفحه آرايي به مجموعه 
عمليات قبل از آماده سازی چاپ نشريه می گويند. انتخاب مناسب رنگ ها جهت چاپ با كيفيت، ديد خلاقانه 

و طراحی قوی از ديگر عوامل يک صفحه آرايي مناسب است.
به عبارت ديگر صفحه آرايي هنر جذب توجه مخاطب به مطالب نشريه و كمک به افزايش توجه او به علاوه 

ايجاد اشتياق در دنبال كردن موضوع نشريه است كه اين مهم با شناخت مخاطب به دست می آيد.
صفحه آرايي به صورت تاريخی توسط حروف چينان و به طور دستی انجام می شده، اما اين روزها با پيشرفت 
علم و فناوری بيشتر از نرم افزارهای رايانه ای برای اين منظور استفاده می گردد كه Adobe InDesign از 
مهم ترين نرم افزارهای صفحه آرايي است كه با امکانات فراوان، دست طراح را برای انواع خلاقيت باز می گذارد. 
Microsoft Publisher از ديگر نرم افزارهايی است كه سابقاً طرفدار زيادی داشته، اما اكنون جای خود را به 
نرم افزار شركت Adobe داده است. Microsoft Word هم امکان صفحه آرايي را برای كاربران غير حرفه ای 

به سادگی فراهم كرده تا برای كارهای روزمره به مشکلی برخورد نکنند.
 

1ـ19ـ9ـ ترکیب بندی در صفحه آرایي 
تركيب بندی به معنی قرار گرفتن اجزای مختلف در كنار هم و تشکيل يک »كل« است. در يک صفحه آرايي 
خوب محل قرارگيری اشيا در توازن و تعادلی با يکديگر قرار دارند كه حس مطلوبی به بيننده القا می كنند. با 
جابه جايی اجزای مختلف در صفحه آرايي خوب می توانيد به اين حس خوب كه همان حس زيبايی است دست 
پيدا كنيد. در يک طراحی صفحه آرايي زيبا، تركيب تصاوير، خطوط، متون، رنگ ها، سايه ها، شفافيت تصاوير 

و غيره به صورت متوازن در كنار يکديگر جای گرفته اند.
يکی از روش های مفيد جهت ايجاد تركيب بندی مناسب، روش تقسيم بندی سه تايی است. به اين صورت كه 
در نرم افزار با استفاده از خطوط راهنما، كادر را به سه قسمت مساوی عمودی و افقی تقسيم بندی می كنيد. از 

محل برخورد اين خطوط می توان به عنوان نقاط اصلی استفاده كرده و اجزای مهم را در آن قرار داد.
جدای از اين ها، يک طراح نيازمند دانش و مبانی هنرهای تجسمی و گرافيک جهت يک صفحه آرايي مناسب 
است. اين دانش است كه به هنرمند طراح می آموزد تا تركيب عناصر ملموس مانند، خط، سطح، متن، تصوير، 
اندازه، شکل، رنگ، تيرگی و روشنی، به همراه كيفيت خاص ديداری آن ها از قبيل تناسب، تعادل، هماهنگی 

و كنتراست را كه باعث مستحکم شدن اثر تجسمی می شود به راحتی به كار گيرد.
 

2ـ19ـ9ـ ویژگی صفحه آرایی خوب 
  مخاطب را در برابر خود متوقف مي كند. 

  توجه بيننده را به خود جلب مي كند و وي را به پيگيري و خواندن آن ترغيب مي كند. 

  آميزش جذابي از حروف و تصاوير را به نمايش مي گذارد. 

  به نحو مطلوب انتظام يافته است.
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  به خوبي مخاطب خود را مي شناسد.

  به خوبي عناصر اصلي طراحي را به خدمت مي گيرد.

  پيام را به مخاطبان خاص خود منتقل كند.

  مفهوم روشني دارد.

  كاملًا صريح است و هيچ ابهامي ندارد.

20ـ9ـ انواع كاغذ برای چاپ

قديم  بسيار  زمان های  از  بسته بندی  و  نوشتن  منظور  به  كه  است  وسيله هايی  قديمی ترين  از  يکی  كاغذ 
نوع محصول، وزن محصول، شرايط  به  با توجه  قرار گرفته شده است. در صنعت بسته بندی  استفاده  مورد 
كاغذ  انتخاب  به  اقدام  هزينه ها  گرفتن  نظر  در  با  می توانيم  ديگر  موارد  و  بسته بندی  ظاهر  زيست محيطی، 
مناسب كنيم. همچنين در چاپ انواع رسانه های چاپی مانند كاتالوگ، كارت ويزيت، بروشور، فولدر، تراكت 
و ساير رسانه های چاپی با توجه به نوع نياز و هزينه مورد نظر، اقدام به انتخاب كاغذ مورد نظرمان می كنيم.

به منظور چاپ انواع رسانه ها و بسته بندی ها، اگر با انواع مختلف كاغذ و مقوا آشنايی داشته باشيم، می توانيم 
در انتخاب محصول مورد نظرمان هوشمندانه تر عمل كنيم. در اين بخش به بررسی انواع كاغذ و مقوا به منظور 

چاپ ديجيتال و افست انواع رسانه های چاپی می پردازيم.
در حالت كلی اصول ساخت انواع كاغذ يکسان است و با توجه به نوع مصرف و نوع چاپ، گروهی از ويژگی ها تغيير 

می كند. قيمت و كيفيت انواع كاغذ بر مبنای نوع خمير آن تعيين می شود و در انواع مختلف ساخته می شود.
با توجه به محدوديت بازار كاغذ در ايران، همه انواع كاغذ در بازار ايران موجود نيست و تنها تعداد محدودی از 
انواع كاغذ در بازار عرضه می شود. اين كاغذها شامل انواع كاغذ ايرانی و خارجی است كه در گرماژهای مختلف 

توليد می شود. در ادامه به معرفی گرماژ كاغذ، انواع پوشش ها و انواع كاغذ می پردازيم.
 

 1ـ20ـ9ـ گرماژ کاغذ 
قبل از پرداختن به معرفی انواع كاغذ لازم است كه با واژه گرماژ كاغذ آشنا شويم و معنی و مفهوم آن را بدانيم.
گرماژ كاغذ يکی از مهم ترين عوامل در تعيين كيفيت و ضخامت كاغذ محسوب می شود. گرماژ كاغذ عبارت 
است از نسبت وزن كاغذ برحسب گرم به مساحت يک مترمربع از سطح كاغذ. برای درک بهتر يک مثال را در 
نظر می گيريم: اگر گرماژ يک كاغذ 70 گرم باشد، بدين معنا است كه هر يک مترمربع از اين كاغذ 70 گرم 
وزن دارد. هرچه مقدار گرماژ بيشتر باشد، كيفيت، ضخامت، استحکام و به تبع آن قيمت افزايش خواهد يافت. 

واحد گرماژ GSM (g/m²) است كه مخفف Grams per Square Meter است.
 

 2ـ20ـ9ـ پوشش لمینت و سلفون 
به فرايند كشيدن روكش به روی هر سطحی اصطلاحاً لمينت می گويند. در سيستم چاپ ديجيتال لايه نازک 
پلاستيکی را يک طرف يا دو طرف كار چاپی می  چسبانند كه كار را در برابر پاره شدن، رطوبت، گرما يا سرما 
اگر  با واحد ميکرون سنجيده می شوند.  لمينت ها، ضخامت متنوعی دارند كه  و چروكيدگی مقاوم می كند. 
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لمينت دارای ضخامت كمی باشد آن را سلفون نيز می نامند. از ديگر مزيت های لمينت كردن كار چاپی در 
چاپ ديجيتال می  توان به جلوه دادن به كار و زيبا كردن بيشتر كار با اضافه كردن لمينت مات يا براق به 
آن اشاره كرد. از لمينت و سلفون در چاپ كارت  های ويزيت، كاتالوگ ها، بروشورها و ديگر محصولات چاپی 

استفاده می شود.

شکل 15ـ9ـ پوشش لمینت و سلفون

در واقع لمينت كردن، محصول چاپی را در مقابل تا شدن و آسيب ديدن مقاوم می كند. در حالی كه سلفون، 
تنها در مقابل تا شدن از آن محافظت می كند.

 3ـ20ـ9ـ انواع کاغذ و مقوا در صنعت چاپ و بسته بندی 
 حال به بررسی برخی از انواع مختلف كاغذها و مقواها از جمله كاغذ تحرير، كاغذ و مقوای گلاسه، كاغذ كتان، 
كاغذ كرافت، مقوای كارتی، مقوای ايندربرد به همراه برخی از ويژگی ها و كاربردهايشان و اين كه برای هر نوع 

كاغذ چه نوع پوششی مناسب تر است می پردازيم.

 کاغذ تحریر 
كاغذ تحرير نوعی از كاغذ است كه امکان چاپ روی هر دو طرف آن موجود است و مركب به سمت ديگر آن 
نفوذ نمی كند. كاغذ تحرير در گرماژ 50، 55، 60، 65، 70، 75، 80، 100 و 120 توليد می شود كه با توجه 

به نوع نياز و كاربرد، از آن ها استفاده می شود.
در توليد كاغذهای تحرير از خميرهای شيميايی چوب پهن برگان و سوزنی برگان استفاده می شود. كاغذ تحرير 

دارای مقاومت مناسبی است كه اين امر، برای بايگانی به مدت طولانی بسيار اهميت دارد.
اين كاغذ در صنعت چاپ بيشتر برای چاپ انواع تراكت، چاپ كتاب، چاپ سربرگ و چاپ پاكت مورد استفاده 
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قرار می گيرد.
كاغذ تحرير در رنگ های مختلف توليد می شود كه نوع رنگ آن با توجه به خمير مورد استفاده هنگام توليد 
تعيين می گردد. سطح كاغذ تحرير علاوه بر اينکه برای چاپ بسيار مناسب است، برای نوشتن روی سطح آن با 
خودكار نيز بسيار مناسب است. روی سطح اين نوع كاغذ نمی توان هيچ نوع پوششی )سلفون و ...( ايجاد كرد.

 
 کاغذ یا مقوای گلاسه 

آن  سطح  روی  جوهر  يکنواخت  جذب  دليل  به  كه  است  هموار  بسيار  و  صاف  سطح  دارای  گلاسه  كاغذ 
برای چاپ انواع رسانه مناسب است. كاغذ گلاسه از مرغوب ترين انواع كاغذ است كه در گرماژهای مختلف 
توليد می شود. هر چه گرماژ در كاغذ گلاسه بالاتر باشد، مقاومت و ضخامت آن بيشتر می شود و همچنين 

می شود. انجام  بيشتری  كيفيت  با  آن  چاپ پذيری 
لازم به ذكر است برای اين نوع كاغذ می توان از پوشش لمينت و سلفون به منظور بالاتر بردن مقاومت كالای 
چاپی استفاده كرد. كاغذ گلاسه به منظور چاپ انواع رسانه های چاپی مانند چاپ كارت ويزيت، چاپ كاتالوگ، 

چاپ تراكت، چاپ بروشور، چاپ ساک دستی، چاپ تقويم و ساير موارد استفاده می گردد.

 مقوای ایندربرد 
ايندربرد نوعی مقوا است كه در گرماژهای مختلف توليد شده و در صنعت بسته بندی كاربرد فراوانی دارد و از 

آن به عنوان مقوای بهداشتی نيز نام می برند.
رنگ اين نوع مقوا سفيد است و به علت بافت خوبی كه دارد در صنعت بسته بندی مواد غذايی كاربرد بسياری 
دارد. اين مقوا به دليل قيمت و استحکام مناسبی كه دارد، در صنعت بسته بندی و چاپ جعبه های محصولات 
دارويی، آرايشی و بهداشتی كاربرد فراوانی دارند. همچنين پوشش سلفون برای بيشتر شدن مقاومت اين نوع 

بسته بندی، بسيار مناسب است.
 

 مقوای پشت طوسی 
مقوای پشت طوسی نوعی از مقوا است كه يک طرف آن سفيد و طرف ديگر آن طوسی است. اين نوع مقوا در 
گرماژهای مختلف 210، 230، 250، 280، 300، 350، و 400 توليد می شود. از مقوای پشت طوسی در 

چاپ جعبه و بسته بندی های متفاوت استفاده می شود.
مقوای پشت طوسی يا دوبلکس از چسبانده شدن ورقه های مقوا به صورت دولايه توسط صفحات مخصوص 
مانند  مصارف  برخی  در  حساسيت  و  بودن  بازيافتی  علت  به  طوسی  پشت  مقوای  می شود.  تهيه  مرطوب 

نمی گيرد. قرار  اين صنايع خاص  توجه  مورد  غذايی  مواد  بسته بندی  و  دارويی  جعبه های 
  

 کاغذ کرافت 
 اين نوع كاغذ از سولفات خمير پالت تهيه شده و دارای مقاومت بالايی است. كاغذهای كرافت انواع متفاوتی 
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دارند؛ از جمله كاغذهای كرافت سفيد نشده كه بيشتر در صنعت بسته بندی استفاده می شوند يا كاغذهای كرافت 
سفيد شده كه برای تهيه كاغذهايی كه پيوستگی بافت آن ها قوی است بيشتر مورد استفاده قرار می گيرد.

شکل 16ـ9ـ کاغذ کرافت
كاغذ كرافت معمولاً با رنگ قهوه ای يا با رنگ سفيد توليد می شود و بادوام است. گرماژ و وزن اين كاغذ بسيار 
متنوع است به طوری كه از تركيب آن ها در توليد ورق و كارتن امکان توليد بيش از يک صد نوع تركيب در 
ورق های 3 لايه و 5 لايه ميسر می گردد و به صورت كاغذ كرافت، مقوای كرافت و مقوای زبر يا خشن كرافت 
است. اين نوع كاغذ مورد استفاده در ساخت جعبه، پاكت و همچنين چاپ ساک دستی است. لازم به ذكر 

است هيچ نوع پوششی برای سطح كاغذ كرافت مناسب نيست.

 کاغذ کتان 
كاغذ كتان نوع خاصی از كاغذ بافت دار است كه به دليل دارا بودن بافت در درون كاغذ، روی سطح ويژگی 
خاصی ايجاد می كند. اين بافت ها بسته به نوع كاغذ كتان و كشور توليد كننده آن، متغير است. كاغذ كتان در 
چاپ كارت ويزيت، چاپ پاكت و چاپ سربرگ استفاده می شود. در اين نوع كاغذ شيار های عمودی يا افقی 
يا هر دو ديده می شود كه اين شيار ها و بافت های ريز، زيبايی ويژه ای به كار های چاپی و به ويژه كارت های 
ويزيت می دهد. به دليل وجود همين بافت های برجسته، برای سطح كاغذ كتان از هيچ نوع پوششی استفاده 

نمی شود تا زيبايی آن به شکل بهتری جلوه گر باشد.

شکل 17ـ9ـ کارت ویزیت با کاغذ کتان بافت دار
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 مقواي کارتی 
اين نوع مقوا در رنگ های متفاوت توليد می شود. مقوای كارتی بافت نسبتاً يک دست و بدون برجستگی و 
فرورفتگی دارد. از اين نوع مقوا براي جدا سازي بخش هاي مطالب در زونکن و از نوع مرغوب و ضخيم تر آن نيز 
براي چاپ كارت ويزيت استفاده مي شود. لازم به ذكر است، در صورت انتخاب اين نوع مقوا برای چاپ كارت 

ويزيت، امکان استفاده از پوشش سلفون و يا لمينت وجود ندارد.
 

 کاغذ کاربن لس 
كاغذی با پوشش شيميايی كه شبيه به كاربن عمل می كند و يک 
كپی از نوشته های دست نويس را روی صفحه بعدی انتقال می دهد. 
پايين است كه  با گرماژ  الوان  و  تحرير سفيد  واقع همان كاغذ  در 
پس از توليد با ماده شيميايی تركيب شده تا قابليت كپی كردن را 

باشد. داشته 
از كاغذهای الوان در چاپ فاكتورها و فرم های سه نسخه ای استفاده 

می شود.

 

21ـ9ـ استاندارد طراحی بروشور

توليد كنندگان، فروشندگان و يا ارائه دهندگان خدمات در جستجوی راهی مؤثر و مقرون به صرفه برای معرفی 
كالا، محصولات و يا خدمات خود هستند و چاپ بروشور را به اين منظور انتخاب می كنند. در اين صورت 
دانستن اصول اوليه طراحی بروشور به شما كمک خواهد كرد تا بتوانيد فايل بروشور خود را به بهترين شکل 

و به صورت استاندارد تهيه كرده و به چاپ برسانيد.

شکل 19ـ9ـ نمونه بروشور

شکل 18ـ9ـ کاغذ کاربن لس
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در اين بخش قصد داريم به معرفی اصول طراحی بروشور های تبليغاتی بپردازيم زيرا دانستن اين اصول به 
طراحان و صاحبان مشاغل كمک می كند تا برای معرفی محصولات و خدمات خود استراتژی درستی به كار 
گيرند. در حقيقت، در طراحی بروشور، مباحثی همچون زيبايی شناسی، خلاقيت و برقرار كردن ارتباط مؤثر 

با مخاطب، اهميت بسياری دارد. 
در واقع لازم است ابتدا اصول طراحی بروشور و نحوه تهيه فايل مناسب برای چاپ را بدانيم تا با كمک اين 
دانش فنی، بروشوری استاندارد طراحی كنيم. لازم به ذكر است، گرچه دانستن اين اصول برای موفقيت در 
طراحی بروشور كافی نيست اما لازمه داشتن يک بروشور خوب و استاندارد به حساب می آيد. بدين معنا كه 
حتی در صورت داشتن يک طراحی جذاب و عالی، با رعايت نکردن اين موارد فنی قطعاً محصول خروجی، 

انتظارات شما را برآورده نخواهد كرد. 
 

 1ـ21ـ9ـ اصول طراحی بروشور برای چاپ 
در طراحی بروشور موارد بسياری وجود دارد كه رعايت آن ها، كيفيت خروجی نهايی را تضمين می كند. در 

ادامه به معرفی اين موارد خواهيم پرداخت و ويژگی های فايل مناسب برای چاپ را عنوان خواهيم كرد.
 

 ابعاد بروشور چاپی 
 در تمام كارهای چاپی اعم از بروشور، تراكت، كاتالوگ، كارت ويزيت و ... پيش از شروع طراحی، حتماً ابعاد 
نهايی كار را در نظر گرفته و يک فايل طراحی به همان اندازه ايجاد كنيد. زيرا تغيير اندازه كار پس از پايان 
طراحی می تواند موجب كاهش كيفيت كار، كاهش خوانايی نوشته ها و يا به هم ريختگی عناصر موجود در 

طراحی شود.
 به عنوان مثال فرض كنيد هنگام طراحی ابعاد فايل خود را A5 در نظر گرفته ايد. حالا تصميم گرفته ايد آن را 
بزرگ تر كرده و با اندازه A4 چاپ كنيد. در اين صورت با بزرگ كردن ابعاد كار، كيفيت تصاوير پايين می آيد، 
چون در واقع تصاوير از دو طرف كشيده می شوند. همچنين در صورتی كه فايل خود را بزرگ تر از ابعادی 
كه قرار است چاپ شود طراحی كنيد، امکان ناخوانا شدن نوشته ها و عناصر كوچک در ابعاد جديد به وجود 
می آيد. به عنوان مثال اگر در ابعاد A4 اندازه فونت نوشته های شما 8 پوينت باشد با كوچک كردن كل فايل 

ممکن است اندازه جديد نوشته ها كاهش يافته و ناخوانا شود.
 جدا از اين موارد مشکل ديگری كه در تغيير ابعاد كار وجود دارد، دفرمه شدن يا تغيير نامتناسب ابعاد كار 
است. به طوری كه تصاوير و عناصر موجود در طراحی با كشيده يا جمع شدن، شکل عادی خود را از دست 
می دهند و از زيبايی بروشور چاپ شده می كاهند. بنابراين بهتر است ابتدا تصميم نهايی خود را برای اندازه 

چاپ بروشور اتخاذ كرده و سپس اقدام به طراحی كنيد.
 

 نرم افزار مناسب برای طراحی بروشور 
انجام شود؟  نرم افزاری  با چه  است  بهتر  بروشور  كه طراحی  می آيد  پيش  اين سؤال  افراد  از  بسياری  برای 
برخی افراد نرم افزارهای نقش بيتی مانند Adobe Photoshop را برای اين كار پيشنهاد می كنند و برخی 
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ديگر، استفاده از نرم افزارهای برداری مانند Adobe Illustrator و Corel Draw را برای اين كار مناسب تر 
به  )نسبت  برای صفحه آرايی   InDesign نرم افزار  تخصصی  ويژگی های  و  امکانات  به  توجه  با  اما  می دانند. 
نرم افزارهای  ياد شده(، InDesign بهترين و مناسب ترين  است به ويژه اگر بروشور و كاتالوگ دارای صفحات 
و تصاوير زيادی باشد. بهتر است در نرم افزار InDesign،  از برگه Print كه مختص كارهای چاپی است، ابعاد 
استاندارد مانند A4 را انتخاب كرده يا ابعاد دلخواه را ترجيحاً به ميلی متر وارد كنيد. اگر فايل بروشور را در 

نرم افزار Photoshop طراحی می كنيد به اين نکات بايد بيشتر توجه كنيد:
  رزولوشن فایل: چه كارت ويزيت طراحی كنيد، چه كاتالوگ يا هر محصول چاپی ديگری، رزولوشن فايل 

طراحی از ابتدا بايد 300dpi تعيين شود. در صورت پايين تر بودن رزولوشن، كيفيت چاپ مناسب نخواهد 
بود. گاهی اوقات افراد فايل خود را در مانيتور مشاهده می كنند و متوجه پايين بودن كيفيت تصاوير نمی شوند 
)رزولوشن نمايشگرها 72dpi است؛ بنابراين مقايسه تصوير چاپی با تصوير نشان داده شده در مانيتور به هيچ 
وجه درست نيست(. همچنين بالا بردن رزولوشن حين طراحی بروشور و يا پس از پايان آن، تأثيری در افزايش 

كيفيت كار، نخواهد داشت. بنابراين لازم است از ابتدا، رزولوشن فايل طراحی را 300dpi مشخص كنيد.

Photoshop شکل 20ـ9ـ تعیین رزولوشن بروشور در نرم افزار

 
 

داشتن رزولوشن 300dpi علاوه بر فايل طراحی، برای تمام عناصر و تصاوير مورد استفاده در طراحی 
نيز الزامی است.

نکته
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  رنگ نوشته ها: نوشته ها از مهم ترين عناصر در طراحی بروشور هستند كه وظيفه انتقال اطلاعات به مخاطب 

را به عهده دارند. اما به دليل ظرافت و داشتن جزئيات، بايد برای نحوه قرارگيری و نمايش آن ها به نکات ريزی 
توجه شود. يکی از اين نکات، رنگ نوشته ها است. رنگ مشکی روی بسياری از زمينه ها، به خوبی خودنمايی 
رنگ  استفاده هر  اما  استفاده می شود.  نوشته ها  برای  رنگ  اين  از  اغلب  بروشور  در طراحی  بنابراين  می كند. 
 Y=0 و M=0 و C=0( مشکی ای برای نوشته ها مناسب نيست. لازم است تركيب رنگ مشکی برای نوشته ها
و K=100( و blending option روی گزينه multiply باشد تا كيفيت و وضوح آن ها در چاپ مناسب باشد.

      لازم به ذكر است گرچه ممکن است اين رنگ مشکی در مانيتور كم رنگ به نظر برسد اما بهترين انتخاب 
برای نوشته های كوچک و متوسط به شمار می رود.

  اندازه فونت نوشته ها: يکی از نکاتی كه در طراحی بروشور و تهيه فايل چاپی آن بسيار مهم است، آن 

است كه اندازه فونت نوشته ها كمتر از 6 پوينت نباشد. در حقيقت كوچک تر بودن اندازه فونت ها، از خوانايی 
مطالب می كاهد. البته اين مقدار در فونت های مختلف و بين زبان فارسی و انگليسی می تواند متفاوت باشد، 
اما عموماً رعايت اين اندازه، خوانايی نوشته را تضمين می كند. البته اندازه استاندارد فونت نوشته ها برای متون 
داخلی اغلب بين 8/5 تا 13/5 است. همچنين اندازه فونت برای نوشته های انگليسی می تواند بين 0/5 تا يک 

پوينت كوچک تر از فونت فارسی تعيين شود.
  سیستم رنگی )Color Mode(: سيستم رنگی در مانيتورها، سه رنگ )RGB( است و ماهيت نمايش 

آن نوری است؛ بدان معنا كه نور، عامل نمايش رنگ ها در نمايشگر است. در واقع هرچه نور بيشتر باشد )درجه 
RGB بالا برود( رنگ نهايی روشن تر می شود. اما در چاپ، سيستم رنگی، چهار رنگ )CMYK( است و اين 
رنگ ها توسط مركب يا جوهر چاپ ايجاد می شوند. هرچه مقدار اين رنگ ها بيشتر شود، رنگ نهايی، تيره تر 
خواهد شد. به دليل اين كه ماهيت اين سيستم ها با يکديگر متفاوت است، موارد استفاده از آن ها نيز متفاوت 
است. بنابراين بايد برای نزديک تر شدن رنگ ها به محصول خروجی، لازم است فايل طراحی در حالت رنگی 

CMYK ايجاد شود.

در صورت استاندارد بودن مانیتور و با رعایت سیستم رنگی ذکر شده در بالا، رنگ های دیده شده در 
نمایشگر به رنگ های چاپی نزدیک می شود، اما به دلیل تفاوت ماهیتی رنگ ها )در چاپ و نمایشگر( 
که در بالا ذکر شد، همچنان احتمال 15 درصد اختلاف رنگ میان فایل طراحی و محصول چاپی 

وجود دارد.

نکته

RGB در برابر CMYK شکل 21ـ9ـ حالت رنگ
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  اضافه رنگ: يکی ديگر از نکات كليدی در طراحی بروشور، رعايت اضافه رنگ است. در تمام دستگاه های 

چاپ امکان جابه جايی چاپ پشت و روی فايل به اندازه چند ميلی متر وجود دارد. بنابراين در سفارش هايی كه 
زمينه آن ها رنگ يا طرح دارد، برای آن كه اطراف كار پس از برش سفيد نماند، لازم است رنگ و طرح زمينه 
را از هر طرف حدود سه ميلی متر خارج از كادر اصلی، امتداد دهيد. به عنوان مثال در صورتی كه سفارش شما 
يک بروشور A4 باشد، بهتر است به جای 21×29/7 سانتيمتر، فايل خود را با ابعاد 21/6×30/3 سانتيمتر 
طراحی كنيد. اما بايد دقت كنيد كه در اين فضای سه ميلی متری، تنها می توانيد رنگ و طرحی را قرار دهيد 
كه بريده شدن آن تأثير منفی ای بر كار ندارد. به عبارتی قرار دادن لوگو و نوشته در اين فضا توصيه نمی شود.

  حاشیه برش و فضای امن: همان گونه كه در بند قبل ذكر شد، هميشه امکان جابه جايی طرح به اندازه 

چند ميلی متر هنگام چاپ و برش وجود دارد و اين خطا اجتناب ناپذير است. بنابراين طراحان، حاشيه امنی را 
برای كار خود در نظر می گيرند تا نوشته ها و عناصر مهم در طراحی، به دليل خطای برش، از بين نروند. اين 
مقدار بين 7 تا 10 ميلی متر از هر طرف كار است. البته در صورتی كه فايل طراحی به اندازه A5 يا كوچک تر 

از آن باشد، رعايت 5 تا 7 ميلی متر فاصله، كافی است.

  خطوط تا: بروشورها يک يا چند خط تا دارند و در نواحی »خط تا« نيز مشابه حاشيه های كار، امکان 

خطا و جابه جايی وجود دارد، بنابراين بهتر است عناصر و نوشته ها، حداقل 5 ميلی متر از هر طرفِ خط تاها 
فاصله داشته باشند.

شکل 22ـ9ـ خط تا

به دليل مسائل مربوط به زيبايی شناسی، در صورتی كه فاصله نوشته ها با حاشيه بيشتر از مقدار مذكور 
باشد، زيبايی و خوانايی بروشور بيشتر می شود. 

نکته
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 نکات تکمیلی 
 هنگام طراحی بروشور شما می توانيد هر لت را به طور جداگانه در يک صفحه طراحی كنيد اما بهتر است تمام 
آن ها را به صورت يک تکه، طراحی كنيد )يک صفحه روی كار و يک صفحه پشت كار باشد(. در اين صورت 
لازم است به اندازه هر لت توجه كنيد تا احتمال خطای طراحی كاهش يابد. اين كار نه تنها به شما ديد بهتری 
نسبت به نحوه قرارگيری عناصر در خروجی نهايی می دهد، بلکه احتمال بروز خطا در چيدمان صفحات موقع 
چاپ را نيز كاهش می دهد. همواره پيشنهاد می شود پيش از ثبت سفارش، يک پرينت سياه و سفيد از بروشور 
خود ـ ترجيحاً در ابعاد واقعی ـ تهيه كنيد تا بتوانيد با بررسی دقيق تر نوشته ها و خطوط تا و محل قرارگيری 

لت ها، خطا و اشتباه را تا حد ممکن كاهش دهيد.
مسئله ديگری كه بر بروشور نهايی شما تأثيرگذار است، انتخاب كاغذ است. شما بايد با توجه به بودجه، نياز و 
سليقه خود، كاغذ مناسبی را جهت چاپ بروشور انتخاب كنيد. به طور كلی، تفاوت كاغذها در جنس و ضخامت 
آن ها است و اين امر تأثير بسياری در خروجی چاپی دارد. به عنوان مثال كاغذ تحرير، مات است و ميزان جذب 
مركب بالاتری نسبت به مقوای گلاسه دارد. با توجه به اين كه مقوای گلاسه اغلب براق است، رنگ ها روی 
آن با درخشندگی بيشتری نسبت به كاغذ تحرير، خودنمايی می كنند. اين تفاوت ماهيتی در كاغذها، موجب 

تفاوت شديدی در خروجی چاپی می شود.

22ـ9ـ استاندارد طراحی كاتالوگ

كاتالوگ ها در شکل، رنگ، جنس، طرح، اندازه و با اهداف مختلف طراحی و توليد می شوند. اگر قصد داريد 
برای محصولات شركت خود يک كاتالوگ زيبا و مؤثر توليد كنيد؛ تا انتهای اين بخش همراه ما باشيد. در ادامه 
درباره ويژگی های مختلف انواع كاتالوگ نکات مهمی را با شما در ميان می گذاريم. نکاتی كه كمک می كند 

انتخاب های بهتری برای طراحی و توليد كاتالوگ داشته باشيد.

 1ـ22ـ9ـ اندازه انواع کاتالوگ 
كاتالوگ ها مانند ساير محصولات تبليغات چاپی، دارای اندازه های استاندارد و مختص به خود هستند. اين 
استانداردها بر اساس تجارب قبلی به وجود آمده و در درجه اول توصيه می شود كاتالوگ خود را در يک اندازه 

استاندارد و پركاربرد طراحی كنيد.
اندازه A4 و A5 و به سه صورت عمودی، افقی و مربعی طراحی و چاپ  به طور معمول كاتالوگ ها در دو 
می شوند. البته اندازه ها و اشکال ديگری از كاتالوگ نيز وجود دارد كه معمولاً به دليل اتلاف زياد كاغذ هزينه 

بيشتری را موجب می شوند.
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شکل 23ـ9ـ کاتالوگ

 2ـ22ـ9ـ جنس و پوشش جلد کاتالوگ 
جنس جلد كاتالوگ ها به طور معمول از كاغذ گلاسه است؛ كه بنابر سليقه شخصی می توان از انواع كاغذ گلاسه 
با ضخامت های مختلف برای آن استفاده كرد. طبيعتاً كاغذهای گلاسه ضخيم تر، كاتالوگ شما را سنگين تر، 
مستحکم تر و البته با هزينه های بيشتر همراه می كند. تجربه ثابت كرده است كه استفاده از كاغذ گلاسه ضخيم 

برای جلد و كاغذهای گلاسه نازک تر برای صفحات داخلی، هارمونی خوبی در محصول نهايی ايجاد می كند.
كاتالوگ ها ابزارهای تبليغاتی با دوامی هستند. از اين رو بسيار مهم است كه مدت طولانی تری با همان كيفيت 
و زيبايی سابق حفظ شده و قابل استفاده باشند. از سويی ديگر يکی از ضعف های چاپ روی كاغذ گلاسه اين 
است كه در صورت استفاده متوالی و لمس جلد كاتالوگ با دست، كم كم از كيفيت تصوير چاپ شده روی آن 

كاسته می شود.
 

شکل 24ـ9ـ نمونه کاتالوگ
باشد.  مؤثر  بسيار  كاتالوگ  عمر  افزايش  در  محافظت كننده می تواند  روكش  از يک  استفاده  اين شرايط  در 
سلفون محبوب ترين پوشش مورد استفاده برای جلد كاتالوگ است. سلفون ها يک لايه پلاستيکی بسيار نازک 
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هستند كه پس از چاپ، روی كاغذ جلد چسبانده می شوند. سلفون ها علاوه بر استحکام موجب افزايش زيبايی 
ظاهری كاتالوگ نيز می گردند. اين پوشش در انواع براق، مات و مخملی )بافت دار( و بنابر سليقه شما مورد 

استفاده قرار می گيرند.

 3ـ22ـ9ـ گرماژ کاتالوگ 
در قسمت اندازه درباره ضخامت كاغذ مورد استفاده در انواع كاتالوگ اشاره كوتاهی داشتيم. اما اينکه چطور 
ضخامت انواع كاغذ را تشخيص دهيد نيازمند آشنايی با موضوع گرماژ كاغذ است. هر نوع كاغذی بر مبنای 
برگ 100  يک  كه  معناست  اين  به  گرم  كاغذ گلاسه 300  مثلًا  تعريف می شود.  مربع  متر  در  آن  گرماژ 

سانتی متر در 100 سانتی متر از اين كاغذ، 300 گرم وزن دارد.
كاتالوگ،  از طراحی  از سليقه شخصی و هدف  فارغ  كاتالوگ،  برای كاغذ  همچنين در مورد گرماژ مناسب 
معمولاً برای جلد كاتالوگ از كاغذ گلاسه 250 يا 300 گرم و برای صفحات داخلی آن از كاغذ با گرماژ  135، 

150، 170 و 200 استفاده می گردد.

شکل 25ـ9ـ کاتالوگ هایی با گرماژهای مختلف

 4ـ22ـ9ـ جهت های باز کردن کاتالوگ 
جهت باز كردن كاتالوگ موضوعی به نسبت ساده است؛ اما اگر هنگام طراحی و چاپ به آن دقت نکنيد به راحتی 
می تواند برای شما مشکل ساز شود. كاتالوگ ها را مانند كتاب ها می توان از چپ به راست يا برعکس باز كرد. 
كاتالوگ های راست به چپ برای محتوای فارسی و كاتالوگ چپ به راست برای محتوای انگليسی مدنظر است.

شکل 26ـ9ـ نمونه ای از یک کاتالوگ انگلیسی
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 5 ـ22ـ9ـ نوع صحافی کاتالوگ 
صحافی كاتالوگ براساس سه سبک مفتول تخت، مفتول لوپ و چسب گرم انجام می شود. به بيان ساده تر 
می توان گفت منظور از صحافی مفتول همان منگنه است. اگر اين منگنه همان حالت ساده هميشگی را داشته 
باشد؛ به نام صحافی مفتول تخت شناخته می شود. اما اگر قسمت بيرون منگنه حالت نيم دايره داشته باشد؛ 
به آن صحافی مفتول لوپ می گويند. مزيت حالت لوپ در اين است كه قابليت آويزان كردن كاتالوگ را از 

آويزهای مختلف فراهم می كند.
 

شکل 27ـ9ـ انواع صحافی کاتالوگ

صحافی به شکل مفتول معمولاً برای كاتالوگ های با تعداد صفحات كم يا كاغذ نازک مناسب است. چرا كه 
در صورت افزايش صفحات و حجم كاتالوگ، اين سبک از صحافی قادر به حفظ ساختار برگه های كاتالوگ در 

كنار يک ديگر نخواهد بود.
صحافی چسب گرم روش معمول ديگری است كه برای انواع كاتالوگ به وفور مورد استفاده قرار می گيرد. در 
اين روش و به كمک دستگاه صحافی حرارتی، نوعی چسب را گرم كرده و عطف صفحات كاتالوگ را به كمک 
آن به هم پيوند می زنند. صحافی چسب گرم در صورت انجام درست فرايند، يکی از بهترين روش های صحافی 

برای كاتالوگ های با تعداد صفحات بالا است.

 6 ـ22ـ9ـ طراحی کاتالوگ متناسب با هر کسب وکار 
گاهی كسب وكارها درک  است.  متفاوت  ديگر  با كسب وكارهای  كاتالوگ،  از طراحی  هدف هر كسب وكاری 
با  تفاوتی  تبليغات چاپی ندارند. به عنوان مثال نمی دانند كاتالوگ چه  ادوات مختلف  از تفاوت های  دقيقی 

بروشور دارد و در كجا به كار می رود.
كاتالوگ  يک  درست  انتخاب  پس  هستند.  شما  خدمات  يا  محصول  كاغذی  نمايشگاه  نوعی  به  كاتالوگ ها 
بيش از هرچيز به شناخت درست شما از محصول مدنظر مرتبط است. به عنوان مثال كاتالوگ يک خودرو با 
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كاتالوگ محصولات آرايشی و بهداشتی متفاوت است. اين تفاوت علاوه بر طراحی، در جزئيات توليد فيزيکی و 
چاپ كاتالوگ نيز بايد احساس شود. توجه به رنگ سازمانی، موضوع محصولات و خدمات، ويژگی ها، مخاطبان 

هدف، شکل توزيع و … از مهم ترين موارد در اين زمينه است

 23ـ9ـ استاندارد طراحی كتاب و مجله

يکی از مهم ترين عواملی كه در تفاوت قطع كتاب ها و نشريات اثرگذار هست ميزان هدررفت كاغذ است كه 
برای اين منظور اندازه كتاب و نشريات به نحوی تعيين شده اند كه بيشترين بازده و كمترين هدررفت كاغذ را 
داشته باشند. انواع قطع استاندارد كتاب و مجله با توجه به پرمصرف بودن 3 نوع كاغذ ورقی يعنی 70×100، 
90×60 و 45×60 تعيين می شوند. به اين ترتيب انتخاب بهترين قطع كار با توجه به ميزان دورريز كاغذ 
می تواند در تصميم گيری شما اثرگذار باشد و شما می توانيد بر اين مبنا قطع كار خود را انتخاب كنيد. در چاپ 
كتاب و نشريات چند صفحه از كار در يک ابعاد كاغذ مورد نظر چيدمان يا در اصطلاح فرم بندی می شوند. در 

شکل 28ـ9 نمونه هايی از فرم بندی قطع های مختلف كتاب و مجله را مشاهده می كنيد.

 
شکل 28ـ9ـ فرم بندی کتاب

 1ـ23ـ9ـ قطع کتاب 
قطع و ابعاد كتاب ها معمولاً به صورت عمودی در نظر گرفته می شود، به اين صورت كه عطف كتاب در ضلع 
از  و عرض هر ضلع  به طول  بستگی  نام گذاری قطع های مختلف كتاب  دليل  قرار می گيرد.  بزرگ تر كتاب 
كتاب ها دارد. چاپ كتاب در ابعاد متفاوت باعث استفاده آسان تر و همچنين امکان نگهداری بهتر می شود.

بياضی، جانمازی،  بغلی،  بغدادی،  بازوبندی،  وزيری،  از: رقعی،  نشريات عبارت اند  و  قطع های مختلف كتاب 
. ... حمايلی، خشتی، رحلی، سلطانی، نيم ربعی، نيم ورقی، جيبی و 
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 2ـ23ـ9ـ قطع مجله 
قطع رحلی به دليل ابعاد بزرگی كه دارد فضای خوبی را برای قرار دادن انواع محتوا در اختيار پديدآورندگان 
مجله قرار می دهد. متداول ترين قطع مجله، قطع رحلی كوچک است كه معمولاً از اين قطع برای طراحی و 
چاپ مجلات با موضوعات مختلف استفاده می شود. همچنين قطع رحلی كوچک به نسبت قطع های بزرگ تر، 
قطع مناسب تری برای جابه جايی و استفاده مخاطب از مجله است. از قطع رحلی بزرگ هم برای برخی مجلات 
و نشريات استفاده می شود كه معمولاً موضوعات خاصی مانند مد و صنايع لوكس دارند و يا اهداف خاصی مانند 
نمايش تصاوير بزرگ را دارند )برای مشاهده ابعاد دقيق قطع رحلی كوچک و بزرگ به جدول 1ـ9 مراجعه كنيد(.

 3ـ23ـ9ـ انواع قطع کتاب و مجله 
در جدول 1ـ9 رايج ترين و پركاربردترين ابعاد و قطع كتاب و مجله را مشاهده می كنيد )ابعاد ارائه شده در 
اين جدول ابعادی هستند كه به طور معمول در كشور برای چاپ كتاب و نشريات از آن ها استفاده می شود، 
البته ناشرانی هستند كه از ابعادی با 2 يا 3 ميلی متر بيشتر استفاده می كنند، ولی در مجموع ابعاد قطع های 

موجود در جدول زير پر استفاده تر و كم ريسک تر هستند(.

جدول 1ـ9ـ انواع قطع کتاب

ابعاد حدودی قطع کتاب
استاندارد

ابعاد بعد از 
)cm( برش

ابعاد قبل از 
)cm( برش

تعداد صفحات در 
هر طرف فرم

کاغذ پیشنهادی 
شیت بندی

B516/5 × 23/517 × 24/5870×50وزيری

A514 × 2114/5 × 22845×60رقعی

A421 × 28/521/5 × 29/5460×45رحلی

50×34470 × 3324/5 × 24—رحلی بزرگ

100×49470 × 4834/5 × 34—سلطانی

50×23670 × 2222 × 21/5—خشتی

60×20645 × 1919/5 × 19—خشتی كوچک

50×231270 × 2212 × 11/5—پالتويی

60×19/51245 × 1911 × 10—پالتويی كوچک

60×14/51645 × 1411 × 10—جيبی

B611/5 × 1612 × 171670×50ربعی



186

شکل 29ـ9ـ انواع قطع و ابعاد استاندارد کتاب و مجله

 قطع وزیری 
قطع وزيری، يکی از قطع های رايج است كه به دليل استفاده بيشتر اين قطع در كتاب های مرتبط با آموزش و 
كتاب های دانشگاهی، بيشتر با آن برخورد داشته ايم. اين قطع به دليل كوچک تر بودن از قطع رحلی و بزرگ تر 
بودن از قطع رقعی، ويژگی های ساختاری مناسبی را برای كتاب های آموزشی و عمومی ايجاد می كند، البته 
اين موضوع هميشگی نيست و نسبت به محتوا، قطع تعيين می شود. كاغذ مناسب برای قطع وزيری، كاغذ 

70×50 است كه با 3 بار تا خوردن می توان به قطع وزيری رسيد.
موارد مناسب برای قطع وزيری: كتاب های درسی، عمومی، آموزشی، دانشگاهی و كتاب های مصور.

 قطع رقعی 
يکی ديگر از رايج ترين قطع ها در ميان كتاب ها قطع رقعی است. اين قطع به دليل ابعاد كوچک برای كتاب های 
اين قطع برای مواردی مناسب است كه معمولاً مدت طولانی  با حجم محتوای كم مناسب تر است. معمولاً 
همراه مخاطب است و جابه جايی زيادی دارد. ابعاد كاغذهای اوليه در سه اندازه مختلف در اختيار چاپخانه ها 

قرار می گيرد. يکی از اين ابعاد 45×60 است. با سه بار تا كردن اين كاغذ قطع رقعی به دست می آيد.
موارد مناسب برای اندازه رقعی: كتاب های رمان، شعر و مذهبی.

 قطع خشتی 
قطع خشتی به كتاب ها و نشرياتی كه به شکل مربع هستند گفته می شود كه معمولاً از كاغذ در ابعاد 45×60 
برای قطع خشتی استفاده می شود. با تا كردن كاغذ به صورتی كه به 6 قسمت 20×20 تقسيم شود يکی از 
ابعادی است كه می توانيد با كمترين هدررفت كاغذ به دست آوريد. اگر از كاغذ با ابعاد 70×50 استفاده كنيد 
كتاب در قطع خشتی با ابعاد 23×23 به دست می آيد كه اندازه استاندارد كتاب های خشتی بزرگ است. موارد 

مناسب برای قطع خشتی: كتاب های كودكان و داستان های مصور، كاتالوگ و بروشورهای تبليغاتی.
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 قطع رحلی 
قطع رحلی يا A4 يکی از رايج ترين قطع های مورد استفاده برای كتاب و مجلات است. به سه دسته رحلی كوچک، 
رحلی متوسط، رحلی بزرگ تقسيم می شود كه ابعاد رحلی 21×28/5 و ابعاد رحلی بزرگ 24×33 است. كاغذ 
مناسب قطع رحلی 45×60 و رحلی بزرگ 50×70 است. قطع رحلی از پركاربردترين قطع های استاندارد است كه 

در شاخه های مختلف چاپ و تبليغات و مشاغل مختلف مورد استفاده قرار می گيرد.
دايره ..  المعارف ها،  و  دانشنامه ها  آموزشی، كتاب های مرجع،  برای قطع رحلی: كتاب های عمومی،  مناسب  موارد 

كتاب های مصور، برخی از كتاب های مذهبی مانند قرآن، مجلات و نشريات، كاتالوگ و بروشور.

 قطع سلطانی 
به دليل ويژگی قطع سلطانی، می توان از اين قطع برای نمايش جزئيات تصاوير و ايجاد حس شکوه و اهميت 
كار بهره گرفت. قطع سلطانی معمولاً به دليل بزرگی و فضای زياد آن برای كتاب های خطی نفيس و مصور 
مانند قرآن  و كتاب های تاريخی و مصور و همچنين مجلات خاص مورد استفاده قرار می گيرد. كاغذ مورد 

استفاده برای اين قطع ابعاد 70×100 است.
برای قطع سلطانی: كتاب های مرجع، قرآن و كتاب های خطی نفيس، شاهنامه و كتاب های  موارد مناسب 

.)... تاريخی و كتاب های مصور، مجلات خاص )مانند مجلات مد، ساختمان، لوكساری و 

 قطع جیبی 
قطع جيبی به دليل ابعاد كوچکی كه دارد امکان استفاده و حمل آسان را فراهم می كند و می تواند برای توليدات 
كم حجم و كوتاه مورد استفاده قرار گيرد. قطع جيبی خود به دو دسته جيبی بزرگ و جيبی كوچک تقسيم 

می شوند. اگر كاغذی در ابعاد 70×50 را چهار بار را تا كنيد می توانيد كتابی در ابعاد جيبی داشته باشيد.
موارد مناسب برای اندازه جيبی: كتاب های مذهبی )ادعيه و زيارت نامه(، شعر و كتاب های كم حجم، پمفلت 

و اقلام تبليغاتی با محتوای كم.

 قطع پالتویی 
همانطور كه از نام اين قطع مشخص است دليل نامگذاری قطع پالتويی عرض كم و ارتفاع زياد است كه به 
راحتی داخل جيب قرار می گيرد. از قطع پالتويی برای كتاب دارای محتوای برخی اقلام تبليغاتی و مواردی 
كه نياز است فرد به راحتی بتواند آن را با خود حمل و جابه جا كند مورد استفاده قرار می گيرد. كاغذ مورد 

استفاده در اين قطع 45×60 و 70×50 است.
موارد مناسب برای قطع پالتويی: كتاب های مذهبی )ادعيه و زيارت نامه(، شعر و كتاب های كم حجم، كاتالوگ 

و بروشورهای تبليغاتی و پمفلت.



188

 قطع بیاضی 
بياضی  قطع  در  كه  است  سانتی متر  بياضی كوچک 29×22  قطع  ابعاد  و  بزرگ 24×34  بياضی  قطع  ابعاد 
برخلاف حالت معمول عطف كتاب در ضلع كوچک تر كتاب قرار می گيرد و ظاهر كتاب يا نشريه به صورت 
افقی است. البته معمولاً به قطع های ديگری كه از ضلع كوچک صحافی می شوند و به صورت افقی هستند، در 

اصطلاح قطع بياضی گفته می شود.
اگر  لذا  می شوند؛  شناخته  معمول  و  استاندارد  قطع های  عنوان  به  شده  ارائه  قطع های  باشيد  داشته  توجه 
از  سفارش دهنده،  يا  طراح  نظر  و  پروژه  به  توجه  با  می توانيد  باشيد  داشته  خاصی  و  متمايز  كار  بخواهيد 
قطع هايی خارج از موارد ذكر شده استفاده كنيد. اين موضوع يکی از راهکارهای ايجاد وجه تمايز محصول 

انتخاب شود! به دقت  و  اگر درست  البته  بود،  شما خواهد 

 اندازه حاشیه استاندارد 
اندازه حاشيه ها  معمولاً به عهده طراح است كه معمولاً بر مبنای موضوع و محتوای كتاب يا نشريه، همچنين 
سليقه و ايده های بصری و گرافيکی طراح تعيين می شود. البته استانداردهايی برای حاشيه كتاب و نشريات 

وجود دارد كه می توانيد بر مبنای آن به حاشيه استاندارد برای كار خود دست يابيد. 
توجه داشته باشيد اگر صفحه آرايي را در نرم افزار InDesign انجام می دهيد، اين اندازه ها را در حين ايجاد 

فايل جديد بايد در قسمت Margins وارد كنيد.

 Document بايد قطع InDesign اندازه پيش از برش 5 ميلی متر بيشتر از اندازه های جدول است. در نرم افزار
بالا  از   bleed برای 5 ميلی متر محدوده برش، در قسمت  و  تعيين كنيد  اندازه های جدول  براساس  را 
)Top( پايين )bottom( و بيرون )Outside( پنج ميلی متر و اندازه داخل )Inside( را صفر تعيين كنيد.

نکته 1

ممکن است در منابع مختلف يا سفارش دهنده، ناشر و ... اندازه دقيق قطع ها تفاوت هايی )در حد چند 
ميلی متر( با جدول داشته باشد. اين تفاوت ها بيشتر اوقات دليل فنی مشخصی ندارد و بهترين كار اين 
اگر شما كارتان را با اندازه ای كه در  است كه قطع موردنظر را از ناشر يا چاپخانه سؤال كنيد. طبيعتاً 
 Document جدول1ـ 9 گفته شد انجام دهيد، تغيير چند ميلی متری در حين خروجی، به سادگی و از

Setup در InDesign قابل انجام است.

نکته 2



واحد كار دهم: تولید پروژه

189

واحد كار دهم
تولید پروژه



190

هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  بروشور طراحی كند.

  پوستر طراحی كند.

  كاغذ كادو طراحی كند.

  كاتالوگ طراحی كند.

  سند تعاملی طراحی كند.

  صفحه آرايی مجله و كتاب را انجام دهد.

1ـ10ـ تهیه یک بروشور

 Print .برويد File>New>Document را باز كرده و به منوی InDesign برای تهيه يک بروشور نرم افزار
را از گزينه های Intent در پنجره فوقانی انتخاب كنيد و در ادامه برای اندازه صفحه از گزينه Letter استفاده 
كنيد. تعداد صفحات را به هشت افزايش دهيد. البته در ادامه در پنل Pages می توانيد تعداد صفحات را تغيير 
 6/35 )Bleed( در حالت تأييد قرار دارد. يک لبه Facing Pages دهيد. همچنين مطمئن شويد كه كادر
ميلی متر برای همه جهت ها به جز جهت درونی تنظيم كنيد. لبه درونی را می توانيد روی 0 قرار دهيد. در 

ادامه روی Create كليک كنيد.

شکل 1ـ10ـ کادر محاوره ای Document Setup برای تنظیم بروشور

زمان آموزش

عملینظری

565
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انتخاب كنيد.  بازشوی پنل  از منوی  New Color Swatch را  انتخاب كرده و گزينه  Swatches را  پنل 
 CMYK كليک كنيد. نمونه رنگ Done و Add را تنظيم كنيد و روی C=77 M=20 Y=0 K=0 مقادير
دوم را به نيز صورت C=91 M=63 Y=49 K=52 قرار دهيد. گزينه New Gradient Swatch را از منوی 

بازشوی پنل انتخاب كنيد.
اين نمونه رنگ را Gradient 1 نامگذاری كرده و نوع آن را Linear انتخاب كنيد و Swatches را از منوی 

Spot Color انتخاب كنيد.
 C=77 M=20 Gradient Ramp روی آن كليک كنيد و مقادير  نقطه توقف چپ روی  انتخاب  برای 
 C=91 M=63 را از فهرست نمونه های رنگ فوق انتخاب كنيد. رنگ آبی تيره را با مقادير Y=0 K=0

Done كليک كنيد.  Add و  Y=49 K=52 در نمونه رنگ سمت راست انتخاب كنيد. سپس روی 

شکل 2ـ10ـ نمونه ها و شیب رنگ

 1ـ1ـ10ـ ایجاد روی جلد برای قالب بروشور
هنگام كار روی لايه Color به ابزار Rectangle سوئيچ كنيد و بکشيد تا شکلی روی صفحه اول سند ايجاد 
كنيد و لبه آن را به سمت بالا و تا لبه برش صفحه چپ بکشيد. از پنل Swatches، مقدار Fill شکل را آبی 

تيره انتخاب كنيد.
Mode را نيز روی  Object>Effects>Inner Glow برويد و  زمانی كه دايره انتخاب می شود به مسير 
Mode كليک كنيد تا پنجره  Normal تنظيم كنيد. به اين منظور روی مربع رنگی سمت راست منوی 

Effect Color انتخاب شود. نمونه رنگ آبی كمرنگ را انتخاب كرده و روی OK كليک كنيد.
 Softer را روی Technique را تا  25درصد كاهش دهيد و Opacity برويد و ميزان Inner Glow به پنجره
Source، را روی Center و Size را در حدود 202 ميلی متر و Noise را روی 83 درصد تنظيم كنيد. و 
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گزينه Choke را روی 40 درصد قرار داده و در نهايت روی OK كليک كنيد.
دو بار دايره را Edit>Copy و Edit>Paste كنيد و اندازه هر يک را كوچک كنيد و آن ها را مانند شکل زير 

روی صفحه پراكنده كنيد.
از ابزار Type برای ايجاد فريم متنی بزرگ در گوشه سمت چپ پايين استفاده كرده و عنوان اصلی بروشور را 

وارد كنيد. فونت را به دلخواه انتخاب كرده و رنگ فونت را روی آبی كمرنگ بگذاريد.
فريم متنی دوم را برای درج يک عنوان فرعی اضافه كنيد كه می تواند نام آن شركت باشد و رنگ آن را سفيد 

بگذاريد و بالای صفحه هم می توانيد لوگو يا آرم شركت را درج كنيد.

شکل 3ـ10ـ جلد روی بروشور

 2ـ1ـ10ـ ایجاد قالب برای صفحه درونی بروشور
حالا به دو صفحه جدا رفته و برای رنگ پس زمينه از رنگی كه در پنل Gradient ايجاد كرده ايد استفاده كنيد و 

دو دايره بزرگ سمت چپ و راست بروشور ايجاد كنيد )شکل 4ـ10( و رنگ آن را آبی كنيد.

شکل 4ـ10ـ طراحی قالب بروشور
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يکی از دايره های ترسيم شده را انتخاب كنيد، سپس به File>Place رفته و تصاوير منتخب را درون هر فريم 
تصوير قرار دهيد. و Direct Selection Tool (A) را انتخاب كرده و عکس را داخل دايره كوچک يا بزرگ 

كنيد تا به اندازه دلخواهتان در بيايد.

شکل 5ـ10ـ طراحی بروشور

حالا متن مورد نظری را كه قرار است در بروشور استفاده كنيد، در جاهای خالی پر كنيد.

شکل 6ـ10ـ انداختن متن در بروشور

 3ـ1ـ10ـ صدور بروشور تجاری برای چاپ
به مسير File>Export برويد و از منوی Format گزينه )Adobe PDF (Print را در انتهای پنجره انتخاب 
كنيد. نامی برای فايل خود انتخاب كرده و روی Save كليک كنيد. در پنجره Export Adobe PDF كه باز 

می شود گزينه Press Quality را از منوی Preset در ابتدای پنجره انتخاب كنيد.
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شکل 7ـ10ـ صدور بروشور

 Use و All Printer’s Marks كليک كرده و هر دو گزينه Marks and Bleeds در منوی سمت چپ روی
Document Bleed Settings را انتخاب كنيد. در نهايت روی Export كليک كنيد تا PDF ايجاد شود. 

بدين ترتيب ما موفق شديم فايل PDF آماده چاپ بروشور خود را توليد كنيم.

شکل 8ـ10ـ تنظیم PDF آماده چاپ بروشور



واحد كار دهم: تولید پروژه

195

قالب مدرن و شيک بروشور تجاری كه در اين راهنما ساختيم را می توان در سبک اصلی يا به عنوان يک قالب 
متنوع برای ايجاد طراحی بروشور منحصر به فرد ديگری مورد استفاده قرار داد.

شکل 9ـ10ـ بروشور طراحی شده

2ـ10ـ تهیه یک پوستر

گام اول
InDesign را باز می  كنيم و وارد مسير File>New>Document می شويم. Web را از پنجره بالا انتخاب 
می  كنيم. Width را روی 8۷0 پيکسل و Height را روی 2600 پيکسل قرار می دهيم. Margins را روی 

44 پيکسل تنظيم كرده و روی Create كليک می كنيم.

شکل 10ـ10ـ تنظیمات اولیه پوستر
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گام دوم
پنل Layers را باز می  كنيم. روی لايه Layer 1 دابل كليک كرده و اسم آن را Background می گذاريم. سه تا لايه 
ديگر به نام های Arrows،وBooks و Type درست می  كنيم. تمام لايه ها را به غير از لايه Background قفل می  كنيم.

شکل 11ـ10ـ لایه های پوستر
گام سوم

 RGB Swatch را از منوی پنل انتخاب می كنيم. يک New Color Swatch می شويم و Swatches وارد پنل
با مقادير رنگی R=209, G=207, B=194 درست كرده و روی Add و بعد هم Done كليک می  كنيم. پنج تا 

RGB Swatch ديگر با مقادير رنگی زير اضافه می  كنيم.
R=51, G=56, B=97
R=82, G=48, B=112
R=237, G=164, B=192
R=255, G=54, B=102
R=90, G=88, B=91

ابزار Rectangle را انتخاب كنيد و يک شکل به صورتی كه می  بينيد روی لايه Background رسم می  كنيم. وارد 
 R=90, G=88, B=91 را روی مقادير رنگی Color و Tint را روی 30 درصد Fill .می شويم Swatches پنل

تنظيم می كنيم.

شکل 12ـ10ـ تنظیمات رنگ پوستر



واحد كار دهم: تولید پروژه

197

 1ـ2ـ10ـ اضافه کردن تصویر کتاب
گام اول

چند آيکن كتاب تهيه كرده و آن ها را در Illustrator باز می  كنيم.
كليک راست كرده و Release Clipping Mask را انتخاب می كنيم.

شکل 13ـ10ـ آیکن های کتاب
گام دوم

كليک راست كرده و دومين رديف از آيکن ها را Ungroup می كنيم.
 

شکل 14ـ10ـ خارج کردن کتاب ها از حالت گروهی

وارد مسير  و  انتخاب كرده  را كه می  بينيد  Ungroup می  كنيم. كتاب هايی  را هم  راست  كتاب های سمت 
می شويم.  Edit>Copy
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گام سوم
 Edit>Paste می  كنيم. وارد مسير Unlock را Books برمی  گرديم. لايه Background  و لايه InDesign سراغ

می شويم. بعد هم اندازه و موقعيت كتاب ها را تنظيم كرده و آن ها را سمت راست پايين لايه قرار می دهيم.
 

شکل 15ـ10ـ تنظیم لایه ها

گام چهارم
حالا سراغ فايل Illustrator می رويم. آيکن سمت راست رديف سوم را Ungroup می  كنيم. بعد هم آن ها را 

Isolate كرده و وارد مسير Edit>Copy می شويم. 

گام پنجم
مسير  بار  اين  و  كرده  راست  كليک  می شويم.   Edit>Paste مسير  وارد  می رويم.   InDesign سراغ  حالا 

می دهيم. قرار  می  بينيد،  كه  محلی  در  را  آن ها  می  كنيم.  دنبال  را   Transform>Flip Horizontal

شکل 16ـ10ـ تنظیم چیدمان کتاب ها
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گام ششم
همين كار را برای رديف چهارم فايل Illustrator تکرار می  كنيم. كتاب ها را به صورت زيگزاگ روی هم قرار 

داده و بين آن ها فاصله می گذاريم.
 

شکل 17ـ10ـ لایه بندی کتاب ها
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گام هفتم
تمام آيکن ها را انتخاب كرده و با هم گروه می  كنيم. 

شکل 18ـ10ـ گروه بندی آیکن ها

گروه را انتخاب كرده و وارد مسير Object>Effects>Drop Shadow می شويم. Opacity را روی 50 درصد، 
Size را روی ۹ پيکسل، Spread را روی 13 درصد، Noise را روی 13 درصد قرار داده و روی مربع رنگی 
سمت راست منوی Mode كليک می  كنيم. Effect Color را هم روی صورتی كم رنگ قرار می دهيم. OK را 

زده و از پنجره خارج می شويم.
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شکل 19ـ10ـ تنظیمات رنگ و جلوه ها

 2ـ2ـ10ـ اضافه کردن متن

گام اول
لايه Books را با Lock و لايه Type را با Unlock تنظيم می  كنيم. 

ابزار Type را برداشته و متن را اضافه می  كنيم. وارد پنل Character يا Controls می شويم. Font را روی 
 R=82, قرار می دهيم. مقادير رنگی Center را روی Align را روی 63 و Size و Bw Modelica Black

G=48, B=112 را هم برای Color در نظر می  گيريم. 
اگر بخواهيد می  توانيد عنوان را هم با همين فونت اما با اندازه 21 وارد كنيد.
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شکل 20ـ10ـ اضافه کردن متن

گام دوم
ابزار Line را بر می  داريم و يک خط به دلخواه در كنار يکی از عناوين رسم می  كنيم.

وارد پنل Stroke می شويم. Weight را روی 14 قرار داده و Rounded Cap را روی آن اعمال می  كنيم. 
وارد پنل Swatches می شويم و Stroke Color را روی Paper قرار می دهيم. خط را روی لبه های ديگر 

هم Copy و Paste می  كنيم.  
تمام خطوط را انتخاب كرده و وارد مسير Object>Effects>Transparency می شويم و Opacity را تا 

60 درصد كاهش می دهيم.
 

گام سوم
متن بيشتری را اضافه می  كنيم.

گام چهارم
اگر بخواهيم می  توانيم كادر متن را جای ديگر Copy و Paste كرده و متن آن را تغيير بدهيم.

 
گام پنجم

لايه Type را Lock و لايه Arrows را Unlock می  كنيم. ابزار Line را برداشته و يک خط باريک در محلی 
كه می  بينيد رسم می  كنيم. Stroke Color را روی R=255, G=54, B=102 قرار می دهيم. 
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Lock و Type شکل 21ـ10ـ انجام تنظیمات

وارد پنل Stroke می شويم و Weight را روی 5 و End Style را روی CircleSolid قرار می دهيم. وارد 
مسير Object>Effects>Drop Shadow می شويم. وارد مسير Copy و Paste می شويم و آن را سمت 

ديگر هم Paste می  كنيم.

 3ـ2ـ10ـ خروجی گرفتن

گام اول
وارد مسير Edit>Spelling>Check Spelling و بعد هم File>Export می شويم.

نامی برای فايل انتخاب كرده و Format را روی PNG قرار می دهيم و روی Save كليک می  كنيم.
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PNG شکل 22ـ10ـ انتخاب فرمت

گام دوم
به اين ترتيب، پنجره Export PNG باز می شود. Quality را روی Medium و Resolution را روی ۷2 

قرار می دهيم. Color Space بايد روی RGB باشد. در نهايت، روی Export كليک می  كنيم.

PNG شکل 23ـ10ـ صدور به
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 4ـ2ـ10ـ نتیجه پوستر تحصیلی

شکل 24ـ10ـ پوستر نهایی
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3ـ10ـ تهیه یک كاغذ كادو

 1ـ3ـ10ـ کاغذ کادو چیست؟
كاغذ كادو به ورق نازكی گفته می شود كه جهت بسته بندی كالا جهت هديه دادن مورد استفاده  قرار می  گيرد. 
توليد كاغذ كادو برحسب نياز و علاقه مندی مشتری انواع مختلفی دارد. شركت های معروف اغلب برای حفظ 
اعتبار خود از كاغذ كادوهای سفارشی و مخصوص با آرم و لوگوی اختصاصی شان استفاده می كنند. زيرا ارسال 
هديه شما همراه با يک بسته بندی و كاور خاص می تواند مکمل هديه ويژه شما باشد و اين امر تأثير شگرفی 

در تثبيت برند شما خواهد داشت. 

 انواع کاغذ کادو 
  كاغذ كادوی فانتزی

  كاغذ كادوی كرافت

  كاغذ كادوی گلاسه

 2ـ3ـ10ـ خصوصیات کاغذ کادو
 كاغذ كادو به طور كلی و معمول برای بسته بندی و زيباتر كردن هديه مورد استفاده قرار می گيرد تا آن را 
تأثيرگذارتر نمايش دهد. كاغذ كادو معمولاً در گرماژ 100 گرم، گلاسه يا كرافت ۷0 گرم استفاده می شود 
و اندازه استاندارد آن 50 در ۷0 يا 60 در 45 است. اندازه 50*۷0 اندازه ای است كه بيشتر در بازار آماده 

و قابل دسترسی هستند. بهتر آن است كه در طراحی شخصی از ابعاد معمول كاغذ در بازار استفاده شود.

 3ـ3ـ10ـ طراحی کاغذ کادو
امروزه كاغذ كادو به يکی از اصلی ترين اجزای هديه در مناسبت ها تبديل شده است. طراحی كاغذ كادوی 
شركتی بايد به نحوی باشد تا هنگام كادو پيچ كردن، خللی به هديه وارد نکند. هديه ای كه با كاغذ كادوی 
رنگارنگ و متنوع كادويی و پيچيده شده است نشان می دهد طرف مقابلتان چقدر برايتان ارزش دارد و لبخند 
او شما را خوشحال می كند. در طراحی كاغذ كادو بايد اين نکته را مدنظر قرار داد كه كاغذ در جهت های قابل 

رؤيت است و نبايد در پيچش كادو مفهوم خود را از دست دهد.

شکل 25ـ10ـ یک نمونه کاغذ کادو
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 4ـ3ـ10ـ نرم افزار طراحی کاغذ کادو
طراحی كاغذ كادو به وسيله برنامه CorelDraw و يا طرح كاغذ كادو با Photoshop يا InDesign انجام 
می شود. طرح گرافيکی كاغذ شامل طرح كاغذ كادوی كودكانه، طرح كاغذ كادوی سنتی، طرح كاغذ كادو 
با اشکال هندسی، طرح كاغذ كادوی مدرن، طرح كاغذ كادوی ولنتاين، طرح كاغذ كادوی تولد، طرح كاغذ 

كادوی بله برون، طرح كاغذ كادوی عروسی و نامزدی و .... است.
با اين شيوه تزئين هديه حتی كاغذ كادوهای ساده نيز بسيار زيبا به نظر خواهند رسيد. هنرهای كاغذی 

از ارزش آن ها كم نمی كند. هميشه زيبا هستند، چنان كه دشواری و سادگی ساختنش 

شکل 26ـ10ـ نمونه هایی از کاغذ کادو

كاغذهای كادو فوايد و مصارف زيادی دارند و با توجه به  سليقه های مختلف طراحی می شوند. اگر طرح پشت 
و روی كاغذ متفاوت باشد، تنوع بيشتری را ايجاد می كند. 

 5ـ3ـ10ـ طریقه طراحی کاغذ کادو
حالا می خواهيم از Adobe InDesign برای طرح بندی طرح های 
خود استفاده كنيم. حالا يک فايل جديد درست كنيد و اندازه های 
آن را 500 در ۷00 ميلی متر قرار دهيد. طرح مورد نظرتان را كه 
باشد،  مختلف  مناسبت های  برای  مختلف  اشکال  شامل  می تواند 
انتخاب كنيد. فرض كنيد می خواهيد طرحی مناسب كودكان اجرا 

كنيد. بنابراين شخصيت های كارتونی را انتخاب كنيد.
مثلًا از تصاوير باب اسفنجی استفاده كرده و برای اينکه پس زمينه، 
شبيه دريا باشد يک مستطيل ترسيم كنيد و رنگ آن را آبي كم 
رنگ در نظر بگيريد. همچنين براي اضافه كردن حباب مي توانيد 
آن را  طراحي كرده يا از Google جستجو و تهيه كنيد. در مرحله 
بيشتري  تا شفافيت  را كمتر كنيد  آن   Opacity است  بهتر  بعد 

شکل 27ـ10ـ ایجاد یک فایل جدیدپيدا كند.
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حالا عکس های انتخابی را فقط در يک ستون پر كنيد و بعد همين عکس ها را در ستون های بعد كپی كرده 
و تکرار كنيد تا تمام ستون ها از عکس باب اسفنجی پر شود. 

شکل 29ـ10ـ طرح باب اسفنجی

شکل 28ـ10ـ طرح سه ستونی
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خاطر  به  می كنيم  تکرار  ستون ها  در  را  عکس ها 
از  كرديد  استفاده  كاغذ  جای  هر  از  وقتی  آنکه 
همه كاراكترهايی كه استفاده شده است روی كادو 
ديده شود البته در طرح های گل يا قلب می توانيد 
كنيد  بيشتر  را  آن ها  تکرار  و  باريک تر  را  ستون ها 
دارد. بستگی  خودتان  طراحی  و  سليقه  به  اين ها 

Export شکل 30ـ10ـ گرفتن خروجی با کادر محاوره ای

در پايان فايل را Save نموده و براي خروجي گرفتن، گزينه File>Export را انتخاب كرده و گزينه فرمت 
 300 ppi ظاهر  شود. در آن كيفيت عکس را روی Export JPEG قرار دهيد تا كادر محاوره ای JPEG آن را

قرار دهيد و تأييد كنيد. كاغذ كادوی طراحی شده شما Save شده و آماده چاپ است.

شکل 31ـ10ـ صدور کاغذ کادو شکل 32ـ10ـ کاغذ کادوی چاپ شده
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 4ـ10ـ تهیه یک كاتالوگ

صفحه آرايی كاتالوگ، يکی از موارد با اهميتی است كه توجه به آن، می تواند طراحی كاتالوگ را منحصر به فرد 
كند. به طور كلی، صفحه آرايی، در چاپ و نشر مبحث با اهميتی است كه اهميت آن بر كسی پوشيده نيست. 
هدف اصلی از صفحه آرايی را می توان انتقال بهتر و سريع تر مفاهيمی مانند متن و تصوير دانست. رعايت اصول 
صفحه آرايی كاتالوگ، می تواند چاپ كاتالوگ شما را حرفه ای تر كند. كاری كه در زبان فارسی به آن صفحه آرايی 
می گوييم، در زبان انگليسی لی آوت )Layout( و در زبان فرانسه ميزانپاژ )MisenPage( ناميده می شود. اما 
مقصود از اين كلمه چيست و چه كاربردهايی دارد و هدف از آن چيست؟ در ادامه به اين موضوع خواهيم پرداخت.

 1ـ4ـ10ـ صفحه آرایی چیست؟
و  زيباسازی  و  چيدمان  برای  لازم  دانش  و  هنر  به 
يک  چاپ  كردن  آماده  از  قبل  فعاليت های  مجموعه 
به طور كلی  كاتالوگ صفحه آرايی می گويند.  و  نشريه 
تمامی فعاليت هايی نظير: انتخاب فونت، اندازه كلمات، 
تنظيم فواصل بين خطوط را صفحه آرايی می گويند. در 
طراحی صفحه يا صفحه بندی مجموعه ای از اطلاعات 

اعم از:
  متن يا نوشته

  تصاوير و عکس های مختلف

  يا تركيبی از هر دو

در يک فضای از پيش تعيين شده و محدود جمع آوری 
و تنظيم می شود.

برای  صفحات  آماده سازی  چگونگی  ديگر  عبارت  به 
چاپ، صفحه آرايی ناميده می شود. بنابراين صفحه آرايی 
كاتالوگ، به معنی آراستن صفحات آن و آماده سازی 

كه  گفت  می توان  واقع  در  شود.  مشتريان  بيشتر  توجه  جلب  موجب  كه  به گونه ای  است،  چاپ  برای  آن 
هنر آراستن يک صفحه، سند يا كتاب به صورت تخصصی و علمی Layout يا طرح بندی خوانده می شود. 
صفحه آرايی، هنری است كه مخاطبان را در مقابل خود متوقف می كند و توجه آن ها را به خود جلب می كند. 
به اين ترتيب آن ها را ترغيب به مطالعه ادامه متن می كند. اما اين كار نياز به دانش و توانايی های لازم دارد 
كه تنها با شناخت مخاطبان، دانش روز صفحه آرايی و به كارگيری اصول علمی و روان شناسی ميسر می شود.

چنين تجربه، تلاش و تمرينی در اين زمينه از مهم ترين ضروريات به شمار می رود. طراحی صفحه كاتالوگ، 
زيرمجموعه ای از هنر گرافيک به شمار می رود. اين هنر تلاش می كند تا يک رابطه موزون و مناسب از نظر 
بصری بين نوشته ها و تصاوير و فضای موردنظر به وجود آورد. طراحی صفحه كاربردهای زيادی دارد و برای 
طراحی مجله و كتاب و انواع نشريات، طراحی حرفه ای كاتالوگ، طراحی پوسترهای حرفه ای و ديگر موارد نيز 

به كار می رود. صفحه آرايی كاتالوگ يکی از مهم ترين مراحل در طراحی كاتالوگ است.

شکل 33ـ10
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در اين مرحله صفحه آرايی وارد مرحله جديدی می شود كه از تکنيک ها و امکانات فنی زيادی در آن استفاده 
می شود. زيبايی شناسی وارد كتاب آرايی و صفحه بندی می شود و متقارن بودن عناصر، تقسيم بندی متقارن 
سطوح، تنظيم هندسی نقوش، تركيب و تلفيق خطوط به صورت موزون و تركيب متعادل رنگ ها برای آرايش 
اجزای  بين  ايجاد يک هماهنگی بصری  از صفحه بندی  واقع هدف  قرار می گيرد. در  اهميت  صفحات مورد 
مختلف صفحه است. امروزه برای تهيه كتاب از الگوی كشورهای پيشرفته صنعتی استفاده می شود كه می تواند 

برای مطبوعات و كتاب ايران بسيار مفيد باشد.

 2ـ4ـ10ـ هدف از صفحه بندی کاتالوگ
مهم ترين اهداف صفحه بندی كاتالوگ را می توان در دو هدف اصلی زير گنجاند:

  يک صفحه بايد اطلاعات را به بهترين و ساده ترين شکل ممکن ارائه كند.

  توجه مخاطب را جلب كند و را مشتاق به مطالعه ادامه مطلب كند.

برای رسيدن به اين اهداف از عکس، طرح، جداول و اشکال مختلف در كنار كلمات و حروف استفاده می كنيد 
تا بتوانيد منظور خود را به بهترين شکل ممکن برسانيد. البته كه همه آن ها را بايد به زيبايی در كنار هم قرار 
دهيد. افزايش سرعت و انتقال اطلاعات به ساده ترين شکل با چيدمان مناسب مطالب و صفحه آرايی ميسر 

می شود كه ارتباط تنگاتنگی ميان مفاهيم و مخاطب به وجود می آورد.
با اين تفاسير مهم ترين اصل در صفحه آرايی كاتالوگ اين است كه اطلاعات درج شده در يک صفحه توسط 
طراح كاتالوگ بايد بسيار روان تر و جذاب تر از زمانی باشد كه يک فرد عادی همان اطلاعات را در صفحه درج 
كرده باشد. بنابراين يک صفحه با مجموعه ای از اطلاعات، نوشته ها و تصاوير در صورتی  كه درک آن برای 

مخاطب مشکل باشد و يا رغبتی به خواندن آن در وی به وجود نياورد صفحه آرايی نيست. همچنين:
  كاربردی بودن

  زيبايی آفرينی

  ارزش گذاری

از اهداف مهم و مورد توجه در طراحی صفحات به شمار می رود.

 3ـ4ـ10ـ نکات مهم در صفحه آرایی
در صفحه آرايی كاتالوگ انتخاب

  نوع فونت، اندازه كلمات

  فاصله از حاشيه، فواصل بين خطوط

  طراحی گرافيکی مناسب صفحات

  انتخاب مناسب رنگ ها

  و جايگذاری متناسب اطلاعات

اهميت زيادی دارد. 
مواردی كه در صفحه آرايی در چاپ بايد به آن توجه كرد شامل:
  حروف چينی: يکی از مفاهيم صفحه آرايی، حروف چينی است.
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  نوع و اندازه حروف: صفحه آرا بايد به نوع و اندازه حروف توجه كند.

  تک ستونه يا دو ستونه: رايج ترين شکل كتاب تک ستونه است اما برای طراحی بروشور و مجله می توان از 

دو ستونه استفاده كرد.
  سطربندی: رديف كردن سطور محتوای كتاب

  حاشيه كتاب: تنظيم حاشيه با دقت كافی

  تورفتگی در اول پاراگراف: معمولاً اولين سطر پاراگراف ها با يک تورفتگی شروع می شود.

  پر كردن كتاب: برای بردن يک مطلب در بيش از يک صفحه يا افزايش حجم كتاب می توان فاصله سطور 

يا حروف را از يکديگر افزايش داد.

 4ـ4ـ10ـ صفحه آرایی چگونه انجام می شود؟
امروزه برای طراحی صفحات از نرم افزارهای مختلف استفاده می شود در حالی كه در گذشته اين كار به صورت 
از بهترين نرم افزارهای كاربردی برای آماده سازی صفحات به صورت حرفه ای  دستی صورت می گرفت. يکی 
نرم افزار  به  می توان  نشر  و  چاپ  صفحه آرايی  نرم افزارهای  ديگر  از  است.   Adobe InDesign نرم افزار 
با  نرم افزار  اين  می رود.  شمار  به  صفحه بندی  برای  حرفه ای  طراح  يک  كه  كرد.  اشاره   QuarkXPress
پروژه های Photoshop سازگار است و امکان بارگذاری تصاوير با حجم و اندازه زياد را نيز فراهم می كند. 
Page Maker و نرم افزار Freehand از ديگر نرم افزارهای مورد كاربرد در صفحه بندی هستند. استفاده از

  Microsoft Word برای تايپ

  Adobe Photoshop برای ويرايش و آماده سازی تصاوير

  Adobe InDesign برای صفحه آرايی

  Adobe Illustrator برای ساخت و تبديل فايل های InDesign به PDF كه جهت چاپ كاربرد دارد.

نصب  فارسی سازی جهت  به  نيازی  نرم افزارها  اين  می روند.  شمار  به  نرم افزارهای صفحه بندی  رايج ترين  از 
باشند. در كشور  انتشارات  و  پاسخگوی طراحان  و می توانند  ندارند  را  دلخواه شما  فارسی  فونت های 

شکل 34ـ10ـ نمونه ای از صفحه آرایی
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5ـ10ـ تهیه یک سند تعاملی

 InDesign تعاملی در PDF های تعاملی می توانند ابزاری عالی باشند. اين بخش بر چگونگی ساخت PDF
 InDesign تعاملی  PDF های  از  كنيد.  اضافه  به سند خود  را  ويژگی های خاصی  بتوانيد  تا  است  متمركز 
می توان برای كاربرگ، پروپوزال، چک ليست و كتاب الکترونيکی استفاده كرد. هنگامی كه PDF های تعاملی 
را در InDesign ايجاد می كنيد، می توانيد از پيوندها، دكمه ها، ليست ها و كادرهای متنی استفاده كنيد. مثال 

PDF تعاملی ديگر افزودن امضای الکترونيکی به پرونده شما است. 

PDFelement با InDesign تعاملی PDF 1ـ5ـ10ـ نحوه ویرایش 
همانطور كه InDesign برای ايجاد PDF های تعاملی مفيد است، بيشتر يک نرم افزار صفحه آرايی است كه 
به طور خاص برای PDF طراحی نشده است. در اين زمينه اگر به نرم افزار حرفه ای تری علاقه مند هستيد، 
 InDesign های تعاملی شما از PDF گزينه خوبی است كه به طور ماهرانه ای برای ويرايش PDFelement

طراحی شده است.

PDFelement شکل 35ـ10ـ

حتی پس از استفاده از InDesign برای ايجاد صفحات تعاملی، باز هم ممکن است با خطاهايی روبه رو شويد 
 PDFelement بايد ويرايش شوند. اين خطاها را می توان با استفاده از PDF كه پس از صادر كردن پرونده ها به

برطرف كرد تا سند شما شسته و رفته و حرفه ای به نظر برسد.
پيمايش اين برنامه آسان است و دسترسی به ويژگی ها ساده است. برای جذابيت سند خود به عناصر اصلی 

مانند فونت های مختلف، رنگ و سبک دسترسی پيدا كنيد.
  اين يک نرم افزار قدرتمند برای ويرايش PDF با مهارت است.
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  همه ابزارهای ويرايش مورد نياز برای انواع سند PDF را ارائه می دهد و به شما امکان می دهد تنظيمات 

خود را برای تجربه ويرايش سريع تر و آسان تر انجام دهيد.
  گزينه حاشيه نويسی به شما امکان می دهد متن را برجسته كنيد، يادداشت های مهم اضافه كنيد و از ابزار 

طراحی در سند PDF خود استفاده كنيد.
  اين يک رابط كاربری آسان است كه گزينه های اساسی موردنياز در ويرايش سند شما را نشان می دهد.

  اين نرم افزار PDF و ساير قالب ها را به Word،وExcel،وPowerPoint،وHTML و RTF تبديل می كند.

  ويژگی استخراج داده ها به طور خودكار فايل شما را در قالب دلخواه شما با دقت ذخيره می كند.

  ويژگی ايجاد فرم به شما امکان می دهد عناصر را به راحتی كشيده و رها كنيد.

  PDFelement به شما امکان می دهد اسناد PDF تعاملی را به صورت دستی يا خودكار ايجاد كنيد. 

در زير مرحله ای است كه می توانيد برای ايجاد يک فايل PDF تعاملی دنبال كنيد:

InDesign های تعاملی  PDF مرحله 1: وارد کردن 
روی »Open Files« كليک كرده و برای انتخاب فايل PDF موردنظر برای تغيير در يک سند تعاملی، به 

برويد. فهرست 

PDFelement شکل 36ـ10ـ باز کردن فایل با

PDF مرحله 2: افزودن لینک به 
به منوی Edit برويد و سپس Link را انتخاب كنيد. يک پنجره بازشو جديد ظاهر می شود. شما می توانيد 
Appearance و Action را در پنجره جديد تنظيم كنيد. همچنين می توانيد هر تعداد پيوندی را كه لازم 

می دانيد اضافه كنيد.
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PDF شکل 37ـ10ـ افزودن لینک به

PDF مرحله 3: افزودن نشانک به 
 »View« افزودن نشانک به سند شما يکی ديگر از ويژگی هايی است كه به راحتی در دسترس است. به منوی
برويد تا نماد »Bookmark« را مشاهده كنيد. با كليک روی اين صفحه پنل نشانک باز می شود و می توانيد 

نشانک ها را از آنجا اضافه، ويرايش و حذف كنيد.

شکل 38ـ10ـ فهرست مطالب با نشانک

 مرحله 4: زمینه فرم تعاملی را به صورت خودکار یا دستی ایجاد کنید
ايجاد فرم های تعاملی به صورت خودكار ساده است و با يک كليک كامل می شود كه باعث كاهش بسيار زمان 

و بهبود كارايی می شود.
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  برای شناسايی برنامه، فاصله و جداول روی Form>Form Field Recognition كليک كنيد. با اين كار 

زمينه های قابل پر كردن ظاهر می شوند.
  روی دكمه »بستن ويرايش فرم« كليک كنيد و نشانگر خود را در يک قسمت خاص قرار دهيد تا پر كردن 

آن شروع شود.
برای ايجاد دستی يک سند تعاملی با InDesign، با اين كار شروع  كنيد:

  فايل PDF خود را باز كرده و سپس روی Form و بعد روی دكمه Add Field كليک كنيد.

  موقعيت مکانی را كه می خواهيد اضافه كنيد انتخاب كنيد تا كادر تأييد ظاهر  شود.

  روی دكمه »بستن ويرايش فرم« كليک كنيد و مکان نما را در قسمت متن قرار دهيد تا مستقيم شروع به 

تايپ كنيد.

شکل 39ـ10ـ اضافه کردن فیلدهای فرم
 

InDesign های تعاملی در  PDF 2ـ5ـ10ـ مراحل ایجاد 
امکان می دهد پيوندها، نشانک ها و دكمه ها را  InDesign نوعی سند است كه به شما  PDF تعاملی در 
اضافه كنيد. می توانيد موارد را انتخاب كرده و سند خود را به صورت ديجيتالی امضا كنيد تا از نظر قانونی 
لازم الاجرا باشد. فرم های اضافه شده به يک PDF تعاملی را می توان با اطلاعات خاصی كه كاربر خواسته 

است پر كرد. ايجاد اسناد PDF تعاملی با انتقال صفحه، نشانک ها و دكمه ها شامل مراحل زير است.
  مرحله InDesign :1 را باز كنيد و گزينه تعاملی را از ميان پنل های موجود در صفحه انتخاب كنيد.
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  مرحله 2: با رفتن به پنل Links و كليک روی دكمه Create Link پيوندها را اضافه كنيد و سپس مقصد 

پيوند را انتخاب كنيد.
  مرحله 3: پنل Bookmarks را باز كنيد و با كليک روی دكمه Create New Bookmark نشانک ها را 

به صفحات مورد نظر خود در سند خود اضافه كنيد.
  مرحله 4: دكمه ها و صفحه فرم ها را باز كنيد تا دكمه هايی در سند PDF خود ايجاد كنيد. به نماد دكمه 

واقع در صفحه دكمه ها برويد و علامت + واقع در كنار صفحه اقدامات را انتخاب كنيد تا دكمه فعال شود. شما 
می توانيد PDF تعاملی خود را از InDesign مشاهده كنيد.

6ـ10ـ آموزش صفحه آرایی مجله و كتاب

در اين آموزش كوتاه و مفيد به شما می آموزيم كه چگونه صفحه آرايی كتاب را در InDesign انجام دهيد. در 
اين آموزش به صورت مرحله به مرحله به ايجاد سند، تنظيم Master Page، شيوه گذاری متون، وارد كردن 

محتوا،  صفحه آرايی كتاب و در نهايت خروجی گرفتن از سند ايجاد شده می پردازيم.

InDesign 1ـ6ـ10ـ ایجاد سند در 
 Document و گزينه New و زيرمجموعه گزينه File می توانيد از منوی ،InDesign برای ايجاد سند جديد در
 New Document بر روی كيبورد خود استفاده كنيد تا پنجره Ctrl+N را انتخاب كنيد و يا از كليد تركيبی

نمايش داده شود.

شکل 40ـ10ـ باز کردن سند جدید

InDesign ایجاد سند جدید در 
در كادر محاوره ای شکل 41ـ10، بايد تنظيمات كلی سند خود مثل ابعاد كار، تعداد صفحات،  فضای قرارگيری 
متن، تعداد ستون متن، جهت باز شدن و چند مورد ديگر را تعيين كنيد. ما در اين آموزش به طور مثال 
به صفحه آرايی كتاب 24 صفحه ای، با ابعاد وزيری می پردازيم و تنظيمات را طبق آن تعيين می كنيم، شما 

می توانيد با توجه به كتاب خود مقدار هر يک از فيلدها را به طور دلخواه تعيين و تنظيم كنيد.
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شکل 41ـ10ـ تنظیم مشخصات سند

)Number of Page=24( :1 تعداد صفحات
2 قطع صفحات: كتاب وزيری با محاسبه خط برش )Width=170 / Height=240( بر حسب ميلی متر

)Gutter( و فاصله بين شان )Columns=1( :3 تعداد ستون ها
4 اندازه حاشیه  متن: فضای سفيد اطراف متن از بالا، پايين، راست و چپ صفحه

)Top=35mm, Bottom=25mm , Inside=25mm ,Outside=25mm( اين موارد با توجه به تشخيص 
شما و با توجه به محل قرار گرفتن سرصفحه و شماره صفحه می تواند متفاوت باشد. ما در اينجا بخش بالايی 

را برای قرارگيری سرصفحه و شماره صفحه بزرگ تر از جهت های ديگر در نظر گرفتيم.
5 پیش نمایش )Preview(: با فعال كردن اين گزينه می توانيد تنظيمات صفحه را به صورت زنده مشاهده كنيد.

بعد از انجام تنظيمات روی دكمه OK كليد كنيد تا سند جديد ايجاد شود.

InDesign در Master Page 2ـ6ـ10ـ ایجاد و تنظیم 
Master Page در InDesign، به صفحاتی گفته می شود كه بخش های پايه ای و تکرارشونده در كتاب مانند 
مشبک بندی، سرصفحه ها، شماره صفحه، عناصر ثابت بصری و … را در آن تعيين و تنظيم می كنند. صفحات 
Master به طور پيش فرض به شکل دو صفحه مقابل هم تعريف شده اند كه می توانند به صورت تکی هم به 

صفحات اعمال شوند.
شما بسته به نوع كارتان می توانيد Master Page را به صورت تک صفحه ای استفاده كنيد و يا از چندين 
Master Page با بخش های متغير و ثابت و حتی با ظاهری متفاوت بهره ببريد و به صفحات و بخش های 
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مختلف ظاهر متفاوتی را اعمال كنيد.
برای ايجاد و تنظيم Master Page، مسير زير را دنبال كنيد و صفحاتتان را شخصی سازی كنيد:

ابتدا از طريق پنجره Page در بخش كناری نرم افزار روی صفحات A- Master دابل كليک كنيد )اگر پنجره 
Page موجود نبود می توانيد از طريق منوی Window و گزينه Page آن را فعال كنيد و يا روی صفحه كليد 

دكمه F12 را فشار دهيد(.

Master Page شکل 42ـ10ـ ایجاد و تنظیم

در بالای فضای متن با ابزار Type Tool يک كادر متنی ايجاد كنيد و نام كتاب خود را درج كنيد و نوع 
فونت و اندازه آن را تعيين كنيد. می توانيد از خطوط و طرح برای زيبايی كار در كنار عنوان خود بهره ببريد.
برای وارد كردن شماره صفحه ابتدا با ابزار Type Tool يک كادر متنی ايجاد كنيد و داخل آن كليک كنيد و 
سپس به مسير  Type>Insert Special Character>Markers>current Page Numberمراجعه كنيد 
و يا با استفاده از كليدهای تركيبی Ctrl+Alt+Shift+N شماره صفحه را درون كادر متنی قرار دهيد. سپس 
نوع فونت و اندازه شماره صفحه را تعيين كنيد )توجه داشته باشيد شماره صفحه در Master Page نمايش 

داده می شود(.

شکل 43ـ10ـ تنظیم فونت و شماره صفحه
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بعد از تنظيم و جايگذاری عنوان و شماره صفحه می توانيد از آن ها كپی بگيريد و آن ها را در صفحه مقابل نيز 
جايگذاری كنيد. حال اگر به صفحات خود مراجعه كنيد مشاهده می كنيد سرصفحه و شماره صفحه به تمام 
صفحات شما اعمال شده است )برای مشاهده صفحات ديگر كافی است در پنجره Page روی صفحه مورد 

نظر خود دابل كليک نماييد(.

اگر در سند خود بيشتر از يک Master Page داشتيد و می خواستيد به صفحه ای، Master Pageای را 
اعمال كنيد كافی است صفحه يا صفحات مورد نظرتان را انتخاب كنيد، سپس كليک راست كرده و روی 
گزينه Apply Master to Pages كليک كنيد. پس از آن از منوی كشويی Master Page مورد نظر 

خود را انتخاب كرده و روی دكمه OK كليک كنيد. 

نکته

InDesign 3ـ6ـ10ـ ایجاد و تنظیم شیوه در 
اگر با نرم افزار Word كار كرده باشيد حتماً می دانيد كه همه اجزای متن مانند عنوان ها، متن ها و پاراگراف ها 
دارای شيوه جداگانه ای هستند. در  بدنه متن  و  و عنوان ها  به خود هستند  يا سبک مختص  دارای شيوه 
InDesign هم همين شيوه ها وجود دارند البته به صورت كاملًا پيشرفته تر و با كارايی بالاتر. در صفحه آرايی 
كتاب با InDesign شيوه ها اهميت ويژه و بسيار مهمی دارند؛ استفاده از آن ها كار شما را حرفه ای تر و سرعت 

انجام كار را بالاتر می برد.
شيوه ها در InDesign به دو صورت پاراگراف و كاراكتر وجود دارند كه به ترتيب برای شيوه گذاری پاراگراف ها 
و كلمات و حتی تک حرف ها مورد استفاده قرار می گيرند و هركدام دارای تنظيمات و ويژگی های مختص به 

خود هستند.

 شیوه پاراگراف متن 
برای ايجاد شيوه پاراگراف جديد در پنجره Paragraph Styles روی گزينه Create New Style كليک 
كنيد. برای تعيين مقادير و تنظيمات شيوه پاراگراف روی آن كليک راست كرده و گزينه Edit را انتخاب كنيد 

و يا با دو بار كليک كردن می توانيد وارد تنظيمات شيوه پاراگراف )Options Paragraph Style( شويد.

شکل 44ـ10ـ تنظیم شیوه پاراگراف
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در بخش General نام شيوه خود را تعيين كنيد. به عنوان مثال نام آن را Matn بناميد. برای تعيين نوع 
كليک كنيد. در بخش پيش رو   Basic Character Formats اندازه فونت در برگه كناری روی گزينه  و 

اعمال كنيد. را  تنظيمات دلخواه خود 

Paragraph Style Options شکل 45ـ10ـ کادر محاوره ای
1 نوع فونت را انتخاب كنيد.

2 نوع شيوه فونت را انتخاب كنيد.
3 اندازه فونت را تعيين كنيد.

4 فاصله بين خطوط را تعيين كنيد.
5 فاصله بين كلمات را تعيين كنيد.

 Indents and Spacing برای تنظيم جهت متن، كشيدگی، همچنين اعمال فرورفتگی و موارد ديگر از برگه كناری گزينه
را انتخاب كنيد، در بخش پيش رو می توانيد تنظيمات خود را با توجه به توضيحات زير تعيين كنيد:

1 جهت پاراگراف )راست به چپ يا چپ به راست(.
2 جهت تراز كردن متن ) با انتخاب گزينه Right justify می توانيد خطوط متن خود را در ابتدا و انتها با 

هم تراز كنيد(.
3 فرورفتگی شروع خط )اين مورد تفاوتی در راست چين و چپ چين بودن متن ندارد(

4 فاصله قبل و بعد پاراگراف.

شکل 46ـ10ـ انجام تنظیمات شیوه پاراگراف
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بعد از تنظيم شيوه پاراگراف متن ممکن است شما در ميان متن پاراگراف كتاب كلمات يا جملاتی داشته 
باشيد كه به عنوان مثال بايد به صورت بولد باشند. در اين حالت شما بهتر است برای تسريع در كار و يا نکات 

حرفه ای ديگر شيوه مختص به اين نوع كلمات و جملات را تعريف كنيد و مورد استفاده قرار دهيد.
برای اين كار به كادر محاوره ای Character Styles مراجعه كنيد و روی گزينه Create New Style كليک 
كنيد. در اينجا نيز مانند شيوه پاراگراف در بخش Basic Character Formats می توانيد نوع و اندازه فونت 
به شيوه های  تعداد گزينه های تنظيمات متن نسبت  به ساختار شيوه های كاراكتر  با توجه  تعيين كنيد.  را 

پاراگراف كمتر است و مواردی مانند Indents and Spacing در كاراكتر وجود ندارد.

شما می توانيد برای متن خود چندين شيوه پاراگراف و شيوه كاراكتر مشابه با اندک تغييرات ايجاد كنيد 
و به تناسب كار خود از آن ها در جاهای مختلف صفحه آرايی كتاب بهره ببريد. به عنوان مثال می توانيد دو 
شيوه پاراگراف متن با فونت و شيوه مشابه داشته باشيد و فقط در بخش فرورفتگی يک شيوه پاراگراف با 

فرورفتگی و شيوه پاراگراف ديگر را بدون فرورفتگی ايجاد كنيد. 

نکته

 تعیین شیوه تیترها 
است.  اهميت  حائز  بسيار  موضوع  اين  كنيد،  استفاده  پاراگراف  از شيوه  نيز  متن  تيترهای  برای  است  بهتر 
به عنوان مثال برای تهيه فهرست مطالب حتماً بايد از شيوه پاراگراف استفاده كنيد، لذا تيترهای شما بر اساس 

پاراگراف استايل شناخته می شوند.
 Basic Character برای ايجاد شيوه پاراگراف تيتر نيز مانند شيوه پاراگراف متن عمل كنيد و فقط در بخش
Formats اندازه فونت را بزرگ تر و نوع شيوه آن را بولد انتخاب كنيد؛ همچنين می توانيد از فونت متفاوتی 

برای تيترها استفاده كنيد.

InDesign به Word 4ـ6ـ10ـ ترتیب قرارگیری صفحات و وارد کردن متن کتاب از 
قبل از وارد كردن متن كتاب به InDesign بهتر است با ترتيب صفحات كتاب آشنا شويد. رعايت اين موارد 
نه تنها بهتر است به آن عمل شود بلکه می تواند مواردی جذاب برای مخاطب رقم بزند. به طور معمول ترتيب 

اجزای كتاب ها به اين شکل است.
3 فهرست مطالب  2 صفحه شناسنامه   1 صفحه عنوان 

6 متن  5 مقدمه    4 پيشگفتار  
 InDesign به Word بعد از آشنايی با ترتيب صفحات به وارد كردن متن كتاب می پردازيم. وارد كردن متن از

به دو روش انجام می شود كه ما در اينجا به روشی كه ساده تر و سريع تر است می پردازيم.

شيوه های  زيرا  كنيد   InDesign وارد  شيوه  بدون  و  خام  به صورت  را  متن  است  بهتر  هستيد  مبتدی  اگر 
 Edit از منوی ،InDesign به Word می تواند برای شما گيج كننده باشند. برای وارد كردن متن خام Word
و از زيرمجموعه Preferences روی گزينه Clipboard Handling كليک كنيد و يا از روی صفحه كليد، 
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كليدهای Ctrl+K را فشار دهيد و از برگه كناری گزينه Clipboard Handling را انتخاب كنيد. در پنجره 
 Text Only گزينه When Pasting Text and Tables from Other Applications پيش رو در قسمت

را انتخاب كنيد و سپس روی دكمه OK كليک كنيد.

InDesign به Word شکل 47ـ10ـ وارد کردن متن از

بعد از انجام تنظيمات، برای كپی كردن متن كافی است به فايل Word خود مراجعه كنيد و كليه مطالب را 
انتخاب و كپی كنيد، بعد از آن مجدداً وارد نرم افزار InDesign شويد و در صفحه شروع مطالب، با استفاده 
از ابزار Type Tool با كشيدن يک كادر متنی به اندازه فضای ميانی حاشيه ها )فضای قرارگيری متن( ايجاد 

كنيد. سپس متن خود را الصاق كنيد.
بعد از جايگذاری متن در فريم متنی به دليل بيشتر بودن متن از فضای در نظر گرفته شده، علامت مثبت 
قرمز رنگی در قسمت پايينی فريم متنی نمايان می شود كه بيانگر اين موضوع است. برای نمايش و جايگذاری 
تمام متن ها در صفحات كتاب، روی علامت مثبت قرمز رنگ كليک كنيد. در اين حالت ظاهر نشانگر ماوس 
تغيير می كند؛ سپس به صفحه بعد مراجعه كنيد و با نگه داشتن دكمه Shift روی فضای متنی صفحه بعد 
 InDesign كليک كنيد. با اين كار شاهد اين خواهيد بود كه تمام متن شما به طور خودكار در تمامی صفحات

جايگذاری می شوند.
حالا می توانيم به شيوه گذاری اجزای مختلف متن و صفحه آرايی كتاب بپردازيم.

InDesign 5ـ6ـ10ـ ایجاد فهرست مطالب در 
قبل از ايجاد فهرست مطالب اين نکته را مد نظر قرار دهيد كه همه بخش هايی كه نياز داريد در فهرست ليست 
شوند بايد دارای شيوه پاراگراف مشخص باشند. به عنوان مثال تيترهای مهم شما بايد دارای پاراگراف مختص 

به خود باشند تا بتوانيد آن ها را در فهرست خودكار InDesign فراخوانی كنيد.
همچنين قبل از تهيه فهرست مطالب می توانيد يک شيوه مشخص برای ليست فهرست خود ايجاد كنيد.

ابتدا به صفحه ای برويد كه فهرست مطالب در آن قرار می گيرد. برای ايجاد فهرست از منوی Layout روی گزينه 
Table of Content كليک كنيد. در پنجره پيش رو تنظيمات خود را با توجه به توضيحات ارائه شده تعيين كنيد.

  نام فهرست يا فهرست مطالب را در اين فيلد وارد كنيد. شيوه مقابل آن را روی شيوه تيتر خود قرار دهيد 
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)شما می توانيد اين فيلد را خالی بگذاريد و بعداً كلمه فهرست مطالب را به هر شکلی كه می خواهيد به صفحه 
اضافه كنيد(.

  در بخش Styles in Table of Contents هر يک از شيوه هايی را كه می خواهيد ليست شوند، می توانيد 

 Include Paragraph كليک كنيد تا به قسمت Add انتخاب كنيد و روی دكمه Other Styles از قسمت
Styles انتقال پيدا كنند.

Include Paragraph Styles شيوه  ابتدا در كادر    برای تعيين نوع نمايش و تنظيمات شيوه فهرست، 

موردنظر خود را انتخاب كنيد و سپس شيوه موردنظرتان )شيوه فهرست ها( را انتخاب كنيد.

شکل 48ـ10ـ تهیه فهرست مطالب

1 عنوان فهرست مطالب
2 ليست كل شيوه های پاراگراف

3 كادر فهرست شيوه های وارد شده
4 شيوه فهرست

5 محل قرارگيری شماره صفحه
برای آشنايی و يادگيری تمام قسمت ها و نکات اين بخش به فصل مربوط به تهيه خودكار فهرست مطالب 

اتوماتيک در InDesign مراجعه كنيد.
بعد از اعمال تنظيمات روی گزينه OK كليک كنيد. اكنون مشاهده می كنيد نشانگر ماوس شما تغيير كرد و فهرست 

شما آماده جايگذاری است. كافی است در فضای متن كليک كنيد يا در محدوده مدنظرتان كليک كرده و بکشيد.
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 6ـ6ـ10ـ خروجی گرفتن PDF برای چاپ
بعد از اتمام صفحه آرايی كتاب در InDesign، برای خروجی گرفتن كتاب كافی است از منوی File روی 

گزينه Export كليک كنيد و يا روی صفحه كليد دكمه های Ctrl+E را فشار دهيد.
 Adobe گزينه Save as Type در پنجره باز شده محل ذخيره سازی و نام فايل را تعيين كنيد و در قسمت

PDF (print) را انتخاب كنيد و روی Save كليک كنيد.

PDF شکل 49ـ10ـ صدور به

در پنجره تنظيمات خروجی PDF در قسمت Adobe PDF Preset گزينه Press Quality را انتخاب كنيد. 
سپس تنظيمات را مطابق شکل 50  ـ10 قرار دهيد و روی گزينه Export كليک كنيد.

Export Adobe PDF شکل 50 ـ10ـ کادر محاوره ای
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واحد كار یازدهم
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كلیات

پيچيدگی و مشکلات موجود در فرايند توليد كتاب، از ديد هيچ كس پوشيده نيست؛ و در اين ميان چگونگی 
آماده سازی فايل چاپی بی كم وكاست، از مسائلی است كه همواره ناشران با آن دست وپنجه نرم  می كنند.

با اهميتی كه آراستگی هرچه بيشتر صفحات داخلی كتاب پيدا كرده است، هر ناشری به زعم خود سعی بر 
بهبود كتاب هايش در اين راستا دارد و در اين راه از تمام عناصر موجود بهره می برد؛ از به كارگيری قلم های 

برتر گرفته تا صفحه آرايی های مدرن، به روز و كارآمد.
بخش  در  )به ويژه  نشر  حوزه  در  شده  عرضه  نرم افزارهای  تنوع  و  ای  رايانه  فناوری های  پيشرفت  با  امروزه، 
فايل كتابشان  برای تهيه  نامناسب  نرم افزارهای  از  ناشران،  از  با چاپ(، هنوز بسياری  صفحه آرايی و مرتبط 

می كنند. استفاده 
يکی از نرم افزارهای متداول كه به اشتباه، در اين زمينه استفاده شده Word است. اين برنامه علی رغم اين كه 
ابزار بسيار قدرتمندی به حساب می آيد، هرگز برای آماده سازی فايل كتابی كه قرار است به شيوه افست چاپ 

شود، طراحی نشده است.
در عين حال، برنامه InDesign از نرم افزارهای مناسبی است كه برای صفحه آرايی كتاب و مجلات عرضه 
شده است؛ و برخلاف تصور رايج، كار كردن با آن، بسيار ساده تر از Word است. اميدواريم با استفاده از آموزش 

گام به گام اين مجموعه ، بتوانيد از امکانات بی نظير اين برنامه، بهره مند گرديد.

هدف رفتاری

پس از مطالعه اين واحد كار از فراگير انتظار مي رود كه:
  مفهوم كسب وكار را درک كند.

  ساختار تهيه كسب وكار را بداند.

  نحوه انجام تعهدات و قراردادهاي حقوقي را بداند.

  مراحل انجام يک پروژه براي InDesign را بداند.

زمان آموزش

عملینظری
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1ـ11ـ مفهوم كسب وكار

نويسندگان مختلف، تعاريف متفاوتی از كسب وكار دارند. در واژه نامۀ آكسفورد كسب وكار به معنی خريد و 
فروش و تجارت آمده است. در واژه نامۀ لانگ من كسب وكار به فعاليت پول در آوردن و تجارتی كه از آن پول 

حاصل شود، گفته می شود.
به زبان ساده، كسب وكار عبارت است از حالتی از مشغوليت و به طور عام، شامل فعاليت هايی است كه توليد و 

خريد كالاها و خدمات با هدف فروش آن ها را به منظور كسب سود، در بر می گيرد.
  بر طبق نظر ارويک و هانت كسب وكار عبارت است از هر نوع كسب وكاری كه در آن خدمات يا كارهايی 

كه ديگر افراد جامعه به آن نياز دارند و مايل به خريد آن هستند و توان پرداخت بهای آن را دارند، از جمله 
توليد، توزيع و عرضه.

  پترسن و پلومن بر اين باورند كه هر تبادلی كه در آن خريد و فروش صورت گيرد، كسب وكار نيست، بلکه 

كسب وكار، هر نوع تبادل تکراری و تجديد شونده خريد و فروش است.
  پروفسور اون، كسب وكار را يک نوع كاسبی می داند كه طی آن كالاها يا خدمات برای فروش در بازار توليد و 

توزيع می شوند.
بنابراين با توجه به تعاريف ياد شده می توان دريافت كه كسب وكار با خريد و فروش كالاها، توليد كالاها يا 

عرضه خدمات، به منظور به دست آوردن سود، سر و كار دارد.

 1ـ1ـ11ـ ساختار تهیه کسب وکار
شروع يک تجارت جديد يک شبه اتفاق نمی افتد و نياز به انجام بسياری از اقدامات قبل از شروع كار تجاری 
است. مواردی مانند انتخاب يک محصول يا خدمت، تصميم گيری در مورد يک ساختار قانونی برای تجارت 
خود، ايجاد نامی به ياد ماندنی برای شركت شما و موارد ديگر. قبل از اينکه به همه اين موارد بپردازيد بايد 

برنامه كسب وكار نوپای خود را بنويسيد.

 2ـ1ـ11ـ چرا به یک برنامه کسب وکار نیاز دارید؟
برنامه های تجاری اغلب هنگام اخذ تسهيلات و تأمين منابع مالی پروژه از طريق بانک ها يا سرمايه گذاران مورد 
نياز است. حتی اگر دنبال حمايت مالی خارج از كشور نيستيد، يک برنامه تجاری برای موفقيت استارتاپ شما 
بسيار مهم است. بدون اينکه ابتدا يک طرح از يک معمار به دست آوريد، ساخت وساز در خانه جديد را شروع 
نمی كنيد! برنامه كسب وكار شما به عنوان يک طرح برای كسب وكار شما عمل می كند و شما بايد مطابق با 

آن جلو برويد.
برنامه كسب وكار به شما امکان می دهد با فکر كردن در مورد همه جوانب كسب وكار و اجرای آن، امکان سنجی 
ايده تجاری خود را آزمايش كنيد. مشکلات و چالش های بالقوه را برجسته می كند و به شما كمک می كند 
تقريباً برای هر كاری آماده باشيد. در اولويت بندی اهدافتان كمک می كند. با نوشتن يک برنامه تجاری، خود 

را برای موفقيت آماده كنيد. مطمئن نيستيد كه چگونه يکی را بنويسيد؟ 
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 هفت مرحله تهیه برنامه کسب وکار
هنگام نوشتن برنامه كسب وكار نوپا، هفت مرحله وجود دارد. اين هفت مرحله عبارت اند از:

1 خلاصه اجرايی
2 توضيحات شركت

3 تحقيقات بازار
4 توضيحی درباره محصولات يا خدمات شما

5 توضيحی در مورد مديريت و ساختار عملياتی شما
6 بازاريابی و استراتژی فروش شما

7 اطلاعات مالی

1ـ خلاصه اجرایی
اين بخش به گونه ای طراحی شده است كه اطلاعاتی را كه در برنامه كسب وكار شما درج شده است، در اختيار 
خوانندگان قرار دهد. ايجاد اين بخش معمولاً پس از اتمام مراحل ديگر آسان تر است و به شما امکان می دهد 
اطلاعات كليدی هر قسمت از طرح را برجسته كنيد. اين بخش به طور معمول حدود يک صفحه است و شامل 

يک يا دو بند در مورد هر يک از عناصر ديگر است كه در اين سند بحث شده است.

2ـ توضیحات شرکت
اطلاعات دقيق درباره شركت خود را اينجا وارد كنيد. درباره مشکلی كه كسب وكار شما حل می كند بحث 
كنيد. از موارد خاصی مانند انواع افراد، سازمان ها يا مشاغل ديگری كه قصد ارائه خدمات را داريد استفاده 
نکنيد. در اينجاست كه بايد رسالت شركت خود را بيان كنيد. در مورد كدام ساختار تجاری مانند مالکان 
به  مربوط  اطلاعات  و حتماً  كنيد.  بحث  مشاركت محدود  يا  مشاركت حرفه ای  عمومی،  مشاركت  شخصی، 

مکان)های( تجاری خود را نيز درج كنيد.

3ـ تحقیقات بازار
انجام يک تحليل عميق از شرايط بازار بسيار مهم است. اين اطلاعات نشان می دهد كه شغل شما چقدر موفق 

است. هرچه بازار هدف خود را بهتر درک كنيد، احتمالاً شركت شما رونق بيشتری خواهد يافت.

شکل 1ـ11ـ هفت مرحله تهیه برنامه کسب و کار
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در اين مرحله تحقيقات زيادی انجام دهيد، از كارشناسان بخواهيد اخبار صنعت، گزارش های مالی و منابع 
را بخوانند. شما می دانيد كه يک بازار مناسب برای محصول يا خدمتی كه قصد ارائه آن را داريد وجود دارد. 

دريابيد كه مشتری بالقوه و ايده آل شما در يک منطقه جغرافيايی خاص زندگی می كند يا خير. 
در اين مرحله شما همچنين می خواهيد تحقيقات رقابتی را به پايان برسانيد. رقبای شما چه كسانی خواهند 
بود؟ كدام يک موفق ترين هستند؟ آن ها چه می كنند و چرا كار می كند؟ و چگونه می توانيد اين كار را بهتر انجام 
دهيد؟ به علاوه، اطلاعات مربوط به پيشنهاد رقيب را جمع آوری كنيد تا بتوانيد تعيين كنيد تفاوت شما با يکديگر 

در چيست. پس از اتمام تحقيقات بازار، يافته های خود را در اين بخش از برنامه تجاری خلاصه كنيد.

4ـ شرح محصولات یا خدمات
در اينجا بايد جزئيات مربوط به آنچه را می فروشيد به اشتراک بگذاريد. اطلاعاتی از قبيل ويژگی ها و چگونگی 
بهره مندی مشتريان از هر يک از آن ها و همچنين مشکلاتی را كه به آن ها كمک خواهيد كرد حل كنيد. در 
ادامه توضيح دهيد كه چگونه پيشنهاد شما به اين نياز پاسخ می دهد. با بحث در مورد چشم انداز رقابتی اين 
كار را انجام دهيد با اين جمله كه چگونه شركت های ديگر در حال حل اين مشکل هستند و چه چيزی راه حل 

شما را نسبت به ديگران متفاوت می كند؟

5ـ ساختار مدیریتی و عملیاتی
در اين بخش نحوه عملکرد شغل شما و ترسيم تداركات سازمان توضيح داده شده است. جزئيات مربوط به 
اين موارد را درج كنيد كه بخش ها مسئوليت كدام يک و كدام سمت يا عنوان كدام يک از آن ها را بر عهده 
دارند. اگر قبلًا برخی يا همه افرادی را انتخاب كنيد كه در اين موقعيت ها حضور داشته باشند، اين مکان برای 
بحث در مورد اين اطلاعات است. پيشينه آن ها و اينکه چرا آن ها برای انجام وظيفه شركت خود و همچنين 
اندازه و ساختار  به  را مرور كنيد. بسته  به موفقيت شركت كمک می كند  چگونه تجربه و تحصيلات آن ها 
كسب وكار مشخص شده شما، مناسب است كه يک نمودار سازمانی را نيز در اين بخش از برنامه كسب وكار 

خود قرار دهيد.

6ـ استراتژی های بازاریابی و فروش
توضيح  با  از جايی شروع كنيد.  بايد  اما  دارد،  فروش وجود  و  بازار  به  نزديک شدن  برای  زيادی  روش های 
چگونگی برنامه ريزی برای جذب و حفظ مشتری شروع كنيد. توضيحی از روند فروش مورد انتظار شما نيز 

بايد در اينجا وارد شود. اين بخش از برنامه كسب وكار شما بايد يک تا دو صفحه باشد.

7ـ اطلاعات مالی
زمانی كه قرار است يک ايده به يک كسب و كار تبديل شود، همواره بحث مالی به ميان می آيد. در نتيجه، 
هرقدر كه ايده شما پتانسيل داشته باشد، بدون برخورداری از منابع مالی لازم قادر به رساندن آن به مرحله 
اجرا نخواهيد بود. اينجاست كه نقش سرمايه گذاری به شکلی جدی مطرح می شود. اين سرمايه گذاران با قبول 
ريسک سرمايه گذاری، صاحب ايده را از منابع مالی لازم برخوردار می كنند. اما چگونه بايد اين افراد را راضی 
كرد تا روی اين ايده ريسک كنند؟ جواب اين مسئله را می توان در ادامۀ طرح مالی كسب و كار جستجو كرد. از 
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آن جايی كه عموماً برای سرمايه گذاران زمان بازگشت سرمايه و رسيدن به سود مناسب از همه چيز مهم تر است، 
ارائه طرح مالی مستحکم و منطقی برای كسب و كار تا حد زيادی اعتماد آنان را جلب خواهد كرد.

2ـ11ـ نحوه انجام تعهدات و قراردادهای حقوقی

برای صحت هر معامله اين شرايط اساسی است: قصد طرفين و رضای آن ها، اهليت طرفين، موضوع معين كه مورد 
معامله باشد و مشروعيت جهت معامله. در اين راستا كسی كه معامله می كند آن معامله برای خود آن شخص 

محسوب است مگر اينکه در موقع انجام عقد يا قرارداد خلاف آن را تصريح كند يا بعد خلاف آن ثابت شود.

 1ـ2ـ11ـ قرارداد چیست؟
را تشکيل می دهد و جزئی  اركان اصلی زندگی اجتماعی روزانه  از  توافق و قرارداد يکی  امروزی  در دنيای 
جدانشدنی از آن به حساب می آيد. انسان ها در هر جايگاهی كه قرار بگيرند هم تعهداتی را قبول می كنند و 
هم تعهداتی را به هم می دهند. بنابراين قراردادهای حقوقی در واقع تعهداتی هستند كه ميان دو طرف قرارداد 
منعقد می شوند با اين تفاوت كه در قالب بخصوص و ويژه ای در می آيند و به اين شکل آن ها را از ساير توافقات 

روزمره متمايز می كنند.
ما در اين بخش برآنيم كه ابتدا در باب تعريف قرارداد حقوقی و مشخصات آن و سپس در مورد قراردادهای 

حقوقی متعارف در عرصه كسب وكار صحبت كنيم.
به طور كلی قرارداد نوعی از توافق بين دو يا چند نفر برای برقراری رابطه تجاری يا غير تجاری است. در يک 
طرف قرارداد فردی قرار دارد كه قصد به وجود آوردن قرارداد را دارد كه به عمل او ايجاب می گويند و در 

طرف ديگر قرارداد شخصی است كه ايجاب طرف مقابل را قبول می كند.
در اين راستا ماده 183 قانون مدنی بيان می كند:

»عقد عبارت از اين است كه يک يا چند فرد در مقابل يک يا چند فرد ديگر تعهد بر 
امری كنند و مورد قبول آن ها باشد.«

نکته مورد توجه اين است كه شخص به تنهايی نمی تواند قرارداد منعقد كند و قانون تحقق توافق يا قرارداد 
را از دو فرد به بالا مقدور دانسته است.

بنابراين برای انجام قرارداد شرايط اصلی وجود دارد كه در ماده 1۹0 قانون مدنی نيز به آن اشاره شده است.
اين ها از شرايط اساسی صحت يک قرارداد محسوب می شوند. به اين معنی كه در صورت عدم تحقق اين 

از: اعتبار قانونی خواهد بود. اين شرايط عبارتند  شرايط توافق فاقد 

قصد طرفین و رضایت آن ها
زمانی كه دو طرف با اراده بر موضوعی توافق كنند ملزم به رعايت آن می شوند. رضايت يک عمل درونی و 
منظور از آن اشتياق برای انجام عملی است و قصد صورت بيرونی اين تمايل محسوب می شود كه به واسطه 

عملی خارجی خود را نشان می دهد.
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صلاحیت طرفین
صلاحيت به معنای قدرت و توانايی اعمال حق است به اين معنا كه فرد بالغ، عاقل و رشيد باشد و همچنين 

در مورد شخص حقوقی لازم است بررسی شود كه آيا در حوزه مورد نظر قدرت عمل لازم را دارد يا خير؟

معلوم و مشخص بودن مورد معامله )موضوع معامله(
موضوع قرارداد عبارت است از مال يا عملی كه طرفين متعهد به انجام آن هستند كه بايد معلوم و مشخص 

باشد.

 2ـ2ـ11ـ مشروعیت جهت معامله
 منظور از جهت معامله همان هدف معامله است. البته بايد گفت كه معمولاً در قراردادهای حقوقی جهت 
معامله ذكر نمی شود ولی اگر ذكر شد نبايد خلاف شرع باشد. علاوه بر اين شروط كه از شرايط كلی و اساسی 
صحت قراردادها هستند ممکن است برخی شروط ديگر هم در قراردادها بيايد كه لازمه آن قرارداد باشد. به 
عنوان مثال در برخی از قراردادها مدت قرارداد جزء اصلی اركان تشکيل دهنده آن قرارداد محسوب می شود. 
مثلًا در قراردادهايی كه موضوع آن ها انجام كار يا ارائه خدمات است و يا در قرارداد اجاره كه شرط اساسی 

صحت آن درج مدت زمان است و يا مواردی نظير مبلغ قرارداد و محل تنظيم قرارداد.
بعد از آشنايی مختصری با قرارداد حقوقی لازم است به انواع قراردادهای حقوقی رايج در عرصه كسب وكار 

اشاره كنيم:

انواع قرارداد حقوقی
در اين عرصه قراردادهای زيادی به چشم می خورد كه گاهی ممکن است از ديد بنيان گذاران، سرمايه گذاران، 
سهام داران و ساير اشخاص حاضر در صحنه كسب وكار به جهت عدم توجه به مسائل حقوقی پنهان بماند. 
ما تصميم داريم با معرفی كامل آن ها اين آشنايی را مقدور سازيم. به طور كلی ما 6 دسته قرارداد در عرصه 

كسب وكار داريم البته اين تقسيم بندی بيشتر صوری بوده و مهم خود اين قراردادها هستند.

InDesign 3ـ11ـ مراحل انجام یک پروژه برای

مراحل انجام پروژه های InDesign عبارت اند از:
  آماده سازی

  پياده سازی 

   نهايی سازی

در مرحله آماده سازی، ابتدا نياز به برنامه ريزی است؛ يعنی ايجاد برنامه ساده ای از الگوی مسئله و قرار دادن 
موارد موردنظر روی اين الگو يا طرح اوليه. در برنامه ريزی هم چنين بايد يک برنامه زمانی برای انجام و تحويل 
پروژه در نظر گرفته شود. در اين مرحله كارهای تايپ اوليه و تهيه تصاوير نيز انجام می شود. البته قبل از هر 

چيزی نياز به عقد قرارداد با كارفرما برای انجام كار است كه در بخش های قبل توضيح داده شد.
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پس از عقد قرارداد لازم است در مورد ابعاد سند نهايی چاپ، الزامات رنگ و چاپخانه چاپ كننده آن از كارفرما 
سؤال كنيد.

در مرحله پياده سازی، بايد كار را در InDesign به صورت عملياتی انجام دهيد؛ يعنی مواردی را كه در اين 
كتاب فراگرفتيد از جمله وارد كردن متن از Word، قرار دادن تصاوير، طراحی جداول و ...، انجام دهيد. 

در مرحله نهايی سازی بايد مواردی همچون گرفتن خروجی از طريق گزينه های صدور را انجام دهيد و از كل 
پروژه پکيج بگيريد. در نهايت يک نمونه از كار را چاپ كرده و ببينيد با اهداف شما مطابقت دارد. در صورت 
تأييد سفارش دهنده پروژه شما به عنوان طراح، به شمارگان مورد نياز مي تواند چاپ شود يا در فضاي مجازي 

استفاده گردد.
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سازمان پژوهش و برنامه ريزي آموزشي جهت ايفاي نقش خطير خود در اجراي سند تحول بنيادين در آموزش 
و پرورش و برنامه درسي ملي جمهوري اسلامي ايران، مشاركت هنرآموزان را به عنوان يک سياست اجرايي 
مهم دنبال مي كند. به منظور تحقق اين امر مهم، اعتبارسنجي كتاب هاي درسي را در دستور كار خود قرار 
داده است تا با دريافت نظرات هنرآموزان درباره كتاب هاي نو نگاشت، كتاب هاي درسي را در اولين سال چاپ، 
 با كمترين اشکال به هنرجويان و هنرآموزان ارجمند تقديم نمايد. در اجراي مطلوب اين فرايند، همکاران گروه 
تحليل محتواي آموزشي و پرورشي استان ها و  گروه هاي آموزشي نقش سازنده اي را برعهده داشتند. ضمن 
ارج نهادن به تلاش تمامي اين همکاران،  اسامي هنرآموزاني كه تلاش مضاعفي را در اين زمينه داشته و با ارائه 

نظرات خود سازمان را در بهبود محتواي اين كتاب ياري كرده اند به شرح زير اعلام مي شود.
اسامي دبیران و هنرآموزان شرکت کننده در اعتبارسنجي کتاب کاربر گرافیک رایانه ای
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استان محل خدمت نام و نام خانوادگي ردیف 

تهران سحر اسماعيلي 1

شهرستان هاي تهرانزهرا كردي2

تهرانليلا سعيد  3

تهرانمريم شفيعي 4

خراسان رضويليلا داودي ثاني5

شهرستان هاي تهرانبيتا رهنماي زربيجاري6

تهرانميترا اميدوار۷

تهراننگار نصر8

تهرانبهاره محمدی۹

آذربايجان  غربیحسين ابازری برگشادی10

تهرانعباس احسان جو11

تهرانهادی صادقی خوانساری12

تهرانعباسعلي رضايي13

تهرانمحمد نقوي 14




